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I Introduction to R-Studio for Linux

R-Studio is a family of powerful and cost-effective undelete and data recovery software. Empowered by new
unique data recovery technologies, it is the most comprehensive data recovery solution for recovering files from

Ext2/3/4FS and XFS (Linux), FAT12/16/32, exFAT, NTFS, NTFS5 (created or updated by Windows 2000/?XP/?2003/?

Vista/?2008/?7/?8/8.1/?10), HFS/HFS+ and APFS (Macintosh), Little and Big Endian variants of UFS1/UFS2 (FreeBSD/?

OpenBSD/?NetBSD/?Solaris) partitions. It functions on local and network disks, even if such partitions are
formatted, damaged or deleted. Flexible parameter settings give you absolute control over the data recovery.?

R-Studio for Linux Features
System Requirements
Contact Information and Technical Support
Data Recovery Using R-Studio for Linux
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Volume Sets and RAIDs

Data Recovery over Network
R-Studio Technician/T80+
Text/?hexadecimal editor
Technical Information and Troubleshooting
Working with the Third-Party Hardware
R-Studio Emergency
R-Studio Agent Emergency

Window s 9x/?ME/?NT4.0/Window s 2000, XP, Vista, 7,8/8.1, 10, 11, Window s Server 2003, 2008, 2012, 2016, 2019, 2022 are registered

trademarks of Microsoft Corporation.

Mac OS X, OS X, and macOS are registered trademarks of Apple Inc.

All other trademarks are the property of their respective ow ners.

1.1 R-Studio for Linux Features

R-Studio is a family of file restoring utilities. It recovers files both on local disks and on disks on remote
computers over network, even if their partition structures are damaged. A unique IntelligentScan technology and
flexible parameter settings give you real control over the fastest data recovery ever seen.

R-Studio for Linux features:

· Host OS: Linux, kernel 2.6 and above.
· Automatic check for updates.
· Remotely recovers data over network. Data can be recovered on network computers running Windows,

Mac, and Linux and some other UNIX OS. 
· Supported file systems:

Windows: FAT12/16/32, exFAT, NTFS, NTFS5, ReFS/ReFS2+ file (Resilient File System); ReFS for
Windows Server 2019 (including deduplication).

macOS: HFS, HFS+, HFSX, APFS, FAT/exFAT;
Linux and UNIX: Ext2/3/4FS and XFS (created by Linux or other OS), and UFS1, UFS2, UFS

BigEndian (used by the FreeBSD, OpenBSD, and NetBSD operating systems);

https://www.r-studio.com/What-is-ExtFS.html
https://www.r-studio.com/What-is-XFS.html
https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-is-ExFAT.html
https://www.r-studio.com/What-is-UFS.html
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-disk-format.html
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-a-File-System.html
https://www.r-studio.com/What-is-ExFAT.html
https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-is-ExtFS.html
https://www.r-studio.com/What-is-XFS.html
https://www.r-studio.com/What-is-UFS.html
https://www.r-studio.com/What-is-UFS.html
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CD/DVD/Images: ISO9660;
Magnetic tape devices: UStar/Tar/CPIO/Pax (R-Studio Technician/T80+).
Please note, that when a file is being deleted on the HFS, HFS+, HFSX file systems, the computer
completely removes all system information on it, and there is no way to recover the deleted file except by
using the Extra Search for Known File Types option. Nevertheless, R-Studio for Linux is able to read
existing files from HFS, HFS+, and HFSX disks.

· Support for known file types. R-Studio for Linux searches for files with known typical features of their
structures allowing the user to search for files on devices with unknown files systems, including an HD, CD,
DVD, floppy disk, Compact Flash Card, USB drive, ZIP drive, Memory Sticks, and other removable
media.

· Scan process visualization. While scanning an object, R-Studio for Linux graphically shows items that have
been found, including files of known types, FAT and NTFS MFT records, boot records, etc.

· Mass file recovery support.
· Support for estimation of chances for successful recovery.
· Support for file recovery lists - lists of files that can be exported from R-Studio for Linux, manually edited,

and then loaded back. Files from such lists will be automatically marked for recovery.
· APM, Basic and GPT support. R-Studio for Linux supports all three partition schemes used to define the

low-level organization of data on disks formatted for use with Macintosh computers.
· Support for Linux mdadm Volumes
· Support for Linux LVM/LVM2
· Dynamic disk support.
· Software RAID, volume set, and stripe set support. Support for RAID 6, RAID 5, and RAID 4 layouts.

Support for custom RAID layouts. Parameters like block size and order, offsets, and even the number of
stripe blocks can be explicitly specified. Custom RAID configurations can be saved.

· Support for Windows Storage Spaces, created by Windows 8/8.1 and Windows 10/Threshold
2/Anniversary/Fall Creators updates.

· Support for Apple software RAIDs
· Support for Apple CoreStorage/FileVault/Fusion Drive Volumes
· Support for Intel Software RAID.
· Hardware RAID, volume set, and stripe set support.
· RAID consistency check (check for valid data parity values).
· Automatic RAID parameter recognition.
· Creates image files for an entire drive, logical disk, or its part. Such image files can be processed like regular

drives. In addition to simple exact object copies (Plain images) and R-Drive Image compatible images. It
can create other disk image and virtual disk formats, together with opening several file formats "read-only".
You may read more about those formats and their properties on the Supported Virtual Disk and Disk Image
Formats page. Images may be saved either on the local or remote computer. Image creation can be stopped
and then resumed. R-Studio for Linux can scan objects while creating their images. R-Studio
Technician/T80+ supports multi-pass and runtime imaging. Images can be mounted in the operating system
as devices which makes their content accessible to any program including any other data recovery software.

· Recovers files on damaged or deleted partitions.
· Recovers compressed files (NTFS, NTFS5).
· Recovers encrypted files (NTFS5).
· Recovers alternative data streams (NTFS, NTFS5).

https://www.r-studio.com/What-is-Raw-File-Recovery.html
https://www.R-Studio.com/What-is-drive-scan.html
https://www.r-studio.com/What-is-disk-format.html
https://www.r-studio.com/What-is-Disk-Image.html
https://www.r-studio.com/What-is-Logical-Disk.html
http://www.drive-image.com/
https://www.r-studio.com/What-are-alternate-data-streams.html
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· Support for NTFS deduplication, including Windows Server 2022.
· Support for file system journal on the HFS+ and Ext3/4fs file systems.
· Support for soft updates journal on the UFS file system.
· Support for extended attributes on the HFS+, Ext3/4fs, XFS, and UFS file systems.
· Support for compressed files on the HFS+ file system.
· Recognizes localized names.
· Recovered files can be saved on any (including network) disks visible to the host operating system.
· A hexadecimal disk and file viewer/editor supporting NTFS file non-resident attribute editing. Data alteration

is available on the Technician/T80+ and Corporate versions only..
· Patterns (or templates) in the hexadecimal editor allowing for parsing the data according to specific data

structure. Such patterns may be custom-created.
· File preview. Most of the file types can be previewed to estimate recovery chances.
· Enhanced remote host scanning procedure. In the new R-Studio for Linux network versions, data are

analyzed on the remote host rather than on the home host, thereby the speed of recovery procedure greatly
increases.

· Recovered files may be saved on a disk on a connected remote computer rather than be transferred over
network to the local one. Saving recovered files on a remote computer may be useful when the remote
computer has a healthy disk because you do not have to transfer files over network. It may be an external
USB hard drive, for example.

· Support for S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) attribute monitoring.
· R-Studio Emergency*. The R-Studio for Linux Emergency version starts from a floppy or compact disk

when it is necessary to recover data on a computer, on which OS cannot start up because its system files are
corrupted or deleted.

*The R-Studio Emergency is a part of the R-Studio for Linux software package. When you buy an
R-Studio for Linux single license you may run the R-Studio Emergency or/and install the R-Studio for
Linux Windows version on one PC only and you may not transfer the licensed software to another PC. 

R-Studio features available only in the Technician/T80+ versions:

· Magnetic tape devices file system: UStar/Tar/CPIO/Pax.
· USB Activation (Technician only)
· Show Files (Advanced) to process problematic hard drives with minimum disk access. 
· Multitasking. Several data recovery tasks can be run simultaneously.
· Additional Recovery Options
· Hidden Devices. Some unnecessary devices can be hidden in the Main panel.
· Extended File Information 
· Symbolic Link Recovery Options
· Drive Copy Wizard to copy any object in the Drives panel to any other object. In addition to byte to byte

copy of any object visible in the Drives panel, smart copy of partitions and drives is available.
· File Maps
· I/O Monitor and Sector Map files.
· Multi-pass and Runtime imaging
· Reverse RAIDs: A technique that decomposes real drive objects into virtual RAIDs. Then those components

of reverse RAID scan be processed like real objects. They can be viewed, edited, imaged, copied to
physical devices.

https://www.r-studio.com/What-is-SMART.html
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· Support for third-party hardware.
· Forensic mode.
· File recovery over Internet.

R-Studio for Linux recovers files:

· That have been removed without the Recycle Bin, or when the Recycle Bin has been emptied;
· Removed by virus attack or power failure;
· After the partition with the files was reformatted, even for a different file system;
· When the partition structure on a hard drive was changed or damaged. In this case, R-Studio for Linux can

scan the drive trying to find previously existed partitions and recover files from found partitions.
· From disks with bad sectors. In this case, R-Studio for Linux can first copy the entire disk or its part into

an image file and then process such image file.

R-Studio for Linux can create image files for an entire hard drive, logical disk, or its part. Such image files can
be processed like regular disks. Images are very useful if there is a risk of total data loss due to hardware
malfunction. If bad blocks are constantly appearing on a hard drive, the only way to save the data is to
immediately create an image of that drive. All data search, scan and recovery can be done from this image.

To learn more about the IntelligentScan technology, go to the IntelligentScan topic .

1.2 System Requirements

· An Intel-compatible x86 or 64-bit platform with 256 MB RAM, a mouse, and enough disk space for
recovered files, image files, etc.

· Linux: Fedora 12+, Ubuntu/Kubuntu 10.4+ , Debian 4.0+ or any kernel 2.6+ Linux distribution capable of
installing .rpm or .deb packages.

· Any Window manager.
· X.Org X server 1.7.6+ installed.
· Root privileges to install and run the program.
· A network connection for data recovering over network. 

1.3 Contact Information and Technical Support

To obtain the latest version of R-Studio for Linux, go to:

Product Site: http://www.r-tt.com
Sales Department: sales@r-tt.com

Many specific data recovery cases are discussed in the R-TT's Data Recovery Guide.

R-Studio for Linux Technical Support Team is available 24 hours a day, seven days a week, and has an
average response time less than 4 hours.

Tech. Support: support@r-tt.com
Send your support request to: http://www.r-tt.com/SupportRequest.shtml 

File Recovery FAQ: http://www.r-tt.com/File_Recovery_FAQ.shtml

R-TT Forum: http://forum.r-tt.com

https://www.r-studio.com/What-are-Bad-Sectors.html
http://www.r-tt.com
mailto:sales@r-tt.com
http://www.r-studio.com/Data_Recovery_Guide.shtml
mailto:support@r-tt.com
http://www.r-tt.com/SupportRequest.shtml
http://www.r-tt.com/File_Recovery_FAQ.shtml
http://forum.r-tt.com
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1.4 R-Studio for Linux Main Panel

When R-Studio for Linux starts, its main panel appears on the desktop.
R-Studio for Linux Main panel

Drives panel:

You can select an object by clicking on it.

Properties tab:

This tab shows the properties of an object selected on the Drives panel.

Depending on the selected object, information on this Properties tab may vary.
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The Properties tab names and values are described in detail on the Properties tab topic.

Log panel

S.M.A.R.T. Info for a Hard Drive

R-Studio for Linux shows hard drive S.M.A.R.T. states using their icons. You may copy all S.M.A.R.T.
attributes and paste them into a text editor. 

Hard drive S.M.A.R.T. states and icons

Normal: This state indicates that
the hard drive is in good
conditions. 

https://www.r-studio.com/What-is-SMART.html
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Warning: This state indicates
that some small problems with
the disk are possible in the
future, you may work with it but
with cautions and regular check
of these parameters. Disk
imaging is strongly
recommended.

Critical: This state indicates that
the hard drive conditions are
critical and chances of
hardware failure are great. The
best recommendation for this
case is to stop working with the
disk and bring it to professional
data recovery specialists. You
may though continue to work
with the disk at your own risk,
but disk imaging is very strongly
recommended.
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When a hard drive is selected on the R-Studio for Linux main panel, an additional S.M.A.R.T. tab will appear.
You may view the detailed S.M.A.R.T. data of the drive.  

S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) is a technology widely-used in hard drives
and solid-state devices that monitors their reliability conditions to predict possible hardware failures.

Changing the program language

You may select the language of R-Studio for Linux main panel. To do so, select an available language on
Change Language on the Help menu.

Panel view options

You may set which panels and bars to enable/disable.
To enable/disable:

Toolbar Select/clear Toolbar on the View menu

Status bar Select/clear Status bar on the View menu

Drive pane Select/clear Device View on the View menu

Properties pane Select/clear Properties View on the View menu

Log panel Select/clear Event Log on the View menu

If you have several tabs in the right pane, you may easily switch to any of the tab by selecting on the View

menu
Properties Tab to view the Properties tab
Scan Information
Tab

to view the Scan Information Tab tab

Parents Tab to view the Parents tab
Properties Select data types in which the data will be represented

Connect

Click this button to connect to a remote computer on a
network.

Refresh

Click this button to refresh the panels.

Scan

Click this button to start scanning a selected object.

Partition Search

Click this button to start fast searching for lost and deleted
partitonsi.

Show Files

Click this button to start searching for files on a selected
object.

http://en.wikipedia.org/wiki/S.M.A.R.T.
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Open Image

Click this button to open a previously created
image.

Create Image

Click this button to create an image of a selected
area.

Create Region

Click this button to create a region on a selected
disk.

Create Virtual RAID

Click this button to create a virtual volume set or RAID.

Select an appropriate type from the menu.

Remove

Click this button to remove a selected object on the main
panel.

The button may change its appearance and title depending
on the context.

Sometimes, there may be a lot of similar objects on the Drives panel. Those may be components of a RAID, for
example. You may turn numerical indexes for such objects to distinguish them better. Those indexes will appear
before the object names on the Drives panel.

To turn the numerical indexes on/off, go to the Device item on the View menu, and select/clear:

Show Physical Drives Indexes to display the indexes only for hard drives
Show All Objects Indexes to display the indexes for all objects on the Drives panel

You may select the units in which object's start and size are displayed.

To select the units

1 Select Devices on the View menu

2 Select the units in which you want to see object sizes.

You may select
Show as Bytes
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Show as Sectors
Show as Bytes and Sectors

Depending on the task R-Studio for Linux performs, its panel may vary. Those panels are described in
appropriate topics. The Properties tab names and values are described in detail on the Properties tab topic.

The general settings can be set on the Settings dialog box.

You may also copy the object's information displayed on the  Drives panel. Right-click the object on the
necessary column and select Copy Device/Disk, Copy Label, and so on.

R-Studio for Linux has two operation modes:

File search on a partition (including recently found during disk scan).

In this mode, R-Studio for Linux analyzes MFTs on NTFS partitions, FATs on FAT partitions, and
SuperBlocks on Ext2/3/4FS partitions. Then it displays all files which records have been found in the analyzed
tables. Then recently deleted files, which records still remain, can be recovered. If files have not been found,
that means that their records have been deleted. In this case, the disk must be scanned.

File search supports file masks and regular expressions. Multiple files in different folders can be found and
recovered in one recover session.

R-Studio for Linux supports mass file recovery. There is no limit in the number of files that may be recovered
during one session.

File content may be previewed before recovery. 

File or disk binary data can be viewed and edited in the text/hexadecimal editor. Also can be viewed and
changed all attributes for NTFS files. 

Disk scan, searching for partitions.

In this mode, R-Studio for Linux scans the entire disk or its part. Using a number of statistic and deterministic
criteria known as IntelligentScan technology, it determines existing or existed partitions on the disk, and their
file systems. It is also possible to add new partitions, by setting manually all required parameters.

A disk can be scanned through several successive scans, each with its own parameters. R-Studio for Linux
accumulates the information from successive scans and keeps track of changes in the information obtained from
different scans. The information obtained from the disc scan can be stored in a file. It may be loaded and
processed later at any convenient time.

1.5 R-Studio for Linux Settings

You may specify some global setting for R-Studio for Linux on the Settings dialog box. You may reach it by
selecting Settings on the Tools menu.

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.R-Studio.com/What-is-drive-scan.html
https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-is-a-File-System.html
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Main 

Main dialog box

Main settings

System Options

Auto-refresh Drive Tree

If this box is selected, R-Studio for Linux automatically refreshes
the list of connected drives. You may disable it if R-Studio for
Linux experiences problems with connected devices.

Debug Mode

If this check box is selected, R-Studio for Linux displays an
additional command Create FS Snapshot on the shortcut menu for
an object with a file system. An FS Snapshot contains system data
for the file system only (file descriptions without file contents). If a
problem appears, this snapshot can be sent to R-Studio for Linux
technical support to identify the problem. This option greatly slows
R-Studio for Linux. 

Enable forensic mode (demo)
If this check box is selected, R-Studio for Linux turns on the
Forensic mode in demo mode.

Check for update
If this box is selected, R-Studio for Linux will automatically check
for updates.

Use dark mode
If this box is selected, R-Studio for Linux will change to its dark
mode.

Edit options

Enable Write

If this check box is selected, R-Studio Technician/T80+ enables
you to write any changes made in the Text/?hexadecimal editor. It
enables wiping objects in R-Studio and R-Studio Corporate.

Max changes buffer size
Maximum amount of data stored for the Undo command in the Text/?
hexadecimal editor. R-Studio Technician(/T80+)

User paths

File types 
Specifies a file name and path to the file where the descriptions of
user's known file types are stored. You need to re-start R-Studio for

https://www.r-studio.com/What-is-a-File-System.html
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Linux or click the Reload User's File Types button on the Known File

Types tab for the new file to take effect.

RAID layout presets
Specifies a file name and path to the file where the descriptions of
user's RAID layouts are stored

Text/?hexadecimal editor
templates

Specifies the path for pattern description files for Text/?hexadecimal
editor.

Mask presets Specifies a file name and path to the file with file mask presets.

Reset all hidden notifications
This button enables all previously disabled notification and warning
messages.

File Systems 

File Systems dialog box
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File Systems

Default encoding for HFS volumes

Encoding Select the national encoding for the HFS partitions.
Default encoding for Ext2/?Ext3/?
Ext4/?UFS volumes

Encoding
Select the national encoding for the Ext2, Ext3, Ext4, and UFS
partitions.

File system sorting

Disable any sorting
Select this option if the number of files on the drive is so large that
R-Studio sorts files in selected folders for too long time.

Advanced file system interpretation

Minimize drive access

Select this option if a lot of bad sectors are on the drive. R-Studio
will reduce access to internal files in the file system to speed up the
interpretation of file system data.

Show deleted empty folders Select this option if you want to view empty deleted folders.

Symbolic Links

All settings are available in the Technician/T80+ version only!

Symbolic links (of symlinks for short) are object that contains references to other files or folders directory in the
form of absolute or relative paths and that affect pathname resolution. For example, if a symlink C:
\ProgramData\Documents points to D:\Recovered Files\Root\Users\Public\Documents, entering it
will result in entering D:\Recovered Files\Root\Users\Public\Documents.

Symbolic Links dialog box

Symbolic Links

Link conversion (Default) 

Both an object and its symbolic link
are selected for recovery:

If both an object and its symbolic link are selected for recovery,
both the object and its symbolic link will be recovered. The file
path in that symbolic link will be converted from absolute to

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-ExtFS.html
https://www.r-studio.com/What-is-UFS.html
https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-are-Hard-Soft-Links.html
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relative. Example: If the object C:\ProgramData\Documents is
a symbolic link to C:\Users\Public\Documents, it will be
converted to a symbolic link to ..\Users\Public\Documents.
Therefore, the symbolic link will point to its object regardless of
the place to which the object has been recovered.

Only an object is selected for
recovery:

Only the selected object will be recovered.

Only a symbolic link is selected for
recovery:

The selected symbolic link will be recovered as a real object.

Log 

Log dialog box

 Log options

Logging

Maximum
messages in the
Event Log

Specifies the maximum number of messages R-Studio for Linux will keep in the event
log

Save log to file If this check box is selected, R-Studio for Linux writes its log into a log file specified in
the File name field.

File name Specifies the file name in which the log will be saved.
Type

File If this check box is selected, R-Studio for Linux logs all events with recovered files.
File System If this check box is selected, R-Studio for Linux logs all events with the file system.
Partition If this check box selected, R-Studio for Linux logs all events with partitions.
Recover If this check box is selected, R-Studio for Linux logs all events with the recovering

processes.
Disk If this check box is selected, R-Studio for Linux logs all events with disks.
Network If this check box is selected, R-Studio for Linux logs all events with network

operation.
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Severity

Error If this check box is selected, R-Studio for Linux adds error messages into its log.
Warning If this check box is selected, R-Studio for Linux adds warning messages into its log.
Information If this check box is selected, R-Studio for Linux adds information messages into its

log.
Success If this check box is selected, R-Studio for Linux adds success messages into its log.

NEVER WRITE A LOG FILE ON THE DISK FROM WHICH YOU RECOVER DATA!!!
Or you may obtain unpredictable results and lose all your data.

Note: If in the Recover dialog box the Condense successful restoration events check box is selected, the
Log will display only Error, Warning, and Information event messages.

Known File Types 

Known File Types dialog box

You may specify which Known File Types will be enabled/disabled by default. You may also specify know
file types to search for during a specific scan session on the Scan dialog box.

Known File Types

Reset
Click this button to reset the settings to the previous state. Active until the Apply

button is clicked.

Select All Click this button to select all file types in the list.

Clear All Click this button to clear all file types in the list except some predefined ones.

Reload User's File
Types

Click this button to apply new file types after the user's file types file has been
changes from the Main tab.

Edit User's File
Types

Click this button to add a new customer's Known File Type, or to edit already
existing ones. See the Customizing File Types help page for more details.

Reset to
Recommended

Click this button to reset the settings to the default (Recommended) file set.

You may search for required file types if necessary

https://www.R-Studio.com/What-is-drive-scan.html
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Search for the doc pattern

Bad Sectors 

Bad Sectors dialog box

Bad Sectors settings

Default read retries count

Specifies a default value for I/O Tries, or how many times R-Studio for Linux
will try to read a bad sector. You may specify this parameter for each drive
separately on the Properties tab.
R-Studio treats bad sectors in the following way:
It reads a certain part of drive (predefined by Windows) and
· If Default read attempts is set to 0, the entire part with bad sectors will be

filled with the specified pattern. 
· If Default read attempts is set to a non-zero value, R-Studio for Linux

reads again that part sector by sector, repeating the attempts the specified
number of times. If R-Studio for Linux still cannot read a bad sector, it fills
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the sectors with the specified pattern. In this case only the bad sectors will
be filled with the pattern, but that extremely slows the drive read process.

For example, if you set Default read retries count to 1, a bad sector will be
read 2 times.

Set default read retries
count for all drives

Select this option to set Default read retries count for all drives to this value.

Pattern to fill bad blocks

Specifies a default pattern R-Studio for Linux will use to fill bad sectors in
files to recover, in images, or when showing data in the Text/?hexadecimal
viewer/editor. You may specify the pattern either in the ANSI or Hex data
format.
Note: R-Studio for Linux will never ever try to write anything on the drive
from which data is to recover or an image is to create. 

Memory Usage

Memory Usage dialog box

These settings control how much memory R-Studio for Linux uses for its work. They help preventing
R-Studio for Linux from locking when trying to perform very memory-consuming tasks like scanning large
disks or processing file systems with a lot of files.

Memory Usage settings

Disable memory control If this option is selected, the memory control is disabled.

Limit usage of the process
memory by

If this option is selected, R-Studio for Linux will automatically stop
performing the task when the amount of used virtual memory reaches the
specified value.

Limit usage of the process
memory by

If this option is selected, R-Studio for Linux will automatically stop
performing the task when the amount of used physical memory reaches the
specified value.

You may see how much memory R-Studio for Linux actually uses on the Memory Usage dialog box.

https://www.r-studio.com/What-is-Disk-Image.html
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II Data Recovery Using R-Studio for Linux

Many specific data recovery cases are discussed in the R-TT's Data Recovery Guide.

Depending on the situation, data recovery may vary:

1. Recovery of deleted files that have resided on an existing logical disk

This can be done using Basic File Recovery.

2. Recovery of files that have resided on a data disk with a damaged file system, or on a previously
deleted or formatted partition

If the file system on such logical disk is damaged, the operating system sees that logical disk as a partition
without a valid file system. Such partition should be previously scanned. Also, it should be scanned if you
want to recover data on a previously deleted or re-formatted partition.

When the partition is scanned, a number of recognized partitions will appear. R-Studio for Linux shows
them in different colors depending on which elements of the partition have been found.

An existing logical disk or partition

An existing logical disk or partition after disk scan

A recognized partition. Both boot records and file entries are found for this
partition
A recognized partition. Only file entries are found for this partition

A recognized partition. Only boot records are found for this partition

A fast found partition
A deleted partition 

Empty space on the object
Files that have been found using scan for known file types.

Although such recognized partitions are virtual objects, files can be searched for and recovered from
recognized partitions as from real logical disks using Basic File Recovery.

To successfully recover files from a recognized partition, it is necessary to find a right one which corresponds
to the real logical disk on which the files resided. No strict rules can be applied to that, but the following
considerations should be taken into account:

· If you are going to recover files from a disk with a damaged file system, most likely the right recognized
partition will be a green one.

· If you are going to recover files from a previously deleted or re-formatted partition, most likely the
right recognized partition will be a yellow one.

Also always check the recognized partition's file system, start point, and size. They should be the same for
the recognized partition and real logical disk/partition. When in doubt, try to preview a couple of files from
the recognized partition. If the files are seen correctly, this is the right partition.

3. Data recovery from a damaged system disk. The computer does not start up.

· If this computer is on a network, create an R-Studio Agent Emergency startup disk for the computer,
install R-Studio for Linux on another computer on the network, and recover data over network.

· If this computer is stand-alone, create an R-Studio Emergency startup disk and use it to start up the
computer and recover data. You may use external USB hard disks to store recovered files.

R-Studio for Linux Features

http://www.r-studio.com/Data_Recovery_Guide.shtml
https://www.r-studio.com/What-is-Logical-Disk.html
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-a-File-System.html
https://www.r-studio.com/What-is-disk-format.html
https://www.r-studio.com/What-is-system-disk.html
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Contact Information and Technical Support
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Volume Sets and RAIDs

Data Recovery over Network
Text/?hexadecimal editor
Technical Information and Troubleshooting
R-Studio Emergency
R-Studio Agent Emergency

2.1 Basic File Recovery

NEVER TRY TO SAVE RECOVERED FILES/FOLDERS TO THE SAME LOGICAL DISK WHERE
THEY RESIDE!!!

Or you may obtain unpredictable results and lose all of your data. 

See the Data Recovery Issues topic for details.

Basic file recovery can be made for deleted files that has resided on an existing partition visible to the operating
system. In all other cases, Advanced Data Recovery is required. 

To recover deleted files from a logical disk (recognized partition),

1 Double-click a logical disk on the R-Studio for Linux's Drives panel to enumerate files on the disk

 Other ways to enumerate files

· Select the disk and click the Open Drive Files button, 
or
· Right-click the selected disk and select Open Drive Files on the context menu, 
or
· Select Open Drive Files on the Drive menu

If you try to enumerate files on a hard drive or another object without a valid file system on it, a Double-click

a logical disk... message will appear. Select a logical disk on the object or scan the object.

> R-Studio for Linux will change its panel showing the disk's folders/?files structure

R-Studio for Linux analyzes data on the object and displays all files for which records have been found in
the analyzed tables. If files have not been found, that means that their records have been deleted. To find
such files, Advanced Data Recovery is required.

Please note that R-Studio for Linux shows only those files/?folders that match a specified file mask.

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-Logical-Disk.html
https://www.R-Studio.com/What-is-drive-scan.html
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 R-Studio for Linux Main panel

Panel view options

You may set which panels and bars to enable/disable. To enable/disable

The Toolbar Select/clear Toolbar on the View menu

The Status bar Select/clear Status bar on the View menu

The Folders panel Select/clear Folders View on the View menu

The Files panel Select/clear Contents View on the View menu

The Log panel Select/clear Event Log on the View menu

The Find Results panel Select/clear Find Results on the View menu

R-Studio for Linux shows folder sizes in the right pane.
Folder sizes

You may also arrange the data as required. On the View menu, select Arrange and them a required
arrangement.
You may specify which columns will be visible on the Files panel. On the View menu, select Contents

Columns, and select the columns you want to see.
Files can be shown as a list or as icons/tiles of different sizes.
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Files shown as icons/tiles

Recovery chances
R-Studio for Linux shows its estimates of chances for successful file recovery in the Rec column. 
Recovery chances

Undefined

Good

Above average

Average

Below average

Bad

When R-Studio has enumerated files, those estimates may not be accurate and aren't available for most
files. You may improved them by right-clicking any folder on the Content pane and selecting Recheck

Recovery Chances on the context menu.

The best estimations are though after scanning the disk/partition.

File Information
You may view some information about a file. Right-click the file and select Get Info on the context menu.

File Information
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R-Studio Technician shows much more information about a file. See the Information about a File topic for
more details.

Folders panel

Deleted folder
Marked folder (all child
objects in this folder are
marked)
Partially marked folder
(some child objects in
this folder are marked)
Target of a symlinked
folder
Symlink to a folder

Cross-linked folder (A
FAT folder containing
data which also belongs
to other FAT folders.)
Questionable deleted
folder (A FAT folder
found by R-Studio for

Linux, but with
apparently invalid
content.)
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Files panel:

Deleted file:
Marked deleted file

Selected deleted file

Target of a hard link

Hard link to a file

Sorted by:

You may also arrange the data as required: by their extensions,
creation/modification time, or as a real file structure
See Find and Mark Multiple Files for more details

Find Results panel
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Reopen All Files

Click this button to list files again.

Recover

Click this button to recover selected folders/?
files.

Recover Marked

Click this button to recover marked folders/?
files.

Find

Click this button to find or/and mark a particular file/folder. 

Find Next

Click this button to find the next object specified in the Find/Mark

dialog box

Find Previous

Click this button to find the previous object specified in the Find/Mark

dialog box.

File Mask

Click this button to specify a file mask.

The Unmask button appears when a mask is
applied. 

Click this button to remove the applied mask.

Up

Click this button to move highlighting one folder
up.

Options

Click this button to change Recovery
Options.

Details

A button selecting how the files will be shown:
Details, Small, Medium, Large Icons

The Log panel will show how many files and folders are on the object, and their size. You may specify which
events will be shown in the log pane by setting a log filter.
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Note: Metafiles are the file system's internal files invisible to any user, or file system data, which R-Studio
for Linux represents as files. These files do not contain user data directly. Unless you want to scrutinize a
disk file system, do not restore them.

If the Too many files... message appears, you may temporally stop file listing and browse through found files.
Then you can resume file listing. You also may skip this file topic and continue. R-Studio for Linux will keep
information about the entire file structure.

You may also copy the information about folders and files. 

For the folder (the Folders pane):

Click Copy Folder: To copy the folder's name

Click Copy Path: To copy the path to the folder

For the file (the Contents pane):

Click Copy (Column

Name):
To copy the file's Name, Size, Created, etc., depending on which column is
selected

Click Copy Path: To copy the file path.

Click Copy Selected

Text:
To copy all the columns of the selected file.

2 Select a file/folder to recover

You may select several files/?folders in the same parent folder by pressing the Shift button and clicking the
objects simultaneously.

 Marking multiple files/folders from different parent folders manually:

Mark a file/folder to recover by clicking the box left to the object, or select Mark on the context menu. You
may mark several files/?folders in different parent folders. You may mark all objects in the folder by selecting
Mark All on the Tools or context menu. To unmark an object, click the box left to the object once more or
select Unmark on the context menu. You may unmark all objects in the folder by selecting Unmark All on
the Tools or context menu.
The Log panel will show how many files and folders you have marked, and their total size.

R-Studio for Linux can search for a particular file. Go to the Searching for a File topic for details. If you
need to find and mark many files, go to the Find and Mark Multiple Files topic for details.

File content may be previewed before recovery. Go to the Previewing Files topic for details.

If you do not find files that you want to recover:

Sometimes R-Studio for Linux can find the files but not the entire file paths to them. It puts such files into
the Extra Found Files folder. Try to search for the files there. If that does not help, try to find them by using
file search globally on the entire disk. Go to the Searching for a File topic for details

If you still cannot find files that you want to recover but are sure they have existed on the logical disk, you
need to use Advanced Data Recovery to find them.

3 Click the Recover or Recover Marked button

 Other ways to recover selected files

· Right-click the selected file/folder and select Recover or Recover Marked on the context menu, 
or
· Select Recover or Recover Marked on the File menu.
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4 Specify recover options and output folder on the Recover dialog box and click the OK button

Recover dialog box

Recover (Advanced) dialog box

If you have another computer connected to R-Studio for Linux over network, the Recover dialog box will be

slightly different. See Data recovery over network for details.

 Recover options

Condense successful restoration events If this check box is selected, R-Studio for Linux will display only
error and warning messages in its Log

Restore folder structure If this check box is selected, R-Studio for Linux recovers the
entire path to the selected object.

Restore from root If this check box is selected, R-Studio for Linux recovers the
entire path to the selected object starting from the root folder of
the disk.

Recover metafiles If this check box is selected, R-Studio for Linux recovers disk
metafiles. Metafiles are the file system's internal files invisible to
any user, or file system data, which R-Studio for Linux
represents as files. These files do not contain user data directly.
Unless you want to scrutinize a disk file system, do not restore
them.

Recover alternative data streams If this check box is selected, R-Studio for Linux recovers
alternative data streams for file systems that support them. Has no
effect on FAT files. See Extended Information Recovery for
the NTFS file system, and Data Recovery on HFS/HFS+ File
System for the Mac computers.

https://www.r-studio.com/What-are-alternate-data-streams.html
https://www.r-studio.com/What-is-FAT.html
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Recover security If this check box is selected, R-Studio for Linux recovers
security attributes for NTFS files. Has no effect on FAT files. See
Extended Information Recovery for details.

Recover extended attributes If this check box is selected, R-Studio for Linux recovers
extended (HPFS) file attributes.

Remove hidden attributes If this check box is selected, R-Studio for Linux removes the
Hidden and System attributes from recovered files enabling the user
to see them in the Windows Explorer.

Recover real folders structure Enabled when the files are sorted by their extensions or date. See
Find and Mark Multiple Files for details. If this check box is
selected, R-Studio for Linux recovers the real folders/?files
structure on the disk rather than that of sorted files.

Skip files with bad sectors If this check box is selected, R-Studio for Linux skips files with
bad sectors and displays their list on the Files with bad sectors

dialog box when the recovery has been completed. You may
separately decide later what to do with those files. See Bad
sectors for details. 
If this check box is cleared, R-Studio for Linux tries to read
those sectors several times (specified on the Settings/Bad

Sectors dialog box), and, if fails, fills bad sectors in the recovered
file with the pattern specified on the same box. Information about
such files will appear in the Log.

Do not recover duplicate files from
Extra Found Files

If this check box is selected, R-Studio for Linux does not
recover files from Extra Found Files (raw files) that coincide with
files recovered from the file system.

Ignore file mask If this check box is selected, R-Studio for Linux recovers all
content of a selected folder, ignoring a specified File Mask.

Open local folder (folders) when done If this check box is selected, the folder with recovered files will be
opened upon recovery completion.

Advanced Specifies options for mass file recovery

If you want to recover multiple files at once, go to the Recover Multiple Files for more information

R-Studio Technician/T80+

It has additional Recovery options.

If a file to be recovered appears to have an invalid name, a Broken File Name dialog box will appear. You
may correct the name and resume file recovery.

Broken File Name dialog box

 Broken File Name properties

File name Shows the current incorrect file name.
New name Field for a new file name.

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-are-Bad-Sectors.html
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Edit broken symbols only If this check box is selected, only invalid symbols may be
corrected

Change all invalid symbols to If this check box is selected, all invalid symbols will be changed to
the specified symbol

Buttons

Rename Click to resume file recovery
Rename All Click to resume file recovery. All other files will be renamed

according to the specified rule.
Skip Click to skip this file
Skip All Click to skip all files and stop file recovery

If there is no space available for the recovered files, the There is not enough space on the disk dialog box
will appear. You may either select other place to store the files, skip that particular file or abort the recovery
process.

There is not enough space on the disk dialog box

> R-Studio for Linux will recover the selected/marked files/?folders to the specified folder and show the

results in the Log pane

The Recovery progress indicator will show the log and progress of recovery process.

Recovery progress indicator

You may change some options during the process of file recovery in real time

You may change some options during the process of file recovery
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Only in the Technician version

Note: R-Studio for Linux recovers files from Ext2/3/4FS partitions, but can write them to any local or
network disks. . R-Studio for Linux successfully recovers files from Ext2FS partitions except its security
attributes. R-Studio for Linux recovers symlinks as files containing the path to files which symlinks point
to.

See Data Recovery on HFS/HFS+ file system for details on recovering data from disks with the
HFS/HFS+ file system

Opening several disk/partitions in one tab
Searching for a File
Finding Previous File Versions
Previewing Files
File Masks
Regular Expressions
Event Log
2.1.1 Opening several partitions in one tab

You may open several partitions in one tab. Then you may search for files and recover them from several
disks/partitions at once. This is especially useful if files are to be recovered from several recognized partitions
found on one real partition or a drive.

To open several partitions in one tab,

1 Open one partition in a usual way (double-click a logical disk, for example).

2 Right-click the next partition, select Show Files In Tab, and select the tab you want the partition appear
in, or

drag the disk/partition from the Device view to the required tab.

Several partitions in one tab

https://www.r-studio.com/What-are-Hard-Soft-Links.html
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-Disk-Partition.html
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> R-Studio for Linux will show files from several partitions in one tab

Several partitions in one tab

Now files may be searched for, marked for recovery, and recovered.

To remove a partition from the tab,

1 Right-click the required partition in the tab and select Close drive in the context menu.

Several partitions in one tab

> R-Studio for Linux remove the selected partition from the tab

2.1.2 Searching for a File

R-Studio for Linux can find a particular file, if it is difficult to find it manually on the Folders or Files panel. You
can also automatically mark/unmark all found files.

To search for a file,

1 Click the Find button

 Other ways to search for the file

· Right-click a folder and select Find on the context menu, 
or
· Select a folder and select Find on the Tools menu

2 Specify a file to be found and its options on the Find dialog box, and click the OK button

Note that a File Mask may be applied.
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Find/Mark dialog box

 Find/Mark options

You may specify how to treat specified strings. Please note that R-Studio for Linux stores previously
entered search strings.
All Files and
Folders

If this option is selected, R-Studio for Linux applies Advanced Options to all files.

File Extensions If this option is selected, R-Studio for Linux treats specified strings as file extensions
Files and Folders If this option is selected, R-Studio for Linux treats specified strings as file names.

Use ? for one unspecified character  and * for an unlimited number of them to specify
file masks. 

Regular
Expressions

If this option is selected, R-Studio for Linux treats specified strings as regular
expressions

File Id Specifies File Id that R-Studio for Linux assigns to a file.
Match case If this check box is selected, R-Studio for Linux makes a case-sensitive search
Look at

Files If this check box is selected, R-Studio for Linux includes files into a search.
Folders If this check box is selected, R-Studio for Linux includes folders into a search.

Disables when the Mark/Unmark All option is selected.
Deleted files If this check box is selected, R-Studio for Linux makes a search among deleted files/?

folders.
Existing files If this check box is selected, R-Studio for Linux makes a search among existing files/?

folders.
Look in Specifies where R-Studio searches for, and marks, files. It can look for them on the

Entire partition, or in/from a certain folder.
If several partitions are opened in one tab, the places will be: All opened partitions,

Selected partition, or in/from a certain folder.
You may specify the starting folder for the search.

https://www.r-studio.com/What-is-Disk-Partition.html
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  identifies current opened folder.

  identifies current starting folder for the search.

 sets starting folder to the current opened folder.

 sets back current starting folder.
Advanced options If this check box is selected, R-Studio for Linux will use the advanced options. 
Size from/up to Specifies file size limits. See the Data Formats and Multipliers topic for more details

on data formats.
Bad sectors Specifies whether there are bad sectors in the files. Not known: it's unclear if there are

bad sectors in the files. 
Runtime image Specifies whether the files have already been included into the runtime image.
Recovery
Chances

Specifies files with certain recovery chances. 

Date Specifies file date boundaries. Dates for Modified, Created, and Last Accessed

timestamps may be set separately. 

The Set for all button sets the specified data for all fields.

Find/?Mark options Specify what R-Studio for Linux does with the found files. 
The Find first/previous/next/last options. R-Studio for Linux stops at the
first/previous/next/last file that matches the specified search criteria.
Find all files. R-Studio for Linux searches for all files that matches the specified search
criteria.. The search results appear in the Find Results panel.
Mark/Unmark All. R-Studio for Linux marks/unmarks all files that match the search
criteria. When these options are selected, R-Studio  marks/unmarks files only, not
folders, regardless of what Look at: Folders specifies.
Please note, that when performing a new find and mark/?unmark task, R-Studio for
Linux does not takes into consideration the previous marked/?unmarked state of files.
For example, if you first mark all doc files, and then all txt files, all doc files remain
marked, too. To unmark them, you should specify doc once again and select Unmark

files.
Find/mark
objects only in
real paths, ignore
links to folders

If this check box is selected, links to folders will be treated as real folders: they will
appear among search results or marked objects.

> R-Studio for Linux will show/mark the found file(s)

If you need to find and mark many files, go to the Find and Mark Multiple Files topic for details.

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Image.html
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To repeat the search, 

* Click the Find Next or Find Previous buttons

 Other ways to repeat the search

· Right-click a folder and select Find Next or Find Previous on the context menu
or
· Select a folder and select Find Next or Find Previous on the Tools menu 

To find all files and show them on the Find Results panel, 

* Select Find all on the on the Find dialog box,

or

select Find all on the Tools menu

> R-Studio for Linux will show the found files on the Find Results panel

You may do the following actions on the found files:

Recover, Mark, Preview

by right-clicking the found file and selecting the appropriate item in the context menu.

2.1.3 Finding Previous File Versions

R-Studio for Linux can find previous versions of files. It searches for them in the file's current folder and in
Extra Found Files.

File versions are searched for using file size. If the size of a files is within 10% of the original filesize, the following
conditions are checked: 

Conditions Legend

File name N

File extension E

Recognized file type T

To search for previous file versions,

1 Right-click the file and select Find Previous Versions of the File on the context menu

* R-Studio for Linux will show the files in the list:

File versions

This technique can be used to find deleted original files after attacks of file encrypting viruses.

2.1.4 Previewing Files

R-Studio for Linux has a built-in file previewer that allows you to preview both existing and deleted files. You
may use this feature to estimate chances for successful file recovery or to find a file to recover. 

While previewing a file in the external viewer, you may recover it or mark the file for recovery using Previewer
buttons.
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Previewer buttons

Locate file, Mark for recovery, Previous file, Next file, Recover,
Zoom In. Zoom Out, Actual Size, Rotate Counterclockwise,
Rotate Clockwise, Fit in Window, Full Screen

To preview a file

1 Right-click a file to preview on the Files panel and select Preview on the context menu

 Other ways to preview the file

· Select the file on the Files panel and click the Preview button,
or
· Select the file on the Files panel and select Preview on the File menu

> R-Studio for Linux will show the content of the file

If you have several files open in the previewer, you may instantly close all of them by selecting Close All

Previews on the File menu.

File Previewer for Pictures:

Pictures can be previewed either as tiles within the main window of R-Studio for Linux or in an external
previewer.

Within the main window as tiles:

Tile size can be changed..

Pictures as tiles

In the external viewer:

Picture files can be zoomed in/out and rotated.
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Picture file previewer

File Previewer for Video and Audio files:

Video and audio files can be played even without their respective application installed.

Video file previewer

File Previewer for Microsoft/Open/Libre Office Documents:

Documents can be shown (including embedded pictures) even without their respective applications installed.
They can be zoomed in/out for better viewing.
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Microsoft/Open/Libre Office document previewer

File Previewer for Adobe Acrobat PDF Files:

Files can be shown even without Adobe Acrobat installed.

The previewer allows the users to jump to a required page, zoom the document, and search for a required text.

Adobe Acrobat pdf document previewer

The files can be shown in different layouts and rotated. Click the View menu and select the required options.

Supported File Types:

Documents:

MS Office and Open/Libre Office files, even without the programs installed: 
· Word/Writer documents: docx;
· Excel/Calc spreadsheets: xlsx;
· PowerPoint presentation: pptx.

Office 97-2003, without the program installed:
· Word documents: doc;
· Excel spreadsheets xls;
· PowerPoint presentation ppt.
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Adobe Acrobat document: pdf.

Multimedia Files

Video formats: 
AIFF, ASF, AVI, BFI, CAF, FLV, GIF, GXF, HLS, QuickTime, 3GP, MP4, Matroska, Maxis XA,
MPEG-DASH, MPEG program stream, MPEG transport stream (including AVCHD), MXF, Material
eXchange Format, SMPTE, MSN Webcam stream, NUT, Ogg, OMA, RL2, TXD, WTV.

Audio formats: 
8SVX, AAC, AAC+, AC-3, ADPCM, AMR-NB, AMR-WB, Amazing Studio PAF Audio, Apple
lossless audio, QuickTime, ATRAC, CELT, DCA (DTS Coherent Acoustics), DPCM, DSD (Direct
Stream Digitial), DSP Group TrueSpeech, DST (Direct Stream Transfer), DV audio, FLAC (Free Lossless
Audio Codec), G.723.1, G.729, GSM, IAC (Indeo Audio Coder), iLBC (Internet Low Bitrate Codec),
IMC (Intel Music Coder), Interplay ACM, MACE (Macintosh Audio Compression/Expansion), MACE
(Macintosh Audio Compression/Expansion), MLP (Meridian Lossless Packing), Monkey’s Audio, MP1
(MPEG audio layer 1), MP2 (MPEG audio layer 2), MP3 (MPEG audio layer 3), MPEG-4 Audio
Lossless Coding (ALS), Musepack SV7/SV8, Nellymoser Asao, AVC (Audio for Video Codec), PCM
A-law/mu-law, QCELP/? PureVoice, QDesign Music Codec, RealAudio, Vorbis, Voxware MetaSound,
WavPack, Westwood Audio, Windows Media Audio, Xbox Media Audio

Graphic files (with file extensions)

3DS Max thumbnail (max), AAA logo (bpr), ACE texture (ace), ADEX (img, rle), AIM Grey Scale (ima,
im), AIPD image (aipd), ARF (arf), AT&T Group 4 (att), AT&T multigen (icn), AVHRR Image (sst), AVT
RAW (raw), AWD (awd), Ability Photopaint Image (apx), Access (g4, acc), Aces200 (ace), Acorn Sprite
(acorn), AdTech perfectfax (adt), Adobe Illustrator (ai), Adobe PhotoParade(images) (php), Adobe
Photoshop (psd), Advanced Art Studio (ocp, art, pic), AirNav (anv), Album bébé (frm), Alias Image File
(pix, als, alias), Alpha Microsystems BMP (bmp), Amapi (2d), Amica Paint (ami, [b]), Amiga IFF (iff, blk),
Amiga icon (info), Amstrad Cpc Screen (cpc), Analyze (avw), Analyze-7 (img), Andrew Toolkit raster
object (atk), Apollo HDRU (hdru, hdr, gn), ArcInfo Binary (hdr), Art Director (art), Artisan (art), Artist 64
(a64), Artrage (ptg), Artweaver Document (awd), Astronomical Research Network (arn), Atari grafik
(pcp), Aurora (sim), Auto F/X (afx), AutoCAD DWG (dwg, dwt), AutoCAD DXF (dxf), Autocad CAD-
Camera (img), Autodesk Animator (fli, flc), Autodesk QuickCAD thumbnail (cad), Autodesk SKETCH
thumbnail (skf), Autodesk SketchUp component (skp, skb), Autologic (gm, gm2, gm4), Award Bios Logo
(epa), Axialis Screensaver(images) (ssp), B3D(images) (b3d), BFLI (bfl, bfli, fli, flp, afl), BIAS
FringeProcessor (msk, img, raw, flt), BLP textures (blp), BMF (bmf), BSB/KAP (kap), BYU SIR (sir),
Bert's Coloring (bmg, ibg), Bfx Bitware (bfx), Bio-Rad confocal (pic), Blazing Paddles (pi), Bob Raytracer
(bob), Brender (pix), Brooktrout 301 (brk, 301, brt), Brother Fax (uni), Buttonz & Tilez texture (til),
CALS Raster (cal, cals, gp4, mil), CDU Paint (cdu), CGM (cgm), CImage (dsi), CMU Window Manager
(cmu), CP8 256 Gray Scale (cp8), CSV (csv), Calamus (cpi, crg), Camera RAW (raw), Canon EOS-1D
Mark II RAW (cr2), Canon Navigator Fax (can), Canon PowerShot (crw), Cartes Michelin (big), Casio
QV-10/100 Camera (cam), Casio RAW (bay, raw), Chinon ES-1000 digital camera (cmt), Cisco IP
Phone (cip), Cloe Ray-Tracer (clo, cloe), ColoRIX (rix, sci, scx, sc?), CompW (wlm), CompuServe GIF
(gif, giff), Computer Eyes, Digital Vision (ce), ComputerEyes Raw (ce1, ce2), Contax RAW (bay, raw),
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Core IDC (idc), Corel Draw Bitmap(preview) (cdr), Corel Draw Pattern(preview) (pat), Corel
Flow(preview) (bmf), Corel Metafile Exchange(preview) (cmx), Corel PhotoPaint 6.0 (cpt),
CoverDesigner(images) (ncd), CoverDesigner Template(images) (nct), Crayola (art), Creative PC-CAM
RAW (bay, raw), DBW Render (), DIV Game Studio Map (map), DIV Game Studio Multi Map (fpg),
DKB Ray-Tracer (dis), DNG (dng), DPX (dpx), Dali Raw (sd0, sd1, sd2), Datacopy (img), Degas &
Degas Elite (pi1, pc1, pi2, pc2, pi3, pc3, pi4, pi5, pi6), Deluxe Paint, Electronic Arts (lbm, ilbm), Dicom
(dcm, acr, dic, dicom, dc3), Digital F/X (tdim), Digital Research(GEM Paint) (img, gem), Direct Draw
Surface (dds), Discorp CMP Image (cmp), DjVu (djvu, djv, iw4), DolphinEd (dol), Doodle Atari (doo),
Doodle C64 (dd), Doodle C64(Compressed) (jj), Dr Halo (cut), Draz Paint (drz), EA Sports FSH (fsh),
EPS Interchange Format (epi, ept), ERI-chan(Entis Rasterized Image) (eri), ESM Software Pix (pix), Ecchi
(ecc), Eclipse (tile), Edmics (c4), Egg Paint (trp), Electric Image (ei, eidi), Embroidery (bmc), Encapsulated
Postscript (ps, eps), Encapsulated Postscript (Preview) (eps), Enhance Simplex (esm), Enhanced
Compressed Wavelet (ecw), Epson RAW (erf), Eroiica (eif), Everex Everfax (efx, ef3), Explore(TDI) &
Maya (iff, tdi), FIF(Iterated System) (fif), FIT (fit), Face Painter (fpt), Fast Piecewise-constant (pwc), Fax
Group 3 (g3, fax), Fax man (fmf), Faxable PCX (fcx), Faxable TIFF (ftf), Fenix Map (map), Fenix Multi
Map (fpg), FileMagic (mag), Flash Image (fi), FlashCam Frame (ncy), FlashPix Format (fpx), Flexible
Image Transport System (fts, fits, fit), Foculus RAW (bay, raw), Fontasy Grafik (bsg), Fremont Fax96
(f96), Fugawi Map (fx3), Fuji S2 RAW (raf), Fun Painter II (fp2, fun), Fun Photor (fpr), Fuzzy bitmap
(fbm, cbm), GRS16 (g16), Gamma Fax (gmf), GeoPaint (geo), Gfa Raytrace (sul), GigaPaint Hi-res (gih),
GigaPaint Multi (gig), Gimp Bitmap (xcf), Gimp Brush (gbr), Gimp Icon (ico), Gimp Pattern (pat), GoDot
(4bt, 4bit, clp), GunPaint (gun, ifl), HD Photo (wdp, hdp), HDRI (hdr, hdri), HF (hf), HP-48/49 GROB
(gro, grb), HP-49 OpenFire (gro2, gro4), HPGL-2 (hp, hpg, hgl, plt, hpgl, hpgl2, gl2, prn, prt, spl), HRU
(hru), HSI Raw (raw), Half-Life Model (mdl), Hasselblad RAW (3fr), Hayes JTFax (jtf), Hemera Photo
Image (hpi), Hemera Thumbs (hta), Heretic II MipMap (m8), Hi-Eddi (hed), Hires C64 (hir, hbm),
Homeworld Texture (lif), IBM Kips (kps), IBM Printer Page Segment (pse), IM5(Visilog) (im5), IMNET
Image (imt), IOCA (ica, ioca, mod), IPLab (ipl), IPod thumb (ithmb), ISS (iss), IcoFX (ifx), Icon Library
(icl), Imacon/Hasselblad RAW (fff), Image Capture Board (icb), Image Magick file (mif, miff), Image
Speeder (ish), Image System(Hires) (ish), Image System(Multicolor) (ism), Image Systems RLC2 Graphic
(rlc), ImageLab (b&w, b_w), ImagePro Sequence (seq), Imaging Fax (g3n), Imaging Technology (img),
Img Software Set (img), Inshape (iim), InterPaint(Hires) (iph), InterPaint(Multicolor) (ipt), Intergraph
Format (itg, cit, rle), Interleaf (iimg), Iris CT (ct), Iris Graphics (iris), J Wavelet Image Codec (wic), JBIG
(jbg, bie, jbig), JBIG-2 (jb2), JFIF based file (jb2), JPEG/? JFIF (jpg, jpeg, jif, jfif, J, jpe), JPEG 8BIM
header(Mac) (jpg, jpeg, jif, jfif, J, jpe), JPEG XR (jxr), JPEG-2000 Code Stream (jpc), JPEG-2000 JP2
File Format (jp2, j2k, jpx, jpf), JPEG-LS (jls), Jeff's Image Format (jif), Jigsaw (jig), Jovian VI (vi), Jpeg
Network Graphics (jng), JustButtons animated bitmap (btn), KONTRON (img), Khoros Visualization
Image file (vif, viff, xv), KinuPix Skin (thb), Kiss Cel (cel), Koala Paint (koa, kla), Koala
Paint(Compressed) (gg), Kodak Cineon (cin), Kodak DC120 Digital Camera (kdc), Kodak DC25
Camera (k25), Kodak Photo CD (pcd), Kodak Pro Digital RAW (dcr), Kofax Group 4 (kfx), Kolor Raw
Format (kro), Konica Camera File (kqp), LSS16 (lss, 16), LView Pro (lvp), LaserData (lda), Leaf RAW
(mos), Leica RAW (bay, raw), Light Work Image (lwi), LucasFilm Format (lff), Lumena CEL (cel),
LuraDocument Format (ldf), LuraDocument.jpm Format (jpm), LuraWave Format (lwf), LuraWave JPEG-
2000 Code Stream (jpc), LuraWave JPEG-2000 Format (jp2, j2k, jpx, jpf), MAKIchan Graphics (mag),
MGI Photosuite Project(images) (pzp), MGR bitmap (mgr), MRC(Medical Research Council) (mrc),
MTV Ray-Tracer (mtv), Mac Paint (mac, mpnt, macp, pntg, pnt, paint), Mac icon (icns), Macintosh
Quickdraw/Pict (pic, pict, pict2, pct), Mac OSX Resource (rsc, rsrc), Maggi Hairstyles & Cosmetics (fff),
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Male MRI (pd, t1, t2), Male Normal CT (fre), Mamiya RAW (mef), Marks Russel File (mrf), Mavica
(411), Maw-Ware Textures (mtx), Mayura Draw (pdx), MegaPaint (bld), Megalux Frame (frm), Micro
Dynamics MARS (pbt), Micro Illustrator Uncompressed (mil), Micrografx Picture Publisher 4.0 (pp4),
Micrografx Picture Publisher 5.0 (pp5), Micron RAW (bay, raw), Microsoft Image Composer (mic),
Microsoft Paint (msp), Microtek Eyestar (img), Mindjongg Format (ipg), Minolta DiMAGE RAW (mrw),
Mobile FAX (rfa), MonkeyCard (pdb), MonkeyLogo (pdb), MonkeyPhoto (mph), MrSid (sid), Msx 2
Screen (sc2), Multiple Network Graphics (mng), NCR Image (ncr), NIST ihdr (pct), National Imagery
Transmission F. (ntf, nitf), NeoBook Cartoon (car), Neochrome(ST & TT) (neo), Neopaint Mask (npm),
Neopaint Stamp (stw), NewsRoom (nsr, ph, bn), Nifti (img), Nikon RAW (nef), Nokia Group Graphics
(ngg), Nokia Logo File (nlm), Nokia OTA bitmap (otb), Nokia Operator Logo (nol), OAZ Fax (oaz, xfx),
OS/2 Bitmap (bmp, bga), Olicom Fax (ofx), Olympus RAW (orf), Open Image Library Format (oil),
OpenEXR (exr), Optigraphics (ctf), Optigraphics Tiled (ttf), Optocat (abs), Oric Hires (hir), Oric TAP
(tap), Os/2 Warp (bga), PABX background (pix), PAX (pax), PC Paint/? Pictor Page (pic, clp), PCO
(b16), PM (pm), Page Control Language (pcl), Paint Magic (pmg), PaintShopPro Browser Cache File
(jbf), PaintShopPro Brush (pspbrush), PaintShopPro Brush (jbr), PaintShopPro Frame (pfr, pspframe),
PaintShopPro Image (psp, pspimage), PaintShopPro Mask (pspmask), PaintShopPro Mask (msk),
PaintShopPro Pattern (pat), PaintShopPro Picture Tube (tub, psptube), PaintShopPro Texture (tex), Palm
Pilot (pdb), Panasonic DMC-LC1 RAW (srf), Panasonic LX3 RAW (rw2), Panasonic RAW (bay, raw),
Pegs (pxs, pxa), Pentax *ist D (pef), Pfs Art Publisher (art), Photo Deluxe (pdd, pdb), Photo Filtre Studio
(pfi), PhotoFantasy Image (fsy), PhotoFrame (frm), PhotoStudio File (psf), PhotoStudio Stamp (stm),
Photomatrix (cat), Pic2 (p2), Picasso 64 (p64), Picture Gear Pocket (prc), Picture It! (mix), Pixar picture
file (pic, pxr, picio, pixar), Pixel Power Collage (ib7, i17, i18, if9), Pixia (pxa), Pixibox (pxb), Planetary
Data System (pds, img), Playback Bitmap Sequence (bms), Pocket PC Bitmap (2bp), Pocket PC
Themes(images) (tsk), Polychrome Recursive Format (prf), Portable Bitmap (pbm, rpbm, ppma), Portable
Document Format (pdf), Portable Greyscale (pgm, rpgm), Portable Image (pnm, rpnm, pbm, rpbm, pgm,
rpgm, ppm, rppm), Portable Network Graphics (png, apng), Portable Pixmap (ppm, rppm), Portfolio
Graphics (pgf), Portfolio Graphics Compressed (pgc), Portrait (cvp), Poser Bump (bum), Postscript (ps,
ps1, ps2, ps3, eps, prn), PowerCard maker (crd), PowerPoint(images) (pps), PowerPoint
Presentation(images) (ppt), Print Master (pm), Print Shop (psa, psb), Printfox/Pagefox (bs, pg, gb), Prism
(cpa), Prisms (pri), Psion Series 3 Bitmap (pic), Psion Series 5 Bitmap (mbm), Punk Productions Picture
(ppp), Puzzle (pzl), Q0 (q0, rgb), Qdv(Random Dot Software) (qdv), Qrt Ray-Tracer (qrt), Quake
Texture (wal), Quantel VPB (vpb), QuickTime Image Format (qtif, qti), RAW DVR (raw), RIPTerm
Image (icn), Radiance (rad, img, pic), Rainbow Painter (rp), Raw (raw, gry, grey), Rawzor (rwz),
Rayshade (pic), Red Storm File Format (rsb), Ricoh Digital Camera (j6i), Ricoh Fax (001, ric), Ricoh IS30
(pig), Rm2K XYZ (xyz), Rollei RAW (rdc, ia), RoverShot RAW (bay, raw), RunPaint(Multicolor) (rpm),
Saracen Paint (sar), SBIG CCD camera ST-4 (st4), SBIG CCD camera ST-X (stx, st4, st5, st6, st7, st8),
SciFax (sci), SciTex Continuous Tone (sct, ct, ch), Seattle Film Works (sfw), Seattle Film Works multi-
image (pwp, sfw), SecretPhotos puzzle (xp0), Sega SJ-1 DIGIO (sj1), Sharp GPB (img), Siemens Mobile
(bmx), SIF MICHEL-Soft (sif), Sigma RAW (x3f), Silicon Graphics RGB (rgb, rgba, bw, iris, sgi, int, inta),
Sinar RAW (cs1, sti), Skantek (skn), Slow Scan Television (hrz), SmartDraw 6 template (sdt), SmartFax
(1), SmoothMove Pan Viewer (pan), Softimage (pic, si), Solitaire Image Recorder (sir), Sony DSC-F1
Cyber-shot (pmp), Sony DSC-F828 RAW (srf), Sony PS2 TIM (tm2), Sony Playstation TIM (tim), Sony
RAW (sr2, arw), Spectrum 512 (spu), Spectrum 512(Compressed) (spc), Spectrum 512(Smooshed)
(sps), SPOT (dat), SriSun (ssi), Stad (pic, pac, seq), Star Office Gallery (sdg), Starbase (img), Stardent
AVS X (x, avs, mbfs, mbfavs), Starlight Xpress SX (RAW), Stereo Image (jps), ST Micro RAW (bay,
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raw), Structured Fax Format (sff), Sun Icon/Cursor (icon, cursor, ico, pr), Sun Rasterfile (ras, rast, sun, sr,
scr, rs), Sun TAAC file (iff, vff, suniff, taac), Syberia texture (syj), Synthetic Universe (syn, synu), SVG
(svg), TG4 (tg4), TI Bitmap (92i, 73i, 82i, 83i, 85i, 86i, 89i), TIFF Revision 6 (tif, tim, tiff), TMSat image
(imi), TRS 80 (hr), TealPaint (pdb), Teli Fax (mh), Thumbnail (tnl), TilePic (tjp), Tiny (tny, tn1, tn2, tn3),
TopDesign Thumbnail (b3d, b2d), Total Annihilation (gaf), Truevision Targa (tga, targa, pix, bpx, ivb),
Ulead Pattern (pst), Ulead PhotoImpact (upi), Ulead Texture(images) (pe4), Usenix FaceServer (fac, face),
Utah raster image (rle, urt), VIPS Image (v), VITec (vit), VRML2 (wrl), Venta Fax (vfx), Verity (vif),
Vicar (vic, vicar, img), Vidcom 64 (vid), Video Display Adapter (vda), Vista (vst), Vivid Ray-Tracer (img),
Vort (pix), Vue d'esprit (vob), WAD(Half life) (wad), WSQ (wsq), WaveL (iwc), Wavefront Raster file
(rla, rlb, rpf), WebShots(images) (wb1, wbc, wbp, wbz), Weekly Puzzle (jig), WebP (webp, wep),
Whypic (ypc), WinFAX (fxs, fxo, wfx, fxr, fxd, fxm), WinMIPS (pic), Windows & Aldus Metafile (wmf),
Windows Animated Cursor (ani), Windows Bitmap (bmp, rle, vga, rl4, rl8, sys), Windows Clipboard (clp),
Windows Comp. Enhanced Metafile (emz), Windows Compressed Metafile (wmz), Windows Cursor
(cur), Windows DIB (dib), Windows Enhanced Metafile (emf), Windows Icon (ico), Winzle Puzzle (wzl),
Wireless Bitmap(level 0) (wbmp, wbm, wap), Word Perfect Graphics(images) (wpg), Worldport Fax
(wfx), X Windows System dump (xwd, x11), X11 Bitmap (xbm, bm), X11 Pixmap (xpm, pm), XV Visual
Schnauzer (p7), Xara(images) (xar), Xerox DIFF (xif), Ximage (xim), Xionics SMP (smp), YUV 16Bits
(yuv, qtl, uyvy), YUV 16Bits Interleaved (yuv, qtl, uyvy), YUV 4:1:1 (yuv, qtl), YUV 4:2:2 (yuv, qtl), YUV
4:4:4 (yuv, qtl), ZX Spectrum Hobetta ($s, $c, !s), ZX Spectrum Snapshot(sna), ZX Spectrum standard
(screen scr), ZZ Rough (rgh), Zeiss BIVAS (dta), Zeiss LSM (lsm), Zoner Callisto Metafile(zmf), Zoner
Zebra Metafile (zbr), Zsoft Multi-page Paintbrush (dcx), Zsoft Publisher's Paintbrush (pcx, pcc, dcx),
byLight (bif)

2.1.5 File Masks

R-Studio for Linux shows only those files/?folders that match the specified file mask. File mask affects files/?
folders that are processed by the Recover and Find commands. 

To specify a file mask,

1 Click the File Mask button

 Other ways to specify the file mask

· Right-click a folder and select File Mask on the context menu
or
· Select the folder and select File Mask on the Tools menu

2 Specify the file mask on the File mask dialog box and click the OK button

Mask (Main) dialog box
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 File mask options

You may specify options for All Files, File Extensions, Files, and Regular Expressions

Match case If this check box is selected, R-Studio for Linux makes a case-sensitive search.
Show empty folders If this check box is selected, R-Studio for Linux will show folders with no files in

them.
Deleted files If this check box is selected, R-Studio for Linux makes a search among deleted

files/folders.
Existing files If this check box is selected, R-Studio for Linux makes a search among existing

files/folders.
Hide symbolic links If this check box is selected, R-Studio for Linux hides all symbolic links. It may be

selected by default if the Don't show symbolic links by default option is selected on the
Settings dialog box.

Use advanced
options

If this check box is selected, R-Studio for Linux will use the advanced options,
even when they are hidden. 

Advanced Options

Size from/up to Specifies file size limits. See the Data Formats and Multipliers topic for more
details on data formats.

Bad sectors Specifies whether there are bad sectors in the files. Not known: it's unclear if there are
bad sectors in the files. 

Runtime image Specifies whether the files have already been included into the runtime image.
Date Specifies file date boundaries. Dates for Modified, Created, and Last Accessed

timestamps may be set separately. 

The Set for all button sets the specified data for all fields.

> R-Studio for Linux will show only those files that match the specified file masks

Mask presets

You may set various presets with different file masks. Just click on the Plus button to add the data from the dialog
box to the presets. You may also give presets names, delete them, and store them permanently.

2.1.6 Regular Expressions

Regular expression is a notation for patterns of text, as opposed to exact strings of characters. The notation uses
literal characters and metacharacters. Every character which does not have special meaning in the regular-
expression syntax is a literal character and matches an occurrence of that character. For example, letters and
numbers are literal characters. A metacharacter is a symbol with special meaning (an operator or delimiter) in the
regular-expression syntax.
.  Wildcard: any character
* Repeat: zero or more occurrences of previous character or class
^ Line position: beginning of line
$ Line position: end of line
[class] Character class: any character in the set
[^class] Inverse class: any character not in the set
[x-y] Range: any characters within the specified range

https://www.r-studio.com/What-are-Hard-Soft-Links.html
https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Image.html
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\x Escape: literal use of metacharacter x
\<xyz Word position: beginning of the word
xyz\> Word position: end of the word

For example, the following regular expression .* matches any string of characters, ^a matches any string
beginning with character a.

2.1.7 Event Log

R-Studio for Linux logs and displays events in the Log panel. You may set a Log filter to display only needed
information and to write it to a log file. You may specify the log settings on the Settings dialog box.

You may clear or save the log 

To clear the log,

* Right-click the Log panel and select Clear Log on the context menu.

To save the log to a file,

* Right-click the Log panel and select Save Log to File on the context menu.

2.2 Advanced Data Recovery

This chapter explains how to perform advanced data recovery operations.

· Disk Scan
· Customizing File Types
· Customizing File Types-I
· Customizing File Types-II

· Regions
· Exclusive Regions

· Images
· Object Copy

2.2.1 Disk Scan

In order to completely analyze data structure on an object, it must be scanned. Any object on the Drives panel can be

scanned. In addition, you may create a region to scan only a part of an object. The Regions topic explains how to create and

work with regions. Scan is also greatly improves estimations for chances of successful file recovery.

You may select scan area and some other scan parameters. Scan information may be saved to a file and later this
file may be opened.

Attention: Scanning large areas may be a very lengthy process!

NEVER TRY TO SAVE SCAN INFORMATION TO THE OBJECT BEING SCANNED!!!
Or you may obtain unpredictable results and lose all of your data. 

To scan an object

1 Select an object on the R-Studio for Linux's Drives panel

2 Click the Scan button

 Other ways to start scan

· Right-click the selected disk and select Scan on the context menu, 
or

https://www.R-Studio.com/What-is-drive-scan.html
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· Select Scan on the Drive menu

3 Specify the required parameters on the Scan dialog box and click the Scan button

Scan dialog box

 Scan options

Disk Size: Shows the size of the object to be scanned
Start: Sets the start point of the area to be scanned.
Size: Sets the size of the area to be scanned. 

Numbers in these fields can be in bytes or sectors. See the Data Formats and Multipliers topic for
more details on data formats.
File Systems: Specifies the file systems which objects are to be searched for.

Current version supports: FAT, NTFS, exFAT, ReFS, Ext2/3/4FS, XFS, HFS,
APFS, and UFS file systems. The Technician version supports also the ISO9660 file
system.
Please note that if you need to scan an HFS, HFS+, or HFSX disk, always enable the
Extra search for Known File Types option. This is very important because when files are
being deleted on the  HFS, HFS+, HFSX file systems, the computer completely
removes all system information on them, and there is no way to recover the deleted files
except by using the Extra Search for Known File Types option. See Data Recovery
on HFS/HFS+ file system for details.

Extra search for
Known File Types

Enables search for Known File Types.

Save scan Info to
File:

If this checkbox is selected, R-Studio for Linux will save scan information to a
specified file. Later this file may be opened. Please note, that this option does not save
actual disk data, only information on disk data structure gathered during disk scan.
R-Studio for Linux shows path to this file during disk scan.

Buttons

Scan Starts scanning
Advanced Activates advanced scan options
Known File
Types...

Selects file types that R-Studio for Linux will recognize during the disk scan.

Cancel Closes the dialog box

NEVER TRY TO SAVE SCAN INFORMATION TO THE OBJECT BEING SCANNED!!!
Or you may obtain unpredictable results and lose all of your data. 

https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-is-ExFAT.html
https://www.r-studio.com/What-is-ExtFS.html
https://www.r-studio.com/What-is-XFS.html
https://www.r-studio.com/What-is-UFS.html
https://www.r-studio.com/What-is-Raw-File-Recovery.html
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If a remote computer is connected for Data Recovery over Network, the the Scan dialog box will have a
different look.

and the Save Scan Information File dialog box will appear when you select a place to store scan info. You
may save it to the local or remote computer.

Known File Types: While scanning, R-Studio for Linux can recognize the data’s particular file type. Using
such information, R-Studio for Linux can obtain more information about data/file structure on the object
being scanned. By default, R-Studio for Linux tries to recognize the default list of supported file types
specified on the Known File Types tab of the Settings panel, greatly increasing time required for the scan.
You may reduce it by selecting only those file types that you need. Click the Known File Types... button and
select the required file types on the File Types dialog box. These selections will be applied to that scan
session only.

File Types dialog box

Known File Types

Set as Default Click this button to set the current list of selected file types as default values.
Revert to Default Click this button to revert the default settings specified on the Known File Types

tab of the Settings panel.
Reset to
Recommended

Click this button to revert to factory-preset default settings.

Select All Click this button to select all file types in the list.
Clear All Click this button to clear all file types in the list except some predefined ones.
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 List of known file types

Document

AbiWord
Document: .abw

Adobe InDesign
File: .indd

Adobe PDF
document: .pdf

Apple iWork Keynote
document: .key

Apple iWork Pages
document: .pages

Apple iWork document Capella document: .cap Final Draft
Document: .fdr

FrameMaker
Document: .fm

GNU Info
Document: .info

Garmin MapSource
data: .mps

Lotus AMI Pro
Document: .sam

Lotus Organizer: .or5 Lotus Word Pro
Document: .lwp

Microsoft Office Open
XML Document

Microsoft OneNote
section file: .one

Microsoft Pocket Streets
Map File: .mps

Microsoft PowerPoint
2007 XML
Document: .pptx

Microsoft PowerPoint
Document: .ppt

Microsoft Visio
document: .vsd

Microsoft Word 2007
XML Document: .docx

Microsoft Word
Document: .doc

Word for Macintosh
Document: .mcw

Microsoft Word2
Document: .doc

Microsoft Works
document: .wps

OLE Storage OpenOffice Writer
document: .odt

OpenOffice
document: .ods

PageMaker
Document: .p65

PostScript
document:.ps

QuarkXPress file: .qxd QuarkXpress
project: .qxp

Rich Text
Document: .rtf

TEX document: .tex Text document: .txt Unicode
document: .txt

WordPerfect
Document: .doc

Document: E-book

Chaoxing SSReader
eBook: .pdg

EPUB eBook: .epub FB2 eBook: .fb2 MOBI eBook: .mobi
Microsoft Money
Data: .mny

Microsoft Reader
eBook: .lit

Microsoft Reader
eBook
annotations: .ebo

Document: Spreadsheet

Apple iWork Numbers
document: .numbers

Lotus 1-2-3 v1
worksheet: .wk3

Lotus 1-2-3 v2
workshee: .wk1, .fmt

Lotus 1-2-3 v3
worksheet: .wk3, .fm
3

Lotus 1-2-3 v4
worksheet: .wk4

Lotus 1-2-3
workbook: .123

Microsoft Excel 2/3/4
worksheet: .xls

Microsoft Excel 2007
XML
Document: .xlsx

Microsoft Excel 4
Spreadsheet: .xls

Microsoft Excel
Spreadsheet: .xls

Quattro Pro
Spreadsheet: .wq1

Document: Database

Cathy database: .caf Data Interchange
Format file: .dif

GDSII database: .gds Microsoft Access 2007
XML
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Document: .accdt

Microsoft Access 2007
Database: .accdb

Microsoft Access
Database: .mdb

Microsoft SQL
Log: .ldf

Microsoft SQL
Database: .mdf

MySQL Database
Dictionary: .frm

MySQL database: .myi Omnis Studio
Library: .lbs

Omnis Studio
Database: .df1

OpenOffice Base
document: .odb

dBase III
Database: .dbf

Document: Financial

Microsoft Money
Data: .mny

QuickBooks Backup
File: .qbb

QuickBooks Primary
Data File: .qbw

Quicken Data: .qdf

TurboTax return
file: .tax

Internet-related files

Compiled HTML
file: .chm

Internet shortcut: .url Microsoft OutLook
Personal Folder: .pst

Microsoft
Outlook/Inbox offline
folder: .ost

Mozilla Firefox browser
extension: .xpi

Mozilla Mail Summary
file: .msf

Outlook Express
Messages: .dbx

The Bat! Address
book: .abd

The Bat! Message
Base: .tbb

The Bat! Message
Index: .tbi

Windows Address
Book: .wab

XML document
(Unicode): .xml

Email

E-Mail Message: .eml Microsoft OutLook
Personal Folder: .pst

Microsoft Outlook Inbox
offline folder: .ost

Mozilla Mail Summary
file: .msf

Outlook Express
Messages: .dbx

The Bat! Address
book: .abd

The Bat! Message
Base: .tbb

The Bat! Message
Index: .tbi

Windows Address
Book: .wab

Font

Adobe PostScript
Font: .pfb

Adobe Printer
Font: .pfm

BDF Unix font: .bdf BGI font: .chr

CPI DOS font: .cpi OpenType font: .otf TrueType Font: .ttf Windows System
Font: .fon

Graphics/Picture

AVHRR Satellite
image: .sst

Adobe Lightroom
preview: .lrprev

Adobe Photoshop
image: .psd

Agfa/Matrix Scodl
Image: .scd

Alias Wavefront Raster
Image: .rla

Amiga icon: .info ArcView Shape:.shp AutoCAD Binary
Image: .dxf

AutoCAD
Drawing: .dwg

AutoCAD Image: .dxf Autodesc Animator Pro
color palette: .col

Autodesc Animator Pro
Image: .pic

Autodesc Animator
Image: .pic

Autologic Image: .gm BMF image: .bmf Bentley MicroStation
CAD Drawing: .dgn
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Canon (CR2) RAW
graphics file: .cr2

Canon (CRW) RAW
graphics file: .crw

ColoRIX Image: .rix Computer Graphics
Metafile image: .cg

ComputerEyes Raw
Image: .ce1, .ce1

Continous Edge Graphic
Image: .ceg

Corel Texture
Image: .tex

CorelDraw CMX
Image: .cmx

CorelDraw Image: .cdr Cubicomp Picture
Maker Image
.r8, .g8, .b8

DICOM medical
image: .dcm

Digital Negative
image: .dbg

Dr. Halo palette: .pal Enhanced MetaFile
Image: .emf

Epson RAW
image: .erf

Epson Stylus
Image: .prn

Erdas LAN/GIS
Image: .lan, .gis

Fractal Image
Format: .fif

Freehand (MX)
Database: .fh10

Fuji RAW image: .raf

GEM Raster
Image: .img

GEM VDI Image: .gdi CompuServe GIF
Image: .gif

Garmin Mapsource
image: .img

Graphics Workshop for
Windows
Thumbnail: .thn

Gridded Binary
Image: .grb

HP Command Language
Image: .pcl

HP Raster Image: .rtl

HSI JPEG Image: .hsi Hemera Photo-Object
Image: .hpi

Hitachi Raster
Image: .hrf

Hotspot Image: .shg

IBM Picture Maker
Image: .pic

JPEG 2000: .jp2 JPEG Digital
Camera: .jpg

JPEG Image: .jpg

Jovian Logic Image: .vi Kodak PhotoCD
Image: .pcd

Kodak RAW
image: .dng

LBM/IFF Image: .lbm

Leica RAW image: .dng Lightwave Object: .lwo Lotus PIC Image: .pic Macintosh PICT
Image: .pct, .pic

Macintosh Paint
Image: .mac

Mamiya RAW
image: .mef

McIDAS Satellite
Image: .goe

Microsoft Paint
Image: .msp

Minolta RAW
image: .mrw

Nikon RAW
image: .nef

OS/2 Icon: .ico Olympus RAW
image: .orf

PBM Image: .pbm PGM Image: .pgm PIX Image: .pix PM Image: .pm

PNG Image: .png PPM Image: .ppm PaintShop Pro
Image: .psp

Panasonic RAW
image: .rw2

PaperPort Image: .max Pentax RAW
image: .pef

Pictor PC Paint
Image: .pic

Print Shop Image: .pds

Quick Link II fax
Image: .qfx

QuickDraw 3D
Metafile: .3dmf

RAW Digital Camera
image: .dng

RenderMan
Image: .rib

Ricoh RAW image: .dng SGI Image: .sgi STAD Image: .pac Samsung RAW
image: .dng

Seattle FilmWorks/?
PhotoWorks
image: .pwm

Sigma RAW
image: .x3f

Sketch Image: .sk SmartDraw file: .sdr

Sony RAW image: .arw Sun Raster Image: .sun SymbianOS
Image: .mbm

TI Image: .92i
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Tagged Image Format
File: .tif

TargetExpress
image: .mte

Utah Raster Toolkit
Image: .rle

VITec Image: .vit

Webshots Image: .wb1 Weresc CADE
drawing: .dtc

Windows Animated
cursor: .ani

Windows Bitmap
Image: .bmp

Windows Color
Palette: .pal

Windows Fax Cover
Image: .cpe

Windows MetaFile
Image: .wmf

Windows cursor: .cur

Windows icon: .ico WordPerfect Graphics
Image: .wpg

X PixMap Image: .xpm X Window Dump
Image: .xwd

Xara Drawing: .xar ZSoft PCX Image: .pcx iPhoto Image: .attr

Multimedia: Audio Files

AIFF Sound: .aif AVR Sound: .avr AY Chip music: .ay AdLib Tracker 2
module: .a2m

Advanced Streaming
Format file: .asf

Audacity audio: .au AudioCD file: .cda Battery 3 sample: .nov

CMF music: .cmf Common Loudspeaker
Binary: .cf1

Creative voice file: .voc DiamondWare
sound: .dwd

Digital Speech File: .dss Digital voice file: .dvf EA ASF/MUS audio
file: .asf

Extended M3U
playlist: .m3u

FLAC audio
file: .fla, .flac

KaraBox sound: .mkf La Lossless audio
file: .la

Liquid Audio File: .la1

MIDI Instrument
definition: .idf

MIDI music: .mid MIDI stream: .mds MPEG Layer I audio
file: .mpg

MPEG Layer II audio
file: .mp2

MPEG Layer III audio
file: .mp3

MUS music: .mus Monkeys audio
file: .ape

Musepack audio
file: .mpc

Next/Sun uLaw
sound: .au

Nitro Composer
sound: .minincs

Nord Modular G2
Patch: .pch2

Ogg Vorbis audio
file: .ogg

OptimFROG audio
file: .ofr

Portable Sound
Format: .psf

RIFF MIDI
music: .rmi

RK Audio sound: .rka Sierra AUD
sound: .aud

Sony OpenMG audio
file: .oma

Super NES audio
file: .spc

TTA audio file: .tta VQF sound: .vqf WavPack audio file: .wv Westwood AUD
sound: .aud

Windows Media Audio
File: .wma

Windows WAVE
sound: .wav

X-MIDI music: .xmi ZyXEL sound: .zyx

aPac audio file: .apc

Multimedia: Video Files

3GPP multimedia
audio/video: .3gp

3GPP2 multimedia
audio/video: .3g2

4X Movie Video: .4xm Adobe Filmstrip
Animation: .fsf

AMV Video: .amv ARMovie video: .rpl Adobe Filmstrip
animation: .fsf

Autodesk
Animator: .fli
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BINK Video: .bik BluffTitler video: .bt DVM video: .dvm DeluxePaint
animation: .anm

Director video: .dcr DriveCam video: .dce Eyemail video: .eye Flash Video: .flv

Intel DVI Video: .dvi Intel Indeo Video
File: .ivf

Interplay MVE
Video: .mve

LZA animation: .lza

LZA Animation: .lza Lotus ScreenCam
video: .scm

MPEG Transport
Stream video: .mts

MPEG video: .mpg

MPEG-2 Transport
Stream video: .m2ts

Matroska video: .mkv MythTV video: .nuv NEOchrome
animation: .ani

Nancy Codec
video: .noa

Nullsoft Video: .nsv QV-10 video: .cam QuickTime video: .mov

SGI movie format: .mv SMJPEG Video: .mjpg Sega FILM/CPK
video: .cpk

Shockwave
video: .swf

Smacker video: .smk Sony Movie Player
video: .mqv

VOB video files: .vob VP6 encoded
Video: .vp6

VideoCD video: .vcd Vivo streaming
video: .viv

Windows AVI
Video: .avi

Windows Media
Video: .wmv

Multimedia Files

MP4 file: .mp4  Material Exchange
File: .mxf

RIFF Multimedia File Real Networks
audio/video: .rm

Archive Files

7-Zip archive: .7z ACE archive: .ace AIN archive: .ain ARJ archive: .arj

ARX archive: .arx Android Package: .apk BAG archive: .bag BIX archive: .bix

BOA
archive: .b58, .boa

BZip2 archive: .bz2 BlackHole archive: .bh Blink archive: .bli

CPIO archive: .cpio ChArc archive: .chz Compress archive: .z Crush archive: .cru

DEB archive: .deb FOXSQZ
archive: .sqz

GZip archive: .gz HA archive: .ha

HAP archive: .hap HPack archive: .hpk Hyper archive: .hyp InstallShield CAB
archive: .cab

InstallShield Z archive: .z InstallShield compressed
file

JAR archive: .jar JRC archive: .jrc

LHA/LZARK
archive: .lzh

LZA
archive: .lza, .lzz 

LZOParchive: .lzo, .
lzop

LZX archive: .lzx

LIMIT archive: .lim Microsoft Cabinet
archive: .cab

Microsoft Compress
compressed file

PAKLEO
archive: .pll

QFC archive: .qfc Quantum
archive: .q, .pak

Quark archive: .ark RAR archive: .rar

RPM archive: .rpm ReSOF archive: .sof SAR archive: .sar SBC archive: .sbc

SQZ archive: .sqz SZip archive StuffIt archive: .sit TAR archive: .tar
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UFA archive: .ufa UHArc archive: .uha UltraCompressor 2
archive: .uc2

WRAptor
archive: .wra

WinImp archive: .imp Windows Installer
Merge Module: .msm

Windows Installer
Package: .msi

indows Installer
Patch: .msp

Windows Installer Patch
Creation File: .pcp

Windows Installer
Validation
Module: .cub

YAC archive: .yc YBS archive: .ybs

ZIP archive: .zip ZOO archive: .zoo ZZip archive: .zz iOS Package: .ipa

xz archive: .xz

Executable/Library/DLL

DOS Style
Executable: .exe

ELF Executable (UNIX) ELF Library (UNIX) ELF Module (UNIX)

Java Bytecode: .class KolibriOS Executable NetWare Loadable
Module: .nlm

Shell Script

UEFI Executable
.efi

Windows DLL: .dll Windows
Executable: .exe

Windows 9x Device
Driver: .vxd

Windows Device
Driver: .sys

Windows OCX
File: .ocx

Development files

ACUCOBOL object Borland Delphi
Compiled Unit: .dcu

Borland Turbo Pascal
compiled Unit: .tpu

C/C++ Source
Code: .c

COM Type
Library: .tlb

GUI Design Studio
project: .gui

LUA Script: .lua Library: .lib

Microsoft .NET XML
Resource
template: .resx

Microsoft ClassWizard
file: .clw

Microsoft Linker
database .ilk

Microsoft Precompiled
header: .pch

Microsoft Program
database: .pdb

Microsoft Visual C++
project: .mdp

Microsoft Visual Studio
Solution: .sln

Microsoft Visual Studio
project: .dsp

Microsoft Visual Studio
workspace: .dsw

OMF Object
library: .lib

PolySpace results: .chk RDOFF Object
File: .rdf

Resource Compiler
Script File: .rc

Visual Studio Solution
User Options: .suo

Visual Studio Widget
File: .wid

Visual Studio
Workspace Options
file: .opt

VisualBasic
Project: .vbp

WinDev Window: .wdw Windows Compiled
resource (32bit) : .res

XPCOM Type
Library: .xpt

Xcode
Project: .pbxproj

Disk images

Hyper-V virtual
disk: .vhdx

JAM compressed
disk: .jam

Norton Ghost disk
image: .ghs

QEMU virtual
disk: .qcow2



Data Recovery Using R-Studio for Linux 51

© 2025 R-Tools Technology Inc.

R-Drive Image disk
image: .rdr

VMware virtual
disk: .vmdk

Virtual PC virtual
disk: .vhd

VirtualBox virtual
disk: .vdi

Other file types

ABBYY Lingvo
dictionary: .lsd

AIX Backup File: .bff ArtMoney Table
file: .amt

CrystalMaker Data
File: .cmdf, .cmmf

Dwarf Fortress save
data: .dat

EasyCrypto
file: .encrypted

Fallout 3 save
game: .fos

Java Applet cache
index: .idx

Kaspersky Anti-Virus
data base: .avc

Kaspersky Anti-Virus
report: .rpt

Kaspersky Anti-Virus
signature bas: .kdc

Magic 3D Easy View
object: .x

Microsoft Security
Catalog: .cat

NHTSA UDS-1992
crash test result: .uds

NOD32 Antivirus
Update file: .nup

ORTIMZeit
project: .ozv

OziExplorer Map
data: .map

PRO100 project: .sto PlayStation 3
Theme: .p3t

RegEdit file: .reg

RegEdit file
(UNICODE): .reg

Source Game Engine
Compiled AI
Nodegraph: .ain

Unreal Package Valve Texture
File: .vtf

WinHelp: .hlp WinHelp
Contents: .cnt

WinXP Prefetch file: .pf Windows Backup
File: .bkf

Windows Clipboard
file: .clp

Windows Color
Profile: .icm

Windows
Minidump: .dmp, .mdm
p

Windows National
locale: .nls

Windows Password
file: .pwl

Windows Registry
hive: .dat, .hiv

Windows Thumbnail
cache: .db

Windows User
Interface Module: .wim

Windows shortcut: .lnk X-Plane Scenery: .dsf XNA Game Data: .xnb

Note: Using scan for Known File Types, R-Studio for Linux can successfully recover only un-fragmented
files.
You may also specify your own file types for scanning. See Customizing File Types for details. User-
defined file types precede over built-in ones, if their definitions overlap.
You may set the defaults for known file types on the R-Studio for Linux Settings.

R-Studio Technician/T80+

Scan (Post Actions) dialog box
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Post Actions Options

Shutdown the computer on
task completion

If this check box is selected, R-Studio for Linux will shut down your
computer when scan has been completed. You should select the Save to file

checkbox and specify a place to save scan info to activate this option.
E-Mail notifications If this check box is selected, R-Studio for Linux will inform you about the

outcome of the operation via email. 

> R-Studio starts scanning the object, and its panel will show information about new found objects:

 shows path 

The Log pane will show scan progress. Scan may be stopped by clicking the Stop button on the tab. Later
the scan process may be resumed with different scan parameters. Some scan parameters may also be
changed during the scan process. Click the Options button and change them on the Scanning dialog box.
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 R-Studio for Linux Main panel



R-Studio Manual54

© 2025 R-Tools Technology Inc.

Drives panel after scanning:

You can select an object by clicking on it
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.

You may change some options during the scan process
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Only in the Technician version

You may see which file object(s) is/are on a particular disk part. Click the corresponding rectangle on the
Scan Information pane and view the information on the Scan Information dialog box.

Scan Information dialog box

Double-click an object to view/edit the file object in the Text/?hexadecimal editor.

When an object is scanned, a number of Recognized partitions will appear. R-Studio for Linux shows them
in different colors depending on which elements of the partition have been found.

An existing logical disk or partition

An existing logical disk or partition after disk scan

A recognized partition. Both boot records and file entries are found for this
partition
A recognized partition. Only file entries are found for this partition

A recognized partition. Only boot records are found for this partition

A fast found partition
A deleted partition 

Empty space on the object
Files that have been found using scan for known file types.

Although such recognized partitions are virtual objects, files can be searched for and recovered from
recognized partitions as from real logical disks using Basic File Recovery.

To see the information about a newly found object, simply click it on the Drives panel. Click this link to see
the information about the object Recognized1 on the Partition5:.

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-Logical-Disk.html
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When an object in a scanned drive is selected, R-Studio shows the scanned area of the object.

Object's scanned area

All scanned information may be deleted on the context menu for a scanned object. 

Scan information may be saved in a file. Previously saved scan information may be loaded. This can be done on
the Drive or context menu for a selected object.

Resuming incomplete scans or scanning the object with different parameters

You may resume the scan of an incompletely scanned object or rescan the already scanned object with different
parameters. The  Scan dialog will be a little bit different in this case.

Scan dialog box for incomplete scans

You may rescan the entire disk, scan unscanned areas, or scan an explicitly  specified area. 

Scan of multiple areas

You may simultaneously scan several  successive or overlapping areas. Click the Advanced button, specify an
offset and size for a new area to scan on the Advanced Scan dialog box and click the Add button. You may
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specify and add several scan areas. You may select which areas should be scanned. Selected scan areas can be
merged. Right-click a necessary area and select either Merge Down, Merge Down All, and Merge Selected.
You may also select/unselect unscanned areas.

Advanced Scan dialog box

R-Studio for Linux accumulates the information from successive scans and keeps track of changes in this
information obtained from different scans.

You may manage the areas 

Managing scan information

Scan information may be saved to a file. Previously saved scan information may be loaded. 

To save scan information

1 Select an object on the R-Studio for Linux Drives panel

2 Select Save Scan Information on the Drive or context menu and save the scan information in a file

The default file extension is *.scn.

To load scan information

1 Select an object on the R-Studio for Linux Drives panel

2 Select Open Scan Information on the Drive or context menu and select the required file with the scan
information

The default file extension is *.scn.

> The scan information will appear in the Drives panel

To remove scan information

1 Select an object on the R-Studio for Linux Drives panel

2 Select Remove Scan Information on the Drive or context menu

> The scan information will disappear from the Drives panel

NEVER TRY TO SAVE SCAN INFORMATION ON THE OBJECT BEING SCANNED!!!
Or you may obtain unpredictable results and lose all your data. 

2.2.2 Fast Search for Lost Partitions

Drive scan gives very detailed and accurate results but takes long time. If you want to find only partitions
previously existed on the disk you may use fast search for lost partitions which is much faster.

https://www.R-Studio.com/What-is-drive-scan.html
https://www.r-studio.com/What-is-Disk-Partition.html
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To perform fast search for lost partitions, 

1 Select an object on the R-Studio for Linux's Drives panel

Fast search for lost partitions

2 Click the Fast Partition Search button

R-Studio for Linux will start searching for lost partitions showing its progress.

Fast search for lost partitions
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> R-Studio for Linux will show fast found partitions in blue. 

Fast search for lost partitions

You may right-click the partition and select Complete scan to scan the entire disk.
2.2.3 Customizing File Types

You may create your own known file types and add their file signatures for scanning in Known File Types. They
will appear in their respective folders on the File Types dialog box. 

You can do that either by using the R-Studio for Linux's graphic interface or by direct editing the known file
description file specified on the R-Studio for Linux Main settings dialog box.

Creating a Known File Types using a Graphic User's Interface

The easiest way to add your own is to use the R-Studio for Linux's graphic interface. 

To create a Known File Type,

1 On the Known File Types settings dialog box, click the Edit User's File Types... button

> The Edit User's File Types dialog box will appear

Edit User's File Types dialog box

https://www.r-studio.com/What-is-Raw-File-Recovery.html
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2 Click the Create File Types button and specify File type properties

Edit User's File Types dialog box

 File Types properties

id digit Required Digital file type identifier. Should be unique for each custom file type. 
group string Optional Specifies a file type group in which found files will appear. You may

specify either your own groups or select those predefined on the File

Types dialog box. 
descrip
tion

string Optional Brief file description

feature
s

NO_SCAN
TXT_ANS
I
TXT_UNI
CODE

Optional Additional properties of the file type. If you want to specify several
properties, they should be separated by a space. 
NO_SCAN: Not to be scanned for. If this flag is used, R-Studio for
Linux will not search for such file type. Such files will be shown
when sorting files by their extensions.
TXT_ANSI: The file can be viewed as ANSI text. If this flag is
specified, the file can be correctly represented as an ANSI text.
When previewing, this file will be immediately sent to Text/?

hexadecimal editor.
TXT_UNICODE: The file can be viewed as UNICODE text. If this flag
is specified, the file can be correctly represented as a UNICODE
text. When previewing, this file will be immediately sent to Text/?

hexadecimal editor.
extensi
on

<string
>

Optional File extension.

3 Click the Add Signature button, specify the signature parameters, and click the Save button

Edit User's File Types dialog box
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 File signature properties

Begin
End

Specifies from where the signature begins.
If End, the offset is from the end of file to the first byte of the signature. That is, if the
signature is two bytes long, the offset value should be 2.

AND
OR

Shows the order of the logical operation (union or intersection)

From A decimal number specifying the leftmost possible offset for the file signature.
To A decimal number specifying the rightmost possible offset for the file signature.

You may specify as many signatures as you need. Moreover, you may specify subgroups within a signature
using the Add Subgroup button. The structure of such possible subgroups is described on the Customizing
File Types-II help page.

> The newly specified file type will appear on the Edit User's File Types dialog box and the File Types
dialog box

Edit User's File Types dialog box

2.2.4 Customizing File Types-I

The syntax of signature description is similar to that of the XML language. They are stored in the file specified on
the R-Studio for Linux Main settings dialog box.

More advanced features are described in Customizing File Types-II.

Signature file example
<?xml version="1.0" encoding="utf-8"?>
  <FileTypeList>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Signature offset="3" count="1">Abc\x5c\x00\x04</Signature>
      <Signature offset="9" count="2">\x23\x01\xf4</Signature>
    </FileType>
  </FileTypeList>

File structure

File header

The file starts with a standard XML header
<?xml version="1.0" encoding="utf-8"?>

Section FileTypeList
<FileTypeList>

It requires a closing element </FileTypeList>.
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Section FileType

This is a description of each file signature. 

Attributes:
id <u32> Required Digital file type identifier.

Should be unique for each
file type.

group <string> Optional Specifies a file type group
in which found files will
appear. You may specify
either your own groups or
those predefined on the
File Types dialog box. 

Default: unknown

description <string> Optional Brief file description Default: null (no description)
features NO_SCAN

TXT_ANSI
TXT_UNICODE

Optional Additional properties of
the file type. If you want
to specify several
properties, they should be
separated by a space. 

Default: 0

extension <string> Optional File extension. Default: null (no extension)

File type properties flags

NO_SCAN Not to be scanned for. If this flag is used, R-Studio for Linux will not search for such file
type. Such files will be shown when sorting files by their extensions.

TXT_ANSI The file can viewed as ANSI text. If this flag is specified, the file can be correctly
represented as an ANSI text. When previewing, this file will be immediately sent to Text/?
hexadecimal editor.

TXT_UNICOD
E

File can viewed as UNICODE text. If this flag is specified, the file can be correctly
represented as a UNICODE text. When previewing, this file will be immediately sent to
Text/?hexadecimal editor.

This section can contain an unlimited number of the Signature elements.If there are several Signature
elements, that means that all those signatures are simultaneously present in the file. Such signatures should have
different offset attributes and they should not overlap.

Element Signature

The element contains a string value of the file signature consisting of ASCII characters and hex bytes in the \xhh
format, where hh is a hexadecimal byte code. If there is not a hexadecimal number after \x , \x are treated as a
part of the string section of the signature

Attributes:
offset <u16> Optional Decimal offset for the signature Default: 0
count <u16> Optional Decimal number specifying the

number of signatures of the same
length. Used when several signatures
of the same length starting with the
same offset can be present in a file.

Default: 1
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In this case they should be
sequentially written in the element,
and the size attribute specifies the
length of signature. count*size
should be equal to the number of
bytes in the element.
If only one signature can be on this
offset, count should be equal "1",
and size should be equal to the
length (the number of bytes) of the
signature.

size <u16> Optional Decimal number specifying the
number of bytes in the signature.

Default: the number
of bytes written in
the element.

from begin
end

Optional Specifies from where the offset is
calculated.
If end, the offset is from the end
of file to the first byte of the
signature. That is, if the signature is
two bytes long, the offset value
should be 2.

Default: begin

Comments
<!-- Comment string -->

An XML standard string for a comment.

2.2.5 Customizing File Types-II

Currently R-Studio for Linux supports two versions of file type descriptions. Version 2 extends legacy Version
1 by adding variable signature offsets and  AND/OR combination of several signatures in one file type. The version
of file type description is specified by the version attribute of the FileTypeList section . Version 1 is the default
option. 

File structure

Elements common to Versions 1 and 2 of file type description

File header

The file starts with a standard XML header
<?xml version="1.0" encoding="utf-8"?>

Section FileTypeList
<FileTypeList>

Attributes:

version 1.0
2.0

Optional Version of file type description Default: 1.0

It requires a closing element </FileTypeList>.

Comments
<!-- Comment string -->
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An XML-standard string for a comment.

Version 1 of file type description

Signature file example

  <FileTypeList>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Signature offset="3" count="1">Abc\x5c\x00\x04</Signature>
      <Signature offset="9" count="2">\x23\x01\xf4</Signature>
    </FileType>
  </FileTypeList>

Section FileType

This is a description of each file signature. 

Attributes:

id <u32> Required Digital file type identifier.
Should be unique for each
file type.

group <string> Optional Specifies a file type group
in which found files will
appear. You may specify
either your own groups or
those predefined on the
File Types dialog box. See
the table below.

Default: unknown

description <string> Optional Brief file description Default: null (no description)
features NO_SCAN

TXT_ANSI
TXT_UNICODE

Optional Additional properties of
the file type. If you want to
specify several properties,
they should be separated
by a space. 

Default: 0

extension <string> Optional File extension. Default: null (no extension)

File type properties flags
NO_SCAN Not to be scanned for. If this flag is used, R-Studio for Linux will not search for such

file type. Such files will be shown when sorting files by their extensions.
TXT_ANSI The file can be viewed as ANSI text. If this flag is specified, the file can be correctly

represented as an ANSI text. When previewing, this file will be immediately sent to
Text/?hexadecimal editor.

TXT_UNICODE The file can be viewed as UNICODE text. If this flag is specified, the file can be
correctly represented as a UNICODE text. When previewing, this file will be
immediately sent to Text/?hexadecimal editor.

List of predefined file type groups

Group Name on the File Types dialog box.
archive Archive Files
graphics Graphics/Picture
internet Internet-related files
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multimedia Multimedia Files
audio Multimedia: Audio Files
video Multimedia: Video Files
font Font
document Document
doc_database Document: Database
doc_sheet Document: Spreadsheet
exe Executable/Library/DLL
unknown Other file types

This section can contain an unlimited number of the Signature elements.If there are several Signature
elements, that means that all those signatures are simultaneously present in the file. Such signatures should have
different offset attributes and they should not overlap.

Element Signature

The element contains a string value of the file signature consisting of ASCII characters and hex bytes in the \xhh
format, where hh is a hexadecimal byte code. If that is not a hexadecimal number after \x, \x are treated as a
part of the string section of the signature

Attributes:

offset <u16> Optional Decimal offset for the signature Default: 0
count <u16> Optional Decimal number specifying the

number of signatures of the same
length. Used when several signatures
of the same length starting with the
same offset can be present in a file. In
this case they should be sequentially
written in the element, and the size
attribute specifies the length of
signature. count*size should be
equal to the number of bytes in the
element.
If only one signature can be on this
offset, count should be equal to "1",
and size should be equal to the length
(the number of bytes) of the
signature.

Default: 1

size <u16> Optional Decimal number specifying the
number of bytes in the signature.

Default: the number
of bytes written in
the element.

from begin
end

Optional Specifies from where the offset is
calculated.
If end, the offset is from the end of
file to the first byte of the signature.
That is, if the signature is two bytes
long, the offset value should be 2.

Default: begin
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Version 2 of file type description

Signature file example

<?xml version="1.0" encoding="utf-8"?>
<FileTypeList version="2.0">
  <FileType id="5626" group="_Test" description="Test file" extension="tst">
    <Begin combine="and">
      <Signature from="0" to="20">ABC</Signature>
      <Signature offset="1">CDEFG</Signature>
      <AND>
        <Signature offset="0">DE</Signature>
        <Signature offset="0">RTD</Signature>
        <OR>
          <Signature offset="12">CP</Signature>
          <Signature offset="16">RTD</Signature>
        </OR>
      </AND>
    </Begin>
    <End combine="or">
      <Signature from="3" to="20">ABC</Signature>
      <Signature offset="5">CDEFG</Signature>
      <AND>
        <Signature offset="2">DE</Signature>
        <Signature offset="3">RTD</Signature>
        <OR>
          <Signature offset="12">CP</Signature>
          <Signature offset="16">RTD</Signature>
        </OR>
      </AND>
    </End>
  </FileType>
</FileTypeList>

Section FileType

This is a description of each file signature. 

Attributes:

Similar to those in Version 1.

The section can contain one element Begin and one End. It should contain at least one of them. 

Example

 <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin [attributes]>
        ...
      </Begin>
      <End [attributes]>
        ...
      </End>
    </FileType>
  </FileTypeList>

Sections Begin and End

Specify the positions of  file type signatures in the file.
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Attributes

combine and
or

Optional Shows the order of the logical
operation (union or intersection)

Default: and

These sections can contain one of several elements Signature. And one or several elements OR or AND. If there
are several elements inside the section they are combined according to the attribute combine.

Example:

  <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin combine="or">
        <Signature [attributes]> ... </Signature>
        ...
        <Signature [attributes]> ... </Signature>
        <AND>
          ...
        </AND>
        <OR>
          ...
        </OR>
      </Begin>
      <End>
        <OR>
          ...
        </OR>
        <Signature [attributes]> ... </Signature>
        ...
        <Signature [attributes]> ... </Signature>
      </End>
    </FileType>
  </FileTypeList>

Sections AND and OR

These sections can contain one of several elements Signature. And one or several elements OR or AND. If there
are several elements inside the section they are combined according to the section type (logical AND or OR).

Example:

  <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin>
        <Signature [attributes]> ... </Signature>
        ...
        <Signature [attributes]> ... </Signature>
        <AND>
          <Signature [attributes]> ... </Signature>
          <OR>
            <Signature [attributes]> ... </Signature>
            <AND>
              <Signature [attributes]> ... </Signature>
              <Signature [attributes]> ... </Signature>
            </AND>
            <OR>
              <Signature [attributes]> ... </Signature>
              <Signature [attributes]> ... </Signature>
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            </OR>
          </OR>
          <Signature [attributes]> ... </Signature>
        </AND>
      </Begin>
    </FileType>
  </FileTypeList>

Element Signature

The element contains a string value of the file signature consisting of ASCII characters and hex bytes in the \xhh
format, where hh is a hexadecimal byte code. If that is not a hexadecimal number after \x, \x are treated as a
part of the string section of the signature

Attributes:

offset <u16> Optional Decimal offset for the signature Default: 0
from <u16> Optional Decimal number specifying the

leftmost possible offset for the file
signature. 
Ignored if the offset attribute is
specified.

Default: undefined

to <u16> Optional Decimal number specifying the
rightmost possible offset for the file
signature. 
Ignored if the offset attribute is
specified.

Default: undefined

size <u16> Optional Decimal number specifying the
number of bytes in the signature.

Default: the number
of bytes written in
the element.

Example:

  <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin>
        <Signature offset="3">Abc\x5c\x00\x04</Signature>
        <Signature from="9" to="15">\x23\x01\xf4</Signature>
      </Begin>
    </FileType>
  </FileTypeList>

2.2.6 Regions

Scanning large objects may take a long time. Sometimes, only a smaller area of a disk needs to be scanned or
searched for files. Such area is called a region. A region can be created on any object in the R-Studio for
Linux's Drives panel. 

Created regions can be scanned, and files on them can be recovered in the same way as from hard drives or
logical disks.

Created regions can be deleted.

Note: R-Studio for Linux does not create anything real on the disk. Regions are virtual objects that do not
affect actual data on the disk.

https://www.r-studio.com/What-is-Disk-Region.html
https://www.r-studio.com/What-is-Logical-Disk.html
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To create a region

1 Select an object on the R-Studio for Linux's Drives panel and click the Create Region button

 Other ways to create the region

· Right-click the selected object and select Create Region on the context menu
or
· Select the object and select Create Region on the Create menu

2 Specify required parameters on the Create region dialog box and click the Create button

Create region dialog box

 Region options

Disk size: Shows size of the object where the region is to be created. The region cannot be larger
than this size.

Start: Start point of the region
Size: Size of the region. Cannot be larger than Disk size.

Numbers in these fields can be in bytes or sectors. See the Data Formats and Multipliers topic for
more details on data formats.

> A Region object will appear on the Drives panel. 

To remove a region

* Select a Region on the R-Studio for Linux Drives panel and click the Remove button, or

Right-click the selected region and select Remove Region on the context menu.

To change the size of a region

* Right-click a Region on the R-Studio for Linux Drives panel, select Edit on the context menu, and enter
a new size on the Edit Region dialog box.

To convert a region into an exclusive one

* Right-click the Region on the R-Studio for Linux Drives panel and select Exclude area on the context
menu

To remove a region

* Select a Region on the R-Studio for Linux Drives panel and click the Remove button, or

Right-click the selected region and select Remove Region on the context menu.
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2.2.7 Exclusive Regions

Exclusive regions are areas on any object visible on the R-Studio for Linux's Drives panel that are excluded
from disk operations. R-Studio for Linux never tries to read/write data from/to such area. Exclusive regions are
necessary when, for example, there are areas with bad sectors on a hard drive, and it is necessary to avoid any
disk operations with such areas to not inflict further damage to such drive and to speed work with it. 

Note: R-Studio for Linux does not create anything real on the disk. Exclusive regions are virtual objects that
do not affect actual data on the disk.

To create an exclusive region

1 Right-click  an object on the R-Studio for Linux's Drives panel and select Create Exclusive Region on

the context menu, or

Select the object and select Create Exclusive Region on the Create menu

2 Specify required parameters on the Create Exclusive Region dialog box and click the Add  button

Create exclusive region dialog box

 Exclusive Region options

Offset: Start point of the exclusive region
Size: Size of the exclusive region. Cannot be larger than Disk size.

Numbers in these fields can be in bytes or sectors. See the Data Formats and Multipliers topic for
more details on data formats.

> An Exclusive Region object will appear on the Drives panel. 

.

Its properties can be seen on the Excluded Areas tab.

https://www.r-studio.com/What-are-Bad-Sectors.html
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To remove an exclusive region

* Select an Exclusive Region on the R-Studio for Linux Drives panel and click the Remove button, or

Right-click the selected region and select Remove Region on the context menu.

To change the size of an exclusive region

* Right-click an Exclusive Region on the R-Studio for Linux Drives panel, select Edit on the context
menu, and add/remove excluded areas on the Edite Exclusive Region dialog box.

You may remove an excluded area by right-clicking it and selecting Remove on the context menu.

2.2.8 Images

An image is an exact, byte by byte, copy of any object on the Drives panel. When created, images can be
processed like their original objects. 

Images are very useful if there is a risk of total data loss due to hardware malfunction. If bad blocks are
constantly appearing on a hard drive, you must immediately create an image of this drive. All data search, scan
and restoring can be done from this image.

While creating images, R-Studio for Linux can simultaneously perform disk scan and save scan information to
lessen time necessary to process the disk. 

The image can be saved on the remote computer if it is created via network. R-Studio for Linux can also load
and process images created with the DeepSpar Disk Imager™.

To create an image,

1 Select an object on the R-Studio for Linux's Drives panel and click the Create Image button

 Other ways to create the image

· Select the object and select Create Image on the Drive menu
or
· Right-click the selected object and select Create Image File on the context menu

2 Specify image options, a file name, and destination for the image on the Create Image dialog box

Note: To store an image file, you need a free space equal to at least the object size.

Create Image (Main) dialog box

https://www.r-studio.com/What-is-Disk-Image.html
https://www.r-studio.com/What-is-free-disk-space.html
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Create Image (Bad sector processing) dialog box

Create Image (Scan Information) dialog box

 Image Options

Image name Specifies the name and path for the image file
Image type: Compressed image (R-Drive Image compatible): If this option is selected, R-Studio

will create an image file which can be compressed, split into several parts, and
password-protected. This image file is fully compatible with the images created
by R-Drive Image, but incompatible with very old versions of R-Studio.
Byte by byte image to a file: If this option is selected, R-Studio will create a
simple exact copy of the object. 
VMDK (ViMware Virtual Machine Disk) image: If this option is selected, R-Studio
will create an image of the VMware virtual disk type. Available in the Corporate,
Technician, and T80+ license.
Byte to byte image to a physical disk: R-Studio will create an exact copy of the
disk on another hard drive. Data on the target drive will be overwritten. Available
in the Corporate, Technician, and T80+ license.
Some other image formats are also available in the Technician, and T80+
licenses. You may read more about these formats in the Supported Virtual Disk
and Disk Image Formats page.

http://en.wikipedia.org/wiki/VMDK
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Image compression
ratio

You may compress the data in the image to save space. Active only if the
Compressed image (R-Drive Image compatible) is selected.

Estimated size Shows the estimated size of the image file. An actual image size depends on how
much empty space is on the selected partition and what file types are there.

Active only if the Compressed image (R-Drive Image compatible) is selected.
Image split size You may set this option to Automatic and let the OS decide how to split the image

file. This mostly depends on the file system on the destination disk. You may also
either explicitly specify the split size, or choose a preset for various devices with
removable storage. Select Fixed size for that. Active only if the Compressed image

(R-Drive Image compatible) is selected.
Password
Encrypt image

You may protect your image file with a password. Note: If you leave the Encrypt

image option clear this feature will provide a relatively moderate protection
against conventional unauthorized access. If this option is selected, R-Studio will
encrypt the image using the AES-XTS algorithm.
Note: Only files in the RDR format can be password protected and encrypted.

Create scan information
file

If this option is selected, R-Studio for Linux will perform disk scan
simultaneously with image creation. See the Disk Scan help page to learn scan
options.

Read retires Specifies a value for I/O Tries, or how many times R-Studio for Linux will try to
read a bad sector.
R-Studio for Linux treats bad sectors in the following way:
It reads a certain part of disk (predefined by Windows) and
· If Default read attempts is set to 0, the entire part with bad sectors will be filled

with the specified pattern. 
· If Default read attempts is set to a non-zero value, R-Studio for Linux reads

again that part sector by sector, repeating the attempts the specified number of
times. If R-Studio for Linux still cannot read a bad sector, it fills the sectors
with the specified pattern. In this case only the bad sectors will be filled with the
pattern, but that extremely slows the disk read process.

For example, if you set Default read attempts to 1, a bad sector will be read 2
times.

Pattern to fill bad blocks Specifies a pattern R-Studio for Linux will use to fill bad sectors in this image.
You may specify the pattern either in the ANSI or Hex data format.
Note: R-Studio for Linux will never ever try to write anything on the disk from
which data is to recover or an image is to create. This pattern fills bad sectors
only in the image.

Drive sector map file
Enable multi-pass
image creation

These options are available only in the Technician/T80+ versions. Read more
about these options in the I/O Monitor and Sector Map files and Multi-pass
imaging help page.

If a remote computer is connected for Data Recovery over Network, the Save Image File dialog box will
appear when you select a place to store the image. You may save it to the local or remote computer.

https://www.r-studio.com/What-is-file-compression.html
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.R-Studio.com/What-is-AES-XTS-encryption.html
https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-a-Sector-Map-File.html
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.

R-Studio Technician/T80+

These options are available only in the Technician/T80+ versions. 

Create Image (Additional output folders) dialog box
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Additional output folders

Additional output folders Additional output folders where image files will be stored when R-Studio for
Linux runs out of space.

Create Image (Post Actions) dialog box

Post Actions Options

Shutdown the computer on
task completion

If this check box is selected, R-Studio for Linux will shut down your
computer when image creation has been completed. 

E-Mail notifications If this check box is selected, R-Studio for Linux will inform you about the
outcome of the operation via email. 

> R-Studio for Linux will start creating the image, the Progress message showing the progress.

Standalone/Corporate Technician/T80+

You may change some options during the imaging process. Click the Options button and change them as
necessary/

You may stop the imaging process and then resume it later on. Click the Stop button and the Cancel drive

operation dialog box will appear. Select Stop if yo want to keep the partially created image or Discard if
you don't need this image file.
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To resume the creation of the image for the same object, select the same file name for the image. You'll be
able to create a new image file or continue to create the image for the object.

Resuming image creation

R-Studio for Linux will create a new file for every new start of imaging for the .rdi and .vmdk file types.

To process an already created Image, the image file should be opened.

To open an image

1 Click the Open Image button, or

Select Open Image File on the Drive menu

If a remote computer is connected for Data Recovery over Network, the Open Image File dialog box will
appear when you select a place to load the image file from. You may load it from the local or remote
computer.

2 Select the required image file 

If the image is a multi-volume one, and not all parts are at the same place, the dialog box will appear 
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Multi-volume image dialog box

Specify paths to other image parts and click the OK button.

> An Image object will appear on the Drives panel

Depending whether this is a byte-by-byte, compressed (R-Drive Image compatible), multi-volume, or
VMDK image, its appearance in the Drives panels is different.

You may perform all data search, scan, and recovery from this image as it were a regular drive/?disk object.

A compressed (R-Drive Image compatible) image

A byte by byte  image

A multi-volume image

A VMDK image

To close an image

* Select the image and click the Close Image button,

· or right-click the image and select Close Image on the shortcut menu

· or select the image and press the F8 key.
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To close all image

* Select Close All Images on the Tools menu

2.2.9 Wiping Objects

Disk objects can be wiped in order to completely destroy its data.

Supported Wipe Algorithms

File wiping is necessary only for files stored on conventional hard drives. Files stored on new SSD storage
devices cannot be effectively wiped out due to the principles of operation of these devices.

Currently R-Studio supports 6 wiping algorithms:

Zeroes The disk object or file is filled with zeroes through 1 pass. The fastest but the least
secure algorithm. Also it does not conceal the fact that the disk or file has been
wiped.

Pseudo-random
numbers

The disk object or file is filled with pseudo-random numbers through 1 pass. A
slower but little bit more secure algorithm than the Zeroes algorithm and it also
conceals to some degree the fact that the disk or file has been wiped.

DoD 5220.22-
M(3)

The disk object or file is wiped using Department of Defense standard 5220.22-
M(3). Provides high-grade data wiping filling the unused space or file with a special
digital pattern through 3 passes This algorithm is very secure, but slow.

DoD 5200.28-
STD(7)

The disk object or file is wiped using Department of Defense standard 5200.28-
STD(7). Provides high-grade data wiping filling the unused space or file with a
special digital pattern through 7 passes. This algorithm is very secure, but very
slow.

Bruce Schneier(7) The disk object or file is wiped using the Bruce Schneier(7) algorithm. The first
pass overwrites the drive with the bit pattern "00", the second with "11", and the
next five with a randomly generated bit pattern. This algorithm is very secure, but
very slow.

Peter Gutmann
(35)

The disk object or file is wiped using the Peter Gutmann's algorithm. Provides high-
grade data wiping filling the unused space or file with a special digital pattern
through 35 passes. This algorithm is military-level secure, but horribly slow.

What algorithm is to choose, depends on your specific needs. All of these wiping algorithms make recovery of
wiped data with any software-based data recover utility impossible. So if you want to protect your information
from a casual snooper, you may safely choose either the Zeroes or Pseudo-random numbers algorithm. The
latter also conceals the fact that you wiped the data.

If you want more security, you need to know the following: 

There are some techniques for recovery of wiped data. These techniques are based on the fact that magnetic
medium on the hard drive's platters "store" some information about previously written data. Such information
cannot be completely removed. Wiped data may be recovered even from mechanically damaged platters. So the

https://www.r-studio.com/What-is-data-wiping.html
https://www.r-studio.com/What-is-Solid-State-Device-SSD.htm
https://www.r-studio.com/What-is-Solid-State-Device-SSD.htm
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only safe way to completely remove data from a hard drive is to mechanically grind the magnetic medium off the
drive platters or dissolve them in special chemical solvents.  

But in order to recover the wiped data using one of these techniques, a hard drive must be disassembled, its
platters placed in a precise magnetic field measurement system, and the results of such measurement statistically
processed. All that is very expensive and requires a very qualified and experienced personnel and a specially
developed equipment. Only a very advanced organization such as a law enforcement or intelligence agency of a
developed nation, or a special high-tech firm can afford this. Moreover, each successive wiping pass makes such
data recovery much and much harder. So, the DoD 5220.22-M(3) clearing and sanitizing standard overwriting the
data with a special pattern through 3 passes is a rather reliable and safe choice for this case.

If you need the ultimate security, use the DoD 5220.22-M(7) clearing and sanitizing standard, the Bruce
Schneier(7), or even the Peter Gutmann (35) wiping algorithms. They render data almost unrecoverable, but they

are extremely slow.

Wiping Disk Objects:

To wipe a disk object,

1 Right-click the disk object in the Device view pane and select Wipe...

> The Wipe an object dialog box will appear.

Wiping Disk Objects

2 Select the desired wiping algorithms and click the OK button.

> R-Studio for Linux will start wiping the object.
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2.3 Mass File Recovery

Recovery of multiple files

If you need to recover multiple files you may do it through the following steps:

1 Find and mark all the necessary files

Go to the Find and Mark Multiple Files topic for more information

2 Recover all marked files in a single file recovery step

Go to the Recover Multiple Files for more information

Memory considerations

R-Studio for Linux stores information about found files in computer memory. If there are too many files,
R-Studio for Linux may run out of it. To avoid this, you have two options:

Recover all files

If you want to recover data from an entire file system object (a logical disk, partition, partition image, etc.), you
may use the Recover All Files command from the Drive or context menu. Right click the object in the Drives

panel to access the context menu. A Recover dialog box will appear. Select required restore settings, including
file mask. This command restores unlimited number of files without memory restrictions.

View file information in steps

As soon as R-Studio for Linux nearly runs out of memory, a Too many files... message appears. You may
temporally stop file listing and browse through found files. Then you can resume file listing. You also may skip this
file section and continue file listing. 

In all cases, R-Studio for Linux keeps information about the entire file structure.

· Find and Mark Multiple Files 
· Recover Multiple Files

2.3.1 Find and Mark Multiple Files

If you need to find and mark many files at once, you may do that in the following ways:

By sorting them by their extensions or creation/modification/accessed time

To sort files by their extensions or creation/modification/accessed time,

* On the Folders/?Files panel select the tab

Extensions  to sort the files by their extensions
Creation
Time

to sort the files by their creation time

Modification
Time

to sort the files by their modification time

Accessed
Time

to sort the files by their accessed time

 Other ways to sort files by their extensions or creation/modification/accessed time

· Select the disk on Drives panel, select Open Drive Files Sorted By on the Drive menu, and select the
respective option, 

or

https://www.r-studio.com/What-is-Logical-Disk.html
https://www.r-studio.com/What-is-Disk-Partition.html
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· On the Drives panel, right-click the disk and select Open Drive Files Sorted By on the context menu and
select the respective option,

or
· On the Folders panel, right-click the disk letter and select Show Files Sorted By on the context menu and

select the respective option,

> R-Studio for Linux will show the sorted files in the Folders and Content panels, showing the path to

each file:

Folders panel for files sorted by their extensions

Content panel with files/?folders sorted by their extensions

To return to the conventional view,

* On the Drives panel, right-click the logical disk, select Open Drive Files Sorted By on the context
menu, and select Real File System Structure, 

or

On the Folders panel, select Show Files Sorted By on the Drive menu and select Real File System

Structure

or

Click the Real tab

By finding and marking multiple files using the Find/Mark dialog box

You may find and mark all the files on the entire disk by using Mark matched files in the Find/Mark mode option.
You may specify all the necessary search options and mark all the found files. Please note that each find and
mark/unmark operation is independent from previous ones. That is, if a file matches the search criteria, it will be
marked/unmarked regardless of its previous marked/unmarked state.

For example, if you first mark all doc files, and then all txt files, all doc files remain marked, too. If you then
decide to unmark all files smaller than 2 kB, all doc and txt files will stay marked except those that less than 2
kB.



Data Recovery Using R-Studio for Linux 83

© 2025 R-Tools Technology Inc.

2.3.2 Recover Multiple Files

If R-Studio for Linux while recovering files encounters either an already existing file or file with a broken name,
normally it will stop working and ask you what to do with the file. If you recover multiple files, that may require
you answer a lot of the same questions. You may use Mass File Recovery Options on the Recover dialog box to
instruct R-Studio for Linux what to do in those cases for all files.

Recover (Advanced) dialog box

Advanced file recovery options

File Already Exists These options instruct R-Studio for Linux what to do if there already exists a
file with the same name. 

Extended options If this option is selected, more advanced options become accessible to process
multiple duplicates of the file.

Prompt If this option is selected, R-Studio for Linux asks the user what to do for
each such file. It stops file recovery until it receives the answer.

Rename If this option is selected, R-Studio for Linux adds a File ID to the file name. If
a file already exists with the same name and that file ID, a number will be
added to th file name and file ID.

Skip If this option is selected, R-Studio for Linux skips all new files with the same
name.

Overwrite If this option is selected, R-Studio for Linux overwrites the existing file with
the new one.

Overwrite Older If this option is selected, R-Studio for Linux overwrites the existing file with
the new one if the existing file is older than the new file. The time stamp used is
Modified.

Overwrite Smaller If this option is selected, R-Studio for Linux overwrites the existing file with
the new one if the existing file is smaller than the new file. The time stamp used
is Modified.

Overwrite Bigger If this option is selected, R-Studio for Linux overwrites the existing file with
the new one if the existing file is bigger than the new file. The time stamp used is
Modified.

Broken File Name These options instruct R-Studio for Linux what to do if a file to be recovered
appears to have an invalid name.

Prompt If this option is selected, R-Studio for Linux shows the standard Broken File

Name dialog box for each file with a broken file name. It stops file recovery
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until it receives the answer.
Rename and change all
invalid symbols to:

If this option is selected, R-Studio for Linux changes all invalid characters to
the character specified.

Skip If this option is selected, R-Studio for Linux skips all files with broken file
names.

Hidden Attribute These options instruct R-Studio for Linux what to do if a file to be recovered
appears to have  the Hidden attribute.

Prompt If this option is selected, R-Studio for Linux asks the user what to do with the
attribute. It stops file recovery until it receives the answer.

Remove If this option is selected, R-Studio for Linux removes the Hidden attribute
from all files.

Keep If this option is selected, R-Studio for Linux keeps the Hidden attribute for all
files.

Extended options

These options give you more flexible ways to process multiple files with the same name. You may compare
files by time (Modified) and size, and decide what R-Studio for Linux should do with those duplicates. If
any of the files has an invalid time, the comparison by time is skipped. In this case, if comparison by size is
not  active, R-Studio for Linux goes to the default action..

Recover (Advanced - Extended options) dialog box

Extended advanced file recovery options

First compare
time
First compare
size 

These options instruct R-Studio for Linux which condition to use first, file time or size.

Compare
time
Compare size

These options instruct R-Studio for Linux to enable comparison by time and size..

Actions These selectable actions instruct R-Studio for Linux what to do if the condition is met.

Empty
field

If this option is selected, R-Studio for Linux skips the condition.

Prompt If this option is selected, R-Studio for Linux asks the user what to do for each such file. It
stops file recovery until it receives the answer.
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Rename If this option is selected, R-Studio for Linux adds a File ID to the file name. If a file already
exists with the same name and that file ID, a number will be added to th file name and file ID.

Skip If this option is selected, R-Studio for Linux skips all new files with the same name.
Overwrite If this option is selected, R-Studio for Linux overwrites the existing file with the new one.

Time
conditions

If the Modified time stamp is invalid, R-Studio for Linux will skip the comparison.

Equal time Two time stamps are the same.
Older The existing file is older than the new one.i
Newer The existing file is newer than the new one.i

Size
conditions

Equal size Two files have the same size.
Smaller The existing file is smaller than the new one.i
Bigger The existing file is bigger than the new one.i

By default The action R-Studio for Linux takes when none of the comparison conditions have been
met. That may happen when the comparison by size is not enabled. 

2.3.3 File Recovery Lists

You may create a file containing a list of files and folder found on a disk/partition. Then such file may be manually
edited to specify files to recover and then loaded back into R-Studio for Linux. R-Studio for Linux will
automatically mark the files in this list for recovery. Such file lists recovery are very useful, for example, when it is
necessary to have such file lists approved for recovery by someone else who is far away from the computer
where R-Studio for Linux is running.

You may create file recovery lists for the entire disk or for specific folders. Moreover, you may create a file
recovery list for all files within the disk/folder, or for marked files/?folders only.

All versions of R-Studio for Linux can create recovery lists in the plain text format with basic functionality.
R-Studio Technician/T80+ can create custom recovery lists in other formats with more advanced options 

Creating a simple recovery list

To create a recovery list

1 For an entire disk, select Export Recovery List on the File menu, or

Right-click the uppermost folder (higher than Root, usually the letter or the name of the disk) and select
Export Recovery List on the shortcut menu.

For a specific folder, right-click the folder and select Export Recovery List on the shortcut menu.

2 Specify the place to save the recovery list and other necessary options on the Export Recovery List
dialog box

Export Recovery List dialog box
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Options dialog box

Export Recovery List options

Export the entire folder/file tree
Export marked file/folder names
Export file/folder names

Specifies which file and folder names will be exported. 

File format:

A file format for the recovery list.
Only text format is available for the standalone and corporate versions.
R-Studio Technician/T80+ can create custom recovery lists in other
formats with more advanced options 
The following formats are available for R-Studio Technician/T80+
version:
Plain Text
HTML
XML
JSON
CSV

File name: Specifies a file name of the recovery list. 

Editing the file recovery list

All files without any marks in the recovery list will be marked when the list is loaded into R-Studio for Linux.

So, if you have some files in the recovery list that don't need to be recovered, just delete them from the list. In
addition, you may use the following marks to specify some options 

:+ Mark the file, or the folder, all its files, and subfolders within the folder.
:* Mark the file, or the folder and its files, don't mark subfolders in the folder.
:- Unmark the file, or the folder, its files, and subfolders in the folder.
:= Unmark the file or the folder and its files, dont unmark subfolders in the folder.
:! Provide the information on the file. (R-Studio Technician/T80+ only)

 R-Studio for Linux processes records in the list consequently. That is, if there are the following lines in the
file,
:+Files_to_Recover\
:-Files_to_Delete\File_2.jpg

the file File_2.jpg won't be marked for recovery, while for the lines
:-Files_to_Recover\File_2.jpg
:+Files_to_Recover\

file File_2.jpg will be.

Loading the edited recovery list

To load a recovery list into R-Studio for Linux,

* Select Import Recovery List from the File menu and select the file, or

Right-click the uppermost folder (higher than Root, usually the letter or the name of the disk) and select
Import Recovery List on the shortcut menu.

> R-Studio for Linux will load the file and mark the files accordingly.
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An example of a simple recovery list

As an example, we'll create a simple recovery list, edit it to mark only those files that are to be recovered, and
load it back to mark those files. 

To create such recovery list

* Mark the necessary folders, right-click the Root folder, and select Export Recovery List on the shortcut
menu.

Right-click the uppermost folder (higher than Root, usually the letter or the name of the disk) and select
Export Recovery List on the shortcut menu.

Export Recovery List

Specify the necessary options and click the OK button.

> R-Studio will save the file.

Structure of a simple recovery list file created by R-Studio for Linux
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"/media/andrew/ntfs test";
label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
product:"disk"; vendor:"flash"; 
Diving/
Diving/Aquarium/
Diving/Aquarium/20190822_100644.jpg
Diving/Aquarium/20190822_101620.jpg
Diving/Aquarium/20190822_102526.jpg
Diving/Aquarium/20190822_103830.jpg
Diving/Aquarium/20190822_104333.jpg
SF/
SF/Sea-Lions/
SF/Sea-Lions/IMG_3493.JPG
SF/Sea-Lions/IMG_3535.JPG
SF/Sea-Lions/IMG_3542.JPG
SF/Sea-Lions/IMG_3579.JPG



R-Studio Manual88

© 2025 R-Tools Technology Inc.

SF/Sea-Lions/IMG_3580.JPG
SF/Sea-Lions/IMG_3581.JPG
SF/Sea-Lions/IMG_3589.JPG
SF/IMG_0869.JPG
SF/IMG_0873.JPG
SF/IMG_0890.JPG
SF/IMG_1739.JPG
SF/IMG_3460.JPG
SF/IMG_3461.JPG
SF/IMG_3476.JPG
SF/IMG_3478.JPG
SF/IMG_3479.JPG
SF/IMG_3480.JPG
SF/IMG_3481.JPG
SF/IMG_3493.JPG
SF/IMG_3535.JPG
SF/IMG_3542.JPG
SF/IMG_3579.JPG
SF/IMG_3580.JPG
SF/IMG_3581.JPG
SF/IMG_3589.JPG
SF/IMG_3590.JPG
SF/IMG_3591.JPG
SF/IMG_3592.JPG
SF/IMG_3593.JPG
SF/IMG_3594.JPG
SF/IMG_3595.JPG
SF/IMG_3596.JPG
SF/IMG_3608.JPG
SF/IMG_3627.JPG
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG

If such recovery list is created from an entire logical disk/partition, it will contain several virtual folders. For
example, they'll have the following structure for an NTFS partition.
System Volume Information/
System Volume Information/IndexerVolumeGuid
System Volume Information/WPSettings.dat
Vegas/
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG
///m/$Extend/
///m/$Extend/$Deleted/
///m/$Extend/$RmMetadata/
///m/$Extend/$RmMetadata/$Txf/
///m/$Extend/$RmMetadata/$TxfLog/
///m/$Extend/$RmMetadata/$TxfLog/$Tops
///m/$Extend/$RmMetadata/$TxfLog/$TxfLog.blf
///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000001
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///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000002
///m/$Extend/$RmMetadata/$Repair
///m/$Extend/$ObjId
///m/$Extend/$Quota
///m/$Extend/$Reparse
///m/$AttrDef
///m/$BadClus
///m/$Bitmap
///m/$Boot
///m/$LogFile
///m/$MFT
///m/$MFTMirr
///m/$Secure
///m/$UpCase
///m/$Volume

Now we need to edit this file to mark for recovery the following folders/files:

1. All files in the root folder;

2. Two files MyPhoto1.jpg and MyPhoto3.jpg in the Diving subfolder;

3. All files in the Diving/Aquarium/ folder;

4. All files in the SF/ folder except the SF/Sea-Lions/ subfolder.

The edited simple recovery list

The final simple recovery list will be the following:
:# Version = 1

:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"/media/andrew/ntfs test";
label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
product:"disk"; vendor:"flash"; 
:= Diving/
:+ Diving/Aquarium/
:+ Diving/MyPhoto1.jpg
:+ Diving/MyPhoto3.jpg
:+ SF/
:- SF/Sea-Lions/
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG

Loading the edited recovery list

When we load this recovery list into  R-Studio for Linux, will see the following results;
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The root folder

The Diving folder

The SF folder

2.4 Volume Sets and RAIDs

R-Studio for Linux detects and processes valid hardware volume sets and RAIDs like regular drives/volumes.

R-Studio for Linux can analyze and recover data from software volume sets and RAIDs. If a software volume
set or RAID is present in your system, R-Studio for Linux detects it, and a Volume sets and RAIDs object
appears on the Drives panel. This object can be searched for files, scanned, and files found on it can be
recovered the same way as from normal drives/volumes.

If, due to hardware failure, a hardware volume set or RAID cannot be accessed, or due to data loss your system
does not recognize a software volume set or RAID, and you know what hard drives were in it, you may create a
Virtual volume set or RAID and process it like a real software volume set or RAID or hardware volume set or
RAID. 

You may find more information on RAID types in our article What is Hardware RAID.

You may turn numerical indexes for objects to distinguish them better while creating virtual RAIDs.

· Volume Sets, Stripe Sets, and Mirrors
· Basic RAID 4 and RAID 5 Operations
· Working with RAID 6 Presets 
· Working with RAID6 (Double Xor)

· Working with RAIDs with Parity Delays
· Working with Advanced RAID Layouts
· Nested and Non-Standard RAID Levels
· Finding RAID Parameters
· Checking RAID Consistency
· Syntax of a Description File for RAID Configurations
· Description Files for RAID Configurations
· Reverse RAIDs

https://www.r-studio.com/What-is-Hardware-RAID.html
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· Various Disk and Volume Managers

Managing your own RAID layouts

To save your own RAID layout in the presets

1 Click the More... button on Parents tab and select Save on the context menu.

2 Specify the name for the configuration on the Preset name dialog box.

Preset name dialog box

> The new RAID configuration will be saved in the presets

The configurations are stored in the user's RAID layout file. The path and name for this file is specified on the
R-Studio for Linux Settings dialog box. If no file is specified, R-Studio for Linux will ask you to enter the
name.

Loading your RAID configuration 

If there're objects in the Parents tab, the preset will be applied to them. If the Parents tab is empty, R-Studio
for Linux will search the disks listed in the Drives tab for the parents in the user's RAID layout file. If the search
fails, R-Studio for Linux will show the Reference Parents not found message.

To load your RAID configuration 

1 Click the More... button on Parents tab and select the preset you want to load

> The new RAID configuration will be loaded

To edit your own RAID configuration

1 Click the More... button on Parents tab and select Edit... on the context menu

2 Select the required configuration on the Edit Block RAID Layout Presets dialog box.

Edit Block RAID Layout Presets dialog box

3 Edit the parameters of the configuration and save it

> The new configuration parameters will be saved.

Turning Disks On-Line and Off-Line on-the-fly

You may turn the objects in the virtual RAID or volume set on-line and off-line by selecting/clearing the
checkbox on the Parents tab. It may be useful, for example, if you need to see which disk is non-actual in a
RAID 5. 

Actually, when you turn an object off-line, R-Studio for Linux substitutes it with a Missing Disk or Empty
Space object.

Missing Disks and Empty Space

If one partition from a hardware volume set or RAID or software volume set or RAID is absent, due to
hardware failure, for example, you need to add a virtual missing disk or empty space in order to correctly re-

https://www.r-studio.com/What-is-Disk-Partition.html
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construct the hardware volume set or RAID or software volume set or RAID structure. The missing disk/empty
space should be placed in the same place as the missing partition.

Note: R-Studio for Linux does not write anything real on the disk. Missing disks/empty space are virtual
objects that do not affect actual data on the drive.

To add a Missing disk/Empty space object 

1 Select a Volume sets and RAIDs object on the R-Studio for Linux's Drives panel

2 Right-click in the Parents tab in the right pane and select Add Missing Disk or Add Empty Space on the
context menu or select Add Missing Disk or Add Empty Space on the Create menu. Which object type is

necessary, R-Studio for Linux decides automatically.

For the Empty space object, Specify its size on the Add Empty Space dialog box.

Add Empty Space dialog box

> A Missing Disk or Empty Space object will appear in the Parents tab

2.4.1 Volume Sets, Stripe Sets, and Mirrors

To create a Volume set object

1 Click the Create Virtual RAID button and select Create Virtual Volume set

or select the Create Virtual Volume set on the Create menu

> A Virtual Volume set object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.
Or right-click the Parents tab and select the required partition from the context menu.

Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order.
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> The Virtual volume set or RAIDs object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on the newly created RAID object, a partition object will
appear on the Drives panel.

To create a Stripe set object (RAID 0)

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Select RAID 0 (Stripe set) on the RAID type

3 Drag the required partitions from the Drives panel to the Parents tab

Or right-click the Parents tab and select the required partition from the context menu.

You may either make R-Studio for Linux to process your changes immediately or wait until you finish
editing the RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click
the Apply button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The Block size and Offset (in sectors) parameters must be set the same as for the original volume set. 

You also need to specify Block order. You may select it on the Blocks order drop-down or context menu.

If the those parameters are not correct, data on the parents will not be damaged, but they cannot be
recovered.
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> The Virtual Block RAID object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on the newly created RAID object, a partition object will
appear on the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

To create a Mirror set object (RAID 1)

1 Click the Create Virtual RAID button and select Create Virtual Mirror

or select the Create Virtual Mirror on the Create menu

> A Virtual Mirror object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

Or right-click the  Parents tab and select the required partition from the context menu.

> The Virtual Mirror object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on the newly created RAID object, a partition object will
appear on the Drives panel.
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2.4.2 Basic RAID 4 and RAID 5 Operations

RAID 4 and RAID 5 are much similar. You may create and edit a RAID 4 object the same way as a RAID 5
one. 

To create a RAID 5 object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Select RAID 5 on the RAID type

3 Drag the required partitions from the Drives panel to the Parents tab

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.
You may either make R-Studio for Linux to process your changes immediately or wait until you finish
editing the RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click
the Apply button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 5. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state
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(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 5. 

You also need to specify Block order for virtual RAID 5. You may select it on the Block order drop-down or
context menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 5
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 5. Find a file and preview it.
If the file appears correct, you have created a correct RAID 5 layout. 

If your RAID 5 has an unusual configuration, you may create them manually. See Working with Advanced
RAID 5 Layouts for details.

Parents tab

> The RAID 5 object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on the newly created RAID object, a partition object will
appear on the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

Creating and saving your own RAID 5 configuration

You may create and save your own RAID configurations for non-standard RAIDs. You may specify Offset,
Block order/size and Row count. See Working with Advanced RAID 5 Layouts for details.

https://www.r-studio.com/What-is-Disk-Partition.html
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2.4.3 Working with RAID 6 Presets

R-Studio for Linux allows you to create and process RAID 6 layouts. You may use either presets for several
RAID 6 layouts, or use your own custom ones.

R-Studio for Linux provides presets for the following RAID 6 layouts:

Reed-Solomon

Left Synchronous
(standard),

Left Asynchronous
(continuous),

Right Synchronous Right Asynchronous

In addition you may create your own RAID 6 configurations.

Creating a RAID 6 object from a preset:

We will use the Reed-Solomon (Left Synchronous (standard)) preset as an example.

To create a RAID 6 object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Select RAID 6/Reed-Solomon on the RAID type

3 Drag the required partitions from the Drives panel to the Parents tab

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.
You may either make R-Studio for Linux to process your changes immediately or wait until you finish
editing the RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click
the Apply button to apply the changes when are you through. 

Parents tab
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Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order.

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original volume set. 

You also need to specify Blocks order (Left Synchronous (standard) for our case) for virtual RAID 6. You may
select it on the Blocks order drop-down or context menu.

If the those parameters are not correct, data on the parents will not be damaged, but they cannot be
recovered.

Note: You may check how correctly you have reconstructed the original volume set or RAID. Find a file
and preview it. If the file appears correct, you have created a correct RAID layout. 

> The Virtual Block RAID object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on the newly created RAID object, a partition object will
appear on the Drives panel. The Description Files for RAID Configurations topic shows the RAID
description file for this RAID configuration.

https://www.r-studio.com/What-is-Disk-Partition.html
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.

2.4.4 Working with RAID6 (Double Xor) Presets

R-Studio for Linux allows you to create and process RAID 6 Double Xor layouts with the following presets:

EVENODD RAID DP X-Code(2) Adaptec 3805

In addition you may create your own RAID 6 configurations.

Creating a RAID 6 (Double Xor) object from a preset:

We will use the EVENODD preset as an example.

To create a RAID 6 (Double Xor) object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Select RAID 6/? Double Xor on the RAID type

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.
You may either make R-Studio for Linux to process your changes immediately or wait until you finish
editing the RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click
the Apply button to apply the changes when are you through. 
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Parents tab

Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order.

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original volume set. 

You also need to specify Blocks order (EVENODD for our case) for virtual RAID 6 (Double Xor). You may
select it on the Blocks order drop-down or context menu.

If the those parameters are not correct, data on the parents will not be damaged, but they cannot be
recovered.

Note: You may check how correctly you have reconstructed the original volume set or RAID. Find a file
and preview it. If the file appears correct, you have created a correct RAID layout. 

> The Virtual Block RAID object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on the newly created RAID object, a partition object will
appear on the Drives panel. The Description Files for RAID Configurations topic shows the RAID
description file for this RAID configuration.

https://www.r-studio.com/What-is-Disk-Partition.html
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You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.5 Working with RAIDs with Parity Delays

R-Studio for Linux allows you to create RAIDs with parity delays (any level that allows that). For example, let
us create a RAID 5 the parity delays with the following layout:

· Three disks, 
· Delay=16
· Block size: 16 KB
· Offset: 1088 sectors (544 KB)
· Block order: Left Asynchronous (Continuous)

 Block order table:

A B C

Delay=16

1 1 2 PD
2 3 4 PD
3 5 6 PD
4 7 8 PD
5 9 10 PD
6 11 12 PD
7 13 14 PD
8 15 16 PD
9 17 18 PD

10 19 20 PD
11 21 22 PD
12 23 24 PD
13 25 26 PD
14 27 28 PD
15 29 30 PD
16 31 32 PD
17 33 PD 34

Delay=1618 35 PD 36
19 37 PD 38
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20 39 PD 40
21 41 PD 42
22 43 PD 44
23 45 PD 46
24 47 PD 48
25 49 PD 50
26 51 PD 52
27 53 PD 54
28 55 PD 56
29 57 PD 58
30 59 PD 60
31 61 PD 62
32 63 PD 64
33 PD 65 66

Delay=16

34 PD 67 68
35 PD 69 70
36 PD 71 72
37 PD 73 74
38 PD 75 76
39 PD 77 78
40 PD 79 80
41 PD 81 82
42 PD 83 84
43 PD 85 86
44 PD 87 88
45 PD 89 90
46 PD 91 92
47 PD 93 94
48 PD 95 96

To create such RAID 5,

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID & Autodetect

or select Create Virtual Block RAID & Autodetect on the Create menu

Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
for Linux from trying to start processing the RAID configuration until you specify it completely.

2 Drug the required objects from the Drives pane to the Parents tab and select RAID 5 on the RAID type

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the
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RAID object you want to add the partition to.
These objects may be hard drives, logical disks, or images. Check that the objects are correctly placed.

Note: Objects should be placed in the same order as they were in the original RAID 5. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order field.

4 Specify the parity delay number in the Parity delay control on the Parents tab. 

The number of rows will change to 48. 

If necessary, adjust the First parity parameter

By default, this parameter is set equal to Parity delay. By changing it, you may "shift" the block order table.
For example, when the First parity parameter is set as 1 for the RAID 5 of 3 disks with Parity delay of 3.,
the block order table will be the following:First parity parameter

https://www.r-studio.com/What-is-Logical-Disk.html
https://www.r-studio.com/What-is-Disk-Image.html
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5 Select Left Asynchronous (Continuous) on the Block Order Field and click the Apply button on the
Parents tab

> The created Virtual Block RAID 1 object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on this RAID object, a partition object will appear on the
Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.6 Working with Advanced RAID Layouts

 R-Studio for Linux allows you to create and process very complex custom RAID layouts.

For example, let us create a RAID 5 with the following layout:

· Three disks, 
· Block size: 4 KB
· Offset: 32768 sectors (64 KB)
· Block order:

A B C

1 PD 1 2
2 PD 3 4

https://www.r-studio.com/What-is-Disk-Partition.html
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3 PD 5 6
4 7 PD 8
5 9 PD 10
6 11 PD 12
7 13 14 PD
8 15 16 PD
9 17 18 PD

To create such RAID 5,

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.
Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
for Linux from trying to start processing the RAID configuration until you specify it completely.

2 Drug the required objects from the Drives pane to the Parents tab and select Custom on the RAID type

These objects may be hard drives, logical disks, or images. Check that the objects are correctly placed.

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

https://www.r-studio.com/What-is-Logical-Disk.html
https://www.r-studio.com/What-is-Disk-Image.html
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3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order field.

4 Manually enter 9 to Number of rows on the Parents tab

Block order will change to Custom.

5 Enter the block order in the table on the Parents tab

Use the RAID sequence window to move from one row to another. 

Using the keyboard: arrow keys to navigate, digit and pd keys to enter the block order.

Using the mouse: right-click the cell and select the number or parity from the context menu. If the block
table is too large, you better use the keyboard to enter the digits. 

Corrections: R-Studio for Linux will tell you if some digits are not correct. Navigate to the required cell
and enter the correct value. Use the Delete key to clear a cell. 

Clear the table: Right-click the table and select Clear all on the context menu.
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6 When you finishes entering the information, click the Apply button on the Parents tab

> The created Virtual Block RAID 1 object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on this RAID object, a partition object will appear on the
Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

Advanced RAID 5

Another example is a RAID with the following layout, similar to that used in Mac Pro internal RAID cards with 4
hard drives.

· Four disks, 
· Block size: 512 KB (1024 sectors)
· Offset: 32768 sectors (64 KB)
· Block order:

A B C D A B C D A B C D

PD 1 2 PD 3 4 PD 5 6 PD 7 8

https://www.r-studio.com/What-is-Disk-Partition.html
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As you see, this layout cannot be fit directly into a standard 2D block order table. Still, it's possible to create
such RAID layout using the RAID Sequence window.

To create such RAID,

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID & Autodetect

or select Create Virtual Block RAID & Autodetect on the Create menu

Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
for Linux from trying to start processing the RAID configuration until you specify it completely.

2 Drug the required objects from the Drives pane to the Parents tab and select RAID 5 on the RAID type

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.
These objects may be hard drives, logical disks, or images. Check that the objects are correctly placed.

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order field.

4 Manually enter 3 to Number of rows on the Parents tab and change Block order to Custom

5 Right-click the RAID Sequence window and select Remove All. Manually enter 3 to Number of rows on
the Parents tab and change Block order to Custom

6 Right-click Cell 1 in the block order table and select Create New Sequence. 

https://www.r-studio.com/What-is-Disk-Image.html
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7 Right-click Cell 2 in the block order table and select Add to Sequence, do that for Cell 3, too. 

8 Right-click Cell 4 in the block order table and select Create New Sequence. 

9 Right-click Cell 5 in the block order table and select Add to Sequence, do that for Cell 6, too. 

Continue those steps for the rest of the table until the RAID Sequence window will have 4 sequences of 3
disks:

Sequences window

10 Select the first line in the RAID Sequence window, right-click Cell 1 in the block order table, and select
Parity of Data. 

If any unnecessary sequences appear, right-click them in the RAID Sequence window, and select Remove.

11 Right-click Cell 2 in the block order table and select 1, do that for Cell 3 selecting 2. 

If any unnecessary sequences appear, right-click them in the RAID Sequence window, and select Remove.

12 Move to the next sequence in the  RAID Sequence window and repeat the procedure for cells 4, 5, and
6. 

Do that for the rest of the sequences until you fill all cells in the block order table in the Parents tab. 

> The created Virtual Block RAID 1 object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on this RAID object, a partition object will appear on the
Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.
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You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

Advanced RAID 6 Layout

For example, let us create a RAID 6 with the following layout:

· Five disks, 

· Block size: 64 KB
· Offset: 0
· Block order:

A B C D E

1 RS 1 2 3 PD
2 4 5 6 PD RS
3 8 9 PD RS 7
4 12 PD RS 10 11
5 PD RS 13 14 15
6 PA PA PA PA PA

where 

PD is parity of data;
PA is parity of all;
RS is Reed-Solomon;

Rows from 1 to 5 use two types of error correction: parity of data (xor) and Reed-Solomon. That is, row 1 uses
blocks A1 and E1, row 2 uses blocks D2 and E2, and so on. 

Row 6 is used for error correction for columns. That is, column A uses block A6, column B uses B6, and so on.
Parity of all is used for error correction.

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.
Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
for Linux from trying to start processing the RAID configuration until you specify it completely.
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2 Drug the required objects from the Drives pane to the Parents tab and select Custom on the RAID type

These objects may be hard drives, logical disks, or images. Check that the objects are correctly placed.

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order parameter.

4 Manually enter 6 to Number of rows on the Parents tab

5 Enter the block order in the table on the Parents tab

You may enter either a block number, or an error correction block of the following types:

PD Parity of data
PA Parity of all
RS Reed-Solomon
U Unknown
I Ignore

Note: You should specify an error correction block only when the correct sequence is selected on the RAID

Sequences window.

Using the keyboard: arrow keys to navigate, digit, and rs, pd, pa, u, i keys to enter the block order.

https://www.r-studio.com/What-is-Disk-Image.html
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Using the mouse: right-click the cell and select the number or parity from the context menu. If the block
table is too large, you better use the keyboard to enter the digits.

For the rows:

Select the required row sequence on the RAID Sequences window, select the cell on the RAID table, and
enter the required value. R-Studio for Linux automatically generates those sequences when you add RAID
parents.

For the columns and arbitrary sequences:

You need to create those sequences and add the respective blocks to it manually. 

To create a sequence: Click Add empty on the RAID Sequences window or select Create New

Sequence on the context menu on the Parents tab.

To add a block to a sequence: Right-click the respective cell and select Add To Sequence on the context
menu on the Parents tab.

To remove a block to a sequence: Right-click the respective cell and select Remove From Sequence on
the context menu on the Parents tab.

6 When you finishes entering the information, click the Apply button on the Parents tab
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> The created Virtual Block RAID 1 object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on this RAID object, a partition object will appear on the
Drives panel. 

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

2.4.7 Nested and Non-Standard RAID Levels

R-Studio for Linux can work with various nested and non-standard RAID levels. Currently, the following
RAID levels are supported:

· RAID10 (1+0)

· RAID1E

· RAID5E

· RAID5EE

· RAID6E
2.4.7.1 RAID10 (1+0)

A RAID 10 (or 1+0) is a stripe of mirrors. Its block order can be represented as:
A B C D

1 1 1 2 2

To create a RAID 10 object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

https://www.r-studio.com/What-are-Nested-Non-Standard-RAIDs.html
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> A Virtual Block RAID object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.

3 Select RAID 10 on the RAID type

You may either make R-Studio for Linux to process your changes immediately or wait until you finish
editing the RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click
the Apply button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 10. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 10. 

You also need to specify Block order for virtual RAID 10. You may select it on the Block order drop-down or
context menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 10
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 10. Find a file and preview
it. If the file appears correct, you have created a correct RAID 10 layout. 
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Parents tab

> The RAID 10 object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on the newly created RAID object, a partition object will
appear on the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.2 RAID1E

RAID 1E is utilizes both the mirroring and striping: data is striped across all drives, as in RAID 0. Additionally, a
copy of each stripe is stored on a different drive, as in RAID 1. Its block order can be represented as:

A B C

1 1 1 2
2 2 3 3

To create a RAID 1E object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

https://www.r-studio.com/What-is-Disk-Partition.html
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> A Virtual Block RAID object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.

3 Select RAID 1E on the RAID type

You may either make R-Studio for Linux to process your changes immediately or wait until you finish
editing the RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click
the Apply button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 1E. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 1E. 

You also need to specify Block order for virtual RAID 1E You may select it on the Block order drop-down or
context menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 1E
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 1E. Find a file and preview
it. If the file appears correct, you have created a correct RAID 1E layout. 



Data Recovery Using R-Studio for Linux 117

© 2025 R-Tools Technology Inc.

Parents tab

> The RAID 1E object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on the newly created RAID object, a partition object will
appear on the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.3 RAID5E

RAID 5E (where E stands for Enhanced) is a RAID 5 layout with an integrated hot-spare drive, where the spare
drive is an active part of the block rotation scheme. An example of such RAID layout is in the table below:

A B C D

1 1 2 3 PD
2 5 6 PD 4
3 9 PD 7 8
4 PD 10 11 12
5 SP SP SP SP

where PD and SP stand for Parity of Data and Spare Part.

https://www.r-studio.com/What-is-Disk-Partition.html
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To create a RAID 5E object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.

3 Select RAID 5E on the RAID type

You may either make R-Studio for Linux to process your changes immediately or wait until you finish
editing the RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click
the Apply button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 5E. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 5E. 

You also need to specify Block order for virtual RAID 5E You may select it on the Block order drop-down or
context menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 5E
cannot be recovered.
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Note: You may check how correctly you have reconstructed the original RAID 5E. Find a file and preview
it. If the file appears correct, you have created a correct RAID 5E layout. 

Parents tab

> The RAID 5E object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on the newly created RAID object, a partition object will
appear on the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.4 RAID5EE

RAID 5EE (where E stands for Enhanced) is a RAID 5 layout with an integrated hot-spare drive, where the
spare drive is an active part of the block rotation scheme. An example of such RAID layout is in the table below:

A B C D

1 1 2 SP PD
2 4 SP PD 3
3 SP PD 5 6
4 PD 7 8 SP

where PD and SP stand for Parity of Data and Spare Part.

https://www.r-studio.com/What-is-Disk-Partition.html
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To create a RAID 5EE object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.

3 Select RAID 5EE on the RAID type

You may either make R-Studio for Linux to process your changes immediately or wait until you finish
editing the RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click
the Apply button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 5EE. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 5EE. 

You also need to specify Block order for virtual RAID 5EE You may select it on the Block order drop-down
or context menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID
5EE cannot be recovered.
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Note: You may check how correctly you have reconstructed the original RAID 5EE. Find a file and preview
it. If the file appears correct, you have created a correct RAID 5EE layout. 

Parents tab

> The RAID 5EE object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on the newly created RAID object, a partition object will
appear on the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.5 RAID6E

RAID 6E (where E stands for Enhanced) is a RAID 6 layout with an integrated hot-spare drive, where the spare
drive is an active part of the block rotation scheme. An example of such RAID layout is in the table below:

A B C D E F

1 RS 1 2 3 4 PD
2 5 6 7 8 PD RS
3 10 11 12 PD RS 9
4 15 16 PD RS 13 14

https://www.r-studio.com/What-is-Disk-Partition.html
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5 20 PD RS 17 18 19
6 PD RS 21 22 23 24
7 SP SP SP SP SP SP

where RS, PD and SP stand for Reed-Solomon, Parity of Data, and Spare Part, respectively.

To create a RAID 6E object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the context menu, 
or
· Right-click the partition on the  Drives panel, select Add to RAID on the context menu, and select the

RAID object you want to add the partition to.

3 Select RAID 6E on the RAID type

You may either make R-Studio for Linux to process your changes immediately or wait until you finish
editing the RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click
the Apply button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 6E. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)
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The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 6E. 

You also need to specify Block order for virtual RAID 6E You may select it on the Block order drop-down or
context menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 6E
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 6E. Find a file and preview
it. If the file appears correct, you have created a correct RAID 6E layout. 

Parents tab

> The RAID 6E object can now be processed like regular drives/volumes

If R-Studio for Linux detects a valid file system on the newly created RAID object, a partition object will
appear on the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.8 Finding RAID Parameters

R-Studio for Linux can find parameters for RAID 5 and 6. RAID parameters can be found automatically or
manually.

https://www.r-studio.com/What-is-Disk-Partition.html
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The number of disks in the RAID should be between 3 and 32. RAID parameters can be found only when all
original disks (or their images) are present. Even one substitute object in a RAID (like a missing disk) makes
finding RAID parameters impossible.

To find RAID parameters automatically, 

1 Click the Auto Detect button on the Parents tab

> R-Studio for Linux will start searching for the RAID parameters and show the most probable one on the
RAID Parameter Detection dialog box

 RAID Parameter Detection dialog box

2 Click the Apply button and R-Studio for Linux will change the RAID layout to the selected one on the

Parents tab.

3 Click the Apply button on the Parents tab

>  R-Studio for Linux will use the found parameters for the RAID.

If necessary, you may return to the RAID Parameter Detection dialog box by clicking the Choose Variants

button, and select another RAID layout. 

To find RAID parameters manually, 

1 Click the drop-down Auto Detect list on the Parents tab and select Advanced Detection.

https://www.r-studio.com/What-is-Disk-Image.html
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2 Specify the necessary detection parameters on the RAID Parameter Detection dialog box and click the
Start detection button

Raid Parameters Detection dialog box

You may change the disk order, offset for disk(s), and enable/?disable disks.
Advanced Parameters

Max offset: The area on the disk to find RAID parameters in. 
Offset search
performance
RAID layouts search
performance

Cumulative parameters that estimates the probability of certain found RAID
parameters. Moving it to the right increases accuracy but slows the process.
Moving it to the left reduces the accuracy but makes the process faster. 

3 Select an offset and click the Click here to find RAID Layouts button on theRaid Parameters Detection
dialog box

RAID Parameters Detection dialog box

You may add your own RAID offsets. Right-click empty space on the Found offsets pane and select Add
Custom offset on the context menu and specify the offset individually for every disk.

4 Select a RAID variant on the Found RAID layouts pane and click the Apply button

5 Click the Apply button on the Parents tab
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>  R-Studio for Linux will use the found parameters for the RAID.

If necessary, you may return to the RAID Parameter Detection dialog box by clicking the Choose Variants

button, and select another RAID layout. 

2.4.9 Checking RAID Consistency

You may check RAID consistency (whether the data parity values are valid) for RAID layouts with parity
blocks.

To check RAID consistency,

* Right-click the RAID and select Check RAID consistency... on the context menu

> The RAID consistency check window will appear showing the progress. 

RAID consistency check window

When the check is finished, you may inspect the results.

Block
color
Green Data parity values are valid.
Red Data parity values are not valid.
White 0's

When a mouse pointer hovers over a block, a tooltip will show the sector range within the block and number
of consistent and inconsistent sectors. Double-clicking the block moves it to the upper-leftmost corner and
zooms in the data by 2.

 RAID consistency check controls

Sectors The number of the first sector in the row.
Offset Offset in the data. Enter the address you want to jump to and press the Enter key.
Sectors/Bytes/KB... Specifies the dimension of the data in the Offset field.
Previous/Next Moves to the previous/next part of the data.
+/- Zooms into/out of, the data.

2.4.10 Syntax of a Description File for RAID Configurations

You may create and store your own RAID configurations The syntax of those files is similar to that of the XML
language. They are stored in an .xml file specified on the R-Studio for Linux Settings.

A number of file examples are shown on the Description Files for RAID Configurations topic.
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There are two types of such description files: for RAID presets and custom-created RAID layouts.

RAID preset configuration file

<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5" rows="3" type="5" order="2"
parityDelay="1">
        <Parents>
            <Parent comp="RAID5Disk1.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="1"/>
            <Parent comp="RAID5Disk2.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="2"/>
            <Parent comp="RAID5Disk3.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="3"/>
        </Parents>
    </RAID>
</RAIDList>

Custom-created RAID configuration file example

<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6Complex" rows="6" type="256">
        <Parents>
            <Parent name="img1.bin" size="941359104" order="1"/>
            <Parent name="img2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="img3.bin" size="941359104" order="3"/>
            <Parent name="img4.bin" size="941359104" order="4"/>
            <Parent name="img5.bin" size="941359104" order="5"/>
        </Parents>
        <Table>
            <Block id="A1">ReedSolomon</Block>
            <Block id="B1">1</Block>
            <Block id="C1">2</Block>
            <Block id="D1">3</Block>
            <Block id="E1">XorOfData</Block>
            <Block id="A2">4</Block>
            <Block id="B2">5</Block>
            <Block id="C2">6</Block>
            <Block id="D2">XorOfData</Block>
            <Block id="E2">ReedSolomon</Block>
            <Block id="A3">8</Block>
            <Block id="B3">9</Block>
            <Block id="C3">XorOfData</Block>
            <Block id="D3">ReedSolomon</Block>
            <Block id="E3">7</Block>
            <Block id="A4">12</Block>
            <Block id="B4">XorOfData</Block>
            <Block id="C4">ReedSolomon</Block>
            <Block id="D4">10</Block>
            <Block id="E4">11</Block>
            <Block id="A5">XorOfData</Block>
            <Block id="B5">ReedSolomon</Block>
            <Block id="C5">13</Block>
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            <Block id="D5">14</Block>
            <Block id="E5">15</Block>
            <Block id="A6" sequence="1">XorOfAll</Block>
            <Block id="B6" sequence="2">XorOfAll</Block>
            <Block id="C6" sequence="3">XorOfAll</Block>
            <Block id="D6" sequence="4">XorOfAll</Block>
            <Block id="E6" sequence="5">XorOfAll</Block>
        </Table>
        <Sequences>
            <Sequence id="1">A1 A2 A3 A4 A5 A6</Sequence>
            <Sequence id="2">B1 B2 B3 B4 B5 B6</Sequence>
            <Sequence id="3">C1 C2 C3 C4 C5 C6</Sequence>
            <Sequence id="4">D1 D2 D3 D4 D5 D6</Sequence>
            <Sequence id="5">E1 E2 E3 E4 E5 E6</Sequence>
        </Sequences>
    </RAID>
</RAIDList>

File structure

File header

The file starts with a standard  XML header:
<?xml version="1.0" encoding="utf-8"?>

Section RAIDList
<RAIDList>

It can contain any number of the <RAID> sections and requires a closing element </FileTypeList>.

Section structure example: 
  <RAIDList>
    <RAID [attributes]>
      ...
    </RAID>
    ...
    <RAID [attributes]>
      ...
    </RAID>

Section RAID

This section describes each RAID layout.

It must contain at least one <Table> and <Parents> sections and can contain one block <Sequences>..
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5" rows="3" type="5" order="2"
parityDelay="1">
        <Parents>
            
        </Parents>
        <Table>

        </Table>
        <Sequences>

        </Sequences>
    </RAID>
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</RAIDList>

Attributes:
blocksize <u32> Required The block size of the RAID in bytes
name <string> Optional The name of the RAID layout
rows <u16> Required The number of rows in the RAID layout table.
type <u16> Required The type of the RAID preset. The following types are

supported:
1: RAID0 (Stripe set)
2: RAID10
3: RAID1E
4: RAID4
5: RAID5
6: RAID5E
7: RAID5EE
8: RAID6/? Reed-Solomon Encoding
9: RAID6E/? Reed-Solomon Encoding
10: RAID6/? Vertical Xor Encoding
256: Custom Raid Table
If the RAID type parameter contradicts to the RAID table,
the RAID table always prevails.

order <u16> Required/Optio
nal

The RAID sub-type. For example, order="2" means Left
Asynchronous for RAID5 layouts. Any value for the custom
RAID layouts will be ignored. 

parityDela
y

<u16> Required The Parity delay parameter.

Section structure example:
<RAID blockSize="65536" rows="6" type="256">
        <Parents>

        </Parents>

        <Table>

        </Table>
        <Sequences>

        </Sequences>
    </RAID>

Section Parents

This section describes the RAID parents. It contains the <Parent> elements of the RAID.

Section structure example:
        <Parents>
            <Parent comp="RAID5Disk1.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="1"/>
            <Parent comp="RAID5Disk2.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="2"/>
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            <Parent comp="RAID5Disk3.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="3"/>
        </Parents>

Element Parent

The element specifies the parent of the RAID.

Attributes:
comp <string> Required/O

ptional
The file-container with the parent object.

name <string> Required The object name of the RAID parent.
offset <u16> Required is

not 0
The offset value in bytes

size= <u16> Required The object size in bytes
order <u16> Required The order of the RAID object

Section Table

This section describes the RAID layout table. It contains the <Block> elements which number is a product of
two attributes in the <RAID> section: <parents> x <rows>.

Section structure example:
  <RAIDList>
    <RAID name="example" parents="2" rows="2" blocksize="16777216">
      <Table>
        <Block [attributes]> ... </Block>
        <Block [attributes]> ... </Block>
        <Block [attributes]> ... </Block>
        <Block [attributes]> ... </Block>
      </Table>
    </RAID>
  </RAIDList>

Element Block

The element specifies the block number in the RAID layout table (a positive integer number) or an error
correction block of the following types:

· PD or ParityOfData

· PA or ParityOfAll

· RS or ReedSolomon

· U or Unknown

· I or Ignore

Any other value is treated as Unknown.

Attributes:
id <string> Required The alpha-numerical identifier of the block in the RAID layout

table. The element in the 3-rd column of the 2-nd line is
designated as C2. AA is used after letter Z, and so on.

sequence <string> Optional The numerical identifier for non-default sequences.
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Section Sequences

This section describes the non-default data checksum sequences used to preserve data integrity. It is not
necessary to explicitly list default sequences (the table rows). Sequences can contain any number of the
<Sequence> elements. 

Section structure example:
  <RAIDList>
    <RAID name="example" parents="4" rows="4" blocksize="16777216">
     <Parents>
     
     </Parents>
      <Table>
        ...
      </Table>
      <Sequences>
        <Sequence [attributes]> ... </Sequence>
        ...
        <Sequence [attributes]> ... </Sequence>
      </Sequences>
    </RAID>
  </RAIDList>

Element Sequence

The element contains the list of the RAID blocks belonging to that sequence. The elements are separated by a
space .

Attributes:
id <u16> Required The sequence identifier.

Element example:

See the RAID configuration file example.

Comments
<!-- Comment string -->

An XML standard string for a comment.

2.4.11 Description Files for RAID Configurations

Below are description files for RAID examples described in the Volume Sets and RAIDs chapter. The syntax
of them is described in the Syntax of a Description File for RAID Configurations topic.

StripeSet

The stripe set layout is described in the Volume Sets, Stripe Sets, and Mirrors topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="StripeSet" rows="2" type="1" order="7"
parityDelay="1">
        <Parents>
            <Parent comp="RAID0Disk1.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="1"/>
            <Parent comp="RAID0Disk2.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="2"/>
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        </Parents>
    </RAID>
</RAIDList>

Basic RAID 5

The RAID layout is described in the Working with Basic RAID 4 and RAID 5 Operations topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5" rows="3" type="5" order="2"
parityDelay="1">
        <Parents>
            <Parent comp="RAID5Disk1.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="1"/>
            <Parent comp="RAID5Disk2.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="2"/>
            <Parent comp="RAID5Disk3.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="3"/>
        </Parents>
    </RAID>
</RAIDList>

RAID 5 with parity delays

The RAID layout is described in the RAID5 with Parity Delays Operations topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="16384" name="RAID5HP" rows="48" type="5" order="2"
parityDelay="16" firstParity="16">
        <Parents>
            <Parent name="RAID5HPDisk1.bin" offset="557056" size="941359104"
order="1"/>
            <Parent name="RAID5HPDisk2.bin" offset="557056" size="941359104"
order="2"/>
            <Parent name="RAID5HPDisk3.bin" offset="557056" size="941359104"
order="3"/>
        </Parents>
    </RAID>
</RAIDList>

Advanced RAID 5

The RAID layout is described in the Working with Advanced RAID Layouts topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="4096" name="RAID5Complex" rows="9" type="256">
        <Parents>
            <Parent name="RAID5CDisk1.bin" offset="16777216" size="941359104"
order="1"/>
            <Parent name="RAID5CDisk2.bin" offset="16777216" size="941359104"
order="2"/>
            <Parent name="RAID5CDisk3.bin" offset="16777216" size="941359104"
order="3"/>
        </Parents>
        <Table>
            <Block id="A1">XorOfData</Block>
            <Block id="B1">1</Block>
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            <Block id="C1">2</Block>
            <Block id="A2">XorOfData</Block>
            <Block id="B2">3</Block>
            <Block id="C2">4</Block>
            <Block id="A3">XorOfData</Block>
            <Block id="B3">5</Block>
            <Block id="C3">6</Block>
            <Block id="A4">7</Block>
            <Block id="B4">XorOfData</Block>
            <Block id="C4">8</Block>
            <Block id="A5">9</Block>
            <Block id="B5">XorOfData</Block>
            <Block id="C5">10</Block>
            <Block id="A6">11</Block>
            <Block id="B6">XorOfData</Block>
            <Block id="C6">12</Block>
            <Block id="A7">13</Block>
            <Block id="B7">14</Block>
            <Block id="C7">XorOfData</Block>
            <Block id="A8">15</Block>
            <Block id="B8">16</Block>
            <Block id="C8">XorOfData</Block>
            <Block id="A9">17</Block>
            <Block id="B9">18</Block>
            <Block id="C9">XorOfData</Block>
        </Table>
    </RAID>
</RAIDList>

Advanced RAID 5

The RAID layout is described in the Working with Advanced RAID Layouts topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="524288" name="RAID_MacPro" rows="3" type="256">
        <Parents>
            <Parent name="RAID_MAC_ProDisk1.bin" fs="NTFS" offset="16777216"
size="941359104" order="1"/>
            <Parent name="RAID_MAC_ProDisk2.bin" offset="16777216" size="941359104"
order="2"/>
            <Parent name="RAID_MAC_ProDisk3.bin" offset="16777216" size="941359104"
order="3"/>
            <Parent name="RAID_MAC_ProDisk4.bin" offset="16777216" size="941359104"
order="4"/>
        </Parents>
        <Table>
            <Block id="A1" sequence="1">XorOfData</Block>
            <Block id="B1">1</Block>
            <Block id="C1">2</Block>
            <Block id="D1" sequence="2">XorOfData</Block>
            <Block id="A2">3</Block>
            <Block id="B2">4</Block>
            <Block id="C2" sequence="3">XorOfData</Block>
            <Block id="D2">5</Block>
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            <Block id="A3">6</Block>
            <Block id="B3" sequence="4">XorOfData</Block>
            <Block id="C3">7</Block>
            <Block id="D3">8</Block>
        </Table>
        <Sequences>
            <Sequence id="1">A1 B1 C1</Sequence>
            <Sequence id="2">D1 A2 B2</Sequence>
            <Sequence id="3">C2 D2 A3</Sequence>
            <Sequence id="4">B3 C3 D3</Sequence>
        </Sequences>
    </RAID>
</RAIDList>

RAID 6 Reed-Solomon (Left Synchronous (Standard)) Preset

The RAID layout is described in the Working with RAID 6 Presets topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6RS" rows="5" type="8" order="1"
parityDelay="1">
        <Parents>
            <Parent name="img1.bin" size="941359104" order="1"/>
            <Parent name="img2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="img3.bin" size="941359104" order="3"/>
            <Parent name="img4.bin" size="941359104" order="4"/>
            <Parent name="img5.bin" size="941359104" order="5"/>
        </Parents>
    </RAID>
</RAIDList>

RAID6 (Double Xor) Preset

The RAID layout is described in the Working with RAID 6 Presets topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID62X" rows="4" type="10" order="1"
parityDelay="1">
        <Parents>
            <Parent name="RAID62X1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID62X2.bin" size="941359104" order="2"/>
            <Parent name="RAID62X3.bin" size="941359104" order="3"/>
            <Parent name="RAID62X4.bin" size="941359104" order="4"/>
            <Parent name="RAID62X5.bin" size="941359104" order="5"/>
            <Parent name="RAID62X6.bin" size="941359104" order="6"/>
        </Parents>
    </RAID>
</RAIDList>

Advanced RAID 6

The RAID layout is described in the Working with Advanced RAID Layouts topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6Complex" rows="6" type="256">
        <Parents>
            <Parent name="img1.bin" size="941359104" order="1"/>
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            <Parent name="img2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="img3.bin" size="941359104" order="3"/>
            <Parent name="img4.bin" size="941359104" order="4"/>
            <Parent name="img5.bin" size="941359104" order="5"/>
        </Parents>
        <Table>
            <Block id="A1">ReedSolomon</Block>
            <Block id="B1">1</Block>
            <Block id="C1">2</Block>
            <Block id="D1">3</Block>
            <Block id="E1">XorOfData</Block>
            <Block id="A2">4</Block>
            <Block id="B2">5</Block>
            <Block id="C2">6</Block>
            <Block id="D2">XorOfData</Block>
            <Block id="E2">ReedSolomon</Block>
            <Block id="A3">8</Block>
            <Block id="B3">9</Block>
            <Block id="C3">XorOfData</Block>
            <Block id="D3">ReedSolomon</Block>
            <Block id="E3">7</Block>
            <Block id="A4">12</Block>
            <Block id="B4">XorOfData</Block>
            <Block id="C4">ReedSolomon</Block>
            <Block id="D4">10</Block>
            <Block id="E4">11</Block>
            <Block id="A5">XorOfData</Block>
            <Block id="B5">ReedSolomon</Block>
            <Block id="C5">13</Block>
            <Block id="D5">14</Block>
            <Block id="E5">15</Block>
            <Block id="A6" sequence="1">XorOfAll</Block>
            <Block id="B6" sequence="2">XorOfAll</Block>
            <Block id="C6" sequence="3">XorOfAll</Block>
            <Block id="D6" sequence="4">XorOfAll</Block>
            <Block id="E6" sequence="5">XorOfAll</Block>
        </Table>
        <Sequences>
            <Sequence id="1">A1 A2 A3 A4 A5 A6</Sequence>
            <Sequence id="2">B1 B2 B3 B4 B5 B6</Sequence>
            <Sequence id="3">C1 C2 C3 C4 C5 C6</Sequence>
            <Sequence id="4">D1 D2 D3 D4 D5 D6</Sequence>
            <Sequence id="5">E1 E2 E3 E4 E5 E6</Sequence>
        </Sequences>
    </RAID>
</RAIDList>

RAID10 (1+0)

The RAID layout is described in the RAID10 (1+0) topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID10" rows="1" type="2" order="7"
parityDelay="1">



R-Studio Manual136

© 2025 R-Tools Technology Inc.

        <Parents>
            <Parent name="RAID10-1.bin" size="941359104" order="1"/>
            <Parent name="RAID10-2.bin" size="941359104" order="2"/>
            <Parent name="RAID10-3.bin" size="941359104" order="3"/>
            <Parent name="RAID10-4.bin" size="941359104" order="4"/>
        </Parents>
    </RAID>
</RAIDList>

RAID1E

The RAID layout is described in the RAID1E topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID1E" rows="2" type="3" order="1"
parityDelay="1">
        <Parents>
            <Parent name="RAID1EDisk1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID1EDisk2.bin" size="941359104" order="2"/>
            <Parent name="RAID1EDisk3.bin" size="941359104" order="3"/>
        </Parents>
    </RAID>
</RAIDList>

RAID5E

The RAID layout is described in the RAID5E topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5E" rows="5" type="6" order="1"
parityDelay="1">
        <Parents>
            <Parent name="RAID5EDisk1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID5EDisk2.bin" size="941359104" order="2"/>
            <Parent name="RAID5EDisk3.bin" size="941359104" order="3"/>
            <Parent name="RAID5EDisk4.bin" size="941359104" order="4"/>
        </Parents>
    </RAID>
</RAIDList>

RAID5EE

The RAID layout is described in the RAID5EE topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5EE" rows="4" type="7" order="1"
parityDelay="1">
        <Parents>
            <Parent name="RAID5EEDisk1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID5EEDisk2.bin" size="941359104" order="2"/>
            <Parent name="RAID5EEDisk3.bin" size="941359104" order="3"/>
            <Parent name="RAID5EEDisk4.bin" fs="NTFS" size="941359104" order="4"/>
        </Parents>
    </RAID>
</RAIDList>
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RAID6E

The RAID layout is described in the RAID6E topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6E" rows="7" type="9" order="1"
parityDelay="1">
        <Parents>
            <Parent name="RAID6E1.bin" size="941359104" order="1"/>
            <Parent name="RAID6E2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="RAID6E3.bin" size="941359104" order="3"/>
            <Parent name="RAID6E4.bin" size="941359104" order="4"/>
            <Parent name="RAID6E5.bin" size="941359104" order="5"/>
            <Parent name="RAID6E6.bin" size="941359104" order="6"/>
        </Parents>
    </RAID>
</RAIDList>

2.4.12 Various Disk and Volume Managers

R-Studio for Linux can work with objects created by various disk and volume managers. Currently, the
following managers are supported:

· BitLocker Drive Encryption

· Windows Dynamic Disks

· Windows Storage Spaces

· Apple RAIDs

· Apple CoreStorage/FileVault/Fusion Drive Volumes

· Linux mdadm RAIDs

· Logical Volume Manager (LVM and LVM2)

R-Studio for Linux can automatically recognize and add their physical components, component images, or the
user can manually add the components when their data is damaged so severely that R-Studio for Linux cannot
recognize them.

In addition, R-Studio can work with various virtual disk and disk image formats.
2.4.12.1 BitLocker Drive Encryption

BitLocker Drive Encryption, or BitLocker, is a data protection feature introduced by Microsoft since
Windows Vista. It implements some hard/software measures to encrypt either USB external flash drives or
internal system SSD/HDD devices. You may read more about BitLocker Drive Encryption on the Microsoft
site or Wikipedia.

There are following encryption methods (protectors in the Microsoft terms) that can be utilized in the BitLocker
protection:

· A TPM/TPM+PIN chip

· A USB key (a flash drive containing a .bek file)

· A user's password (not to confuse with a user's logon password) / recovery key

https://www.r-studio.com/What-is-Disk-Image.html
https://learn.microsoft.com/en-us/windows/security/operating-system-security/data-protection/bitlocker/
https://learn.microsoft.com/en-us/windows/security/operating-system-security/data-protection/bitlocker/
https://en.wikipedia.org/wiki/BitLocker
https://en.wikipedia.org/wiki/Trusted_Platform_Module
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These methods can be used either individually or as a combination thereof. If they are used as a combination,
knowing the decryption information for only one method is enough to unlock the device.

R-Studio can unlock devices encrypted with BitLocker provided that all the necessary information is known. 

BitLocker ToGo

This is the method used to lock external removable devices. The password or a recovery key is necessary to
know to unlock the device. A recovery key may be in the printed form or contained in a file. A name of such a
file has the following pattern: BitLocker Recovery Key 600397A9-48AA-4DE4-B775-C71EB130EA1B.txt
, where the last characters is the BitLocker volume identifier. That file contains the BitLocker volume identifier
and a recovery key.

To unlock a BitLocker ToGo device,

1 Locate the device and double-click the BitLocker partition.

BitLocker ToGo

2 Enter the password or recovery key and click the Unlock button.

BitLocker ToGo
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> R-Studio will unlock the volume

BitLocker ToGo

BitLocker System Drive Encryption

This is the method used to lock internal system drives. 

Depending on what methods are used, the following information is necessary to know to unlock the drive.

· A recovery key in the printed form or in a file. A name of such a file has the following pattern: BitLocker
Recovery Key FDA7B96C-635E-45AA-BE63-00C3DB3771EE.txt , where the last characters is the
BitLocker volume identifier. That file contains the BitLocker volume identifier and a recovery key.

· A password used to start the preboot process. It shouldn't be confused with the password for the user's
logon. 

· An external USB flash drive containing its .bek file. Note that Windows sets System and Hidden attributes
for such files and Windows doesn't show such files by default. 

To unlock a system drive with a BitLocker partition,

1 Locate the device and double-click the BitLocker partition.

BitLocker System Drive Encryption
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2 Enter the password or recovery key and click the Unlock button.

BitLocker System Drive Encryption

If you have the .bec file, click the Unlock by key file button and load the file.

> R-Studio will unlock the volume

BitLocker System Drive Encryption

TPM/TPM+PIN modes

Only in registered R-Studio Technician/T80+ versions.

If only the TPM/TPM+PIN hardware was used to encrypt the partition, you must have either the FVEK (Full
Volume Encryption Key) or VMK (Volume Master Key) data. Obtaining these keys is a very hard task, only
quite advanced forensic professionals can do that using specialized hardware. Sometimes it may be possible to
extract a FVEK from memory dumps and/or hibernation files, but this is still not a trivial process. 

If you have FVEK or VMK data, click the Advanced button, select the key type of the data, enter the key or
load a file with the key.
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BitLocker TPM/TPM+PIN modes

R-Studio for Linux will unlock the volume.

You may also save and load encryption information from a BitLocker Encryption volume.
2.4.12.2 Windows Dynamic Disks

R-Studio for Linux supports dynamic disks, including Windows software RAIDs, mirrors, and spanned
volumes. When R-Studio for Linux detects components from such dynamic disks, it assembles them
accordingly. 

Windows dynamic disks (RAID5)

R-Studio for Linux automatically detects components form dynamic disks and creates those dynamic disks
automatically. At the same time, R-Studio for Linux gives access to the parents of the dynamic disks (hard
drives and images).

Windows dynamic disks (RAID5) in R-Studio for Linux

Also, R-Studio for Linux automatically detects inconsistent components of dynamic disks and marks them
accordingly.

https://www.r-studio.com/What-is-Windows-Dynamic-Disks.html
https://www.r-studio.com/What-is-Software-RAID.html
https://www.r-studio.com/What-is-Disk-Image.html
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Windows dynamic disks (RAID5) with unsynced parent

R-Studio for Linux shows the components of the selected dynamic disk on its LDM Components tab. 

LDM Components tab

R-Studio for Linux shows broken dynamic disks in pink. 

Broken dynamic disks in R-Studio for Linux

The LDM Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio for Linux cannot recognize them as parts of a broken dynamic disk.
Select the object from the drop-down box and click the Connect button. R-Studio for Linux displays the
objects it recognizes as the components of the dynamic disk in blue. 
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Adding a component manually

You may immediately switch to the dynamic disk configuration that R-Studio for Linux believes most probable
by clicking the Reassemble button.

R-Studio for Linux shows dynamic disks with manually added components in blue:

Dynamic disks with added components in R-Studio for Linux

2.4.12.3 Windows Storage Spaces

Windows storage spaces is a new storage technology, introduced in Windows 8 and Windows Server 2012, that
allows the user to combine various (not always similar) hard drives into a kind of a RAID or compound volume.
First, the hard drives are combined into a storage pool, then several storage spaces with striping (similar to
RAID0), mirroring (similar to RAID1), and parity (similar to RAID5) can be created in that storage pool. You
may read more about storage pools and spaces in the Microsoft's Storage Spaces: FAQ

When drives from a storage pool are connected to a Windows computer, it automatically detects them and
assembles storage spaces accordingly. 

R-Studio for Linux supports Windows Storage Spaces created by Windows 8/8.1 and Windows 10/Threshold
2/Anniversary/Fall Creators updates.

When Windows storage spaces use caching, R-Studio for Linux can process both the cache and the storage
space itself simultaneously greatly increasing chances for successful recovery of deleted files. For SSD (Solid
State Device) media, bypassing the cache may be the only available option to recover lost files.

https://www.r-studio.com/What-is-Windows-Storage-Spaces.html
http://windows.microsoft.com/en-us/windows-8/storage-spaces-pools#
https://www.r-studio.com/What-is-Solid-State-Device-SSD.htm
https://www.r-studio.com/What-is-Solid-State-Device-SSD.htm
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Storage spaces in Windows

Storage pools and spaces can be managed using the Storage Spaces item in the Windows Control Panel.

Storage spaces in Windows

R-Studio for Linux detects disks (or their images) from storage pools and creates storage pools and spaces
automatically. At the same time, R-Studio for Linux gives access to the parents of the storage spaces (hard
drives and images)

https://www.r-studio.com/What-is-Disk-Image.html
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Storage spaces in R-Studio for Linux

If recognized parents of a storage space, including disk images, are added to R-Studio for Linux later, it
automatically adds them to their respective storage space.

When an automatically created storage space is selected, R-Studio for Linux highlights its components. 

R-Studio for Linux shows the components of the selected storage space on its WSS Components tab. 

WSS Components tab

R-Studio for Linux shows broken storage spaces in pink. 

Broken storage spaces in R-Studio for Linux

https://www.r-studio.com/What-is-Disk-Image.html


R-Studio Manual146

© 2025 R-Tools Technology Inc.

The WSS Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio for Linux cannot recognize them as parts of a broken storage space.
Select the object from the drop-down box and click the Connect button. R-Studio for Linux displays the
objects it recognizes as the components of the storage space in blue. 

Adding a component manually

You may immediately switch to the storage space configuration that  R-Studio for Linux believes most probable
by clicking the Reassemble button.

R-Studio for Linux shows such storage spaces in blue:

Storage spaces with added parents in R-Studio for Linux

2.4.12.4 Apple RAIDs

macOS can create several software RAIDs from disks connected to a Mac computer: RAID1 (Mirror set),
RAID0 (Stripe set), and Concatenated disk set. 
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Apple RAID0 example

R-Studio for Linux detects components of Apple RAID sets and creates their virtual RAIDs automatically. At
the same time, R-Studio for Linux gives access to the individual components of the Apple RAID sets (hard
drives and images).

Apple RAIDs in R-Studio for Linux

When an automatically created Apple RAID is selected, R-Studio for Linux highlights its components.

R-Studio for Linux shows the components of the Apple RAID on its MacOS Components tab. 

MacOS Components tab

R-Studio for Linux shows broken Apple RAIDs in pink. 

https://www.r-studio.com/What-is-Disk-Image.html
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Broken Apple RAIDs in R-Studio for Linux

The MacOS Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio for Linux cannot recognize them as parts of a broken Apple RAID.
Select the object from the drop-down box and click the Connect button. R-Studio for Linux displays the
objects it recognizes as the components of the Apple RAID in blue. 

Adding a component manually

You may immediately switch to the Apple RAID configuration that  R-Studio for Linux believes most probable
by clicking the Reassemble button.

R-Studio for Linux shows Apple RAIDs with manually added components in blue:

Apple RAIDs with added members in R-Studio for Linux

2.4.12.5 Apple CoreStorage/FileVault/Fusion Drive Volumes

The macOS operating system has the following disk management systems:

FileVault, is a disk encrypted utility;

Fusion Drive is an Apple's hybrid drive technology;

CoreStorage is a logical volume management system. 

https://www.r-studio.com/What-is-Apple-FileVault.html
https://www.r-studio.com/What-is-Apple-Fusion-Drive.html
https://en.wikipedia.org/wiki/Core_Storage
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R-Studio for Linux supports all these technologies and can unlock their encrypted volumes (hard drives and
images) using either their passwords or recovery keys.

CoreStorage/FileVault

Locked CoreStorage Volume in R-Studio for Linux

To unlock the volume

1. Right-click the encrypted volume and select Unlock encrypted drive on the context menu.

2. Enter the password/recovery key on the Unlock encrypted drive dialog box

> R-Studio for Linux will unlock the volume

Unlocked CoreStorage Volume in R-Studio for Linux

If the volume is partially encrypted, R-Studio for Linux can recognize which part is encrypted and which isn't. It
will provide a correct access to the unencrypted and encrypted parts of the volume, provided that the correct
password is entered.

Partially encrypted volume

R-Studio Technician/T80+

In addition to the password, it’s possible to enter other decryption data. Click the Advanced… button and enter
available data.

https://www.r-studio.com/What-is-Disk-Image.html
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Unlock encrypted drive: Advanced

This data is usually very hard to obtain and only very advanced institutions can recover it from actual hardware.

Data recovery from deleted or damaged APFS volumes

Note: this method doesn't always yields positive results.

When macos deletes an APFS volumes, it also wipes out all decryption information from its APFS container. In
this case even knowing the password won’t help. Still, there’s a trick that may help to open a deleted or
damaged encrypted volume.

Let’s us have a hard drive with an APFS container with 3 APFS volumes:

APFS container and its volumes

One of them has been deleted and R-Studio for Linux cannot unlock (decrypt) it:
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APFS container with a deleted APFS volume

But if we have an image of the disk’s previous state, we can extract the necessary encryption information from
that image.

Load the image and double-click the existing volume. Click the Advanced… button instead of entering its
password.

Export of encryption information

Click the Export crypto context... button and save a file with this information. Then click the Close Image button
to unload the image.

Then double-click the APFS-1 volume and click the Advanced button.
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APFS container with a deleted APFS volume

Click the Load and apply crypto context… button

Loading the encryption information

and load the file generated from the image.

Select the required information type (a password for our case), enter the data, and click the Unlock button.
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Unlocking the APFS volume

Note that the password will be explicitly shown.

R-Studio for Linux will open files on the volume.

Apple Fusion Drive

R-Studio for Linux detects components of Apple Fusion Drive and creates virtual Fusion Drives automatically.
At the same time, R-Studio for Linux gives access to the individual components of the Fusion Drives (hard
drives and images).

Fusion Drive in R-Studio for Linux

When an automatically created Fusion Drive  is selected, R-Studio for Linux highlights its components.

R-Studio for Linux shows the components of the Fusion Drive on its APFS Fusion Components tab. 

https://www.r-studio.com/What-is-Disk-Image.html
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Fusion Drive Components tab

R-Studio for Linux shows broken Fusion Drive s in pink. 

Broken Fusion Drive in R-Studio for Linux

The Fusion Drive Components tab also allows you to manually disconnect or connect the components, for
example, if they are such damaged that R-Studio for Linux cannot recognize them as parts of a broken Fusion
Drive. Select the object from the drop-down box and click the Connect button. R-Studio for Linux displays
the objects it recognizes as the components of the Fusion Drive in blue. 

Adding a component manually

You may immediately switch to the Fusion Drive configuration that  R-Studio for Linux believes most probable
by clicking the Reassemble button.

R-Studio for Linux shows Fusion Drive with manually added components in blue:
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Fusion Drive with added members in R-Studio for Linux

2.4.12.6 Linux mdadm RAIDs

mdadm is a Linux utility used to manage and monitor software RAID devices.

R-Studio for Linux supports such devices and when drives from a mdadm RAID are connected to a Mac
computer, it automatically detects them and assembles mdadm RAIDs accordingly. 

Linux mdadm RAIDs

R-Studio for Linux detects components from mdadm RAIDs and creates those RAIDs automatically. At the
same time, R-Studio for Linux gives access to the components of those RAIDs (hard drives and images).

mdadm RAIDs in R-Studio for Linux

If recognized components of a mdadm RAID, including disk images, are added to R-Studio for Linux later, it
automatically adds them to their respective mdadm RAID.

When an automatically created mdadm RAID is selected, R-Studio for Linux highlights its components. It also
highlights the mdadm RAID that Linux may itself create from the same components. 

R-Studio for Linux shows the components of the mdadm RAIDs on its mdadm Components tab.

https://www.r-studio.com/What-is-mdadm-RAIDs.html
https://www.r-studio.com/What-is-Disk-Image.html
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mdadm Components tab

R-Studio for Linux shows broken mdadm RAIDs in pink. 

Broken mdamd RAIDs in R-Studio for Linux

The mdadm Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio for Linux cannot recognize them as parts of a broken mdadm RAID.
Select the object from the drop-down box and click the Connect button. R-Studio for Linux displays the
objects it recognizes as the components of the mdadm RAID in blue. 

Adding a component manually

You may immediately switch to the mdadm RAID configuration that  R-Studio for Linux believes most
probable by clicking the Reassemble button. 

R-Studio for Linux shows such mdadm RAIDs in blue:
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mdadm RAIDs with added components in R-Studio for Linux

2.4.12.7 Linux LVM/LVM2

Linux LVM is a logical volume manager for the Linux OS that manages disk drives and other data storage
devices. Using it, It is possible to create single logical volumes on several physical disks, add and replace them in
a running system, resize logical volumes, create various RAID configuration, and so on. You may read more
about Linux LVM in our article: What is Logical Volume Manager (LVM).

LVM volume example

R-Studio for Linux automatically detects disks from LVMs and creates their virtual volumes automatically. At
the same time, R-Studio for Linux gives access to the components of the virtual LVM volumes (hard drives and
images).

LVM Volumes in R-Studio for Linux

If recognized components of an LVM volume, including disk images, are added to R-Studio for Linux later, it
automatically adds them to their respective LVM volume.

When an automatically created LVM volume is selected, R-Studio for Linux highlights its components. It also
highlights the LVM volume that Linux may itself create from the same components. 

https://www.r-studio.com/What-is-Logical-Volume-Manager-LVM.html
https://www.r-studio.com/What-is-Disk-Image.html
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R-Studio for Linux shows the components of the LVM volume on its LVM Components tab. 

LVM Components tab

R-Studio for Linux shows broken virtual LVM volumes in pink. 
Broken LVM volumes in R-Studio for Linux

The LVM Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio for Linux cannot recognize them as parts of a broken LVM volume.
Select the object from the drop-down box and click the Connect button. R-Studio for Linux displays the
objects it recognizes as the components of the LVM volume in blue. 

Adding a component manually

You may immediately switch to the LVM volume configuration that  R-Studio for Linux believes most probable
by clicking the Reassemble button. 

R-Studio for Linux shows such virtual LVM volumes in blue:
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LVM volumes with added components in R-Studio for Linux

2.5 Data Recovery over Network

This chapter explains how to perform data recovery operations over network.

R-Studio for Linux has network capabilities that allow the system administrator, using its computer, to recover
files on any computers accessible over network. 

R-Studio for Linux supports the TCP/IP protocol and any protocol supported in Microsoft Network.

R-Studio Agent must be installed on computers where files are to be recovered. This program gives R-Studio
for Linux access to local disks on remote computers over network. 

If, due to file system crash, the network computer where you are going to recover your data cannot start, you
may use R-Studio Agent Emergency to start the computer.

Files can be recovered without R-Studio Agent if the computer where the files are to be recovered runs
Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10 is accessible from a computer also running Windows
NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10. In this case, the administrator must have administrator privileges on
the remote computer. 

You should always disable a firewall and/or antivirus software on the both computers. As an alternative,
advanced users may tune them to allow R-Studio for Linux and R-Studio Agent to communicate via network.

All data transmitted over network are encrypted with a strong algorithm for data security. Restoring data over
network is very much the same as that on a local computer.

In addition, R-Studio for Linux can load/save any files like disk images, scan info files, RAID configuration files,
from/to the computers to which it has access using R-Studio Agent.

· R-Studio Agent
· Data Recovery over Network
· Connecting over the Internet

2.5.1 R-Studio Agent

R-Studio Agent is a program that provides R-Studio for Linux with an access to the drives of a network
computer. It should be installed and properly registered on the computer which drives are to be accessed.
R-Studio Agent has versions for the following PC operating systems:

· Linux
· Windows
· Mac OS

and there is R-Studio Agent Emergency that can be used to start a computer from which you are going to
recover data that cannot start other way due to a file system crash, for example. Please, note that you need to
use R-Studio Emergency as an emergency agent if you want to start an Intel-based Mac computer.
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Note: You cannot use this program to start Mac computers based on Apple Silicon.

R-Studio for Linux can work equally with all versions of R-Studio Agent and access computers run under
Windows, Mac OS, and Linux.

You must have enough rights on the remote computer to install and run R-Studio Agent.
2.5.1.1 R-Studio for Linux Agent for Linux

You need to have the root privileges to run R-Studio Agent for Linux.

Unlike R-Studio Agent for Windows and R-Studio Agent for Mac, R-Studio Agent for Linux is a console application and
should be run in the Terminal. You also need to mark it as an executable before start.

When it is started for the first time, R-Studio Agent for Linux asks for its configuration.

R-Studio Agent for Linux Configuration dialog box

 R-Studio Agent for Linux Options

Specify password
for incoming
connection

Enter a password to obtain access to this computer from a network.

Confirm password
for incoming
connection

Re-enter the password for confirmation. 

Specify IP
address... 

Specifies addresses and a subnet mask from which this computer can be accessed.
Enter 0 to allow connections from any address.

Specify TCP/IP Port
for listening

A TCP/IP port for incoming connections. Press Enter for the default one [3174].

Don't pay much attention to the warning about "unregistered demo version". If necessary, you'll be able to
register R-Studio Agent for Linux through R-Studio for Linux.

You may see the current configuration by starting  R-Studio Agent for Linux with the command rsagent --
show_config .

R-Studio Agent for Linux Configuration dialog box

You may change the current configuration by starting  R-Studio Agent for Linux with the command rsagent --
configure .
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Connecting from R-Studio Agent for Linux to R-Studio for Linux.

To establish a connection from R-Studio Agent for Linux to R-Studio for Linux, 

1 Run the R-Studio Agent for Linux and press Enter

2 Enter the necessary information

Connect to R-Studio for Linux dialog box

> R-Studio Agent for Linux will connect to the computer where R-Studio for Linux is running and it

will show the hard drive and logical disk structure of the remote computer.

It can be processed the same way as that on a local computer.
2.5.1.2 R-Studio Agent  for Windows

Attention Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10 users: R-Studio Agent should be installed
under an administrator account. 

When installed, R-Studio Agent starts automatically and runs as a service. To configure it, R-Studio Agent
should be started again manually. 

 The following switches are available:
-? evokes a help screen;
-install installs R-Studio Agent as a service
-remove removes R-Studio Agent services
-console starts R-Studio Agent as a console application

Started without a switch, R-Studio Agent runs as a GUI application and its icon appears on the taskbar tray. In
this mode, it can be configured and its log may be viewed. 

Simply connect to the remote computer providing a desired password for R-Studio Agent in the Connect to

Remote Computer dialog box. R-Studio for Linux checks if there is R-Studio Agent running on this
computer. If not, a Can't connect... message will appear. 

Click the Yes button, and R-Studio for Linux will remotely install R-Studio Agent.
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Attention Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10 users: R-Studio Agent may be remotely
installed over a network from a computer running Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10
to another computer running Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10. To do so, you must
have administrator accounts on both computers.

To access the R-Studio Agent main panel, 

1 Click its tray icon

> The main panel will appear. You may view its log

R-Studio Agent main panel

To configure R-Studio Agent, 

1 Right-click its tray icon and select Configure 

2 Specify required parameters on the Please configure R-Studio Agent dialog box and click the OK
button

Please configure R-Studio Agent dialog box

 R-Studio Agent Options

Password: Enter a password to obtain access to this computer from a network.
Re-Enter: Re-enter the password. 
Accepted Protocols

Pipes supported by Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10 only. To improve
security, this option should be disabled.

TCP/IP supported by any network OS.
Port port for incoming connections
Accepted IP Addresses

IP Address specifies addresses from which this computer can be accessed.
Subnet Mask specifies a subnet mask of the network from which this computer can be accessed.

> R-Studio Agent will now run with the specified parameters
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2.5.1.3 R-Studio Agent  for Mac

You need to have an administrative account on the Mac computer to start R-Studio Agent for Mac.
To start the R-Studio Agent for Mac and access its main panel, 

1 Go to the Application folder, double-click R-Studio Agent for Mac, and enter the account password

> The main panel will appear. You may view its log

R-Studio Agent for Mac main panel

To configure R-Studio Agent for Mac, 

1 Go to the R-Studio Agent for Mac menu and select Preferences 

2 Specify required parameters on the Please configure R-Studio Agent dialog box and click the OK
button

Please configure R-Studio Agent Mac dialog box

 R-Studio Agent for Mac Options

Password: Enter a password to obtain access to this computer from a network.
Re-Enter: Re-enter the password. 
Incoming connection preferences

Enable incoming
connections

Select this checkbox if you want to allow incoming connections.

TCP/IP Port A TCP/IP port for incoming connections
Accepted IP Addresses

IP Address specifies addresses from which this computer can be accessed.
Subnet Mask specifies a subnet mask of the network from which this computer can be accessed.

> R-Studio Agent for Mac will now run with the specified parameters

Connecting from R-Studio Agent for Mac to R-Studio for Linux.

To establish a connection from R-Studio Agent for Mac to R-Studio for Linux, 

1 Run the R-Studio Agent for Mac and select Connect from the Tools menu
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2 Enter the necessary information on the Connect to R-Studio for Linux dialog box and click the Connect
button.

Connect to R-Studio for Linux dialog box

Connect to R-Studio settings

Server Specify the DNS name or IP address of the host where R-Studio
for Linux is running.

Port Specify the port set on the R-Studio for Linux Connect to Remote

Computer dialog box.
Password Specify the password set on the R-Studio for Linux Connect to

Remote Computer dialog box.

> R-Studio Agent for Mac will connect to the computer where R-Studio for Linux is running and it will

show the hard drive and logical disk structure of the remote computer.

It can be processed the same way as that on a local computer.

2.5.2 Data Recovery over Network

Generally, data restoring over network is very much the same as that on a local computer. 

R-Studio Agent should be running on the network computer where data are to be recovered. 

Read the Connecting over the Internet topic to learn how to establish connection between R-Studio for
Linux and R-Studio Agent over the Internet.

To connect to a remote computer

1 Click the Connect to Remote button, or

Select Connect To Remote on the Drive menu

2 Specify the name or IP address of the remote computer where data are to be recovered in the
Computer: field

Connect to Remote Computer dialog box

The Port should coincide with the port specified for the R-Studio Agent.
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The Password: field is for the password of R-Studio Agent running on the remote computer. If you want to
see the entered password, right-click the field and select Show password on the context menu.

Note: If the remote computer is started with R-Studio Agent Emergency, leave this field blank.

> R-Studio for Linux will connect to the remote computer and show its hard drive and logical disk

structure of the remote computer below the device/disk structure of your local computer

It can be processed the same way as that on a local computer.

Recover dialog box

When the Recover dialog box appears, you may select whether you want to save recovered files on the local
or remote computer. Saving recovered files on a remote computer may be useful when the remote computer
has a healthy disk because you do not have to transfer files over network. It may be an external USB hard
drive, for example.

When R-Studio for Linux connects to the remote computer, it check if R-Studio Agent is present and its
password. If there is no R-Studio Agent installed, R-Studio for Linux may try to remotely install it. See
the R-Studio Agent topic for details.

2.5.3 Connecting over the Internet

R-Studio for Linux and R-Studio Agent can be connected over the Internet. The connection can be made either
using IP addresses or DNS names. 
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If hosts where R-Studio for Linux and R-Studio Agent are running have public IP addresses the connection can be
made the same way as for the local network, except that the IP address or DNS name should be explicitly
specified in the Computer filed the Connect to Remote Computer dialog box

If either (or both) of the hosts are on private networks behind NATs and firewalls and do not have public IP
addresses, the corresponding ports should be opened or forwarded. In addition, connection should be made
either only from R-Studio for Linux or from R-Studio Agent.

Connection directions

* Both R-Studio for Linux and R-Studio Agent have public IP addresses (no NAT/firewall) or the ports on the

NAT/firewall are forwarded/opened.

A connection can be made either from R-Studio for Linux or from R-Studio Agent.

* R-Studio for Linux is behind a NAT and R-Studio Agent has a public IP address or the ports on its

NAT/firewall are forwarded/opened.

https://www.r-studio.com/What-is-NAT.html
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A connection should be made from R-Studio for Linux.

* R-Studio for Linux has a public IP address or the ports on its NAT/firewall are forwarded/opened and

R-Studio Agent is behind a NAT.

A connection should be made from R-Studio Agent.

* Both R-Studio for Linux and R-Studio Agent are behind NATs/firewalls.

No connections are possible.

Connection from R-Studio Agent to R-Studio for Linux

R-Studio for Linux settings

If a connection is to be made from R-Studio Agent to R-Studio for Linux, R-Studio for Linux should be set
to accept connection on the Connect to Remote Computer dialog box. 



R-Studio Manual168

© 2025 R-Tools Technology Inc.

Connect to Remote Computer dialog box

Select Wait connection from remote computer, and specify options for incoming connections.

 R-Studio Incoming Connection Options

Password: Enter a password to obtain access to this computer from a network.
IP Address specifies addresses from which this computer can be accessed.
Subnet Mask specifies subnet mask of the network from which this computer can be accessed.
Port port for incoming connections.

R-Studio for Linux will wait for an incoming connection.

Waiting for remote connection dialog box

Connecting from R-Studio Agent to R-Studio for Linux.

To establish a connection from R-Studio Agent to R-Studio for Linux, 

1 Right-click the R-Studio Agent tray icon and select Connect

2 Enter the necessary information on the Connect to R-Studio for Linux dialog box and click the Connect
button.

Connect to R-Studio for Linux dialog box

Connect to R-Studio settings

Server Specify the DNS name or IP address of the host where R-Studio
for Linux is running.

Port Specify the port set on the R-Studio for Linux Settings (Server)

dialog box.
Password Specify the password set on the R-Studio for Linux Settings

(Server) dialog box.
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> R-Studio Agent will connect to the computer where R-Studio for Linux is running and it will show the

hard drive and logical disk structure of the remote computer.

It can be processed the same way as that on a local computer.

III R-Studio Technician/T80+

R-Studio Technician/T80+ Demo can perform all data recovery actions except saving recovered files greater
than 1 MB and multi-pass imaging.

The R-Studio T80+ version requires an active internet connection to register and run. You may read more about
R-Studio T80+ in our article R-Studio T80+ - A Professional Data Recovery and Forensic Solution for Small
Business and Individuals Just for US$1/day.

R-Studio Technician has additional controls on its main panel. 

https://www.r-studio.com/pro-data-recovery-and-forensic-for-small-business.html
https://www.r-studio.com/pro-data-recovery-and-forensic-for-small-business.html
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R-Studio Main Technician/T80+ panel

Click this button to start runtime imaging of the selected
object.

(Technician/T80+ versions only)

I/O Monitor

Click this button to open I/O Monitor.

Show Files (Advanced)

Click this button to start enumerating files with minimum disk
access.

This chapter covers features that available only in the R-Studio Technician/T80+ versions.

· USB Activation (Technician only)
· Multitasking
· Show Files (Advanced)
· Additional Recovery Options
· Hidden Devices
· Extended File Information 
· Symbolic Link Processing
· Custom Recovery Lists
· Drive Copy Wizard
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· File Maps
· I/O Monitor and Sector Map files
· Runtime Imaging
· Multi-pass Imaging
· Reverse RAIDs
· Working with Third-Party Hardware
· Forensic Mode
· Some other information about R-Studio Technician/T80+ is shown on the following pages:

· R-Studio Settings

· Drive Scan

· Images

· BitLocker Drive Encryption

· Apple CoreStorage/FileVault/Fusion Drive Volumes

· Connecting over the Internet

· Supported Virtual Disk and Disk Image Formats

3.1 USB Activation

The R-Studio Technician license provides the ability to create an activation USB, which allows the licensee to
activate/verify the license in a completely offline mode using a supported USB stick selected by the licensee. The
article R-Studio Technician: activation using a USB stick explains this process in more detail.

The activation USB can be used not only to verify the license, but also to add R-Studio Technician Portable
and one of the versions (based on WinPE or Linux) of the bootable R-Studio Technician Emergency (Startup
version). It means that a technician version licensee can create a universal USB stick and use it to run R-Studio
Technician on any computer online or offline, running OS or with a damaged OS, at a facility with or without
Internet access.

Creating an Activation Stick

To create an activation USB stick you need a working Internet connection.

1. Run R-Studio, go to the Help, and select Create Activation USB.

2. Select one of the supported USB sticks and click the OK button. USB devices that are not supported for
creating an activation stick will not be displayed in the list.

R-Studio will display a message about the completion of the operation, and from this moment on, this R-Studio
Technician license will be automatically activated when you start the software with the USB stick connected to
the serviced computer. Internet connection and online activation will no longer be required 

Erased, Damaged or Lost Activation Stick

The same activation stick with corrupted data but with working hardware 

Quick format doesn’t erase the activation information, even if the USB stick been formatted to another file
system.

If the data on the activation stick has been completely erased, you can  recreate the activation data on the same
stick. There are no limitations for the activation stick recreation ON THE SAME USB DEVICE. 

https://www.r-studio.com/universal-usb-stick-for-professional-data-recovery.html
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The activation stick is lost or damaged.

You can temporally activate the installed R-Studio Technician over the Internet and contact R-TT, Inc
customer support for assistance.

3.2 Show Files (Advanced)

File enumeration may take a very long time if a hard drive has some hardware issues or its file system is severely
damaged. Moreover, each access to a problematic drive inflicts additional damage. R-Studio Technician/T80+
has a special action to avoid this: Show Files (Advanced) that minimizes both parsing the file system and disk
access.  

There are two types of this action: the first one when the entire file system is processed with some exclusions
(default), and the second one when only some individual folders are processed. 

Enumerate files for the entire FS

These options depend on the file system type being processed. You should know what your are doing when
selecting/clearing them. If you don't know which option to select/clear, select Do not process deleted files.

NTFS FAT/exFAT

FAT32

FAT32 Broken Hi Cluster 

Windows erases file's hi clusters when deletes files on FAT32 file systems. That makes recovery of such files
very difficult. R-Studio may collect more information about such files to increase their chances for their
successful recovery. Such collection will require additional information which in its turn require additional disk
reads. You can control to what extent R-Studio Technician/T80+ will reduce disk reads.

No additional disk reads (fastest but less files to find)

R-Studio Technician/T80+ will try to recover
broken hi clusters without additional disk reads and
therefore additional information. Fast but not many
files will be successfully recovered.

https://www.r-tt.com/PurchasingRequest.shtml
https://www.r-tt.com/PurchasingRequest.shtml
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Smart disk reads (default, most files to find)

Some additional disk reads will be performed to
gather more information, and R-Studio
Technician/T80+ will use some heuristic methods to
recover broken hi clusters. Slower but more files will
be successfully recovered.

Exhaustive disk reads (very slow but recovers the
largest number of files)

A lot of additional disk reads will be performed to
gain most possible information to recover the
maximum possible number of files will be successfully
recovered.

APFS/HFS EXT XFS

Enumerate files in individual folders starting from the root

R-Studio Technician/T80+ can enumerate files and subfolders in individual folders rather than in the entire file
system. This is especially important when the hard drive has severe hardware damage or file system corruption.
This can be done by selecting Enumerate files in individual folders starting from the root on the Show Files

(Advanced) dialog box.
Files in individual folders

Click the folder where you want to enumerate files. 



R-Studio Manual174

© 2025 R-Tools Technology Inc.

Files and subfolders in individual folders

3.3 Multitasking

R-Studio Technician can perform several tasks simultaneously. For example, you can simultaneously recover
files from one disk, create an image of another disk, and scan a loaded image. The number of simultaneously
running tasks depends on the system performance: CPU power, RAM size, free space on the disks, data transfer
speed, and so on.

When, for example, 3 tasks are simultaneously running, R-Studio Technician will mark them with a special
rotating sign in its Device view pane. In this example, these 3 tasks are file recovery from a logical disk
(partition), hard drive image creation, and scanning of an image of a hard drive.

Three tasks running

It also shows a list of running tasks. You may switch to the required task by clicking it. The progress bar at
the bottom show the overall progress of all tasks.
Each task runs independently in its own tab, has its own I/O Monitor, and can be independently controlled: 
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File recovery

Image creation

Image scan
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When all tasks have been completed, R-Studio Technician will show their results with special marks.

All task completed

These marks will disappear when the corresponding tabs are opened. 

3.4 Additional Recovery Options

R-Studio Technician has additional Recovery options.

Recover (Additional Output Folders) dialog box
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Additional Output Folders

Additional Output Folders Additional output folders where recovered files will be stored when R-Studio
Technician/T80+ runs out of space.

NEVER TRY TO SAVE RECOVERED FILES/FOLDERS TO THE SAME LOGICAL DISK WHERE
THEY RESIDE!!!

Or you may obtain unpredictable results and lose all of your data.

Recover (Post Actions) dialog box

Post Actions Options

Shutdown the computer on
task completion

If this check box is selected, R-Studio Technician/T80+ will shut down
your computer when file recovery has been completed. The program will
warn you if any option on the Advanced tab is set to Prompt.

E-Mail notifications If this check box is selected, R-Studio Technician/T80+ will inform you
about the outcome of the operation via email. 

3.5 Hidden Devices

R-Studio Technician/T80+ can hide unnecessary devices on the Device View pane. Most likely, they may be
system drives and drives connected to save recovered data. Hiding those devices doesn't prevent R-Studio
Technician/T80+ from saving recovered and service files on them.

No hidden devices
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To hide unnecessary devices,

1 Go to Settings and then to the Hidden Devices tab, mark all devices you want to hide,

Hidden Devices tab

and restart R-Studio Technician/T80+.

> Only necessary devices will be visible

Necessary devices

You may make hidden devices visible once again on the Hidden Devices tab.

Hidden Devices tab
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3.6 Extended File Information

R-Studio Technician/T80+ shows much more information about files than R-Studio for Linux does. 

Info about a file with good chances
for recovery

Info for a file with below average
recovery chances

More information

Click this button to pin the file information. This panel will show the information
about the "pinned" file regardless of the current selected file.

Click this button to copy all this information

Click this button to select the file you want to go to. 

Click this button to close all the information. 

Overlapping files Shows the list or files that may occupy the same disk sectors. You may click the file
id to see information about this file.

Regions Shows the list of sectors occupied by the file and corresponding overlapping files.
You may click a sector number open the sector in the built-in Hexadecimal editor.
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Examples of file information on other file systems

File info on an NTFS file system Info for a file on an HFS+ file
system

File info on an APFS file system Info for a file on an XFS file system

3.7 Symbolic Link Processing

R-Studio Technician/T80+ give its users more control over symbolic links processing.

Symbolic links (of symlinks for short) are object that contains references to other files or folders directory in the
form of absolute or relative paths and that affect pathname resolution. For example, if a symlink C:
\ProgramData\Documents points to D:\Recovered Files\Root\Users\Public\Documents, entering it
will result in entering D:\Recovered Files\Root\Users\Public\Documents.

https://www.r-studio.com/What-is-XFS.html
https://www.r-studio.com/What-are-Hard-Soft-Links.html
http://en.wikipedia.org/wiki/Symbolic_link
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Symbolic Links dialog box

Symbolic Links

Symbolic links display settings

Don't show symbolic links by default
(Technician version)

If this option is selected, R-Studio Technician/T80+ hides all
symbolic links by default. Only real objects will be visible. You
may make them visible by clearing the Hide symbolic links option on
the Mask dialog box.

Show folder symbolic links as links to
their targets, without target content
(Technician version)

Only links to their target will be shown in the right pane (Contents).
They target content can be reached by clicking those links.

Symbolic links recovery options

For all options:

When both the symbolic link and its target are selected for recovery,
both the symbolic link and its target will be recoveredl.

When only the target is selected fore recovery, only the target will
be recovered. 

Link conversion (Default) 

Only a symbolic link is selected for
recovery:

The selected symbolic link will be recovered as its target.

If both a symbolic link and its target
are selected for recovery:

If both a symbolic link and its target are selected for recovery,
both the target and its symbolic link will be recovered. The file
path in that symbolic link will be converted from absolute to
relative. Example: If the object C:\ProgramData\Documents is
a symbolic link to C:\Users\Public\Documents, it will be
converted to a symbolic link to ..\Users\Public\Documents.
Therefore, the symbolic link will point to its object regardless of
the place to which the object has been recovered.

Recovery as it is (Technician version)

Only a symbolic link is selected for
recovery:

The symbolic link will be recovered as a symbolic link which may
contain a path to a nonexistent object.
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If both the symbolic link and its
target are selected for recovery, the
absolute link will remain as the
original absolute symbolic link.

If both the symbolic link and its target are selected for recovery,
the file path in that symbolic link will remain unchanged. 
Example: 
The place to store recovered data: D:\Recovered Files. 
The object to recover: C:\Users\Public\Documents
The symbolic link: C:\ProgramData\Documents
After recovery:
The recovered object: D:\Recovered
Files\Root\Users\Public\Documents

The recovered symbolic link: D:\Recovered

Files\Root\ProgramData\Documents pointing to C:

\Users\Public\Documents.
Therefore, if someone tries to enter to the symbolic link, the
system will open the object C:\Users\Public\Documents,
rather than recovered D:\Recovered

Files\Root\Users\Public\Documents.
Usually a recovered target has a new path, therefore its recovered
absolute links will point to a wrong place, or to a non-existent
object.

The Data Recovery Topics topic explains processing of symbolic links recovery in more detail.

3.8 Custom Recovery Lists

The R-Studio Technician/T80+ versions can create more advanced recovery lists.

Export Recovery List options

Export the entire folder/file tree
Export marked file/folder names
Export file/folder names

Specifies which file and folder names will be exported. 

File format:

A file format for the recovery list.
Only text format is available for the standalone and corporate versions.
R-Studio Technician/T80+ can create custom recovery lists in other
formats with more advanced options 
The following formats are available for R-Studio Technician/T80+
version:
Plain Text
HTML
XML
JSON
CSV

File name: Specifies a file name of the recovery list. 

Editing the file recovery list

All files without any marks in the recovery list will be marked when the list is loaded into R-Studio for Linux.

So, if you have some files in the recovery list that don't need to be recovered, just delete them from the list. In
addition, you may use the following marks to specify some options 

:+ Mark the file, or the folder, all its files, and subfolders within the folder.
:* Mark the file, or the folder and its files, don't mark subfolders in the folder.
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:- Unmark the file, or the folder, its files, and subfolders in the folder.
:= Unmark the file or the folder and its files, dont unmark subfolders in the folder.
:! Provide the information on the file. (R-Studio Technician/T80+ only)

 R-Studio for Linux processes records in the list consequently. That is, if there are the following lines in the
file,
:+Files_to_Recover\
:-Files_to_Delete\File_2.jpg

the file File_2.jpg won't be marked for recovery, while for the lines
:-Files_to_Recover\File_2.jpg
:+Files_to_Recover\

file File_2.jpg will be.

A simple recovery list for reference

Structure of a simple recovery list file created by R-Studio for Linux
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"/media/andrew/ntfs test";
label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
product:"disk"; vendor:"flash"; 
Diving/
Diving/Aquarium/
Diving/Aquarium/20190822_100644.jpg
Diving/Aquarium/20190822_101620.jpg
Diving/Aquarium/20190822_102526.jpg
Diving/Aquarium/20190822_103830.jpg
Diving/Aquarium/20190822_104333.jpg
SF/
SF/Sea-Lions/
SF/Sea-Lions/IMG_3493.JPG
SF/Sea-Lions/IMG_3535.JPG
SF/Sea-Lions/IMG_3542.JPG
SF/Sea-Lions/IMG_3579.JPG
SF/Sea-Lions/IMG_3580.JPG
SF/Sea-Lions/IMG_3581.JPG
SF/Sea-Lions/IMG_3589.JPG
SF/IMG_0869.JPG
SF/IMG_0873.JPG
SF/IMG_0890.JPG
SF/IMG_1739.JPG
SF/IMG_3460.JPG
SF/IMG_3461.JPG
SF/IMG_3476.JPG
SF/IMG_3478.JPG
SF/IMG_3479.JPG
SF/IMG_3480.JPG
SF/IMG_3481.JPG
SF/IMG_3493.JPG
SF/IMG_3535.JPG
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SF/IMG_3542.JPG
SF/IMG_3579.JPG
SF/IMG_3580.JPG
SF/IMG_3581.JPG
SF/IMG_3589.JPG
SF/IMG_3590.JPG
SF/IMG_3591.JPG
SF/IMG_3592.JPG
SF/IMG_3593.JPG
SF/IMG_3594.JPG
SF/IMG_3595.JPG
SF/IMG_3596.JPG
SF/IMG_3608.JPG
SF/IMG_3627.JPG
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG

If such recovery list is created from an entire logical disk/partition, it will contain several virtual folders. For
example, they'll have the following structure for an NTFS partition.
System Volume Information/
System Volume Information/IndexerVolumeGuid
System Volume Information/WPSettings.dat
Vegas/
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG
///m/$Extend/
///m/$Extend/$Deleted/
///m/$Extend/$RmMetadata/
///m/$Extend/$RmMetadata/$Txf/
///m/$Extend/$RmMetadata/$TxfLog/
///m/$Extend/$RmMetadata/$TxfLog/$Tops
///m/$Extend/$RmMetadata/$TxfLog/$TxfLog.blf
///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000001
///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000002
///m/$Extend/$RmMetadata/$Repair
///m/$Extend/$ObjId
///m/$Extend/$Quota
///m/$Extend/$Reparse
///m/$AttrDef
///m/$BadClus
///m/$Bitmap
///m/$Boot
///m/$LogFile
///m/$MFT
///m/$MFTMirr
///m/$Secure
///m/$UpCase
///m/$Volume
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HTML format

This is a default format of recovery lists for the R-Studio Technician/T80+ version. It allows its users to supply
their customers with the recovery lists with the easiest way to edit. 

Export Recovery List dialog box for the HTML format

HTML Options dialog box

You may export the default HTML template and edit it to adapt it for your own purposes. 

When the customer loads an HTML recovery list in their browser, they can mark files they want to recover, and
export their names into the final recovery list in the plain text format.

HTML Recovery list in a browser

You may compare this list with the edited simple recovery list.

  An exported recovery list 

:# Version = 1
:# Sort = by real 
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"/media/andrew/ntfs test";
label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
product:"disk"; vendor:"flash"; 
Diving/Aquarium/20190822_100644.jpg
:! Id=3866625
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Diving/Aquarium/20190822_101620.jpg
:! Id=3932161
Diving/Aquarium/20190822_102526.jpg
:! Id=3997697
Diving/Aquarium/20190822_103830.jpg
:! Id=4063233
Diving/Aquarium/20190822_104333.jpg
:! Id=4128769
Diving/MyPhoto1.jpg
:! Id=2883585
Diving/MyPhoto2.jpg
:! Id=2949121
Diving/MyPhoto3.jpg
:! Id=3014657
Diving/MyPhoto4.JPG
:! Id=3080193
Diving/MyPhoto5.jpg
:! Id=3145729
SF/IMG_0869.JPG
:! Id=4915201
SF/IMG_0873.JPG
:! Id=4980737
SF/IMG_0890.JPG
:! Id=5046273
SF/IMG_1739.JPG
:! Id=5111809
SF/IMG_3460.JPG
:! Id=5177345
SF/IMG_3461.JPG
:! Id=5242881
SF/IMG_3476.JPG
:! Id=5308417
SF/IMG_3478.JPG
:! Id=5373953
SF/IMG_3479.JPG
:! Id=5439489
SF/IMG_3480.JPG
:! Id=5505025
SF/IMG_3481.JPG
:! Id=5570561
SF/IMG_3493.JPG
:! Id=5636097
SF/IMG_3535.JPG
:! Id=5701633
SF/IMG_3542.JPG
:! Id=5767169
SF/IMG_3579.JPG
:! Id=5832705
SF/IMG_3580.JPG
:! Id=5898241
SF/IMG_3581.JPG
:! Id=5963777
SF/IMG_3589.JPG
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:! Id=6029313
SF/IMG_3590.JPG
:! Id=6094849
SF/IMG_3591.JPG
:! Id=6160385
SF/IMG_3592.JPG
:! Id=6225921
SF/IMG_3593.JPG
:! Id=6291457
SF/IMG_3594.JPG
:! Id=6356993
SF/IMG_3595.JPG
:! Id=6422529
SF/IMG_3596.JPG
:! Id=6488065
SF/IMG_3608.JPG
:! Id=6553601
SF/IMG_3627.JPG
:! Id=6619137
MyPhoto6.JPG
:! Id=4194305
MyPhoto7.JPG
:! Id=4259841
MyPhoto8.JPG
:! Id=4325377
MyPhoto9.JPG
:! Id=4390913

A manually edited plain text recovery list

The edited simple recovery list

The final simple recovery list will be the following:
:# Version = 1

:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"/media/andrew/ntfs test";
label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
product:"disk"; vendor:"flash"; 
:= Diving/
:+ Diving/Aquarium/
:+ Diving/MyPhoto1.jpg
:+ Diving/MyPhoto3.jpg
:+ SF/
:- SF/Sea-Lions/
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG
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Plain text format

Custom recovery lists in the text format contains more information about files than simple recovery lists.

Export Recovery List dialog box for the plain text format

You may compare two versions of the same plain text recovery list:

An advanced text recovery list

This is an advanced version of the recovery list described on the Recovery List page.
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"/media/andrew/ntfs test";
label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
product:"disk"; vendor:"flash"; 
Diving/
:! Id=4000000260001
:! Flags=directory
:! Created=4/4/2023 04:10 PM
:! Modified=4/4/2023 06:16 PM
:! Accessed=4/5/2023 01:31 PM
:! MFT number=38
:! Parent MFT number=5

Diving/Aquarium/
:! Id=4000000270001
:! Flags=directory
:! Created=4/4/2023 04:10 PM
:! Modified=4/5/2023 01:31 PM
:! Accessed=4/5/2023 01:31 PM
:! MFT number=39
:! Parent MFT number=38

Diving/Aquarium/20190822_100644.jpg
:! Id=3b0001
:! Size=5.49 MB (5,760,305 Bytes)
:! Created=4/5/2023 01:27 PM
:! Modified=8/5/2020 01:34 PM
:! Accessed=4/5/2023 01:27 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682782 (offset: 80 ) size: 72 Bytes / resident
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    :! other files:  [240000000410001] MyPhoto7.JPG
:! sector 682782 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [240000000420001] MyPhoto8.JPG
:! sector 1282304 size: 5.49 MB (5,760,305 Bytes) / first data
    :! other files:  [240000000410001] MyPhoto7.JPG
:! Bad sectors=No
:! MFT number=59
:! Parent MFT number=39

Diving/Aquarium/20190822_101620.jpg
:! Id=3c0001
:! Size=5.75 MB (6,030,395 Bytes)
:! Created=4/5/2023 01:27 PM
:! Modified=8/5/2020 01:47 PM
:! Accessed=4/5/2023 01:27 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682784 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [240000000420001] MyPhoto8.JPG
:! sector 682784 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [240000000430001] MyPhoto9.JPG
:! sector 1293560 size: 5.75 MB (6,030,395 Bytes) / first data
    :! other files:  [240000000420001] MyPhoto8.JPG
:! Bad sectors=No
:! MFT number=60
:! Parent MFT number=39

Diving/Aquarium/20190822_102526.jpg
:! Id=3d0001
:! Size=4.92 MB (5,163,217 Bytes)
:! Created=4/5/2023 01:27 PM
:! Modified=8/5/2020 09:10 PM
:! Accessed=4/5/2023 01:27 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682786 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [240000000430001] MyPhoto9.JPG
:! sector 682786 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [240000000440001] IMG_3493.JPG
:! sector 1478800 size: 4.92 MB (5,163,217 Bytes) / first data
    :! other files:  [240000000430001] MyPhoto9.JPG
:! Bad sectors=No
:! MFT number=61
:! Parent MFT number=39

Diving/Aquarium/20190822_103830.jpg
:! Id=3e0001
:! Size=5.41 MB (5,674,169 Bytes)
:! Created=4/5/2023 01:27 PM
:! Modified=8/5/2020 09:10 PM
:! Accessed=4/5/2023 01:27 PM
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:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682788 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [240000000440001] IMG_3493.JPG
:! sector 682788 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [240000000450001] IMG_3535.JPG
:! sector 1488888 size: 5.41 MB (5,674,169 Bytes) / first data
    :! other files:  [240000000440001] IMG_3493.JPG
:! Bad sectors=No
:! MFT number=62
:! Parent MFT number=39

Diving/Aquarium/20190822_104333.jpg
:! Id=3f0001
:! Size=6.36 MB (6,673,935 Bytes)
:! Created=4/5/2023 01:27 PM
:! Modified=8/5/2020 09:13 PM
:! Accessed=4/5/2023 01:27 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682790 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [240000000450001] IMG_3535.JPG
:! sector 682790 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [240000000460001] IMG_3542.JPG
:! sector 1642440 size: 6.36 MB (6,673,935 Bytes) / first data
    :! other files:  [240000000450001] IMG_3535.JPG
:! Bad sectors=No
:! MFT number=63
:! Parent MFT number=39

Diving/MyPhoto1.jpg
:! Id=2c0001
:! Size=2.56 MB (2,682,000 Bytes)
:! Created=4/4/2023 06:16 PM
:! Modified=4/29/2009 05:52 AM
:! Accessed=4/4/2023 06:16 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682752 (offset: 80 ) size: 72 Bytes / resident
:! sector 682752 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [2400000002d0001] MyPhoto2.jpg
:! sector 2036600 size: 2.56 MB (2,682,000 Bytes) / first data
:! Bad sectors=No
:! MFT number=44
:! Parent MFT number=38

Diving/MyPhoto2.jpg
:! Id=2d0001
:! Size=1.75 MB (1,830,252 Bytes)
:! Created=4/4/2023 06:16 PM
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:! Modified=4/29/2009 05:53 AM
:! Accessed=4/4/2023 06:16 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682754 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [2400000002e0001] MyPhoto3.jpg
:! sector 682754 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [2400000002e0001] MyPhoto3.jpg
:! sector 2041840 size: 1.75 MB (1,830,252 Bytes) / first data
:! Bad sectors=No
:! MFT number=45
:! Parent MFT number=38

Diving/MyPhoto3.jpg
:! Id=2e0001
:! Size=1.73 MB (1,816,964 Bytes)
:! Created=4/4/2023 06:16 PM
:! Modified=4/29/2009 05:53 AM
:! Accessed=4/4/2023 06:16 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682756 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [2400000002f0001] MyPhoto4.JPG
:! sector 682756 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [240000000300001] MyPhoto5.jpg
:! sector 1683624 size: 1.73 MB (1,816,964 Bytes) / first data
    :! other files:  [2400000002f0001] MyPhoto4.JPG
:! Bad sectors=No
:! MFT number=46
:! Parent MFT number=38

Diving/MyPhoto4.JPG
:! Id=2f0001
:! Size=880.15 KB (901,269 Bytes)
:! Created=4/4/2023 06:16 PM
:! Modified=4/29/2009 05:54 AM
:! Accessed=4/4/2023 06:16 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682758 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [240000000310001] IndexerVolumeGuid
:! sector 682758 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [240000000310001] IndexerVolumeGuid
:! sector 2045416 size: 880.15 KB (901,269 Bytes) / first data
    :! other files:  [240000000300001] MyPhoto5.jpg
:! Bad sectors=No
:! MFT number=47
:! Parent MFT number=38

Diving/MyPhoto5.jpg
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:! Id=300001
:! Size=3.13 MB (3,286,883 Bytes)
:! Created=4/4/2023 06:16 PM
:! Modified=4/29/2009 06:13 AM
:! Accessed=4/4/2023 06:16 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682760 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [240000000320001] IMG_0201.JPG
:! sector 682760 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [240000000320001] IMG_0201.JPG
:! sector 1687176 size: 3.13 MB (3,286,883 Bytes) / first data
    :! other files:  [240000000310001] IndexerVolumeGuid
:! Bad sectors=No
:! MFT number=48
:! Parent MFT number=38

SF/
:! Id=4000000290001
:! Flags=directory
:! Created=4/4/2023 04:10 PM
:! Modified=4/5/2023 12:36 PM
:! Accessed=4/5/2023 01:27 PM
:! MFT number=41
:! Parent MFT number=5

SF/Sea-Lions/
:! Id=40000002a0001
:! Flags=directory
:! Created=4/4/2023 04:10 PM
:! Modified=4/4/2023 05:03 PM
:! Accessed=4/5/2023 12:36 PM
:! MFT number=42
:! Parent MFT number=41

SF/Sea-Lions/IMG_3493.JPG
:! Id=440001
:! Size=4.75 MB (4,985,023 Bytes)
:! Created=4/4/2023 05:02 PM
:! Modified=6/5/2009 09:50 PM
:! Accessed=4/4/2023 05:02 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682800 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000004c0001] IMG_0873.JPG
:! sector 682800 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000004c0001] IMG_0873.JPG
:! sector 682800 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000004c0001] IMG_0873.JPG
:! sector 1043832 size: 4.75 MB (4,985,023 Bytes) / first data
    :! other files:  [2400000004b0001] IMG_0869.JPG
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:! Bad sectors=No
:! MFT number=68
:! Parent MFT number=42

SF/Sea-Lions/IMG_3535.JPG
:! Id=450001
:! Size=3.55 MB (3,718,479 Bytes)
:! Created=4/4/2023 05:02 PM
:! Modified=6/5/2009 09:55 PM
:! Accessed=4/4/2023 05:02 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682802 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000004d0001] IMG_0890.JPG
:! sector 682802 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000004d0001] IMG_0890.JPG
:! sector 682802 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000004d0001] IMG_0890.JPG
:! sector 1076608 size: 3.55 MB (3,718,479 Bytes) / first data
    :! other files:  [2400000004c0001] IMG_0873.JPG
:! Bad sectors=No
:! MFT number=69
:! Parent MFT number=42

SF/Sea-Lions/IMG_3542.JPG
:! Id=460001
:! Size=3.92 MB (4,110,749 Bytes)
:! Created=4/4/2023 05:02 PM
:! Modified=6/5/2009 09:57 PM
:! Accessed=4/4/2023 05:02 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682804 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000004e0001] IMG_1739.JPG
:! sector 682804 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000004e0001] IMG_1739.JPG
:! sector 682804 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000004f0001] IMG_3460.JPG
:! sector 1109376 size: 3.92 MB (4,110,749 Bytes) / first data
    :! other files:  [2400000004e0001] IMG_1739.JPG
:! Bad sectors=No
:! MFT number=70
:! Parent MFT number=42

SF/Sea-Lions/IMG_3579.JPG
:! Id=470001
:! Size=3.92 MB (4,109,345 Bytes)
:! Created=4/4/2023 05:02 PM
:! Modified=6/5/2009 09:59 PM
:! Accessed=4/4/2023 05:02 PM
:! File type=JPEG Digital Camera
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:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682806 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000004f0001] IMG_3460.JPG
:! sector 682806 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000500001] IMG_3461.JPG
:! sector 682806 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000500001] IMG_3461.JPG
:! sector 1142144 size: 3.92 MB (4,109,345 Bytes) / first data
    :! other files:  [2400000004f0001] IMG_3460.JPG
:! Bad sectors=No
:! MFT number=71
:! Parent MFT number=42

SF/Sea-Lions/IMG_3580.JPG
:! Id=480001
:! Size=3.35 MB (3,510,477 Bytes)
:! Created=4/4/2023 05:03 PM
:! Modified=6/5/2009 09:59 PM
:! Accessed=4/4/2023 05:03 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682808 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000510001] IMG_3476.JPG
:! sector 682808 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000510001] IMG_3476.JPG
:! sector 682808 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000510001] IMG_3476.JPG
:! sector 1207680 size: 3.35 MB (3,510,477 Bytes) / first data
    :! other files:  [240000000500001] IMG_3461.JPG
:! Bad sectors=No
:! MFT number=72
:! Parent MFT number=42

SF/Sea-Lions/IMG_3581.JPG
:! Id=490001
:! Size=4.09 MB (4,285,353 Bytes)
:! Created=4/4/2023 05:03 PM
:! Modified=6/5/2009 09:59 PM
:! Accessed=4/4/2023 05:03 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682810 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000520001] IMG_3478.JPG
:! sector 682810 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000520001] IMG_3478.JPG
:! sector 682810 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000530001] IMG_3479.JPG
:! sector 1240448 size: 4.09 MB (4,285,353 Bytes) / first data
    :! other files:  [240000000520001] IMG_3478.JPG
:! Bad sectors=No
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:! MFT number=73
:! Parent MFT number=42

SF/Sea-Lions/IMG_3589.JPG
:! Id=4a0001
:! Size=4.44 MB (4,651,043 Bytes)
:! Created=4/4/2023 05:03 PM
:! Modified=6/5/2009 10:00 PM
:! Accessed=4/4/2023 05:03 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682812 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000530001] IMG_3479.JPG
:! sector 682812 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000540001] IMG_3480.JPG
:! sector 682812 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000540001] IMG_3480.JPG
:! sector 1273216 size: 4.44 MB (4,651,043 Bytes) / first data
    :! other files:  [240000000530001] IMG_3479.JPG
:! Bad sectors=No
:! MFT number=74
:! Parent MFT number=42

SF/IMG_0869.JPG
:! Id=4b0001
:! Size=3.53 MB (3,698,659 Bytes)
:! Created=4/4/2023 05:05 PM
:! Modified=5/30/2009 01:13 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682814 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000550001] IMG_3481.JPG
:! sector 682814 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000550001] IMG_3481.JPG
:! sector 682814 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000550001] IMG_3481.JPG
:! sector 1305984 size: 3.53 MB (3,698,659 Bytes) / first data
    :! other files:  [240000000540001] IMG_3480.JPG
:! Bad sectors=No
:! MFT number=75
:! Parent MFT number=41

SF/IMG_0873.JPG
:! Id=4c0001
:! Size=5.61 MB (5,881,104 Bytes)
:! Created=4/4/2023 05:05 PM
:! Modified=5/30/2009 01:15 PM
:! Accessed=4/5/2023 12:35 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
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:! Regions (sector size=512B):
:! sector 682816 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000560001] IMG_3493.JPG
:! sector 682816 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000560001] IMG_3493.JPG
:! sector 682816 (offset: 272 ) size: 16 Bytes / resident
    :! other files:  [240000000570001] IMG_3535.JPG
:! sector 682816 (offset: 312 ) size: 80 Bytes / resident
    :! other files:  [240000000570001] IMG_3535.JPG
:! sector 1338752 size: 5.61 MB (5,881,104 Bytes) / first data
    :! other files:  [240000000560001] IMG_3493.JPG
:! Bad sectors=No
:! MFT number=76
:! Parent MFT number=41

SF/IMG_0890.JPG
:! Id=4d0001
:! Size=5.40 MB (5,663,358 Bytes)
:! Created=4/4/2023 05:05 PM
:! Modified=5/30/2009 01:47 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682818 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000580001] IMG_3542.JPG
:! sector 682818 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000580001] IMG_3542.JPG
:! sector 682818 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000580001] IMG_3542.JPG
:! sector 1371520 size: 5.40 MB (5,663,358 Bytes) / first data
    :! other files:  [240000000570001] IMG_3535.JPG
:! Bad sectors=No
:! MFT number=77
:! Parent MFT number=41

SF/IMG_1739.JPG
:! Id=4e0001
:! Size=4.07 MB (4,266,181 Bytes)
:! Created=4/4/2023 05:05 PM
:! Modified=6/3/2009 12:59 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682820 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000590001] IMG_3579.JPG
:! sector 682820 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000590001] IMG_3579.JPG
:! sector 682820 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000005a0001] IMG_3580.JPG
:! sector 1404288 size: 4.07 MB (4,266,181 Bytes) / first data
    :! other files:  [240000000590001] IMG_3579.JPG
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:! Bad sectors=No
:! MFT number=78
:! Parent MFT number=41

SF/IMG_3460.JPG
:! Id=4f0001
:! Size=4.38 MB (4,593,453 Bytes)
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 07:58 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682822 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000005a0001] IMG_3580.JPG
:! sector 682822 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000005b0001] IMG_3581.JPG
:! sector 682822 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000005b0001] IMG_3581.JPG
:! sector 1469824 size: 4.38 MB (4,593,453 Bytes) / first data
    :! other files:  [2400000005a0001] IMG_3580.JPG
:! Bad sectors=No
:! MFT number=79
:! Parent MFT number=41

SF/IMG_3461.JPG
:! Id=500001
:! Size=3.91 MB (4,102,032 Bytes)
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 07:58 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682824 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000005c0001] IMG_3589.JPG
:! sector 682824 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000005c0001] IMG_3589.JPG
:! sector 682824 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000005c0001] IMG_3589.JPG
:! sector 1502592 size: 3.91 MB (4,102,032 Bytes) / first data
    :! other files:  [2400000005b0001] IMG_3581.JPG
:! Bad sectors=No
:! MFT number=80
:! Parent MFT number=41

SF/IMG_3476.JPG
:! Id=510001
:! Size=3.92 MB (4,114,595 Bytes)
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 08:02 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
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:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682826 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000005d0001] IMG_3590.JPG
:! sector 682826 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000005d0001] IMG_3590.JPG
:! sector 682826 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000005e0001] IMG_3591.JPG
:! sector 1535360 size: 3.92 MB (4,114,595 Bytes) / first data
    :! other files:  [2400000005d0001] IMG_3590.JPG
:! Bad sectors=No
:! MFT number=81
:! Parent MFT number=41

SF/IMG_3478.JPG
:! Id=520001
:! Size=4.74 MB (4,968,784 Bytes)
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 08:03 PM
:! Accessed=4/5/2023 12:35 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682828 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000005e0001] IMG_3591.JPG
:! sector 682828 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000005f0001] IMG_3592.JPG
:! sector 682828 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000005f0001] IMG_3592.JPG
:! sector 1568128 size: 4.74 MB (4,968,784 Bytes) / first data
    :! other files:  [2400000005e0001] IMG_3591.JPG
:! Bad sectors=No
:! MFT number=82
:! Parent MFT number=41

SF/IMG_3479.JPG
:! Id=530001
:! Size=4.28 MB (4,484,110 Bytes)
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 08:03 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682830 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000600001] IMG_3593.JPG
:! sector 682830 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000600001] IMG_3593.JPG
:! sector 682830 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000600001] IMG_3593.JPG
:! sector 1600896 size: 4.28 MB (4,484,110 Bytes) / first data
    :! other files:  [2400000005f0001] IMG_3592.JPG
:! Bad sectors=No
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:! MFT number=83
:! Parent MFT number=41

SF/IMG_3480.JPG
:! Id=540001
:! Size=4.28 MB (4,491,209 Bytes)
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 08:03 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682832 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000610001] IMG_3594.JPG
:! sector 682832 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000610001] IMG_3594.JPG
:! sector 682832 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000620001] IMG_3595.JPG
:! sector 1633664 size: 4.28 MB (4,491,209 Bytes) / first data
    :! other files:  [240000000610001] IMG_3594.JPG
:! Bad sectors=No
:! MFT number=84
:! Parent MFT number=41

SF/IMG_3481.JPG
:! Id=550001
:! Size=3.38 MB (3,541,845 Bytes)
:! Created=4/4/2023 05:05 PM
:! Modified=6/20/2009 02:00 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682834 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000620001] IMG_3595.JPG
:! sector 682834 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000630001] IMG_3596.JPG
:! sector 682834 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000630001] IMG_3596.JPG
:! sector 1666432 size: 3.38 MB (3,541,845 Bytes) / first data
    :! other files:  [240000000620001] IMG_3595.JPG
:! Bad sectors=No
:! MFT number=85
:! Parent MFT number=41

SF/IMG_3493.JPG
:! Id=560001
:! Size=4.75 MB (4,985,023 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 09:50 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
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:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682836 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000640001] IMG_3608.JPG
:! sector 682836 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000640001] IMG_3608.JPG
:! sector 682836 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000640001] IMG_3608.JPG
:! sector 1699200 size: 4.75 MB (4,985,023 Bytes) / first data
    :! other files:  [240000000630001] IMG_3596.JPG
:! Bad sectors=No
:! MFT number=86
:! Parent MFT number=41

SF/IMG_3535.JPG
:! Id=570001
:! Size=3.55 MB (3,718,479 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 09:55 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682838 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000650001] IMG_3627.JPG
:! sector 682838 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000650001] IMG_3627.JPG
:! sector 682838 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000400001] MyPhoto6.JPG
:! sector 1731968 size: 3.55 MB (3,718,479 Bytes) / first data
    :! other files:  [240000000650001] IMG_3627.JPG
:! Bad sectors=No
:! MFT number=87
:! Parent MFT number=41

SF/IMG_3542.JPG
:! Id=580001
:! Size=3.92 MB (4,110,749 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 09:57 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682840 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000610001] IMG_3594.JPG
:! sector 682840 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000420001] MyPhoto8.JPG
:! sector 682840 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000430001] MyPhoto9.JPG
:! sector 1764736 size: 3.92 MB (4,110,749 Bytes) / first data
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    :! other files:  [240000000410001] MyPhoto7.JPG
:! Bad sectors=No
:! MFT number=88
:! Parent MFT number=41

SF/IMG_3579.JPG
:! Id=590001
:! Size=3.92 MB (4,109,345 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 09:59 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682842 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000370001] IMG_0390.JPG
:! sector 682842 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000380001] IMG_0391.JPG
:! sector 682842 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000450001] IMG_3535.JPG
:! sector 1797504 size: 3.92 MB (4,109,345 Bytes) / first data
    :! other files:  [240000000440001] IMG_3493.JPG
:! Bad sectors=No
:! MFT number=89
:! Parent MFT number=41

SF/IMG_3580.JPG
:! Id=5a0001
:! Size=3.35 MB (3,510,477 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 09:59 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682844 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000470001] IMG_3579.JPG
:! sector 682844 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000620001] IMG_3595.JPG
:! sector 682844 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000480001] IMG_3580.JPG
:! sector 1830272 size: 3.35 MB (3,510,477 Bytes) / first data
    :! other files:  [240000000460001] IMG_3542.JPG
:! Bad sectors=No
:! MFT number=90
:! Parent MFT number=41

SF/IMG_3581.JPG
:! Id=5b0001
:! Size=4.09 MB (4,285,353 Bytes)
:! Flags=deleted
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:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 09:59 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682846 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000004a0001] IMG_3589.JPG
:! sector 682846 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000003b0001] 20190822_100644.jpg
:! sector 682846 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000003c0001] 20190822_101620.jpg
:! sector 1863040 size: 4.09 MB (4,285,353 Bytes) / first data
    :! other files:  [240000000490001] IMG_3581.JPG
:! Bad sectors=No
:! MFT number=91
:! Parent MFT number=41

SF/IMG_3589.JPG
:! Id=5c0001
:! Size=4.44 MB (4,651,043 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 10:00 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682848 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000004c0001] IMG_0873.JPG
:! sector 682848 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000330001] IMG_0211.JPG
:! sector 682848 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000340001] IMG_0250.JPG
:! sector 1895808 size: 4.44 MB (4,651,043 Bytes) / first data
    :! other files:  [2400000004b0001] IMG_0869.JPG
:! Bad sectors=No
:! MFT number=92
:! Parent MFT number=41

SF/IMG_3590.JPG
:! Id=5d0001
:! Size=4.67 MB (4,899,941 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 10:00 PM
:! Accessed=4/5/2023 12:35 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682850 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000350001] IMG_0283.JPG
:! sector 682850 (offset: 152 ) size: 90 Bytes / resident
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    :! other files:  [240000000360001] IMG_0389.JPG
:! sector 682850 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000004e0001] IMG_1739.JPG
:! sector 1928576 size: 4.67 MB (4,899,941 Bytes) / first data
    :! other files:  [2400000004d0001] IMG_0890.JPG
:! Bad sectors=No
:! MFT number=93
:! Parent MFT number=41

SF/IMG_3591.JPG
:! Id=5e0001
:! Size=4.08 MB (4,280,042 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 10:00 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682852 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000004f0001] IMG_3460.JPG
:! sector 682852 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000003d0001] 20190822_102526.jpg
:! sector 682852 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000003e0001] 20190822_103830.jpg
:! sector 1961344 size: 4.08 MB (4,280,042 Bytes) / first data
    :! other files:  [240000000630001] IMG_3596.JPG
:! Bad sectors=No
:! MFT number=94
:! Parent MFT number=41

SF/IMG_3592.JPG
:! Id=5f0001
:! Size=5.04 MB (5,285,211 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 10:00 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682854 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000510001] IMG_3476.JPG
:! sector 682854 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000520001] IMG_3478.JPG
:! sector 682854 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000390001] IMG_3694.JPG
:! sector 1994112 size: 5.04 MB (5,285,211 Bytes) / first data
    :! other files:  [240000000500001] IMG_3461.JPG
:! Bad sectors=No
:! MFT number=95
:! Parent MFT number=41
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SF/IMG_3593.JPG
:! Id=600001
:! Size=4.74 MB (4,969,442 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 10:00 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682856 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000530001] IMG_3479.JPG
:! sector 682856 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000540001] IMG_3480.JPG
:! sector 682856 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000003f0001] 20190822_104333.jpg
:! sector 2026880 size: 4.74 MB (4,969,442 Bytes) / first data
    :! other files:  [2400000003a0001] IMG_3699.JPG
:! Bad sectors=No
:! MFT number=96
:! Parent MFT number=41

SF/IMG_3594.JPG
:! Id=610001
:! Size=4.69 MB (4,917,237 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 10:00 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682858 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000640001] IMG_3608.JPG, [240000000320001]
IMG_0201.JPG
:! sector 682858 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000640001] IMG_3608.JPG, [240000000320001]
IMG_0201.JPG
:! sector 682858 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000002e0001] MyPhoto3.jpg
:! sector 973080 size: 4.69 MB (4,917,237 Bytes) / first data
    :! other files:  [240000000550001] IMG_3481.JPG
:! Bad sectors=No
:! MFT number=97
:! Parent MFT number=41

SF/IMG_3595.JPG
:! Id=620001
:! Size=5.09 MB (5,338,697 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 10:00 PM
:! Accessed=4/4/2023 05:05 PM
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:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682860 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000560001] IMG_3493.JPG
:! sector 682860 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000570001] IMG_3535.JPG
:! sector 682860 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000580001] IMG_3542.JPG
:! sector 1174920 size: 5.09 MB (5,338,697 Bytes) / first data
    :! other files:  [240000000300001] MyPhoto5.jpg
:! Bad sectors=No
:! MFT number=98
:! Parent MFT number=41

SF/IMG_3596.JPG
:! Id=630001
:! Size=4.93 MB (5,174,072 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 10:00 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682862 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000005a0001] IMG_3580.JPG
:! sector 682862 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000650001] IMG_3627.JPG
:! sector 682862 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000005b0001] IMG_3581.JPG
:! sector 1437064 size: 4.93 MB (5,174,072 Bytes) / first data
    :! other files:  [240000000590001] IMG_3579.JPG
:! Bad sectors=No
:! MFT number=99
:! Parent MFT number=41

SF/IMG_3608.JPG
:! Id=640001
:! Size=5.01 MB (5,257,021 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 10:01 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Below Average (Integrity OK, Beginning overwritten by existing
file)
:! Regions (sector size=512B):
:! sector 682864 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000005d0001] IMG_3590.JPG
:! sector 682864 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000005e0001] IMG_3591.JPG
:! sector 682864 (offset: 272 ) size: 80 Bytes / resident
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    :! other files:  [2400000005f0001] IMG_3592.JPG
:! sector 1673352 size: 5.01 MB (5,257,021 Bytes) / first data
    :! other files:  [2400000005c0001] IMG_3589.JPG
:! Overlapping files=[240000000320001] IMG_0201.JPG
:! MFT number=100
:! Parent MFT number=41

SF/IMG_3627.JPG
:! Id=650001
:! Size=3.48 MB (3,651,691 Bytes)
:! Flags=deleted
:! Created=4/4/2023 05:05 PM
:! Modified=6/5/2009 10:02 PM
:! Accessed=4/4/2023 05:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682866 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000002c0001] MyPhoto1.jpg
:! sector 682866 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000002d0001] MyPhoto2.jpg
:! sector 682866 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000002f0001] MyPhoto4.JPG
:! sector 1837136 size: 3.48 MB (3,651,691 Bytes) / first data
    :! other files:  [240000000600001] IMG_3593.JPG
:! Bad sectors=No
:! MFT number=101
:! Parent MFT number=41

MyPhoto6.JPG
:! Id=400001
:! Size=1.07 MB (1,123,560 Bytes)
:! Created=4/4/2023 04:13 PM
:! Modified=4/29/2009 05:54 AM
:! Accessed=4/4/2023 04:13 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682792 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000460001] IMG_3542.JPG
:! sector 682792 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000470001] IMG_3579.JPG
:! sector 682792 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000470001] IMG_3579.JPG
:! sector 938624 size: 1.07 MB (1,123,560 Bytes) / first data
    :! other files:  [240000000460001] IMG_3542.JPG
:! Bad sectors=No
:! MFT number=64
:! Parent MFT number=5

MyPhoto7.JPG
:! Id=410001
:! Size=842.76 KB (862,983 Bytes)
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:! Created=4/4/2023 04:13 PM
:! Modified=4/29/2009 05:55 AM
:! Accessed=4/4/2023 04:13 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682794 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000480001] IMG_3580.JPG
:! sector 682794 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000480001] IMG_3580.JPG
:! sector 682794 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [240000000480001] IMG_3580.JPG
:! sector 971392 size: 842.76 KB (862,983 Bytes) / first data
    :! other files:  [240000000470001] IMG_3579.JPG
:! Bad sectors=No
:! MFT number=65
:! Parent MFT number=5

MyPhoto8.JPG
:! Id=420001
:! Size=997.99 KB (1,021,937 Bytes)
:! Created=4/4/2023 04:13 PM
:! Modified=4/29/2009 05:55 AM
:! Accessed=4/4/2023 04:13 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682796 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [240000000490001] IMG_3581.JPG
:! sector 682796 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [240000000490001] IMG_3581.JPG
:! sector 682796 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [2400000004a0001] IMG_3589.JPG
:! sector 1004160 size: 997.99 KB (1,021,937 Bytes) / first data
    :! other files:  [240000000490001] IMG_3581.JPG
:! Bad sectors=No
:! MFT number=66
:! Parent MFT number=5

MyPhoto9.JPG
:! Id=430001
:! Size=3.37 MB (3,533,017 Bytes)
:! Created=4/4/2023 04:13 PM
:! Modified=4/29/2009 05:56 AM
:! Accessed=4/4/2023 04:13 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682798 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [2400000004a0001] IMG_3589.JPG
:! sector 682798 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [2400000004b0001] IMG_0869.JPG
:! sector 682798 (offset: 272 ) size: 80 Bytes / resident
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    :! other files:  [2400000004b0001] IMG_0869.JPG
:! sector 1036928 size: 3.37 MB (3,533,017 Bytes) / first data
    :! other files:  [2400000004a0001] IMG_3589.JPG
:! Bad sectors=No
:! MFT number=67
:! Parent MFT number=5

Other recovery list formats

You may export recovery lists in the following formats:

XML format

Export Recovery List dialog box for the XML format

JSON format

Custom recovery lists in the text format contains more information about files than simple recovery lists.

Export Recovery List dialog box for the JSON format

CSV format

Custom recovery lists in the text format contains more information about files than simple recovery lists.

Export Recovery List dialog box for the CSV format
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CSV Options dialog box

3.9 Drive Copy Wizard

You may copy any object in the Drives panel to any other object, if there is enough space on the target one.

Before Copy object to... becomes enabled on the Create menu, you need to enable writing.

To enable writing,

1 On the R-Studio for Linux main panel, select the Tools menu, then Settings, and select Enable Write

on the Settings dialog box.

> The Copy object to... will be enabled on the Create menu.

Now objects can be copied.

While the objects are being copied, you may change some parameters and view the I/O monitor on the Object
Copy Progress dialog box.

You may change some options during the copy process
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Depending on the objects to copy and your tasks, you may do:

Binary (byte to byte copy)

An exact copy of the source object (or a part thereof) to the destination device (from its beginning or a specified
offset). Any object may be copied to any object this way.

To perform a binary copy of an object,

1 Select Copy object to... on the Create menu

2 Select a source and destination objects on the Drives Copy Wizard panel and click the Next button

Drives Copy Wizard



R-Studio Technician/T80+ 211

© 2025 R-Tools Technology Inc.

3 Select Binary (byte to byte) copy on the Copy Options dialog box, specify copy options, and click the
Next button

Copy options dialog box

 Copy options

Source

Copy whole object Select this option if you want to copy the entire source object to the destination one
Copy range Select this option if you want to copy a part of the source object
Offset Specify the offset from which the source object data will be copied to the destination

object
Size Specify the size of the source object data which will be copied to the destination

object
Destination

Offset Specify the offset on the destination object to which the source object data will be
copied

3 View the copy task settings on the Drives Copy Wizard and click the Finish button

Drives Copy Wizard

or click the <Back button to edit the copy parameters

> R-Studio for Linux will start copying data from the source object to the destination one.
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Smart partition copy

Only partitions can be copied with this option to other partitions or empty spaces. You may change some
parameters of the the copied partition(s) on the destination drive.

To perform a smart partition copy of a partition,

1 Select Copy object to... on the Create menu

2 Select source and destination partitions on the Drives Copy Wizard  panel and click the Next button

Drives Copy Wizard

3 Select Smart partition copy on the Copy Options panel, specify copy options, and click the Next button

Copy options dialog box

 Copy options

Destination

Copy without
stretching 

Select this option if you want to copy the partition exactly to the destination place

Copy to: Select this option if you want to change some parameters of the copied partition on
the destination place

Free space before Specify how much space will be left empty before the start of the copied partition
Partition size Select this option and specify the new size of the copied partition
Partition type
Primary (Active)/
Primary/Logical

Specify the type of the partition to be copied. Do not change this setting unless you
have serious reasons to do so.

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-free-disk-space.html
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3 View the copy task settings on the Drives Copy Wizard and click the Finish button

Drives Copy Wizard

or click the <Back button to edit the copy parameters

> R-Studio for Linux will start copying data from the source partition to the destination place.

Smart drive copy

Only  whole drives  can be copied with this option to other drives. You may change some parameters of the
copied drives.

To perform a smart drive copy of a hard drive,

1 Select Copy object to... on the Create menu

2 Select a source and destination hard drives on the Drives Copy Wizard panel and click the Next button

Drives Copy Wizard
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3 Select Smart drive copy on the Copy Options panel, specify copy options, and click the Next button

Copy options dialog box

 Copy options

Copying mode

Copy all partitions
onto original places

Select this option if you want to copy all partitions to their original places.

One partition after
another

Select this option if you want to copy the partitions one after another preserving their
space. If there is empty space between the partitions, it will be omitted. Otherwise it
is similar to Copy all partitions onto original places.
If Fixed active partition is selected, the original offset/size of the active partition will be
preserved (in case the loader has links to it).

Expand/Shrink
partition to whole
disk

Specify this option if you want to proportionally expand/shrink the selected partitions
to occupy the entire target drive. 
If Fixed active partition is selected, the original offset/size of the active partition will be
preserved (in case the loader has links to it).

3 View the copy task settings on the Drives Copy Wizard and click the Finish button

Drives Copy Wizard

or click the <Back button to edit the copy parameters

> R-Studio for Linux will start copying data from the source hard drive to the destination one.
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3.10 File Maps

R-Studio for Linux can show file maps. Right-click  the file and select Map of file in their shortcut menu.

File Map

3.11 I/O Monitor and Sector Map Files

These features greatly improves working with failing drives for R-Studio for Linux.

I/O Monitor

I/O Monitor allows you to inspect the process of drive input/output operations in real time. When R-Studio for
Linux performs a disk operation the I/O Monitor button becomes active.

Click this button, and the I/O Monitor will appear.
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I/O Monitor

You may also start I/O Monitor from the context menu and progress dialog boxes during various drive
operations.

Sector Map Files

Sector map files are files that contain information about conditions of drive sectors, which may be good, bad,
slow, and unstable. R-Studio for Linux estimates chances for successful file recovery basing on these files and
avoiding unnecessary attempts to read bad sectors. Sector map files are crucial for multi-pass imaging.

R-Studio for Linux creates its own sector map files or can import such files created from other disk imaging
programs. Currently R-Studio for Linux supports sector map files from HDDSuperClone and DDRescue. 

To open, save or clean a sector map file for an object,

* Right-click the object and select Open Sector Map, Save Sector Map, or Clean Sector Map,
respectively, on the context menu.

You may look at the graphical representation of the loaded sector map by starting I/O Monitor.

Sector Map 

https://www.r-studio.com/What-is-a-Sector-Map-File.html
https://www.r-studio.com/What-are-Bad-Sectors.html
http://www.hddsuperclone.com/sitev1/
http://www.gnu.org/software/ddrescue/
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3.12 Runtime Imaging

Runtime imaging is image creation for a drive object performed simultaneously with other data read operations
from this drive. When R-Studio for Linux reads data from a certain area of the source (a drive, partition, or
region), it writes the data to the target which can be either a dedicated drive or an image file. When the data from
this area is needed again, R-Studio for Linux reads it from the target rather than the source thus reducing access
to the source. This is very important for faulty or unstable drives which health may be constantly deteriorating
during data recovery operations. 

R-Studio for Linux also creates a sector map file during runtime imaging.

To start runtime imaging of an object,

using a plain image file

1 Select a drive object on the R-Studio for Linux's Drives panel and click the Set Runtime Image button, 

or right-click the object and select Set Runtime Image on the context menu.

https://www.r-studio.com/What-is-Disk-Image.html
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-a-Sector-Map-File.html
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Runtime imaging

Select Plain or another image type in the Image type field, specify the file name and path for the image and
sector map files, and click the OK button. Don't select the VMDK image file unless you can disable writing to
the drive later. Cloning to a physical drive is not recommended because Windows can write some data to the
drive corrupting the imaged data when the image has been completed and runtime imaging is over.

Plain image file requires immediate allocation of disk space equal to the object size, whereas VMDK image

file is growing gradually upon imaging progress.

> R-Studio for Linux will turn on runtime imaging.

Runtime imaging

Select the object and click the Stop Runtime Imaging button or this item in the context menu turn runtime
imaging off.

using a physical drive

1 Select a drive object on the R-Studio for Linux's Drives panel and click the Set Runtime Image button, 

or right-click the object and select Set Runtime Image on the context menu.
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Runtime imaging

Select Physical drive in the Image type field, specify the name and path for the sector map file, and click the
OK button.

Note: all data on the drive will be destroyed. 

> R-Studio for Linux will turn on runtime imaging.

Runtime imaging

Select the object and click the Stop Runtime Imaging button or item in the context o menu turn runtime
imaging off.

R-Studio for Linux stores the information about runtime configurations and asks the users whether they want

to keep runtime imaging or discard it during its startup.
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Runtime imaging

and this configuration will appear in R-Studio for Linux.

Runtime imaging

Completing Runtime Image

You may complete the runtime image without browsing through the entire file system on the disk.

1 Select the object being imaged and click the Complete Runtime Image button, 

or right-click the object and select Complete Runtime Image on the shortcut menu.

Runtime imaging
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> The Complete Runtime Imaging dialog box will appear.

Runtime imaging

Select the necessary parameters of multi-pass imaging and select the OK button.

> R-Studio for Linux will complete the creation of the runtime image.

If the runtime image has not been completed, you may resume it next time you start runtime imaging.

Runtime imaging

Creating runtime image for individual files

You may create a runtime image containing only individual files rather than all data on the disk.

1 Establish a runtime imaging for the disk with the files, open the disk, mark the files, and click the Save
marked to runtime image button.

or right-click on the right pane, and select Save Marked to Runtime Image on the shortcut menu.
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Runtime imaging

> The Complete Runtime Imaging dialog box will appear.

Runtime imaging

Select the necessary parameters of multi-pass imaging and select the OK button.

> R-Studio for Linux will complete the creation of the runtime image. You may Skip files with bad sectors

if necessary.

You may open such images as regular ones. 

https://www.r-studio.com/What-are-Bad-Sectors.html
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Runtime imaging

Such image contains information about the entire file system, but if a non-imaged file is opened, it'll contain
only zeros.

3.13 Multi-pass Imaging

Multi-pass imaging is a process of image creation through several passes (phases). Each phase reads data from
different areas of a hard drive, starting from areas with good sectors then going to slow sector areas and finishes
with bad sector areas. This approach maximizes the amount of data that can be recovered from a failing drive
and reduces it chances to fail during this process. 

Phase 1. Copying most good data from the drive

In this phase, R-Studio reads data from drive by sector blocks, or groups of consecutive drive sectors read in
one go. The phase is performed in several steps.

Step 1. R-Studio reads data from the drive until it runs into a block with bad or slow sector(s). Then it drops
that block and jumps to another area until it finds a block with no bad or slow sectors. Then it continues reading
data until it runs into another bad or slow block, and the process repeats. When this step is finished, most good
data from the hard drive has been read, and R-Studio has detected the front blocks (edges) of bad and slow
sector areas.

Step 2. R-Studio finds the rear edges of bad sector areas. It reads the skipped area from its rear end backwards
until it runs into a block with a bad sector. Then R-Studio jumps to another bad sector area and the process is
going on until all bad sector areas have been processed. When this step is finished, some good data from the
hard drive has been read, and R-Studio has detected the rear edges of bad sector areas.

Step 3. R-Studio reads data from slow sector areas. It does that much the same way as for bad sector areas. 
When this step is finished, good data from slow sectors on the hard drive has been read, and R-Studio has
detected the rear edges of slow sector areas.

Step 4. R-Studio finds the rear edges of bad sector areas in slow sector areas. When this step is finished, some
new good data from slow sectors on the hard drive has been read, and R-Studio has detected the rear edges of
all bad sectors within slow sector areas.

Step 5. R-Studio tries to read all skipped sector blocks. This is done without skipping bad sector blocks and
checking read speed against minimum I/O rate.

https://www.r-studio.com/What-is-Disk-Image.html
https://www.r-studio.com/What-are-Bad-Sectors.html
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When Phase 1 is completed, R-Studio has read most of readable data and detected front and rear edges of all
bad sector areas.

R-Studio tries to read the rest of data in the next phases, and does that sector by sector (rather than blocks).

Phase 2. Trimming

R-Studio detects the front and rear sectors of bad sector areas. When this step is finished, some new good data
from bad sector areas has been read, and R-Studio has detected the front and rear sectors of all bad sector
areas.

Phase 3. Scraping

R-Studio tries to read data from bad sector areas sector by sector.

Phase 4. Retrying (mostly optional)

R-Studio tries to read data from bad sectors through several attempts. 

You may read more about this process in our article Multi-pass imaging in R-Studio

To create an image through multi-pass imaging,

1 Select an object on the R-Studio's Drives panel and click the Create Image button

 Other ways to create the image

· Select the object and select Create Image on the Drive menu
or
· Right-click the selected object and select Create Image File on the context menu

2 Specify image options, a file name, and destination for the image on the Create Image dialog box and
click the OK button

Create Image (Bad sector processing) dialog box

Bad sectors processing options

Image filename Specifies the name and path for the image file

http://www.r-studio.com/Multipass-imaging-damaged-drives.html
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Image type: Compressed image (R-Drive Image compatible): If this option is selected, R-Studio
will create an image file which can be compressed, split into several parts, and
password-protected. This image file is fully compatible with the images created
by R-Drive Image, but incompatible with the previous versions of R-Studio.
Byte by byte image: If this option is selected, R-Studio will create a simple exact
copy of the object.
VMDK (ViMware Virtual Machine Disk) image: If this option is selected, R-Studio
will create an image of the VMware virtual disk type. Available in the Corporate,
Technician, and T80+ license.
Some other image formats are also available in the Technician, and T80+
licenses. You may read more about these formats in the Supported Virtual Disk
and Disk Image Formats page.

Drive sector map file A file with the sector map of the object to image. Optional for the RDI image
type, mandatory for the byte-by-byte and VMDK image types.

Enable multi-pass
image creation

Turns multi-pass imaging on and off.

Data to process All data: All data on the disk will be imaged.
Existing files only (FS bitmap): Only the disk's area where existing files reside will
be imaged.
Unused clusters only: Only the disk's free space will be imaged.
You may image the existing files first and then unused clusters. 

Perform reading in
reverse order if possible

Switches the direction of all phases/steps to reverse.

Minimum skip size Minimum size of drive area to skip when a bad sector is encountered.
Maximum skip size Maximum size of drive area to skip when a bad sector is encountered.
Number of retries
(Retrying phase)

The number of read attempts in the Retrying phase.

Disable imaging phases Multi-imaging phases that can be skipped.

> R-Studio will start creating the image, the Progress message showing the progress.

Multi-pass imaging progress dialog box

http://en.wikipedia.org/wiki/VMDK
https://www.r-studio.com/What-is-a-Sector-Map-File.html
https://www.r-studio.com/What-is-free-disk-space.html
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You may change operation parameters during image creation. Click the Options button and change them
accordingly. 

Drive Options tab

Multi-pass imaging options tab

Post Actions tab

Advanced multi-pass imaging settings window

Note: You should completely understand what you are going to do, or you may severe deteriorate R-Studio
performance or even damage the hard drive being imaged. When in doubt, confine yourself to parameters on the
Multi-pass imaging options tab. 

The Bad sector processing dialog box spe cifies options for all stages of multi-pass imaging. You can perform
more versatile control of these options on the Advanced multi-pass imaging settings window. You may add or
delete individual phases and steps, change their order, and fine-tune each phase and step separately. 
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Advanced multi-pass imaging settings

Depending on the phase/step, these options are different. Some of them are described in the Bad sectors
processing options tab, some are self-evident, and some are described in the table below.

Advanced bad sectors processing options

Possible areas Specifies the areas to which this phase will be applied. Selecting an area in ALL
CAPITALS selects all their subareas. 

Options You may specify separate options for sectors where FS metadata resides. 
Block skip rules
Skip after N failed blocks

Specifies how many times various failed blocks will be encountered to skip them. 

Disk areas to process All se lected subareas 

Failed blocks
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FS metadata options

A particular set of these options can be saved as a preset and loaded back when necessary. 

The Bad sector processing tabs will look different when the advanced multi-pass imaging settings have been
altered.

Multi-pass imaging options tab Multi-pass imaging options tab

3.14 Reverse RAIDs

Reverse RAIDs is a technique that is reverse to creating virtual RAIDs. When creating a reverse RAID, the data
from a real object is decomposed into virtual parents.Then data on those virtual parents can be processed like on
real objects. They can be viewed, edited, imaged, copied to physical drives, etc.

· Reverse RAID of an Object
This technique can be used to decompose data on a single volume into virtual parents. Then such virtual parents
can be processed like on real objects. They can be viewed, edited, imaged, copied to physical drives, etc.

· Reverse RAID of a RAID
This technique can be used to re-construct data on individual RAID disks when data on physical disks is
corrupted, but can be recovered using RAID redundancy. A missing disk is an example of this case. Or if there
are bad sectors scattered over the physical disks but the overall RAID integrity remains. Then the data can be
copied to physical hard drives to create a healthy RAID.

Note: Many controllers write their own metadata to disks to recognize that the disks belong to certains RAIDs.
Without that metadata they won't see those RAIDs. You have to write that metadata manually.

3.14.1 Reverse RAID of an Object

This technique can be used to decompose data on a single object into virtual parents. Then such virtual parents
can be processed like on real objects. They can be viewed, edited, imaged, copied to physical drives, etc.

Suppose you have an image of a former RAID 6 (Reed-Solomon) and you wand to re-create data on individual
disks from that RAID 6. You can do that by creating a reverse RAID of an  image. 

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Image.html
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Note: Many controllers write their own metadata to disks to recognize that the disks belong to certains RAIDs.
Without that metadata they won't see those RAIDs. You have to write that metadata manually.

To create a reverse RAID of a disk image (or other disk object),

1 Right-click the disk object on the Drives panel and select Create Reverse RAID on the context menu.

> The Reverse parents will appear on the Drives panel

Initially, the reverse RAID is set to its default values as RAID 5 on the Parents tab.

2 Adjust RAID parameters on the Parents tab, as necessary. 

You need to add one reverse parent, change RAID type, and adjust RAID offset .
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> Process the appeared reverse parents  on the Drives panel as real objects.

These parents can be imaged, viewed/edited, etc.

3.14.2 Reverse RAID of a RAID

This technique can be used to re-construct data on individual RAID disks when data on physical disks is
corrupted, but can be recovered using RAID redundancy.

Suppose you have a RAID 5 with one missing hard drive and you need to reconstruct data on that disk. You can
do that by creating a reverse RAID for it and then copy data from that missing disk to a real one, or to an image. 

Note: Many controllers write their own metadata to disks to recognize that the disks belong to certains RAIDs.
Without that metadata they won't see those RAIDs. You have to write that metadata manually.

To create a reverse RAID of a RAID with a missing disk,

1 Create a virtual RAID 5 of the existing hard drives or their images

Add a missing disk to the Parents tab.

https://www.r-studio.com/What-is-Disk-Image.html
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If necessary, read the Basic RAID 4 and RAID 5 Operations and Volumes Sets and RAIDs help pages for
details. 

2 Right-click the Virtual Block Raid on the Drives panel and select Create Reverse RAID on the context
menu.

> The Reverse parents will appear on the Drives panel

These parents may be processed as real objects, they can be imaged, viewed/edited. For your case the
missing disk can be copied to a hard drive in the Drive Copy Wizard.



R-Studio Manual232

© 2025 R-Tools Technology Inc.

Note: The reverse parents contain the data that should be on the RAID parents, according to its layout,
while RAID parents contain actual data, that may be corrupted. 

3.15 Working with Third-Party Hardware

The Technician version of R-Studio for Linux can work together with third-party hardware developed for in-
depth data recovery. Currently, the following devices are supported:

· DeepSpar Devices
· HDDSuperClone

3.15.1 DeepSpar Devices

Currently only the Windows version of R-Studio can directly work with several DeepSpar Disk Imager™
hardware devices for data recovery.

DeepSpar Disk Imager™ (DDI) is an HDD imaging device specifically built for data recovery from hard
drives with hardware issues. It greatly increases imaging speed, accuracy, and integrity of data retrieved from
such drives. 

You may learn more about DDI on its vendor site: DeepSpar Disk Imager™.

DeepSpar USB Stabilizer™, a device that allows any Windows software to reliably work with
unstable/degraded USB storage devices providing a connection between the computer and source device. The
storage devices can be hard drives, SSD devices , USB memory sticks, memory cards connected through a
special adapter, etc. Windows shows such device as if it was connected directly to the system providing access
to it for R-Studio.

You may learn more about USB Stabilizer on its vendor's USB Stabilizer or our sites.

The USB Stabilizer 10Gb™: a further development of the USB Stabilizer .

You may learn more about USB Stabilizer 10Gb on its vendor's USB Stabilizer 10Gb site.

RapidSpar™ is a specialized data recovery device intended to extract data from problematic drives. Failing
(source) and target drives are connected to the device, and it autonomously copies data from the source to the
target in a way that maximizes the amount of successfully extracted data and minimizes possible damage to the
source drive. The copy parameters can be quickly changed during this process directly on the device. Then the
recovery software can read data from the target drive

https://www.r-studio.com/Unformat_Help/deepspar_disk_imager.html
http://ww.deepspar.com/products-ds-disk-imager.html
https://www.r-studio.com/Unformat_Help/usb-stabilizer.html
http://www.deepspar.com/usb-stabilizer.html
http://www.r-studio.com/USB-Stabilizer-for-unstable-drives.html
https://www.r-studio.com/Unformat_Help/usb-stabilizer-10gb.html
https://www.deepspar.com/usb-stabilizer-10gb
https://www.r-studio.com/Unformat_Help/deepspar-rapidspar.html


R-Studio Technician/T80+ 233

© 2025 R-Tools Technology Inc.

You may read more about RapidSpar on its web site.

Viewing the drive map

A drive map shows the conditions for individual disk sectors. You may see which sectors are OK, bad, or
unstable. 

To view the drive map, 

* Right-click the required hard drive/partition and select Show drive map... on the context menu,

> The drive map will appear in the right tab.

 Drive map controls

Sectors The number of the first sector in the row.
Offset Offset in the data. Enter the address you want to jump to and press the Enter key.
Sectors/Bytes/KB... Specifies the dimension of the data in the Offset field.
Previous/Next Moves to the previous/next part of the data.
+/- Zooms into/out of, the data.

To see more detailed information about a particular sector range, right click the corresponding rectangle and

select Information on the context menu.

Click the Open in Hex Editor button to open the selected block in the Text/?hexadecimal editor.

Viewing the file map

A file map shows the conditions for individual file sectors. You may see which sectors are OK, bad, or unstable. 

To view the file map, 

* Right-click the required file and select Map of file... on the context menu,

> The file map will appear in the lower pane.

 File map controls

Sectors The number of the first sector in the row.
Offset Offset in the data. Enter the address you want to jump to and press the Enter key.
Sectors/Bytes/KB... Specifies the dimension of the data in the Offset field.
Previous/Next Moves to the previous/next part of the data.
+/- Zooms into/out of, the data.

To see more detailed information about a particular sector range, right click the corresponding rectangle and

select Information on the context menu.

Click the Open in Hex Editor button to open the selected block in the Text/?hexadecimal editor.

3.15.2 HDDSuperClone

HDDSuperClone from SD Computing Service is a software solution for disk imaging, cloning, and data
extraction tasks. It's specifically designed to work with unstable, faulty, or dying hard drives. It uses several
advanced techniques to extract data from hard drives with bad sectors and other hardware issues while doing
everything possible to avoid inflicting even more damage on the drive being processed. 

It has two modes of operations:

1. The disk cloning/imaging mode: It simply copies data from one disk (the source) to another disk or a file (the
target). It also creates a disk map file (the log) that specifies the sectors that cannot be read (the bad sectors).

https://www.rapidspar.com/
http://www.hddsuperclone.com/sitev1/
https://www.r-studio.com/What-are-Bad-Sectors.html
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Such data may be processed by a third-party data recovery program. This mode is available in both free and
commercial versions, with some small limitations for the former.

2. A virtual drive mode (the commercial version only): In this mode, HDDSuperClone installs a special driver
that creates a virtual drive from the disk. This virtual drive becomes accessible to the host OS and other
programs.

To work with the HDDSuperClone in the virtual drive mode,

1 Connect the source drive and the target drive if such drive is necessary. If the source drive is small, it's
possible to use a disk image file rather than another hard drive.

2 Run HDDSuperClone and create a new project. Next, install the virtual driver before connecting the
source and target. 

As the source drive is small, the target may be an image file in our case. Select the necessary Virtual Mode

and click the Start button.

HDDSuperClone connected to the source drive

https://www.r-studio.com/What-is-Disk-Image.html
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You may read more about installing the driver and configuring HDDSuperClone in its documentation:
HDDSuperClone User Manual.

> A virtual drive will appear in the system

Virtual drive created by HDDSuperClone

And in the Main Panel of R-Studio for Linux

Faulty hard drive and its virtual drive created by HDDSuperClone

You may work with this virtual drive as it is a real physical drive.

You may read more about working with HDDSuperClone in our article Joint work of R-Studio and
HDDSuperClone.

3.16 Forensic Mode

Note: This feature is available for the Technician version of R-Studio for Linux only!

When this mode is enabled, R-Studio for Linux will generate a forensic data collection audit log that can be
presented at court hearings. This log includes information about a hardware configuration on which the forensic
data collection takes place and MD5 for recovered files.

Note: A new log will be generated each time the hardware configuration is changed (a hard drive is
connected/disconnected, an external USB device is connected/disconnected, etc)

http://www.hddsuperclone.com/sitev1/hddsuperclone/manual
https://www.r-studio.com/HDDSuperClone-drive-imaging.html
https://www.r-studio.com/HDDSuperClone-drive-imaging.html
https://www.r-studio.com/What-is-a-Computer-Forensic-Analysis.html
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To enable this feature,

* Select Enable Forensic Mode on the Main tab of the Settings dialog box.

The Forensic Log tab will appear on the Recover dialog box.

Forensic Log tab

Enter the required information on this tab and then go to the other tabs of the Recovery dialog box.

While file recovery, R-Studio will create forensic data collection audit log in the specified folder. Below is an
example of such log.
******************************** Forensic Data Collection Audit Log
********************************

R-Studio

**************************************** Drives Information
****************************************

- Drive Number 0 ---------------------------------
* Drive Type [256 bytes]: Computer,Local Computer
* Name [30 bytes]: Local Computer
* OS [152 bytes]: Linux 5.15.0-43-generic #46~20.04.1-Ubuntu SMP Thu Jul 14 15:20:17
UTC 2022
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* System [132 bytes]: 4 x Intel(R) Core(TM) i3 CPU 530 @ 2.93GHz, 1200 MHz, 3747 MB
RAM

- Drive Number 1 ---------------------------------
* Drive Type [256 bytes]: Physical Drive,Disk
* Name [62 bytes]: KINGSTON SA400S37120G 03090005
* OS Object [18 bytes]: /dev/sda
* R-Studio Driver [10 bytes]: ahci
* Size [8 bytes]: 111.7GB (234441648 sec)
* Logical Sector Size [4 bytes]: 512B
* Physical Sector Size [4 bytes]: 4KB
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 14593
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
# Partition Layout Sector Size [4 bytes]: 512B
+ Device Identification [8 bytes]: 
  * Vendor [32 bytes]: KINGSTON
  * Product [64 bytes]: SA400S37120G
  * Firmware [16 bytes]: 03090005
  * Serial Number [32 bytes]: 50026B77843A5628
+ IDE Properties [8 bytes]: 
  * Size [48 bytes]: 111.7GB (234441648 LBA)
  * Sector Size [8 bytes]: 512
  * Device Type [8 bytes]: SSD
  * Interface [38 bytes]: SATA 3.2, 6.0 Gb/s
  * Interface Speed [18 bytes]: 3.0 Gb/s
  * Standard [12 bytes]: ACS-3
  * Features [70 bytes]: S.M.A.R.T., APM-, LBA48, NCQ, TRIM
* Bus Type [4 bytes]: SerialATA-II

- Drive Number 2 ---------------------------------
* Drive Type [256 bytes]: Physical Drive,Disk
* Name [50 bytes]: SAMSUNG HD642JJ 1AA01110
* OS Object [18 bytes]: /dev/sdb
* R-Studio Driver [10 bytes]: ahci
* Size [8 bytes]: 596.1GB (1250263728 sec)
* Logical Sector Size [4 bytes]: 512B
* Physical Sector Size [4 bytes]: 512B
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4096
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 77825
  * Tracks Per Cylinder [4 bytes]: 255
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  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
# Partition Layout Sector Size [4 bytes]: 512B
+ Device Identification [8 bytes]: 
  * Vendor [32 bytes]: SAMSUNG
  * Product [64 bytes]: HD642JJ
  * Firmware [16 bytes]: 1AA01110
  * Serial Number [32 bytes]: S1AFJ1MQ400283
+ IDE Properties [8 bytes]: 
  * Size [50 bytes]: 596.1GB (1250263728 LBA)
  * Sector Size [8 bytes]: 512
  * Standard [24 bytes]: ATA/ATAPI-7
  * Features [70 bytes]: S.M.A.R.T., APM-, AAM-, LBA48, NCQ
* Bus Type [4 bytes]: SerialATA-II

- Drive Number 3 ---------------------------------
* Drive Type [256 bytes]: Physical Drive,Disk
* Name [66 bytes]: Hitachi HTS545016B9SA00 PBBOC64G
* OS Object [18 bytes]: /dev/sdc
* R-Studio Driver [10 bytes]: ahci
* Size [8 bytes]: 149GB (312581808 sec)
* Logical Sector Size [4 bytes]: 512B
* Physical Sector Size [4 bytes]: 512B
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4096
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 19457
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
# Partition Layout Sector Size [4 bytes]: 512B
+ Device Identification [8 bytes]: 
  * Vendor [32 bytes]: Hitachi
  * Product [64 bytes]: HTS545016B9SA00
  * Firmware [16 bytes]: PBBOC64G
  * Serial Number [32 bytes]: 100713PBPB08ECE4XS0F
+ IDE Properties [8 bytes]: 
  * Size [44 bytes]: 149GB (312581808 LBA)
  * Sector Size [8 bytes]: 512
  * Device Type [36 bytes]: HDD 2.5" 5400 RPM
  * Interface [38 bytes]: SATA 2.6, 1.5 Gb/s
  * Standard [18 bytes]: ATA8-ACS
  * Features [66 bytes]: S.M.A.R.T., APM, AAM, LBA48, NCQ
* Bus Type [4 bytes]: SerialATA-II

- Drive Number 4 ---------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [4 bytes]: /
* Mount Points [4 bytes]: /
* OS Object [20 bytes]: /dev/sda2
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* Size [8 bytes]: 103.4GB (216860672 sec)
* Logical Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 1MB (2048 sec)
* Partition Size [8 bytes]: 103.4GB (216860672 sec)
+ Ext2/Ext3/Ext4 Information [8 bytes]: 
  # FS Character Set [4 bytes]: Utf8
  * Block Size [4 bytes]: 4KB (8 sec)
  * First SuperBlock Offset [4 bytes]: 1KB (2 sec)
  * Blocks Per Volume [8 bytes]: 27107584
  * INodes Per Volume [4 bytes]: 6782976
  * Creator OS [4 bytes]: Linux
  * Major Version [4 bytes]: 1
  * Minor Version [2 bytes]: 0
  * Last Mount Time [8 bytes]: 5.8.2022 18:54:4
  * Last Write Time [8 bytes]: 5.8.2022 18:54:3
  * Last Check Time [8 bytes]: 12.7.2022 15:43:7
  * Volume Size [8 bytes]: 103.4GB (216860672 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4096
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 13498
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B

- Drive Number 5 ---------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [12 bytes]: /home
* Mount Points [12 bytes]: /home
* OS Object [20 bytes]: /dev/sdb1
* Size [8 bytes]: 596.1GB (1250260992 sec)
* Logical Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 1MB (2048 sec)
* Partition Size [8 bytes]: 596.1GB (1250260992 sec)
+ Ext2/Ext3/Ext4 Information [8 bytes]: 
  # FS Character Set [4 bytes]: Utf8
  * Block Size [4 bytes]: 4KB (8 sec)
  * First SuperBlock Offset [4 bytes]: 1KB (2 sec)
  * Blocks Per Volume [8 bytes]: 156282624
  * INodes Per Volume [4 bytes]: 39075840
  * Creator OS [4 bytes]: Linux
  * Major Version [4 bytes]: 1
  * Minor Version [2 bytes]: 0
  * Last Mount Time [8 bytes]: 5.8.2022 18:54:14
  * Last Write Time [8 bytes]: 5.8.2022 18:54:14
  * Last Check Time [8 bytes]: 6.2.2022 12:42:58
  * Volume Size [8 bytes]: 596.1GB (1250260992 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
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  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4096
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 77825
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B

- Drive Number 6 ---------------------------------
* Drive Type [256 bytes]: Partition,Primary
* Name [22 bytes]: Partition1
* Size [8 bytes]: 8.38GB (17577984 sec)
* Partition Offset [8 bytes]: 103.4GB (216862720 sec)
* Partition Size [8 bytes]: 8.38GB (17577984 sec)
* Partition Type [256 bytes]: Linux (swap) (0x82)

- Drive Number 7 ---------------------------------
* Drive Type [256 bytes]: Partition,Active
* Name [22 bytes]: Partition2
* Mount Points [4 bytes]: /
* Size [8 bytes]: 103.4GB (216860672 sec)
* Partition Offset [8 bytes]: 1MB (2048 sec)
* Partition Size [8 bytes]: 103.4GB (216860672 sec)
* Partition Type [256 bytes]: Ext2FS/XIAFS (0x83)
+ Ext2/Ext3/Ext4 Information [8 bytes]: 
  # FS Character Set [4 bytes]: Utf8
  * Block Size [4 bytes]: 4KB (8 sec)
  * First SuperBlock Offset [4 bytes]: 1KB (2 sec)
  * Blocks Per Volume [8 bytes]: 27107584
  * INodes Per Volume [4 bytes]: 6782976
  * Creator OS [4 bytes]: Linux
  * Major Version [4 bytes]: 1
  * Minor Version [2 bytes]: 0
  * Last Mount Time [8 bytes]: 5.8.2022 18:49:39
  * Last Write Time [8 bytes]: 5.8.2022 18:54:3
  * Last Check Time [8 bytes]: 12.7.2022 15:43:7
  * Volume Size [8 bytes]: 103.4GB (216860672 sec)

- Drive Number 8 ---------------------------------
* Drive Type [256 bytes]: Partition,Primary
* Name [22 bytes]: Partition1
* Mount Points [12 bytes]: /home
* Size [8 bytes]: 596.1GB (1250260992 sec)
* Partition Offset [8 bytes]: 1MB (2048 sec)
* Partition Size [8 bytes]: 596.1GB (1250260992 sec)
* Partition Type [256 bytes]: Ext2FS/XIAFS (0x83)
+ Ext2/Ext3/Ext4 Information [8 bytes]: 
  # FS Character Set [4 bytes]: Utf8
  * Block Size [4 bytes]: 4KB (8 sec)
  * First SuperBlock Offset [4 bytes]: 1KB (2 sec)
  * Blocks Per Volume [8 bytes]: 156282624
  * INodes Per Volume [4 bytes]: 39075840
  * Creator OS [4 bytes]: Linux
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  * Major Version [4 bytes]: 1
  * Minor Version [2 bytes]: 0
  * Last Mount Time [8 bytes]: 5.8.2022 18:54:14
  * Last Write Time [8 bytes]: 5.8.2022 18:54:14
  * Last Check Time [8 bytes]: 6.2.2022 12:42:58
  * Volume Size [8 bytes]: 596.1GB (1250260992 sec)

- Drive Number 9 ---------------------------------
* Drive Type [256 bytes]: Partition,Primary
* Name [22 bytes]: Partition1
* Size [8 bytes]: 52GB (109121536 sec)
* Partition Offset [8 bytes]: 512KB (1024 sec)
* Partition Size [8 bytes]: 52GB (109121536 sec)
* Partition Type [256 bytes]: NTFS/HPFS/exFAT (0x7)
+ NTFS Information [8 bytes]: 
  * Cluster Size [4 bytes]: 2KB (4 sec)
  * MFT Record Size [4 bytes]: 1KB
  * MFT Position [8 bytes]: 12KB (24 sec)
  * MFT Mirror Position [8 bytes]: 302KB (604 sec)
  * Index Block Size [4 bytes]: 4KB
  * Sector Size [4 bytes]: 512B
  * Volume Size [8 bytes]: 52GB (109121535 sec)

- Drive Number 10 --------------------------------
* Drive Type [256 bytes]: Partition,Primary
* Name [22 bytes]: Partition2
* Size [8 bytes]: 36.7GB (77139794 sec)
* Partition Offset [8 bytes]: 52GB (109126110 sec)
* Partition Size [8 bytes]: 36.7GB (77139794 sec)
* Partition Type [256 bytes]: FAT32 (0xb)
+ FAT Information [8 bytes]: 
  * FAT Bits (12,16,32) [4 bytes]: 32
  * Cluster Size [4 bytes]: 4KB (8 sec)
  * First Cluster Offset [8 bytes]: 73.4MB (150392 sec)
  * Root Directory Cluster [4 bytes]: 2
  * First FAT Offset [8 bytes]: 19KB (38 sec)
  * Size of One FAT Table [8 bytes]: 36.7MB (75185 sec)
  * Number of FAT Copies [4 bytes]: 2
  # Active FAT copy [4 bytes]: Auto
  * Sector Size [4 bytes]: 512B
  * Major Version [1 bytes]: 0
  * Minor Version [1 bytes]: 0
  * Volume Size [8 bytes]: 36.7GB (77139794 sec)

- Drive Number 11 --------------------------------
* Drive Type [256 bytes]: Partition,Primary
* Name [22 bytes]: Partition3
* Size [8 bytes]: 2GB (4210688 sec)
* Partition Offset [8 bytes]: 88.8GB (186265904 sec)
* Partition Size [8 bytes]: 2GB (4210688 sec)
* Partition Type [256 bytes]: FAT16 (big) (0x6)
+ FAT Information [8 bytes]: 
  * FAT Bits (12,16,32) [4 bytes]: 16



R-Studio Manual242

© 2025 R-Tools Technology Inc.

  * Cluster Size [4 bytes]: 32KB (64 sec)
  * First Cluster Offset [8 bytes]: 209KB (418 sec)
  * Root Directory Offset [8 bytes]: 263168
  * Root Directory Length [4 bytes]: 16KB
  * First FAT Offset [8 bytes]: 1KB (2 sec)
  * Size of One FAT Table [8 bytes]: 128KB (256 sec)
  * Number of FAT Copies [4 bytes]: 2
  # Active FAT copy [4 bytes]: Auto
  * Sector Size [4 bytes]: 512B
  * Major Version [1 bytes]: 0
  * Minor Version [1 bytes]: 0
  * Volume Size [8 bytes]: 1.99GB (4193698 sec)

- Drive Number 12 --------------------------------
* Drive Type [256 bytes]: Partition,Logical
* Name [22 bytes]: Partition4
* Size [8 bytes]: 11.7GB (24576000 sec)
* Partition Offset [8 bytes]: 90.8GB (190480384 sec)
* Partition Size [8 bytes]: 11.7GB (24576000 sec)
* Partition Type [256 bytes]: NTFS/HPFS/exFAT (0x7)
+ FAT Information [8 bytes]: 
  * FAT Bits (12,16,32) [4 bytes]: 32
  * Cluster Size [4 bytes]: 8KB (16 sec)
  * First Cluster Offset [8 bytes]: 11.9MB (24544 sec)
  * Root Directory Cluster [4 bytes]: 2
  * First FAT Offset [8 bytes]: 299KB (598 sec)
  * Size of One FAT Table [8 bytes]: 5.85MB (11989 sec)
  * Number of FAT Copies [4 bytes]: 2
  # Active FAT copy [4 bytes]: Auto
  * Sector Size [4 bytes]: 512B
  * Major Version [1 bytes]: 0
  * Minor Version [1 bytes]: 0
  * Volume Size [8 bytes]: 11.7GB (24576000 sec)

- Drive Number 13 --------------------------------
* Drive Type [256 bytes]: Partition,Logical
* Name [22 bytes]: Partition5
* Size [8 bytes]: 21.4GB (45056000 sec)
* Partition Offset [8 bytes]: 102.5GB (215058432 sec)
* Partition Size [8 bytes]: 21.4GB (45056000 sec)
* Partition Type [256 bytes]: Mac OS X HFS+ (0xaf)
+ HFS/HFS+ Information [8 bytes]: 
  * HFS Type [64 bytes]: HFS+, Case-sensitive, Journaled
  * Block Size [4 bytes]: 4KB (8 sec)
  * HFS Version [4 bytes]: 5
  * Create Time [8 bytes]: 4.3.2022 21:7:1
  * Last Write Time [8 bytes]: 2.5.2022 12:58:2
  * Last Check Time [8 bytes]: 4.3.2022 18:7:1
  * Volume Size [8 bytes]: 21.4GB (45056000 sec)

- Drive Number 14 --------------------------------
* Drive Type [256 bytes]: Partition,Logical
* Name [22 bytes]: Partition6
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* Size [8 bytes]: 25GB (52461568 sec)
* Partition Offset [8 bytes]: 124GB (260116480 sec)
* Partition Size [8 bytes]: 25GB (52461568 sec)
* Partition Type [256 bytes]: Ext2FS/XIAFS (0x83)
+ Ext2/Ext3/Ext4 Information [8 bytes]: 
  # FS Character Set [4 bytes]: Utf8
  * Block Size [4 bytes]: 4KB (8 sec)
  * First SuperBlock Offset [4 bytes]: 1KB (2 sec)
  * Blocks Per Volume [8 bytes]: 6557696
  * INodes Per Volume [4 bytes]: 1640160
  * Creator OS [4 bytes]: Linux
  * Major Version [4 bytes]: 1
  * Minor Version [2 bytes]: 0
  * Last Mount Time [8 bytes]: 3.5.2022 16:40:24
  * Last Write Time [8 bytes]: 3.5.2022 16:41:17
  * Last Check Time [8 bytes]: 4.3.2022 18:10:17
  * Volume Name [16 bytes]: EXTFS
  * Volume Size [8 bytes]: 25GB (52461568 sec)

- Drive Number 15 --------------------------------
* Drive Type [256 bytes]: Empty Space
* Name [28 bytes]: Empty Space15
* Size [8 bytes]: 1.82MB (3729 sec)
* Partition Offset [8 bytes]: 90.8GB (190476592 sec)
* Partition Size [8 bytes]: 1.82MB (3729 sec)

************************************************************************************
****************

-------------------------------------------- Session 1
---------------------------------------------
START Date / Time of Collection: 2022-08-05 15:04:59

Case Name: Steven vs. Christofer
Case Number: 28-5-0205-CR-85763
Operator / Investigator Name: J.F. Lewson

Source drive:Sector Modification Date    MD5                                
SHA-1                                   SHA-256                            

                            File Name
  9                 2011-04-05 15:42:13  Root/Docs
  9                 2011-03-01 09:41:14  1b81a7a90fd69e59098737fef990733c   

1c9c6f7f4ba9818a06fb84f19e331c1f20af9f02
710ae48e42cabf8379b55823db8a55737bbd64922c9bfa084bdafb74dd9d83c5
Root/Docs/MyDoc1.odt
    DATA: DATA (Non-Resident)
         2268-2315
  9                 2011-02-28 15:31:02  1b81a7a90fd69e59098737fef990733c   

1c9c6f7f4ba9818a06fb84f19e331c1f20af9f02
710ae48e42cabf8379b55823db8a55737bbd64922c9bfa084bdafb74dd9d83c5
Root/Docs/MyDoc2.odt
    DATA: DATA (Non-Resident)
         2316-2363
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  9                 2011-02-28 15:31:10  10bb34bb18ca4d30d577bbd7833f6f28   
621b7baacb7ed059e7aec486ba0bcc18e0b2a894

d5f57625ea06ebad876318b42d5a6a9f35dd2974c0639076210a3b377a9d69bc
Root/Docs/MyDoc3.odt
    DATA: DATA (Non-Resident)
         2020080-2383343
  9                 2022-03-04 13:25:38  Root/Documents
    $I30: INDEX_ALLOC (Non-Resident)
         2992312-2992319
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-files
    $I30: INDEX_ALLOC (Non-Resident)
         2972848-2972855
  9                 2022-03-04 13:25:37  Root/Documents/OpenOffice-
files/Calc-files
    $I30: INDEX_ALLOC (Non-Resident)
         2438980-2438987
  9                 2022-03-04 13:25:37  Root/Documents/OpenOffice-
files/Calc-files/ods-files
    $I30: INDEX_ALLOC (Non-Resident)
         2955404-2955411
  9                 2020-04-06 19:21:52  b1eb4cc9101bcb86c0042231f898f0ae   

8e5da7978ebe26604b5f556ec2d20a4ce1176ff1
4d226d7f3c0e1c874f0aaf772f9a5cf9bed2c7d982906a4a0314c206cbc4bb35
Root/Documents/OpenOffice-files/Calc-files/ods-files/.DS_Store
    DATA: DATA (Non-Resident)
         2955388-2955403
  9                 2020-04-06 19:18:30  eab006354c7cf4e1fd3772afd0643672   

bfc7b3368a46a640c3145646b0dfad10bb89f096
4709af13b6dbaf11feab0750bc2a3734eab9a94e184bd7f736805adcb02ac368
Root/Documents/OpenOffice-files/Calc-files/ods-files/file_example_ods_10.ods
    DATA: DATA (Non-Resident)
         2972768-2972795
  9                 2020-04-06 19:20:50  94790aeb545e806ea9cf161f6ae2697f   

152a13f940c2dfa4530b1b022897cb3dbd0cb45b
edb79e7965f6b61722f1c6427200e4ba44692e573b2f2f8cd210f356aed7f3c9
Root/Documents/OpenOffice-files/Calc-files/ods-files/file_example_ods_1000.ods
    DATA: DATA (Non-Resident)
         2945868-2945967
  9                 2020-04-06 19:19:47  000389561d71032e79411613d73f01f5   

3e9fdd1b26eed17f40e98a0f8d13af11decdf951
b668e04c130d51d023531482c8067b5232284decdf54760c6ae431e3718388c3
Root/Documents/OpenOffice-files/Calc-files/ods-files/file_example_ods_50.ods
    DATA: DATA (Non-Resident)
         2972796-2972823
  9                 2020-04-06 19:21:44  28aa35b07f4a28f4f001e28f277dd1be   

f9dfcafc3e9b6c1c15a949ab9150b8e7d599f1d6
069ad480df6dba6de101188dc126f688127206932d98f02149eb390b6e8f2928
Root/Documents/OpenOffice-files/Calc-files/ods-files/file_example_ods_5000.ods
    DATA: DATA (Non-Resident)
         3047196-3047567
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-
files/Calc-files/oxlsx-files
    $I30: INDEX_ALLOC (Non-Resident)
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         2972840-2972847
  9                 2020-04-06 19:31:06  c763a032a1999d42934abebc25fc6a83   

07c1d02aa03ae7768dfb88445bff68e9c32c2264
208fef9240237b668cbb927255a8f204e6ab808a68701ffe72bf3ca85e4d13e1
Root/Documents/OpenOffice-files/Calc-files/oxlsx-files/.DS_Store
    DATA: DATA (Non-Resident)
         2972824-2972839
  9                 2020-04-06 19:25:50  f893b7290b96905f0776e0e1cb4b91c4   

d80a4175a6a2767b61fe8e2b33774bd211b6a934
ab82e943104f1edfa17b58595b4221c02ddf93aa4056fa630473de192f85d1fe
Root/Documents/OpenOffice-files/Calc-files/oxlsx-files/file_example_OXLSX_10.xlsx
    DATA: DATA (Non-Resident)
         2947864-2947875
  9                 2020-04-06 19:30:27  be99eeaa2e2aa77ecb4d7b9eeff44cb4   

1aad45945f99a02383e168e339a20d38999491b6
cd6583c0aa16dde7342c4dc5483987edf173d7378ce946ded7383bbf4b5990ba
Root/Documents/OpenOffice-files/Calc-files/oxlsx-files/file_example_OXLSX_100.xlsx
    DATA: DATA (Non-Resident)
         2945968-2945987
  9                 2020-04-06 19:30:10  2280cba8bea0ded6bf9c428939f9cb32   

4aee4fe0add47392f508fef28af3f5c02a9eb4a2
59da4d0e97a54c462fcf34268b14a4214ef324da368712a0a32678c976e89484
Root/Documents/OpenOffice-files/Calc-files/oxlsx-files/file_example_OXLSX_50.xlsx
    DATA: DATA (Non-Resident)
         2945988-2946003
  9                 2020-04-06 19:30:42  980e7a175ea67333379753a788d331e5   

c90c1841006b8da26e69636596c7a8e5fcc26ec6
0d66f10f1b76f620d69e4054eeab6669f2e64b0b2fa5e3365101027aa5b657e7
Root/Documents/OpenOffice-files/Calc-files/oxlsx-files/file_example_OXLSX_5000.xlsx
    DATA: DATA (Non-Resident)
         3047568-3047939
  9                 2020-04-06 19:23:13  db42bc048678d194bda93124fcc1e359   

9f7137c6703b51cd78a797b56b5f2a2e7c8b83ea
433476459c23ba979ab467ce4c310e29a40e3b9a8d68dd63467b503ddc4cdf23
Root/Documents/OpenOffice-files/Calc-files/.DS_Store
    DATA: DATA (Non-Resident)
         2955948-2955963
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-
files/Microsoft-files
    $I30: INDEX_ALLOC (Non-Resident)
         3050316-3050323
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-
files/Microsoft-files/Excel-files
    $I30: INDEX_ALLOC (Non-Resident)
         2946172-2946179
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-
files/Microsoft-files/Excel-files/xls-files
    $I30: INDEX_ALLOC (Non-Resident)
         2946164-2946171
  9                 2020-04-06 19:13:48  7901a6038143aa293bff65c1dcc564a9   

13c30d142999708f8b0f3b71bce35c1c91304032
ad75eff3191cbb4e3215b25ce1733f062f474ff6aa242db82de391eada0f114e
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-files/.DS_Store
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    DATA: DATA (Non-Resident)
         2946040-2946055
  9                 2018-10-19 14:12:18  01a42d82b4e2e143876cc0afea4883ed   

3cc9264c3a5569c08abfb9ee343dba1bf96f1b3d
be198ae04df0476e6a8153e4b396da05c9badef729f87f1abbb626f8bfae8491
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-
files/file_example_XLS_10.xls
    DATA: DATA (Non-Resident)
         2946056-2946095
  9                 2018-10-19 14:14:00  efcb6e746de385a6ba15f9e697503f4c   

96451e09d24aacaab7c00292316020ecd8090dbf
8562df19f14cb945b769a0812fb1afd5acd9e349f0cdd71150282202d71319ee
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-
files/file_example_XLS_100.xls
    DATA: DATA (Non-Resident)
         2946096-2946163
  9                 2018-10-19 14:14:56  f9773bf0bd611c8a9107140956b3881f   

7a538e2ca18bb7cb0c2fb0130767012f7acd9019
d3107cae4af0231540887be840135ec03763d83926c2900fb76aead0226787ca
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-
files/file_example_XLS_1000.xls
    DATA: DATA (Non-Resident)
         3047940-3048243
  9                 2018-10-19 14:13:23  b3df6dd6764416491f51415c4ccf1aaf   

eea1bebb11f6beab8f38bc2b1705dbf598bcbfa6
a7beba6217ffa60c9e79f0310d024a74cbaf363d7b884d214178e413e758b68e
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-
files/file_example_XLS_50.xls
    DATA: DATA (Non-Resident)
         3048244-3048295
  9                 2018-10-19 14:15:24  ecb548b885ec5cf6f6e38ece80fa5f2e   

5ddffe520563c9b9c26a7c297c99b2e896e891d0
bc8d33d7033eb858dd63ae4882d4381fb9fe85c0740fd41efb9a309fca9e366f
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-
files/file_example_XLS_5000.xls
    DATA: DATA (Non-Resident)
         3048296-3049659
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-
files/Microsoft-files/Excel-files/xlsx-files
    $I30: INDEX_ALLOC (Non-Resident)
         3049708-3049715
  9                 2020-04-06 19:16:33  8f9765363a3610383bbafb7ed7e8928c   

075e8f3a721f3d733c20e897c3e9db0c907322b7
9320252c62acfa865ebd315c1597d767f9ebc16ea410bff7e3d2e479bdcde088
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-files/.DS_Store
    DATA: DATA (Non-Resident)
         2946180-2946195
  9                 2018-10-19 14:16:15  bd5ec17de931c601b3231fdb4eac6db6   

2a647da6430913fa47cfd7874721f0832bb91f52
584bd2879378c518796f4422f8ed41c971798e76c5ee58c307fc3d40adb03eaa
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-
files/file_example_XLSX_10.xlsx
    DATA: DATA (Non-Resident)
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         3049660-3049679
  9                 2018-10-19 14:17:58  43cb8b1c3ede97eaeb779d0bc7d03710   

41360a2a5d2f8a2aaacd2ae503ea754fc33d93f4
97e004974d26f04bf7bf960d5b4e33f2f59a81d79e95526804f5b570f819eacb
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-
files/file_example_XLSX_100.xlsx
    DATA: DATA (Non-Resident)
         3049680-3049707
  9                 2018-10-19 14:18:45  513e4fac7ff88720001864d1a350ed1c   

87e9c39ea24c1949cca6f68ff42cdb8208c32a13
14fed5fcf63206d7f5bd275058b7d79184ce187b062fcdab5d9ff77b4ea19502
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-
files/file_example_XLSX_1000.xlsx
    DATA: DATA (Non-Resident)
         3049716-3049823
  9                 2018-10-19 14:16:44  775654d96ef34c95ce1a60e9606977e9   

1954ba25e67edc407955203d21aeb8c3a99d272f
e40aeadfebe57e3be87ac46260ad09ec1c4c030b95eef2af767382d0fe79198a
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-
files/file_example_XLSX_50.xlsx
    DATA: DATA (Non-Resident)
         3049824-3049847
  9                 2018-10-19 14:19:09  ea38c0c454aa508b5909161bd8260918   

e566e8c34a723ad44431cc3f0fdbf3bce18410e5
acbd5c728f2738a70f59c245c961eb8122d59aa07b7debdc7d348efe472b650b
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-
files/file_example_XLSX_5000.xlsx
    DATA: DATA (Non-Resident)
         3049848-3050315
  9                 2020-04-06 19:31:14  52d71be9d0971685678823c546b72eff   

1930f5ed939a35965802a508afb3865810e7e0af
8ffc5293b616b558264fdb2277fb6a8d032ebecaf6b678b491ddcfdef1a3f9f2
Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/.DS_Store
    DATA: DATA (Non-Resident)
         2946020-2946039
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-
files/Microsoft-files/Word-files
    $I30: INDEX_ALLOC (Non-Resident)
         3054572-3054579
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-
files/Microsoft-files/Word-files/Doc-files
    $I30: INDEX_ALLOC (Non-Resident)
         3051564-3051571
  9                 2020-04-06 19:12:41  34b20ad44b5d33cc3401b0ca1c9c55ad   

236a6271d535ea5149eca9fe73e939900968c019
9cc166b17367418d3af128bd74ae79c7b0a20c0a1fd19c4d458c1834897905db
Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files/.DS_Store
    DATA: DATA (Non-Resident)
         3050340-3050355
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  9                 2018-10-19 14:10:23  759cbcd3d7c574ec4de97222bc407665   
1308c158c06c9050ffa3f0f5898a5ccf4a94c8c7

3fbfda0b36c4edc4b4d48ec5c0425ced04ed15c6e3891495201a7289533a2ce2
Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-
files/DOCFile_500kb.doc
    DATA: DATA (Non-Resident)
         3050356-3051359
  9                 2018-10-19 14:20:26  35176f9b7f521954445100e5df74dee9   

5aee31c3f490b421e75548ea713a6755818980db
f907aadb6b9b38c8e19eaf44aa11796051eeac35d0d2115246449da98f1137f7
Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files/file-sample-
doc_100kB.doc
    DATA: DATA (Non-Resident)
         3051360-3051563
  9                 2018-10-19 14:19:59  bb8c0ad499fc64837a45154a27e07734   

1e09acf84e23e9eddb152f812354785e2f7cd159
2bcd9c011678a8aa7045a6485bef7872c4295fbb6c2467cc29135ffcc769457b
Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files/file-sample-
doc_1MB.doc
    DATA: DATA (Non-Resident)
         3051572-3053587
  9                 2018-10-19 14:21:18  e16fb51cef336edf2c19d065ef49a662   

15bfff84aea3602cd0ec81bd7ac9789a969c3528
41f65cf10d9b0b42d12307a46b66ae632e6d883e067db5959969822780823d7a
Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files/file-sample-
doc_500kB.doc
    DATA: DATA (Non-Resident)
         3053588-3054571
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-
files/Microsoft-files/Word-files/Docx-files
    $I30: INDEX_ALLOC (Non-Resident)
         3055528-3055535
  9                 2020-04-06 19:12:41  0717f9af8c983c9af7d5fb9d311ab163   

0ce1f83b661658d58caee54b75ede278a30e0927
359246310af6c9ff8c7192b637ae949a8c388f1c9b684d46c1ea013d4fcafffb
Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files/.DS_Store
    DATA: DATA (Non-Resident)
         3054580-3054595
  9                 2018-10-19 14:11:20  96d043aabc6bdad1046db4c47aa7a3a8   

7705c94a188ecebd1be2f68f70687b1ef7360d21
9383ce8098236174683cefab77cbddfe8cc17d8656b4e87281e783ce55b76d52
Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-
files/DOCXFile_500kb.docx
    DATA: DATA (Non-Resident)
         3054596-3055279
  9                 2018-10-19 14:22:33  0815c2eb26ab3ad59fab1ccba9d18fd0   

20898f28011ae05f5062e09690b292ed13fbbf20
acd7fe4a7ee20c77b48489be5b9dbad8a850a2b29af721c912f6993e238b5471
Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files/file-sample-
docx_100kB.docx
    DATA: DATA (Non-Resident)
         3055280-3055527
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  9                 2018-10-19 14:21:55  9a1485d3bca8dd88cb67f248c0144d0b   
0dcff5af4a39b3d57e964ead8a004636c3a276f4

98983b17e3562d015ac1c1a6f9d9971090303c04d0d70d6729416d376385eb2b
Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files/file-sample-
docx_1MB.docx
    DATA: DATA (Non-Resident)
         3055536-3057619
  9                 2018-10-19 14:23:09  183a5dc1a099e3c8c0b54c6aa52d64b7   

1266501c54bdea72f239925138a61a62a9f8b2ba
ff010e8d024e80c14901ea9ac618f253862667e7a69f69b070002cbc74df9f58
Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files/file-sample-
docx_500kB.docx
    DATA: DATA (Non-Resident)
         3057620-3058751
  9                 2020-04-06 19:44:01  8b1836fc208a9ab78cb95bc0d00b6256   

c6f205d3920442756681d4bc1c3091dae0b69466
5dba5fad9c2bf25ea40190fb34594641a66e44d4fd40a7cabf9ea11862e6246a
Root/Documents/OpenOffice-files/Microsoft-files/Word-files/.DS_Store
    DATA: DATA (Non-Resident)
         3050324-3050339
  9                 2020-04-06 19:44:31  b6e071bf10615607b95d544a2022d187   

199662a8e3916924b81b13ac8ae705f3c581cec9
c988d303b52f36214ce9464a07df2dbf114b6820971eddd987668e89bb0167a6
Root/Documents/OpenOffice-files/Microsoft-files/.DS_Store
    DATA: DATA (Non-Resident)
         2946004-2946019
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-
files/Writer-files
    $I30: INDEX_ALLOC (Non-Resident)
         3062596-3062603
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-
files/Writer-files/odocx-files
    $I30: INDEX_ALLOC (Non-Resident)
         3061716-3061723
  9                 2020-04-06 19:33:22  70b4b7f69342042902032114b234fa03   

79bfe4ccde5838e150a0f236b9c7478104b9cd09
2dd6ea9aef467ef368f7024e22ae3ea03d3e4f73949c0e1ee7cb055779c596a7
Root/Documents/OpenOffice-files/Writer-files/odocx-files/file-sample-
odocx_100kB.docx
    DATA: DATA (Non-Resident)
         3058768-3058911
  9                 2020-04-06 19:36:02  e579cd58b1ac23749e4251835bc0f610   

e8d59c3b4ea9f4c08c4e59031736a578d728dff6
1c0f9edf45a390e0d279a1d10da038e374b515cef3e5c077c8bae99e3dd4a5cc
Root/Documents/OpenOffice-files/Writer-files/odocx-files/file-sample-odocx_1MB.docx
    DATA: DATA (Non-Resident)
         3058912-3060811
  9                 2020-04-06 19:36:58  0a64c077c83153e159aa45906220ff3e   

ca27738f86b01900b3b94e19bd99003fb47a5c80
05100d4633bff3a8809b8b075ecbb7e9dd22f94148307faabad972ee8c8307d7
Root/Documents/OpenOffice-files/Writer-files/odocx-files/file-sample-
odocx_500kB.docx
    DATA: DATA (Non-Resident)
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         3060812-3061715
  9                 2020-04-06 19:34:45  f1dbf4f7ad95d39ccc0f877d9b887afa   

c6b1149ecbd1303d75868e19643e61c60a822808
fb723512f7f3f166cb0013f3160d98b648719f08bc6dcde7db5043277cb1ca85
Root/Documents/OpenOffice-files/Writer-files/odocx-files/ODOCXFile_500kb.docx
    DATA: DATA (Non-Resident)
         3061724-3062595
  9                 2022-03-04 13:25:38  Root/Documents/OpenOffice-
files/Writer-files/odt-files
    $I30: INDEX_ALLOC (Non-Resident)
         3064956-3064963
  9                 2020-04-06 19:43:34  d4c494a030d81983196866482a5597fe   

46aa85342a8d01ae27ea91965ce088813a4410ed
8fcb878c093e2f4652b632bb347b3f69db28ece431801b9651b3809b47ff16e4
Root/Documents/OpenOffice-files/Writer-files/odt-files/.DS_Store
    DATA: DATA (Non-Resident)
         3062604-3062619
  9                 2020-04-06 19:40:21  c3e2b9d976977ec25d6347ed02673120   

c913470ca428305f83c37c34a17cdf79903a3248
455b56ea7a3bd759f917b8e3a3d16b567f10ada93c8202ddee8945db150bf810
Root/Documents/OpenOffice-files/Writer-files/odt-files/file-sample-odt_100kB.odt
    DATA: DATA (Non-Resident)
         3062620-3062863
  9                 2020-04-06 19:42:33  5f1e8dfdac3fc3133511a75f26001854   

7a26c32e318fa96d08c4515122c197e7bf7397ba
23a5d871d288d0b5bd3a65747e2dc6bba4689a9c67ccf8e609e8d8ce9af74336
Root/Documents/OpenOffice-files/Writer-files/odt-files/file-sample-odt_1MB.odt
    DATA: DATA (Non-Resident)
         3062864-3064955
  9                 2020-04-06 19:41:23  324dd4fe1e621090a5dfe7e0c7680050   

c070a68cce81d1058838a5438a91c3a6bff11fa5
de09f89e254cc5ecc388ba278cf2f224067e9fbc9c64ae3009adf565fcc798c6
Root/Documents/OpenOffice-files/Writer-files/odt-files/file-sample-odt_500kB.odt
    DATA: DATA (Non-Resident)
         3064964-3066095
  9                 2020-04-06 19:43:29  b45be240cb18dda2cd78caee72891837   

06bb21bd6ffd5eae59034e4cf9533076ccb68bb5
ed39112cdf37ddc805e39b9edb033fd97dcce179831c1392a2a59e46f85a0796
Root/Documents/OpenOffice-files/Writer-files/odt-files/ODTFile_500kb.odt
    DATA: DATA (Non-Resident)
         3066096-3066611
  9                 2020-04-06 19:37:14  14a0ca21163393f57c739e278f95dfde   

cc80e712df7b497601fb5ab86c23f4d6ebd8db0c
b4c09d792b41a04e369df0ccdd202eba89a11c9f1530a62be60183379cd85335
Root/Documents/OpenOffice-files/Writer-files/.DS_Store
    DATA: DATA (Non-Resident)
         3058752-3058767
  9                 2020-04-06 19:34:59  229601a0b29ad34773e4891161a14e2b   

e0a791be31e35348bac1d6840e27e8e47c730f98
2c6a0a942b9466457708117adfecb2408b24b214cd595fd00a850a8cca2a8d26
Root/Documents/OpenOffice-files/.DS_Store
    DATA: DATA (Non-Resident)
         2953248-2953263
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  9                 2022-03-04 13:25:38  Root/Documents/pdf
    $I30: INDEX_ALLOC (Non-Resident)
         3070908-3070915
  9                 2018-10-19 14:31:09  cafaa4fe6206c58f5dec13c3ea9d0371   

7ed087345df3071191fbb455470a4ae8e4b423e7
2a42cd96488ebc2e8fd807008726dee7ab1709c007fa9abe8affbc5843591bb0
Root/Documents/pdf/file-sample-pdf_100kB.pdf
    DATA: DATA (Non-Resident)
         3066612-3067131
  9                 2018-10-19 14:28:32  f75c9215162661abdd9cd1aa11d792e6   

06dcbad6d7184b39925fb0a19f55b4a9ce3f297b
0da983da280865ec4ef11497f7ae9a3322d36b88a12b419e90109774ae50d40f
Root/Documents/pdf/file-sample-pdf_1MB.pdf
    DATA: DATA (Non-Resident)
         3067132-3069495
  9                 2018-10-19 14:30:08  23d2d7627d3edbc66586726cbd4225b1   

34d580da967fbc3ba1bc54e59da11b7183afffb6
0dce6c42b677f621d5f8ac8abbfad0ed7d69e7e18e1f328c9276453e2b57680b
Root/Documents/pdf/file-sample-pdf_500kB.pdf
    DATA: DATA (Non-Resident)
         3069496-3070907
  9                 2018-10-19 15:05:41  2cea8c95dc5f5db6065f704068292867   

6628857689d03f6e0b52cdaef20c9be4f17d0f79
5e147079d557fe26de3dbdf0c5c7aab4ac18ec13d4e31bea320d1167475dae0c
Root/Documents/pdf/large_pdf.pdf
    DATA: DATA (Non-Resident)
         2439500-2469391
  9                 2018-10-19 14:49:27  4bfa34445fe5e92cee0d4be1c4b6afbd   

4c166dd5ad455053664bb095fbed5238f5a17a68
1284a8bd83fa65802aa0ee0d7ca77a008c6db18cbd288f1b1f1319aae703fa4a
Root/Documents/pdf/PDFFile_500kb.pdf
    DATA: DATA (Non-Resident)
         3070916-3073503
  9                 2018-06-22 14:08:57  b05a97e064cc54b99daba53bde958d58   

31249aec7b1e9dd55828b296f3626c5654071860
b0e8e10fc34b366dfa1709719cd737745581fb277a82509a60518cb5e6c8ddfc
Root/Documents/easychair.docx
    DATA: DATA (Non-Resident)
         3002580-3007051
  9                 2013-06-26 11:00:33  0a4ffa384ae31d33a801acc0e1746e65   

f09aedad237560fe3fc2d255d39520923cab91f2
6387b9576f369e587e7c810df976b29ededf8c4f7e3f1d6662b7ccd78dc4a521
Root/Documents/Mac_mini_Early2009_UG.pdf
    DATA: DATA (Non-Resident)
         3007052-3013299
  9                 2013-06-26 10:58:08  12ab314eb73a4a938bed3d6550da0ff2   

22b0141246f4f5c7cf20171645c0f8de596cb35a
eada5fecc16cb98c28c54b080319ff79eb20b62a313ed4b6ba5c254a4a3ede7e
Root/Documents/Mac_mini_Intel-based_Mid2007_UserGuide.pdf
    DATA: DATA (Non-Resident)
         3013300-3015047
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  9                 2013-06-26 10:56:33  bcb1278d0441dd482bc9aafb57abe8a6   
790de86e64018a72d48b97ed9281d9bbe036d728

b9aa929d68b88288d49fa4850143e18120c67d55c81c8733e605a639637cdb7c
Root/Documents/Mac_mini_Intel_User_Guide.pdf
    DATA: DATA (Non-Resident)
         3015048-3019475
  9                 2018-10-19 15:04:44  9bc47b9f8c3ddc76f98b888d29d58dc8   

ca2d122f689a98ca752fdbe0414e6296dcff8c68
18ca6866a60efd06455338739bed02ed3a60bbe8e9cd5e8688b7877aa2a11ef6
Root/Documents/MyDoc1.docx
    DATA: DATA (Non-Resident)
         3019476-3047195
  9                 2016-08-09 09:43:29  cbe35c8518717402622e37fe748e08b3   

028f8ea45432e9b87e45693847d0b6c068b3096d
4868c01d946e0ab00fb2af3bb186ead65ff41d82817f8cc210e254cb115f494a
Root/Documents/Test_Arch.zip
    DATA: DATA (Non-Resident)
         3073504-3080463
  9                 2011-04-05 15:43:41  Root/MyPhoto
    $I30: INDEX_ALLOC (Non-Resident)
         1908-1915
  9                 2009-04-29 05:52:42  1be9257a5f5816119a1ee7932f277709   

b164610273e1684806c4cfdfb087dd6bb9c45ae4
de7eee26d1a8ef8b8f7098ca323d635bc2f2e2ec3260a8e7cdb9afee41d679aa
Root/MyPhoto/MyPhoto1.jpg
    DATA: DATA (Non-Resident)
         952892-958131
  9                 2009-04-29 05:53:22  96d4bd523d897cb9b71d81b9703e7361   

d4688bb699075afc0892b2a044eb42367c934c3e
7c0cb8fc34246a7711cf0e0ea56589fafdc204a911d20fe60ec23f516ca6a859
Root/MyPhoto/MyPhoto2.jpg
    DATA: DATA (Non-Resident)
         958132-961707
  9                 2009-04-29 05:53:58  bb6bbeaad2b8ef9c9abe4648de3a5999   

cdfcfb3779a3a208af1f7643914dce53632588c4
6030e056aa02221686bf6e6a32cfa7abff8a1401c28b43d57eab23a2aa1fc5f2
Root/MyPhoto/MyPhoto3.jpg
    DATA: DATA (Non-Resident)
         961708-965259
  9                 2009-04-29 05:54:20  beb944c66d0c83a708fe1c69011a5d42   

4a9ebcece6a0c3a780f6e9852e065f2ce7d625a0
2b6598767763c096a1ec8161fd98ad00c878a514e91224e74598774e1285d00e
Root/MyPhoto/MyPhoto4.JPG
    DATA: DATA (Non-Resident)
         1997828-1999591
  9                 2009-04-29 06:13:38  55bef019410f8bcd10731a46fa250909   

35fa0050b34ec540b6f9facd24d01d31094f8bc4
c343fee6083774eeabe36c0e4496de4af942ec99ac3f454c675cef28cf6f9552
Root/MyPhoto/MyPhoto5.jpg
    DATA: DATA (Non-Resident)
         2006504-2012923
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  9                 2009-04-29 05:54:46  3feacbf5dd9afc05143f12a55f0536f0   
acf18fc7824c46e2107113e28438a1a7f3d5364c

501d7f5876228466260bcf200bed3e71fbf362f9f7f5601cf45ff8b7e3dd792e
Root/MyPhoto/MyPhoto6.JPG
    DATA: DATA (Non-Resident)
         2898344-2900539
  9                 2009-04-29 05:55:06  22bf64446fcd3a630ab17bf839de6e7d   

6e023a946c407fb59b2b96216f46b6d0e7f4081d
d317be69a99418cd6c1aa628837db02537b04cd2c0549099e2f5edc7f4361c40
Root/MyPhoto/MyPhoto7.JPG
    DATA: DATA (Non-Resident)
         2924760-2926447
  9                 2009-04-29 05:55:30  cb4bed7e6405a90b65cd80ccbec04928   

6581e5cc10659704ea5d98b81a7a326ab9640a26
94f3d3b0877947b05a4e4a6be15f9caa590ff9a9dbc3984b65bf5ea9760758d8
Root/MyPhoto/MyPhoto8.JPG
    DATA: DATA (Non-Resident)
         2922764-2924759
  9                 2009-04-29 05:56:50  2abc60a295d7e3eaa91cb7ad92efc788   

52de9551e8710d6978e525194b8e9cd3a44ea992
20141717c1bfbf42901603843fdd360a56ed64af6865fdc61197ec48fc89807b
Root/MyPhoto/MyPhoto9.JPG
    DATA: DATA (Non-Resident)
         1999600-2006503
  9                 2007-04-23 06:08:09  c1bffb09ff0b3a418fe76df995cf58fa   

f90b22dcd65f848762bacfa7e9aa985415d090a7
4877436d651e00b30728c081286cbf81025197b886dfd1e1f622e13794cabcf6
Root/MyPhoto/Picture 001.jpg
    DATA: DATA (Non-Resident)
         1962376-1965587
  9                 2007-04-23 06:08:12  ca23ee170541b5dbcf099bb9e8e94ce0   

56f5ee823718caee4c9a7090beed100b06d57c87
864daf84caff14e8a078a59c9f185817d2d76bb396f927be0b301be5839c5354
Root/MyPhoto/Picture 002.jpg
    DATA: DATA (Non-Resident)
         2425972-2429715
  9                 2007-04-23 06:08:14  2a9a0d53c84bc3358a5ee68abffcccdf   

9baa28e00327f5fe17a54c9bd61c9ac94046f76e
00e0ef480705863eaee0e3f0c65fd5c7f153cb68f55318ce81157adf49a1d312
Root/MyPhoto/Picture 003.jpg
    DATA: DATA (Non-Resident)
         2429716-2432999
  9                 2007-04-23 06:08:17  163a4f725b82318c333ed4a3c6877954   

88ff7a7c8e016723bb8eae2e9475e1dc0099cab4
6f38401f742229af5c53403bf96735426e0e95633dd77233a8b71fb1e179afba
Root/MyPhoto/Picture 004.jpg
    DATA: DATA (Non-Resident)
         943680-946863
  9                 2007-04-23 06:08:19  e982a269710dbdd81cd793fcf6fc79a5   

e073695ccfabebef4af273f127bd027412fb7fd2
332bfe915c37aa1c817782da6fe1e7a77ebf56058515bd22207694c884f73be9
Root/MyPhoto/Picture 005.jpg
    DATA: DATA (Non-Resident)
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         946864-949963
  9                 2007-04-23 06:08:22  849b6c0dbd1dfd9e216f4c4670420d3d   

bb6780d41f01d253f85c9247a09e4f26c403e51b
64563295d55b1a67b36076b9c8c7f6d532d8276f135c96779be32fa4c3eeff73
Root/MyPhoto/Picture 006.jpg
    DATA: DATA (Non-Resident)
         949964-952891
  9                 2022-03-04 13:28:41  Root/Video
    $I30: INDEX_ALLOC (Non-Resident)
         2843104-2843111
  9                 2022-03-04 13:25:57  Root/Video/Avi
    $I30: INDEX_ALLOC (Non-Resident)
         2843080-2843087
  9                 2022-03-04 13:26:59  Root/Video/Avi/Cops_Season_24_HDTV
    $I30: INDEX_ALLOC (Non-Resident)
         2843088-2843103
  9                 2016-06-06 01:18:26  7f0357f25d88e1369c8dc1acd0aed663   

317dd884a8bc77e96e7fd1656e4aed35d077b0da
a48313a5f5756abd792ba5fa1da6e92f9caf0a7511435e2f5dcfce5250bea41a
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E01.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         7024208-7382223
  9                 2016-06-06 01:19:24  8dd47bbfb3420f7ff4b0b101e8cad36b   

1fd74b806f952314abfecea3fbd56b0560ebb315
72a952dc62b83d078327a25c5e0d81e6027e684238c7b1bcf02c1c29e8f097ef
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E02.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         7382224-7739611
  9                 2016-06-06 01:19:41  e389377f24ca35cc802aa90d821a246d   

3f4c33408ad18287d5f1dca0b474c208748c7002
8622c265f0c0533bd756b0b45fdbf661c23370c093c8a708b14a503238a2ad9f
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E03.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         7739612-8097635
  9                 2016-06-06 01:12:38  5e828eea4a7d198d5d029eb6a5fd8a97   

5f696a6568215a658415bbf736098166253c7bd2
ce10df567443f9c8211655bf9c62071d636dd5106f334efbbf22d57b62e0a256
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E04.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         8097636-8455771
  9                 2016-06-06 01:17:43  409e0f6332db4c12da861cd3cab5ae14   

6d21926f26bd26e3730274b37ad69731219c29f5
e8b357b3f488e04276a2f1dfd9147e8f1b73e4a5a4ad7854abebb1e6a83fc379
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E05.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         8455772-8813603
  9                 2016-06-06 01:18:57  b55ee3db70b62f883db5573a5746e4d1   

08c309ee65b69c1a937f447b9b45e95055ad422e
e39d39283cd4fbee2a5e4e59dba6751c4b2be36eedfaf0ad4d2b3e904867dd9d
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E06.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         8813604-9171227



R-Studio Technician/T80+ 255

© 2025 R-Tools Technology Inc.

  9                 2016-06-06 01:17:05  1febb45222f9f114e88c533c36f8f29b   
b1656a3eb4766af43e31b46defb3827be551bfde

42513d7f9738dd06077f8e2636cdb6852aa852bc67316cbbc45b6bec5cff69c9
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E07.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         9171228-9528443
  9                 2016-06-06 01:16:17  0ecf424d46e619cd1d09bce2dae5b570   

a15b481e4083022254c0ff9aa85f369782a7c87b
7240d9aed4d0129139f9d817bd1beb140f2c46b226e77570f083387e54a04ebd
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E08.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         9528444-9886203
  9                 2016-06-06 01:17:14  88b3f03a9e20f9b2310dde6cd0296fca   

b839c39d53c22c5e8a46cda745f0c90ac86ac38d
2b61dad5b94d79f8b0e202db5dc30f5a581f1093b588a16354701419aaeb6ebb
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E09.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         9886204-10244171
  9                 2016-06-06 01:19:17  de1cf8808dff26c1b4398220a8913dd1   

139ad01952126d3294c49e4f2258168462f4b61d
3a70dfd2993d0ae572855aa7a20847d58a0e8823fba77e0e136a9a2a92b0bb6e
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E10.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         10244172-10602083
  9                 2016-06-06 01:16:49  216bdd9f74a00a7a9b4383e2e655ef58   

47bdb9493dc69f0aff6c38536f3100cca3c6c3f3
ed4d42a3c4162a16da28f21d85a2dfb53b0f07fe005b9012e573717fef70af59
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E11.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         10602084-10959887
  9                 2016-06-06 01:17:34  51bf22c8ed46f23cd1efde24952d305e   

a090ee7373d093cf91ee3afa42decbbdf5f43d6a
72d917ebda33cc238fa1bcada877f7949ff460105e7467d2c314a63fd1224740
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E12.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         10959888-11317795
  9                 2016-06-06 01:19:31  ac81e8b5472ca54054c8e57b6e69b1b0   

bdb5963313cf1cdcbd9d7ae2e66daf8b669000d6
eae261da6d61b544dc42c8843ab4752496fb4869fcbff869baa9f62ea47b9ee7
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E13.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         11317796-11676463
  9                 2016-06-06 01:16:28  8d99cfc73a09a48825a276375bfad763   

735aa03db094173277fb702ef0c7d96bdc8e11c2
052e121628b631a3154d04a2b30774340fdaf0e4593b9b751187f867b2c433e3
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E14.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         11676464-12035723
  9                 2016-06-06 01:18:51  6c498108cd539cb1b05c813b8e91893d   

843e634c0def9751870c8bbe5087be478211d62b
42d916b97a81a2147ef5e03a9e07dab0e6db4d6b148693492644f539ebbf1cdc
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E15.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
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         12035724-12393419
  9                 2016-06-06 01:18:10  0e418b50264b2bb748f031e1250de762   

b6a7edd6909b1ff6e5d6e85b6cd3734a8ddff4ef
9286b40a34a4fae19a24117c179cca4f4493f54341dc66fa2255e49eb209c1ab
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E16.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         12393420-12751411
  9                 2016-06-06 01:19:07  65fe333f28d8c5f27d21a2445d95fa91   

f6ed23e660b1f8559e5f7151ee16cd583e3fc353
344d36ce2ecefe1d3676197f247dca485e37be2282a469aa2fb2a219907d737e
Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E17.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         12751412-13109855
  9                 2016-06-06 01:18:17  514b0659f98a3c45202f1cc8a125fe61   

1ba85643445ac825a4d4a5281020d6f82b5bc69a
b99c92603b97699ed7aa10a4e7f21fbd92a4cd8688a4083e33e8a4c54049aaba
Root/Video/Avi/Cops.S24E18.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         5206192-5564299
  9                 2016-06-06 01:18:12  0e6f2a5dea0e8a1e4dd33ad2c99395cb   

9a0b653b3820ba4dd0d78ae94d0da524ff62567a
133cccd202e162aa8f52cbf289351dcb3414d78cfb82945ae49233b4d245d907
Root/Video/Avi/Cops.S24E19.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         5564300-5920111
  9                 2016-06-06 01:18:38  f3704970997f2eb8af3fb9dd2691f7d0   

580ca470463e58d4b29eba6471081910b7b4ebfc
3544a68251c3b273675eae72431be23a3971057c6c18292bf69f71cd5b42590f
Root/Video/Avi/Cops.S24E20.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         5920112-6278491
  9                 2016-06-06 01:18:47  ba81e0c6597f2e3898535fb78ffa0ccb   

7f537260ad18099950dcc69964de66ceb45fe176
3797d035d4b503fa1c8b05153790ed1371394b7d549589219955d75c77abedbd
Root/Video/Avi/Cops.S24E21.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         6278492-6635391
  9                 2016-06-06 01:19:37  f61d04146b1f1e8404b1a16e9adfab5e   

306ebaddaa2d57688f4e5888cf5363da207e3f28
ad0d94c09fb496f2f2177c0d6de71ac3d8f2188c1631676ed713acd251b3f406
Root/Video/Avi/Cops.S24E22.HDTV.x264.mp4
    DATA: DATA (Non-Resident)
         6635392-7024207
  9                 2012-09-04 09:35:36  Root/Video/DVR
    $I30: INDEX_ALLOC (Non-Resident)
         2945688-2945695
  9                 2012-09-03 13:21:55  86113b44e50500b1105dd580b0f9e42a   

4b194310f3dddd7dfadd9c01dcafcc32876fba2d
ee5cf3e5c3a7b5695e5d5ac41155f91bdb810d71ffa006a59d235b4810b6f503
Root/Video/DVR/ch00000000000003-120819-023024-023024-12p103000000.264
    DATA: DATA (Non-Resident)
         2972856-2987703
    Zone.Identifier: DATA (Non-Resident)
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         2945728-2945731
  9                 2012-09-03 08:32:37  c34452e92b49bff9e9d038c2a690c90e   

110d094fcf713c7680ccd6f79c89f08fa7babe14
aa6098fbca1118b0d94565551f4f4a65fef46183ece8f6f3a66e9e91177fe782
Root/Video/DVR/ch00000000000003-120819-023155-023155-12p003000000.264
    DATA: DATA (Non-Resident)
         2946196-2947219
    Zone.Identifier: DATA (Non-Resident)
         2945724-2945727
  9                 2012-09-03 09:38:59  3f61e75a3aedc81e6a1493aa7848a31b   

29cdab282c34fb9109c8f4d5b243ce8c4613c678
829cfe1938ca3d5e3fecb861d7306334a8724f2035d855952e4cb341321d6981
Root/Video/DVR/ch00000000000003-120820-003908-003908-12p003000000.264
    DATA: DATA (Non-Resident)
         2947224-2947863
    Zone.Identifier: DATA (Non-Resident)
         2945720-2945723
  9                 2012-09-04 10:00:10  56fdcb8908bb728fafd4ae33ab7c71a4   

9ad6b6798f57abab40975a1e432f0d3c44f624f6
4ae468b2093995ab9568f297c0dbca4b984a67ff7368a89bb1625f4f72071e47
Root/Video/DVR/dvr.xml
  9                 2012-09-03 11:36:31  5ef432e651457058ab4954831c7f9d0f   

093b7dd72f3bef9a8107943ed4903f8a0a6a1fcf
03e048830d4aa193033c51fe1dbde73c8c107907b5e5b1fc8c236c0a23d11997
Root/Video/DVR/es_ES.oxt
    DATA: DATA (Non-Resident)
         2947876-2948851
    Zone.Identifier: DATA (Non-Resident)
         2945716-2945719
  9                 2010-01-29 10:51:29  53d73828dfd5cbb53408a1940fb25ef7   

261c7164b24035377d144f401dda5adf5e1a1f58
49a0743c2ad0b4b09db3a826cd7275960ed813af9e9f4982399a98b92e065f82
Root/Video/DVR/FileTypes.xml
    DATA: DATA (Non-Resident)
         2945672-2945679
  9                 2012-09-03 11:34:37  148c66b1f3f23e0725db4645bfd1eeab   

6bcfea38f0193fab83a570d4c52d95901ca177c8
3899b56b880cea89031d3e2f230d73945ecf6379d2f82e26e9a6b3faf7f5b9c6
Root/Video/DVR/ooo-dictionnaire-fr-moderne-v4.5.oxt
    DATA: DATA (Non-Resident)
         2948856-2953247
    Zone.Identifier: DATA (Non-Resident)
         2945712-2945715
  9                 2022-03-04 13:27:02  Root/Video/Flv
  9                 2010-01-05 17:11:42  d2ef7350396693de9389e8b39774b4d7   

31920aa00dc386e8d2e1889f80c7b170560d349c
38a0753248b06cfca4ceeb4bc67198214216bdd2313e0d8cc3ee641471054766
Root/Video/Flv/Better_than_me_flv.flv
    DATA: DATA (Non-Resident)
         13109856-13125951
  9                 2022-03-04 13:27:02  Root/Video/M4V
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  9                 2012-08-22 10:36:44  968139c8f965b32be629b5eddac23382   
3d4ab462a46e985f61e55d3d293598ae658179e9

d84d38f3792764ab30e3d735da22c5977920c92a0339d46055d5710b40e008bc
Root/Video/M4V/general_hospital_fall_2008_promo_(hq)_m4v.m4v
    DATA: DATA (Non-Resident)
         13125952-13127943
  9                 2022-03-04 13:27:40  Root/Video/Mov
  9                 2015-10-11 10:33:14  53bd8bd63f73df2e647b20ac336b5184   

3847624df92163b5857177e06fccfc01f09655c6
4b5af7cae10bd584f7ffcfd7c6a690a8df6f12bf4a5d54e83fdcec6d44d6ae8d
Root/Video/Mov/FILE0031.MOV
    DATA: DATA (Non-Resident)
         13127944-15791631
  9                 2015-10-11 10:48:14  4d0737f26d565e7ade41c1eeff0e7cae   

9a11b89381fc546c638eb8cbdfb1a1f4b892348e
0afc907c0ae3aa8f6ee9a35ec2f863650872a30f9dcc3cb72391f856b7124370
Root/Video/Mov/FILE0032.MOV
    DATA: DATA (Non-Resident)
         15791632-18455539
  9                 2022-03-04 13:28:17  Root/Video/MP4
    $I30: INDEX_ALLOC (Non-Resident)
         2843112-2843119
  9                 2010-11-30 13:58:19  3e3661d0dc6f16a5d416791614623e9e   

3d41e5063b1c5b1a4f659c669a2016873578c3c2
553fcee0ff4df6eefc45024c334ff2ddda887031c2d2ce75d64f8a0cc28365f1 Root/Video/MP4/mp4
Haiti_can_succeed,_but_not_without_your_help_(Former_US_president_Bill_Clinton).mp4
    DATA: DATA (Non-Resident)
         18455540-18631839
  9                 2015-09-18 20:52:23  f9d18db99b4d4f3d5d8f7ecda07a283a   

3f30923a876e075e0c5735d095fafc71798a5a8f
d055ab546e6c24517aeaadc8217b3a56443baf902230c7a41235f6402770e4c0
Root/Video/MP4/VID_20150918_215223.mp4
    DATA: DATA (Non-Resident)
         18631840-18836859
  9                 2015-09-18 21:00:20  b970ad6b6fc339a639a747d43279fc24   

226dd51746a2765ebfeb7e58a61d5f43ee8cfcf3
0e2d63dc86db96e93cb84e61724699bce08aa1f68ca17216e98355800ead5038
Root/Video/MP4/VID_20150918_220020.mp4
    DATA: DATA (Non-Resident)
         18836860-19173295
  9                 2015-09-20 11:31:20  050863ea63873886856c1850f89b2872   

15e1a4f4ed00ae657cc4892959e2d161d011b84f
64e86ce37f11c639c102721be53d58f6f42302056fc183a701c7cbd6696a0f38
Root/Video/MP4/VID_20150920_123120.mp4
    DATA: DATA (Non-Resident)
         19173296-19426331
  9                 2022-03-04 13:28:20  Root/Video/MPEG
  9                 2016-08-06 14:50:22  8661e7edc04aa49accced6da2520decc   

0b7c023cd7f19445e78f11a5d3d4c2058196e307
63a8045b7ee6345adec7079e0e18fe89656e0cb188eb34712614e9b539f89740
Root/Video/MPEG/Mpeg_Video.mpeg
    DATA: DATA (Non-Resident)
         19426332-19510263
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  9                 2022-03-04 13:28:24  Root/Video/MTS
  9                 2015-08-05 06:44:42  28264a21f4babe4c26fd9422ecce8066   

ddd8c7b7717e0c0374d50af851a499b9ec11e428
fdaf9826c0bb27005d60b611857f6ac4d81191cfcdd63519343f7d4192208491
Root/Video/MTS/00026.MTS
    DATA: DATA (Non-Resident)
         19510264-19700727
  9                 2013-03-20 10:16:48  c8813d64f8e33e4e41c773d188ce6f62   

cd6dae3c9a31db7f02d18bfa8fa493d85b64e64b
1cfbb5d3d93c7725f06a388d93490e112427c640db705dfe90036c98c6db4820
Root/Video/MTS/00140.MTS
    DATA: DATA (Non-Resident)
         19700728-19714359
  9                 2013-03-20 10:16:20  40566a6585ba0440175eed119a32a32a   

95776ef4d52ea51062c472ce744de1ef075bdf2f
34cf55b950cbce275ddc1ecad2e9fc0821e4b664d23eeb3270059b3e6e8d0c4e
Root/Video/MTS/00168.MTS
    DATA: DATA (Non-Resident)
         19714360-19730487
  9                 2013-03-20 10:15:22  90b17b9d8b04d14b2a72aa1a7ea2c6c8   

19ddc6147e3f8d9c628c83cf33525cc859423c00
fbf55ea6c3b86c666c79caaf5c1386eebede4f02b8b70c7c91610effaf874ddc
Root/Video/MTS/00346.MTS
    DATA: DATA (Non-Resident)
         19730488-19746999
  9                 2011-02-25 05:07:46  6299534199985cc1c9071f8adcd06685   

33a21bbb8c7ec7d6956dc8eddb0e3944633654af
0e6cc6acb1230bccde6269b6b26ebc47d98226cb34f5bbd331c3352cc1116ae5
Root/Video/MyMovie1.mp4
    DATA: DATA (Non-Resident)
         2383344-2425971
  9                 2011-02-25 05:07:47  7185b8d6a921ac1d1cdf6c0d7881868f   

8a34c5478b7b8bb58d4fd16999f99bf1ba3d8c63
63342879fc8df632732efca8084f8eed3bbd37fb7fa44068b4175f897b9a0c3d
Root/Video/MyMovie2.mp4
    DATA: DATA (Non-Resident)
         902396-943679
  9                 2011-02-25 05:07:48  19542a1073bad1b58a0f94ee9fde0772   

2a1383ea3c41d1388deba4e10473c75eb62162bb
c53641c7fc100233bdf929963766abae7807822ce63eb57a925649955e5aa18c
Root/Video/MyMovie3.mp4
    DATA: DATA (Non-Resident)
         2843520-2885903
  9                 2011-02-25 05:07:49  8d336514bb974726b20d8d358db1dba1   

1fbc1cf51a1a6f4b7b8162267d69bd9be77077e0
48a660f1359f763a77502688c59691fed8aee2b08d59c3bed5af9d45fdea4720
Root/Video/MyMovie4.mp4
    DATA: DATA (Non-Resident)
         1870024-1913723
  9                 2016-06-05 12:36:07  d6b0ce497e569371b94e19fea48355cd   

37fbacb48c80859f47024f2382d9880be633477b
b08522bb8e9d63c86c290a8c7032f3097fc78db704ea1d54eaaa75934c29de46
Root/Video/The.Lincoln.Lawyer.2011.1080p.BluRay.x264.DTS-FGT.mkv
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    DATA: DATA (Non-Resident)
         19747000-36177927

END Date / Time of Collection: 2022-08-05 15:12:07
------------------------------------------------------------------------------------
----------------

IV Text/hexadecimal Editor

Any object visible to R-Studio for Linux can be viewed and edited in the Text/?hexadecimal editor. It is also
able to parse the data and represent data according to various data patterns. You may also create your own
patterns to parse data.

Note: Data alteration is available on the Technician/T80+ and Corporate versions only.

You may turn numerical indexes for objects to distinguish them better.

· Viewing and Editing Objects 

· Navigating through an Object

· Data Copy

· Files and Sectors

· Creating Custom Patterns

· Pattern Example I

· Pattern Example II

R-Studio for Linux Features
Contact Information and Technical Support
Data Recovery Using R-Studio for Linux
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Volume Sets and RAIDs

Data Recovery over Network
Technical Information and Troubleshooting
R-Studio Emergency
R-Studio Agent Emergency

4.1 Viewing and Editing Objects

YOU MUST BE ABSOLUTELY SURE OF WHAT AND WHERE YOU ARE WRITING!

Or you may completely lose all your data.

Before you can physically write anything on a disk, you need to enable writing. 
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To enable writing,

1 On the R-Studio for Linux main panel, select the Tools menu, then Settings, and select Enable Write

on the Settings dialog box.

> The Editable: status will change to Yes from Read Only.

Now the object can be edited.

To view/edit an object,

1 Right-click the object and select View/Edit on the context menu, or

Select the object and select View/Edit on the File menu

 R-Studio Text/hexadecimal editor
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Data Parsed According to the Selected Pattern Object Properties

Object Sector Mapping Data Shown as Various Digits

Binary view



Text/hexadecimal Editor 263

© 2025 R-Tools Technology Inc.

Text view

Find Results

List of Bookmarks

Text/?hexadecimal Editor status

Previous Pattern

Click this button to go to the previous
pattern.

Next Pattern

Click this button to go to the next
pattern.

Save Changes

Click this button to save changes.

Code pages

Turns supported code pages on/off.

Autoflow

Click this button to turn autoflow on.
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Panel view options
You may set which panels and bars to enable/disable.

 To enable/disable:

ANSI data Select/clear ANSI on the View menu

OEM data Select/clear OEMr on the View menu

UNICODE data Select/clear UNICODE on the View menu

UNICODE+ data Select/clear UNICODE+ on the View menu
Toolbar Select/clear Toolbar on the View menu
Properties View Select/clear Properties View on the View menu
Sectors View Select/clear Sectors View on the View menu
Data Interpreter
View

Select/clear Data Interpreter View on the View menu

Template View Select/clear Template View on the View menu
Bookmarks View Select/clear Bookmarks View on the View menu
Find Results View Select/clear Find Results View on the View menu

2 View the information and make necessary changes

Select Save Changes on the Tools menu if you want to save changes.

 Other ways to save changes

· Select Save Changes on the File menu
or
· Press the Ctrl+S keys

Viewing

There are up to four tabs showing the data in different representations. Actual number of tabs depends on the
object and property being viewed/edited.
Std Exact attribute data. If the attribute is compressed, R-Studio for Linux decompresses it prior

to showing.
Unlimited Exact attribute data + free space of last cluster. If the attribute is compressed, R-Studio for

Linux decompresses it prior to showing.
Direct Actual data written on the disk. If the attribute is not compressed, it coincides with the Std

representation.
Allocation Resident part of the attribute.

You may view data in 4 various code pages: ANSI/OEM/UNICODE/UNICODE+ by switching on/off the
respective code pages in the Code pages buttons or select the appropriate code pages on the View menu.

Patterns or Templates

You may select a pattern according to which the data will be parsed and shown in the parsed data pane. The
Data Interpreter shows the data selected on the Template pane in various representations.

You may find the next or previous data that matches the pattern signature on the disk. Right-click the right
pane of the editor and select either Find Template Signature Next or Find Template Signature Previous

on the context menu. You may also select these items on the Edit menu.

You may also create your own patterns to parse data from various objects. 

https://www.r-studio.com/What-is-free-disk-space.html
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Navigating.
Text/?hexadecimal Editor gives you various ways to navigate into an object. See the Navigating through
an Object for more details

Data Copy

Text/?hexadecimal Editor gives you various ways to copy selected data navigate in an object. See the Data
Copy for more details.

Filling an area with a pattern

To fill an area with a pattern, select Fill on the Edit menu, and specify the pattern and area on the Fill dialog
box.

Fill dialog box

 Fill options

Fill pattern

HEX Field for the pattern to fill the area in the hexadecimal representation
ANSI Field for the pattern to fill the area in the ANSI encoding
OEM Field for the pattern to fill the area in the OEM encoding
UNICODE Field for the pattern to fill the area in the UNICODE encoding
Fill range

From (hex) Field for the start position of the area to fill with the pattern
To (hex) Field for the end position of the area to fill with the pattern

3 Click the Save Changes button to save the changes

 Other ways to save the changes made

· Select Save Changes on the Edit menu
or
· Press the F2 key

> Viewer/Editor will save the changes on the object

YOU MUST BE ABSOLUTELY SURE OF WHAT AND WHERE YOU ARE WRITING!
Or you may completely lose all your data.

Selecting and saving an area in the Viewer/Editor

You may select an area in the Viewer/Editor panel and save it as a file. 

To select and save an area in the Viewer/Editor panel,

1 Right-click the beginning of the selection and select Select From on the context menu

2 Right-click the end of the selection and select Select To on the context menu

 Other ways to select an area

·  Select Select... on the Tools menu and specify an area to select on the Select dialog box,
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or
· Click the start point of the area and drag the mouse cursor to its end.

If you need to select an entire object, select Select All on the Tools menu or click the Ctrl+A key

Select dialog box

3 Select an appropriate item in the Tools menu to save the data in a required format and specify its file
name

Select: 
Save to Binary File... to save the data in the binary format (default extension is .bin)
Save to Hexadecimal
File

to save the data in the binary format (default extension is .hex)

on the Tools menu.

If you select an existing file, R-Studio for Linux will ask you if you want to append or overwrite the file.

If a remote computer is connected for Data Recovery over Network, the Save as... dialog box will
appear when you select a place to save the data. You may save it to the local or remote computer.

> Viewer/Editor will save the data in the file

Loading data from an external file

You may load a data from a file and overwrite an area of the object opened in the Viewer/Editor panel. 

To load binary data from a file and overwrite an area of the object opened in the Viewer/Editor

panel,

1 Select an area to overwrite and select Load from File... on the Tools menu

If a remote computer is connected for Data Recovery over Network, the Open as Binary File dialog box
will appear when you select a place to open the data file from. You may open it from the local or remote
computer.

2 Select the necessary file and load the data.

> The area in the Viewer/Editor will be overwritten with the new data.

4.2 Navigating through an Object

Navigating

You may quickly move to a particular part of the object. To move to a particular part of the object being
viewed/edited, enter the required offset in the Go to Offset field between the buttons.
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 Type an offset to which you want to go. You may select between bytes and sectors. See the Data
Formats and Multipliers topic for more details on data formats.

If a file is opened in Text/?hexadecimal Editor , you may select data representation for that file.

 

You may also use the Go To Offset dialog box to go to a specified place in the object. Click the Offset field
on the Status bar. You may also use this dialog box to copy the offset.

Go To Offset dialog box

 Go To Offset options

From: Jump/? offset direction. For example, if you need to find the offset from the object
end for a selected byte, switch to the End (backward) option.

HEX/? DEC Switch between the hexadecimal and decimal data representation.
Range Range of values that can be entered.
dec/? hex: Alternative data representation. 
Offset: Flat data offset (without separation between the sector and offset in the sector).
Sector/? offset Data offset represented as a sector and offset in the sector.
Go!/?OK buttons The Go! button moves the cursor to the specified positions, but the Go To Offset

dialog box remains open. The OK button closes the dialog box after moving the
cursor. 

Searching

To search for a particular string, click the Find, Find Next, or Find Previous buttons or the same items on
the Edit menu, and specify the string on the Search dialog box.

Search dialog box
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 Search options

Not Equal Search for the place which content is not equal to the string. For
example, the first byte not equal to 00 or FF.

Search for

HEX Field for the string to search for in the hexadecimal
representation

ANSI Field for the string to search for in the ANSI encoding
OEM Field for the string to search for in the OEM encoding
UNICODE Field for the string to search for in the UNICODE encoding
Match case Select this check box to make the search case-sensitive
Search area

From current position Select this check box to start search from the current position
From start position Select this check box to start search from the beginning of the

object
From Address Select this check box and specify the range in which the search

is to be carried out
Search position

Exhaustive search Select this check box to search the entire object
Search at offset Select this check box and specify the sector offset from which

the search will start
Reverse Select this check box to start the search in the reverse direction
Find all Select this check box to search for all instances of the string to

search. Search results will be shown in the Find Results pane.

Text/?hexadecimal Editor will show the search progress.

Search results are shown on the Find Results pane. You may easily move to the required found item by
clicking the item.

Features of the Not Equal option

Suppose we have an object which first 3 consecutive sectors start with:
Sector1   FILEAAAAA..............................................
Sector2   FILEBBBBB..............................................
Sector3   NOTAFILE...............................................

And the search string is Not Equal FILE.
If the Exhaustive search option is selected, the Text/?hexadecimal Editor will stop at the first A character in
Sector1.
If the Search at offset=0 option is selected, the Text/?hexadecimal Editor will stop at the N character in
Sector3.

Bookmarking

You may create bookmarks to easily move to those places. Right-click the cursor on the place you want to
bookmark and select Toggle Bookmark on the context menu. The list of bookmarks appears in the
Bookmark pane. You may easily move to the required bookmark by clicking it in the list.

You may control bookmarks on the Edit menu.
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4.3 Data Copy

Text/?hexadecimal Editor gives you various ways to copy selected data in an object. 
Data selected in Text/?hexadecimal editor

Depending on what column you have control-clicked, the following commands are available in the context menu:

When right-clicking any column
Copy Editor Display

Data pasted into a text editor

When right-clicking any column
Copy as File Signature

Data pasted into a text editor

When right-clicking the Binary data
column
Copy as "Binary data"

Data pasted into a text editor

When right-clicking the ANSI column
Copy as "ANSI"

Data pasted into a text editor
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When rightl-clicking the UNICODE
column
Copy as "UNICODE"

Data pasted into a text editor

4.4 Files and Sectors

You may see which file is written on a particular sector. To do so:

1 Enumerate files on a logical disk on the Drives panel.

2 Go to the tab of that logical disk and select Show Files in HexEditor on the Files menu.

3 Return to the Drives panel and select View/Edit on the context menu. 

> R-Studio for Linux will show a file that belongs to a particular section.

File in a sector

4.5 Creating Custom Patterns

You may create your own patterns yourself.

An example of a commented pattern parsing an AVI file.
The syntax of pattern description is similar to that of the XML language. The folder where the files should be
placed is specified on the Main tab of the Settings dialog box.
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Pattern structure

Pattern header

Each pattern starts with a standard header
<?xml version="1.0" encoding="utf-8"?>

Section template

Each pattern starts with a section giving to the pattern a name that will be shown in the parsed data pane.

Attributes:
name Specifies the pattern name shown in the parsed data pane

Example:

<template name="AVI File LIST">
........

</template>

Section signature 

Attributes:
align <positive
integer> 

Specifies if the data structure address is aligned (i.g., by  a sector: 512)

This section contains elements field with hex-codes of the signature. The attribute offset  specifies their
offset from the start of the record. Field length is equal to the number of hex-codes.

Example:

<signature align="1">
<field offset="0">46 49</field>
<field offset="2">4c 45</field>

</signature>

Section section 

Such sections contain all expressions and operations needed for the pattern to parse the data. A section name is
shown in the parsed data pane. In fact, sections are virtual objects used to group logically connected fields.
Sections can be nested.

The main section is not shown in the parsed data pane.

Section contain elements field which are actual data objects. field names are shown in the parsed data pane
with their values. 

Attributes:
name Specifies the pattern name shown in the parsed data pane

Example:

<section name="JUNK">
 ....
</section>

List of All Objects in Patterns

Data types (in field)

· integer 
Sub-types:

int8 

int16 
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int32 

int64 

uint8 

uint16 

uint32 

uint64 

uintX

Attributes: 
endian: (be | le

| system) 
Optional.  Default: system.

base: (decimal |

hex | octal) 
Optional. Specifies data representation. Default: decimal.

as-offset:

<expression> 
Optional. Specifies that this field is an offset and its value should be evaluated using
the expression. A special variable this returns the value of  this field.

purpose: (offset
| rsector |
sector | cluster

| rcluster) 

Optional. Specifies the type of the as-offset expression result . If this attribute is
present, the attribute  is necessary if the offset value should differ from the value of
this field (variable this ).
 rsector and rcluster  are offsets relative to the absolute position of the pattern
beginning.

assigned-
template:

<TemplateName> 

Specifies the pattern name linked with this field. Ignored if the as-offset or
purpose attributes are not specified.

var: <Name> Optional. Specifies the name under which the value of this field can be accessed in
expressions.

· binary 
Attributes: 
display-encoding:

(hex | binary) 
Optional. Default: hex. 

size: <bytes> Mandatory.

· char 
Attributes: 

size: <bytes> Mandatory. 
codepage: (ansi |

oem | utf8 | utf16) 
Optional. Specifies which codepage is used. Default: ansi.

· filetime 
Shows time in the Win32 format (64 bits)

· unixtime 

Shows time in the Unix format (seconds from 01/01/1970)
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· filetime 

Shows time in the DOS format (date: hiword, time: loword)

· bits 

Attributes: 

size: <bytes> Mandatory. 
pos: <comma
separated list of

bit positions> 

Mandatory. Specifies bit positions in a data block.

Commands

· goto 

Specifies a jump to a specified offset (either absolute or relative one)

Attributes: 
address:

<expression> 
Specifies an absolute address to jump to.

offset: <expression> Specifies a relative offset to jump by.

One and only one of the attributes should always be specified.

· if 

Evaluates a condition specified in the test attribute and, if the condition is true, reads fields specified in this
tag.

Attribute: 

test: <expression> Sets a condition to test against.

· repeat 

Reads the fields specified in the tag until the exit condition is equal to 0 or specified times

Attributes: 

count: <expression> <expression> is evaluated one time upon entering the block. Internal
elements are read the specified number of times.

test: <expression> <expression> is evaluated upon entering the block. Similar to the C++
construction while(...) {}. 

test: <expression> <expression> is evaluated upon exiting the block. Similar to the C++
construction do {} while(...). 

· setvar 

Sets the value of an internal variable. As an example, this command is convenient to store the current offset.
The value of the current offset is stored in a predefined variable offset.

Attributes: 

var: <string> Specifies the name of the variable.
expr: <expression> Specifies an expression which result will be assigned to the variable.
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Expressions

Expressions in the patterns are arithmetic expressions which syntax is similar to that of the C language, including
operation preceding. 

The following operations are supported:
+ - */  & | > < <= >= != == || &&

Predefined variables

· offset 

An offset in bytes from the pattern beginning data is currently read at. 

· start_position 

An absolute position of the pattern beginning. offset + start_position = absolute offset.

· this 
This variable exists only within the context of the ass-offset expression evaluation and is the current value
of the data field for which that expression is specified

4.6 Pattern Example I

Below is an example of a commented pattern parsing an AVI file. 
<?xml version="1.0" encoding="utf-8"?>

<!-- A pattern section. The pattern name is AVI File. -->
<template name="AVI File">

    <!-- A template signature section. Alignment is 1. -->

    <signature align="1">

        <!-- A 4-byte signature at offset 0x00. -->

        <field offset="0x00">52 49 46 46</field> <!-- ANSI: RIFF -->

        <!-- A 4-byte signature at offset 0x08. -->

        <field offset="0x08">41 56 49 20</field> <!-- ANSI: LIST -->

    </signature>

    <!-- A data section. Its name is AVI File. This is the main data section. It is not shown in the parsing tree as
a section (its name is ignored). -->

    <section name="AVI File">

        <!-- The first 4 bytes are read and shown as an ANSI  string. -->

        <field type="char" size="4" name="Signature: RIFF" var="signature"/>

        <!--  The current position is moved to the beginning of the file. -->

        <goto offset="-4"/>

        <!-- The first 4 bytes in the file are read and shown as an unsigned integer. The internal variable signature
gets the value of the field. --> 

        <field type="uint32" base="hex" name="Signature RIFF as unsigned integer in hex
format" var="signature"/>

        <!-- A test against the condition (signature == RIFF) -->



Text/hexadecimal Editor 275

© 2025 R-Tools Technology Inc.

        <if test="signature == 0x46464952"> <!-- ANSI: RIFF -->

            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable dataSize gets
the value of  the field. -->

            <field type="uint32" name="Size of the data in file" var="dataSize"/>

            <!-- A new internal variable endOfFile is created and the expr field evaluates its value.-->

            <setvar var="endOfFile" expr="offset + dataSize - 8"/>

            <!-- The next 4 bytes is read and shown as an ANSI string. -->

            <field type="char" size="4" name="File type"/>

            <!-- A new section named DATA is created -->

            <section name="DATA">

                <!-- A new internal variable chunksOffset is created, the expr filed evaluating its value. This variable
gets the absolute value of template offset. -->

                <setvar var="chunksOffset" expr="start_position"/>

                <!-- A loop is created. Its condition is set in the test field (while the endOfFile variable is greater
then the current position.) -->

                <repeat test="endOfFile > offset">

                    <!-- 4 bytes are read and shown as an ANSI string. -->

                    <field type="char" size="4" name="Signature"/>

                    <!-- The current position is moved backwards by 4 bytes. -->

                    <goto offset="-4"/>

                    <!-- The same 4 bytes are read and shown as an unsigned integer. The internal variable signature
gets this value. -->

                    <field type="uint32" name="Signature as unsigned integer"
var="signature"/>

                    <!-- A test against the condition (signature == LIST) -->

                    <if test="signature == 1414744396"> <!-- ANSI: LIST -->

                        <!-- The section is shown. Its name is LIST -->

                        <section name="LIST">

                            <!--  The current position is moved backward by 4 bytes. -->

                            <goto offset="-4"/>

                            <!-- The 4 bytes are read and shown as an unsigned hexadecimal integer. This field has the
attributes offset and assigned-template. If the user double-clicks this field, the AVI File LIST pattern
will be invoked and the current pattern position will be moved to the address specified in as-offset.-->

                            <field type="uint32" base="hex" name="Signature LIST as unsigned
integer in hex format" as-offset="start_position + offset - 4" assigned-
template="AVI File LIST"/>

                            <!-- The next 4 bytes are read and shown as an unsigned integer. The listSize variable gets
its value.  -->
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                            <field type="uint32" name="Size of the data in the list"
var="listSize"/>

                            <!-- The 4 bytes are read and shown as an ANSI string. -->

                            <field type="char" size="4" name="List type"/>

                            <!-- The current position is moved backward by 4 bytes. -->

                            <goto offset="-4"/>

                            <!-- The same 4 bytes are shown as an unsigned hexadecimal integer. The listType variable
gets its value.-->

                            <field type="uint32" base="hex" name="List type as unsigned integer in
hex format" var="listType"/>

                            <!-- A test against condition (type == movi) -->

                            <if test="listType == 0x69766f6d"> <!-- ANSI: movi -->

                                <!-- The chunksOffset variable gets the value evaluated in the expr attribute. -->

                                <setvar var="chunksOffset" expr="start_position + offset - 4"/>

                            </if>

                            <!-- The current position is moved to the address evaluated in the address attribute. -->

                            <goto address="offset + listSize - 4"/>

                        </section>

                    </if>

                    <!-- A test against condition (signature == JUNK) -->

                    <if test="signature == 1263424842"> <!-- ANSI: JUNK -->

                        <!--  The section is shown with the JUNK name. -->

                        <section name="JUNK">

                            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable
junkSize gets its value. -->

                            <field type="uint32" name="Size of the data of the junk"
var="junkSize"/>

                            <!-- The current position is moved by junkSize bytes forward.  -->

                            <goto offset="junkSize"/>

                        </section>

                    </if>

                    <!-- A test against condition (signature == idx1) -->

                    <if test="signature == 829973609"> <!-- ANSI: idx1 -->

                        <!--  The section is shown with the idx1 name. -->

                        <section name="idx1">

                            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable
idxSize gets its value. --> 
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                            <field type="uint32" name="Size of the data of the idx1"
var="idxSize"/>

                            <!-- The section is shown with the  First AVIINDEXENTRY name. -->

                            <section name="First AVIINDEXENTRY">

                                <!-- The 4 bytes are read and shown as an ANSI string. -->

                                <field type="char" size="4" name="Chunck id"/>

                                <!-- The next 4 bytes are read and shown as an unsigned hexadecimal integer. -->

                                <field type="uint32" base="hex" name="Flags"/>

                                <!-- The next 4 bytes are read ans shown as an unsigned hexadecimal integer. The offset
attribute is evaluated for this field as a sum of  the chunksOffset variable and valued of this field.  -->

                                <field type="uint32" base="hex" name="Chunk offset" as-
offset="chunksOffset + this"/>

                                <!-- The next 4 bytes are read and shown as an unsigned integer. -->

                                <field type="uint32" name="Chunk size"/>

                            </section>

                            <!-- The current position is moved by idxSiz bytes forward. -->

                            <goto offset="idxSize"/>

                        </section>

                    </if>

                    <!-- A test against the condition. &amp;&amp; is a logical AND (&&) -->

                    <if test="signature != 1414744396 &amp;&amp; signature != 1263424842
&amp;&amp; signature != 829973609">

                        <!-- An empty section is shown. Its name is Unknown signature found -->

                        <section name="Unknown signature found">

                        </section>

                        <!-- The current position is moved to the address set in the endOfFile variable. -->

                        <goto address="endOfFile"/>

                    </if>

                </repeat>

            </section>

        </if>

    </section>
</template>

4.7 Pattern Example II

<?xml version="1.0" encoding="utf-8"?>

<!-- A pattern section. The  pattern name is AVI File LIST -->
<template name="AVI File LIST">

    <!-- A template signature section. Alignment is 1. -->

    <signature align="1">

        <!-- A 4-byte signature at offset 0x00. -->
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        <field offset="0x00">4C 49 53 54</field> <!-- ANSI: LIST -->

    </signature>

    <!-- A data section. Its name is AVI File LIST. This is the main data section. It is not shown in the parsing
tree as a section (its name is ignored).-->

    <section name="AVI File LIST">

        <!-- The first 4 bytes are read and shown as an ANSI  string. -->

        <field type="char" size="4" name="Signature: LIST"/>

        <!-- The current position is moved to the beginning of the file (4 bytes backward). -->

        <goto offset="-4"/>

        <!-- The first 4 bytes in the file are read and shown as an unsigned integer. The internal variable signature
gets the value of the field. -->

        <field type="uint32" name="Signature LIST as unsigned integer" var="signature"/>

        <!-- A test against the condition (signature == LIST) -->

        <if test="signature == 1414744396"> <!-- ANSI: LIST -->

            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable listSize gets its
value. -->

            <field type="uint32" name="Size of the data in the list" var="listSize"/>

            <setvar var="endOfList" expr="offset + listSize"/>

            <field type="char" size="4" name="List type"/>

            <goto offset="-4"/>

            <field type="uint32" base="hex" name="List type as unsigned integer in hex
format" var="listType"/>

            <!-- A test against condition (listType == movi) -->

            <if test="listType == 0x69766f6d"> <!-- ANSI: movi -->

                <!-- This chunk is not to be parsed. The current position is moved to the end of the chunk. -->

                <goto address="endOfList"/>

            </if>

            <setvar var="mediaType" expr="0"/>

            <repeat test="endOfList > offset - 8">

                <section name="CHUNK">

                    <field type="char" size="4" name="Chunk ID"/>

                    <goto offset="-4"/>

                    <field type="uint32" name="Chunk ID as unsigned integer" var="chunkId"/>

                    <if test="chunkId == 1414744396"> <!-- ANSI: LIST -->

                        <goto offset="-4"/>
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        <field type="uint32" base="hex" name="LIST chunk ID as unsigned integer in hex
format" as-offset="start_position + offset - 4" assigned-template="AVI File LIST"/>

                    </if>

                    <field type="uint32" name="Size of the data in the chunk"
var="chunkSize"/>

                    <setvar var="endOfChunk" expr="offset + chunkSize"/>

                    <!-- Rounding the value of the variable endOfChunk to a number divisible by 2. -->

                    <if test="endOfChunk &amp; 1">

                        <setvar var="endOfChunk" expr="endOfChunk &amp; 0xFFFFFFFE"/>

                        <setvar var="endOfChunk" expr="endOfChunk + 2"/>

                    </if>                    

                    <if test="chunkId == 1751742049"> <!-- ANSI: avih -->

                        <field type="uint32" name="Number of microseconds between frames"/>

                        <field type="uint32" name="Approximate maximum data rate of the file"/>

                        <field type="uint32" name="Alignment for data, in bytes"/>

                        <field type="uint32" name="Bitwise combination of zero or more of the
flags"/>

                        <field type="uint32" name="Total number of frames of data in the file"/>

                        <field type="uint32" name="Initial frame for interleaved files"/>

                        <field type="uint32" name="Number of streams in the file"/>

                        <field type="uint32" name="Suggested buffer size for reading the file"/>

                        <field type="uint32" name="Width of the AVI file in pixels"/>

                        <field type="uint32" name="Height of the AVI file in pixels"/>

                        <field type="binary" size="16" name="Reserved"/>

                    </if>

                    <if test="chunkId == 1852994675"> <!-- ANSI: strn -->

                        <field type="char" size="chunkSize" name="Stream name"/>

                    </if>

                    <if test="chunkId == 1752331379"> <!-- ANSI: strh -->

                        <field type="char" size="4" name="Type"/>

                        <goto offset="-4"/>

                        <field type="uint32" base="hex" name="Type as unsigned integer in hex
format" var="type"/>

                        <setvar var="mediaType" expr="type"/>

                        <field type="char" size="4" name="Handler (codec)"/>

                        <field type="uint32" base="hex" name="Flags"/>



R-Studio Manual280

© 2025 R-Tools Technology Inc.

                        <field type="uint32" name="Number of the first block of the stream that
is present in the file"/>

                        <field type="uint32" name="Scale"/>

                        <field type="uint32" name="Rate"/>

                        <field type="uint32" name="Start time of stream"/>

                        <field type="uint32" name="Size of stream in units as defined in Rate
and Scale"/>

                        <field type="uint32" name="Size of buffer necessary to store blocks of
that stream"/>

                        <field type="uint32" name="Quality"/>

                        <field type="uint32" name="Sample size (number of bytes of one stream
atom)"/>

                    </if>

                    <if test="chunkId == 1718776947"> <!-- ANSI: strf -->

                        <if test="mediaType == 0x73646976"> <!-- ANSI: vids -->

                            <section name="BITMAPINFOHEADER">

                                <field type="uint32" name="Number of bytes required by the
structure"/>

                                <field type="int32" name="Width of the bitmap, in pixels"/>

                                <field type="int32" name="Height of the bitmap, in pixels"/>

                                <field type="uint16" name="Number of planes for the target device"/>

                                <field type="uint16" name="Number of bits-per-pixel"/>

                                <field type="uint32" name="Type of compression for a compressed
bottom-up bitmap"/>

                                <field type="uint32" name="Size, in bytes, of the image"/>

                                <field type="int32" name="Horizontal resolution, in pixels-per-
meter, of the target device for the bitmap"/>

                                <field type="int32" name="Vertical resolution, in pixels-per-meter,
of the target device for the bitmap"/>

                                <field type="uint32" name="Number of color indexes in the color
table that are actually used by the bitmap"/>

                                <field type="uint32" name="Number of color indexes that are required
for displaying the bitmap"/>

                            </section>

                        </if>

                        

                        <if test="mediaType == 0x73647561"> <!-- ANSI: auds -->

                            <section name="WAVEFORMATEX">

                                <field type="uint16" name="Waveform-audio format type"/>

                                <field type="uint16" name="Number of channels in the waveform-audio
data"/>
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                                <field type="uint32" name="Sample rate, in samples per second
(hertz)"/>

                                <field type="uint32" name="Required average data-transfer rate, in
bytes per second, for the format tag"/>

                                <field type="uint16" name="Block alignment, in bytes"/>

                                <field type="uint16" name="Bits per sample for the Waveform-audio
format type"/>

                                <field type="uint16" name="Size, in bytes, of extra format
information appended to the end of the WAVEFORMATEX structure"/>

                            </section>

                        </if>

                    </if>

                    <goto address="endOfChunk"/>

                </section>

            </repeat>

        </if>

        <if test="signature != 1414744396">

            <section name="Invalid LIST signature found">

            </section>

        </if>

    </section>
</template>
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V Technical Information and Troubleshooting

This chapter covers various technical issues and troubleshooting.

· IntelligentScan technology

· Data Recovery Issues

· Extended Information Recovery

· Data Formats and Multipliers

· Data Recovery on HFS/HFS+ file system

· Supported Virtual Disk and Disk Image Formats

· Bad Sectors

· File Information (R-Studio Technician/T80+)

· Memory Usage

· Forensic Mode

· R-Studio for Linux Switches

· Properties Tab

R-Studio for Linux Features
Contact Information and Technical Support
Data Recovery Using R-Studio for Linux
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Volume Sets and RAIDs

Data Recovery over Network
Text/?hexadecimal editor
R-Studio Emergency
R-Studio Agent Emergency

5.1 IntelligentScan Technology

R-Studio for Linux uses a unique IntelligentScan technology when it tries to recover data on the area being
scanned. 

While scanning the selected area, R-Studio for Linux reads data directly from the disk, analyzes them, and tries
to determine a record to which the data belong. The following record types are possible:

· MBR/GPT records
· NTFS Boot Sector, Folder, and MFT records
· FAT/exFAT Boot Sector, folder, and file records
· ReFS Boot sector records and ReFS Meta blocks
· HFS/HFS+ Volume headers and BTree+ nodes
· APFS Super blocks, APFS Volume blocks, and APFS nodes
· Ext2/3/4FS SuperBlocks records
· UFS/FFS SuperBlock records

https://www.r-studio.com/What-is-ExFAT.html
https://www.r-studio.com/What-is-UFS.html
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· Specific file signatures of Known File types for raw file carving

All these record types have different, but known, structure. Knowing valid values of record fields and relations
between them for each record type, R-Studio for Linux determines a record type for the data. If such record
type cannot be unambiguously determined, the data are assigned to the most probable record type. The same
data can be assigned to several record types, with a certain probability for each assignment. A list of possible
files is generated from these records.

R-Studio for Linux generates a record list for each record type. This list contains references to records
assigned to a record type from the list with their assignment probability. The same data can be included into
different record lists. Then R-Studio for Linux analyzes relations between elements in each list and between
different lists, and generates a list of found partitions with their parameters, such as partition start point and
probable size, file system type, cluster size, and existence probability.

Using the file list and partition list, R-Studio for Linux reconstructs file systems and files on the found partitions.
One file can be attributed to several different partitions.

When the entire disk or its part has been scanned, R-Studio for Linux shows all found partitions. Then the
parameters of the found partitions may be manually corrected, if additional information on them is available. 

Using the IntelligentScan technology, R-Studio for Linux can recover files not only on new and existing
partitions. It also can find and recover data on partitions that have been deleted or reformatted. If, for example,
there was an NTFS partition, which later was reformatted as a FAT partition, R-Studio for Linux will show
two partitions on the same place on the disk, one having the FAT file system, the other the NTFS. Then, found
files can be recovered.

The IntelligentScan technology makes R-Studio for Linux a very powerful data recovery tool, but it is not
omnipotent. As it uses probabilistic approach to data reconstruction, it cannot guarantee 100% correct results.
Moreover, even if R-Studio for Linux has reconstructed data structure correctly, it is impossible to guarantee
that all found files will be completely and correctly recovered, as new data may be already written over the old
files. See the Data Recovery Issues topic for details.

5.2 Data Recovery Issues

NEVER TRY TO SAVE RECOVERED FILES/FOLDERS TO THE SAME LOGICAL DISK WHERE
THEY RESIDE!!!

Or you may obtain unpredictable results and lose all of your data.

R-Studio for Linux writes directly to a hard drive only when writing recovered data and from its hex editor, if
writing is enabled. In all other actions, R-Studio for Linux only reads data and analyzes them, and never
modifies data on the hard drives being analyzed. 

Most operating systems use lazy-write. So, there is a time lag between file actions and actual changes on data on
a hard drive. R-Studio for Linux analyzes data on hard drives only. That is why it does not always detect recent
changes in data structure.

Most operating systems constantly write their service information on hard drives. Such writing is especially
intensive during startup and shutdown procedures. When an operating system deletes a file/folder, it treats the
space where it has resided as empty and may write something in this place. If this happened, the file/folder and its
parameters may be detected correctly, but its data may be lost. 

Folder names like $$$Folder58448 on NTFS partitions mean that the folder has not been found on the drive but
some references to it have been. For example, folders My documents, Work, Photos have been found and all they
have one parent folder, whose description has not actually been found on the disk, so its name is unknown and

https://www.r-studio.com/What-is-Raw-File-Recovery.html
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-disk-format.html
https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-is-Disk-Partition.html
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therefore represented as $$$Folder58448. It may happen that the description of such folders was outside of the
scan area, so try to enlarge the region or scan the entire hard drive. If that does not help, most likely that the
description of the folder has been overwritten. 

Folder names like $ROOT58448 on FAT partitions mean that some folders have been found, but they cannot
be included into the folder structure for this FAT partition. Sometimes, such folders may contain other folder
structures.

If you recover a file, and it appears that the file contains wrong data, try to do the following:

· Scan: 
the logical disk, if the file has been just deleted.

the hard drive, if the data structure is damaged more seriously.

· Search for the file to be restored on all found partitions and try to recover it from all found partitions.
Check each recovered file to ensure that it contains correct data. As soon as you found the partition from
which the file is recovered correctly, use this partitions to recover all other deleted files.

If there are several deleted files to be restored, you should use a file larger than 2KB to select the required
partition.

FAT file system:

Cross-Linked Folders

Often R-Studio for Linux finds several FAT folder records that contain the same data. Such folders are called

cross-linked. R-Studio for Linux marks such folders with an arrow mark: 

R-Studio for Linux attributes the content of cross-linked folders to one folder called a target folder. When
recovering, R-Studio for Linux places the content to the target folder.

To view the list of cross-linked folders,

1 Right-click a cross-linked folder and select Cross Linked Folders on the context menu

> A list of cross-linked folders will appear

You may go to any folder in this list by clicking it.

To find a target folder, 

* Right-click a cross-linked folder and select Go Target on the context menu, or

Select the cross-linked folder and select Goto Target on the File menu

If Go Target is gray, this folder is already the target folder.

To set the target folder manually,

* Right-click a cross-linked folder and select Set As Default Target on the context menu, or

Select the cross-linked folder and select Set As Default Target on the File menu.

If Set As Default Target is gray, this folder is already the target folder.

Questionable Folders

Sometimes, R-Studio for Linux may find FAT records, which look like folders, but their content is invalid. For
example, file names have invalid characters, date, time, and size, or other file attributes may look strange. Please
note that R-Studio for Linux correctly recognizes localized names. R-Studio for Linux treats such records as
folders, but does not analyze their content and structure. You can manually scan such folders, but results may be
unpredictable. Usually, such scan reveals garbage.

https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-is-Logical-Disk.html
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R-Studio for Linux marks such folders with a question mark.

To re-scan an object, 

* Right-click a questionable folder on the R-Studio for Linux's Folders panel and select Rescan on the

context menu, or

Select the questionable folder and select Rescan on the File menu.

NTFS, APFS, HFS, XFS, and ext fs file systems:

Symbolic links (symlinks)

Symbolic links (of symlinks for short) are object that contains references to other files or folders directory in the
form of absolute or relative paths and that affect pathname resolution. For example, if a symlink C:
\ProgramData\Documents points to D:\Recovered Files\Root\Users\Public\Documents, entering it
will result in entering D:\Recovered Files\Root\Users\Public\Documents.

They are present in almost all modern file systems. NTFS, HFS+, APFS, and EXT FS are probably the most
popular examples.

R-Studio for Linux shows such symlinks and their targets in the following way:

Symlinks can be marked for recovery

Only symlinks on the picture above are marked for recovery. They will be recovered as real files and folders. 

https://www.r-studio.com/What-is-XFS.html
https://www.r-studio.com/What-is-ExtFS.html
https://www.r-studio.com/What-are-Hard-Soft-Links.html
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Only targets (real folders) on the picture above are marked for recovery. They will be recovered as real files and
folders. 

Both  targets (real folders) and symlinks on the picture above are marked for recovery. They will be recovered
as real files and folders and symlinks. 

The R-Studio for Linux Settings topic gives more details about symlink recovery.

Files:

Hard links 

Hard links are file system entries that give file names to files. This term is usually used when files may have several
names. R-Studio for Linux shows hard links using the following icons:

A hard link: 

The target file: 

You may find a target or hard link for a file. Right-click the file and select Links on the context menu.

5.3 Extended Information Recovery

R-Studio for Linux supports recovery of compressed files, alternative data streams, encrypted files, file security
and extended file attributes. If the R-Studio for Linux host OS and the file system of the disk you are going to
save file to support any particular extended information, it will be saved with the file, too. Otherwise, the
extended information will be saved as separate files with the same name as the restored file and extension
showing the type of the extended information. Below is a quick reference for the host OS and file system of the
target drive. 

Extended Information Required host OS Required target disk FS
Encrypted files Windows 2000/?XP/?2003/?Vista/?

2008/?7/?8/8.1/?10
NTFS

Alternative data streams Windows NT/2000/?XP/?2003/?
Vista/?2008/?7/?8/8.1/?10

NTFS

File security Windows NT/2000/?XP/?2003/?
Vista/?2008/?7/?8/8.1/?10

NTFS

https://www.r-studio.com/What-are-Hard-Soft-Links.html
https://www.r-studio.com/What-are-alternate-data-streams.html
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Extended file attributes Windows NT/2000/?XP/?2003/?
Vista/?2008/?7/?8/8.1/?10

NTFS or FAT/exFAT

5.4 Data Formats and Multipliers

You may enter data in all numerical fields either in sectors or in bytes. If there is no letters are after the number,
R-Studio for Linux assumes the numbers are in bytes.

Decimal numbers are entered as they are: 2372354

Hexadecimal numbers are entered as 0x23Fa67 or 23Fa67 hex.

The following case-insensitive notation is possible:
b 1 byte
kb 1 kb = 2^10=1024 bytes
mb 1 mb = 2^20=104857 bytes
gb 1 gb = 2^30=1073741824 bytes
tb 1 tb = 2^40=1099511627776 bytes
eb 1 eb = 2^50=1125899906842624 bytes
hex A hexadecimal number
sec
(sector)

A number is in sectors

You may also select the multipliers in the drop-down boxes. 

 Type an offset to which you want to go. You may select between bytes and sectors. See the Data
Formats and Multipliers topic for more details on data formats.

If a file is opened in Text/?hexadecimal Editor , you may select data representation for that file.

 

When the multiplier has been changed, the data value will be changed according to the specific context
commands for that field:

Suppose, the initial value is 1 GB, and the sector size of the object is 512 byte. The results will be the following:

Command: No recalculate

Change from GB to MB: 1

Change from GB to Sectors: 1

Command: Always recalculate

Change from GB to MB: 1024

Change from GB to Sectors: 2097152

Command: Units type recalculate

Change from GB to MB: 1

Change from GB to Sectors: 2097152

5.5 Data Recovery on HFS/HFS+ File System

When deleting a file, Mac OS X deletes system BTree+ records describing the file. Therefore, it is hard to
recover such file directly. Those records may remain in:
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1. The swap file (if the deleted file has been deleted recently).
2. In the journal (if the HFS+ journaling is on, and the deleted file has been CREATED recently)

Actually, if a file has been deleted, chances that the records would be found are small. To greatly increase the
chances to recover deleted files successfully , you may actively use scanning with enabled Known Files Types.

Note: All above is correct for intentionally deleted files. In case of a corrupted file system, HFS/HFS+ can be
recovered quite successfully.

When recovering files with HFS+-specific attributes (resource fork, finder info, etc.), R-Studio for Linux saves
them in the so-called AppleDouble format. When they are copied to an HFS+ disk under Mac OS X, those
attributes will be automatically restored.

5.6 Supported Virtual Disk and Disk Image Formats

Along with file formats used for purely disk backup and imaging purposes, there are file formats for virtual disks.
Virtual disks are software components that emulates data storage devices in virtual machines. A the same time,
virtual disks can be used for disk backup and imaging, too. That is why it’s expedient for disk backup and
imaging software to support various file formats for virtual disks. This is especially important for system
interoperability, when it’s necessary to use disk backup/image files on other machines where the disk backup and
imaging software isn’t installed.

Currently R-Studio for Linux supports the following virtual disk and disk image formats:

RDR: A proprietary disk image format developed by R-Tools Technology, Inc (R-TT). It is the main format
in R-Drive Image, R-Studio, R-Linux, and R-Undelete. RDR files are interchangeable, that is, any R-TT
program may load and process, within its capabilities, any rdr file created in another R-TT program. 

The following image formats can be created only in the R-Studio Corporate and Technician/T80+ versions:

VHD/VHDX: A virtual disk file format built into Windows. It’s a native virtual hard drive for Hyper-V, the
Windows virtual machine. You may read more about these file formats in Wikipedia: VHD (file format). R-
Studio creates a special file with some metadata for the VHD file format, its extension is vhr. The VHDX file
format contains this metadata within its main file.

VMDK: A virtual disk file format for the most virtual machines like VMware Workstation, VirtualBox, Parallels
Desktop for Mac, etc. You may read more about these file format in our Glossary: What is a VMDK Virtual
Disk.

VDI: A virtual disk file format for the VirtualBox virtual machine. R-Studio creates a special file with some
metadata for the VDI file format, its extension is vdr. You may read more about these file format in Wikipedia:
VDI.

R-Studio Standalone can load these image formats.

The main features of these file formats are presented in the table below:

Features RDR VHD/VHDX VMDK VDI

Several objects in
one file

Yes No No No

Compression Yes No Yes No

Encryption Yes No No No

Image Split Yes No Yes No

http://en.wikipedia.org/wiki/AppleSingle_and_AppleDouble_formats
https://www.r-studio.com/What-is-Disk-Image.html
https://en.wikipedia.org/wiki/VHD_(file_format)
https://www.R-Studio.com/What-is-VMDK-virtual-disk.html
https://www.R-Studio.com/What-is-VMDK-virtual-disk.html
https://en.wikipedia.org/wiki/VirtualBox#VirtualBox_Disk_Image
https://www.r-studio.com/What-is-Disk-Image.html
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Native mounting on
Windows

No Yes No No

Mounting on
Windows

using R-Studio
Yes Yes Yes Yes

Additional file formats that can be opened "read-only"

Extensions Description Licenses

dmg Apple Disk Image All

e01/(ewf) Expert Witness File Format Technician/T80+

aff Advanced Forensic Format Technician/T80+

5.7 Bad Sectors

Quite often, drives from which the data are to be recovered have bad sectors, or those sectors that are very
hard, even impossible, to read, mostly due to hardware problems. R-Studio for Linux tries to read such sectors
several times. The number of tries is specified either on the Settings/Bad Sectors dialog box, or on the
Properties tab, the Drive Control section, for each drive separately. 

When R-Studio for Linux encounters such bad sectors while performing various tasks and they appear
unreadable, it treats them as follows:

Object images:

R-Studio for Linux fills the space in the image file where the bad sectors should be with the pattern specified in
the Pattern to fill bad blocks field on the Settings/Bad Sectors dialog box. Please note that R-Studio for Linux
writes the pattern on the image, not on the source drive. 

Files

If Skip files with bad sectors on the Recovery dialog box is cleared,  R-Studio for Linux fills bad sectors in the
recovered file with the pattern specified on the the Settings/Bad Sectors dialog box. Information about such
files will appear in the Log.

If Skip files with bad sectors on the Recovery dialog box is selected,  R-Studio for Linux skips files with bad
sectors and displays their list on the Files with bad sectors dialog box when the recovery has been completed.
You may select files to immediately recover them or to mark for later recovery. You may also save this list to a
text file.

Files with bad sectors dialog box

Files with bad sectors Buttons

Select All Click this button to select all files in the list.

https://en.wikipedia.org/wiki/Apple_Disk_Image
https://en.wikipedia.org/wiki/EnCase#Expert_Witness_File_Format
https://www.loc.gov/preservation/digital/formats/fdd/fdd000412.shtml
https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Image.html
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Clear All Click this button to unselect all selected files.
Mark Click this button to mark all selected files in the list. 
Save to File Click this button to save the list of files with bad sectors to a text file. 
Recover Click this button to immediately recover selected files. The bad sectors in the

recovered files will be filled with the pattern specified in the Pattern to fill bad blocks

field on the Settings/Bad Sectors dialog box.

Objects edited in the Text/?hexadecimal editor/viewer

Bad sectors in the objects viewed/edited in the Text/?hexadecimal editor are shown as filled with the pattern
specified in the Pattern to fill bad blocks field on the Settings/Bad Sectors dialog box.

5.8 Memory Usage

You may see how much memory R-Studio for Linux uses while performing a data recovery task. This is
especially useful when scanning large disks on a computer with limited resources. You may specify memory
control options on the Memory usage tab in the R-Studio for Linux Settings

To view memory usage,

1 Select Memory usage on the Tools menu

> R-Studio for Linux will show the total memory in your computer and how much memory it uses

Memory usage dialog box

 Memory usage

Process Memory Shows how much memory R-Studio for Linux uses. Limit shows how much
memory your system can virtually allocate to R-Studio for Linux. Actual memory
allocation depends also on the RAM and swap file sizes.

System Memory
Physical

Shows how much RAM is in your system

System Memory
Swap

Shows how much virtual memory is in your system

5.9 R-Studio for Linux Command Line Commands and Switches

You may start R-Studio for Linux from the terminal using the following command: 

For R-Studio for Linux: rstudio.

For R-Studio for Linux Technician: rstudio-tech.

Note: You need to elevate your privilegies if you're not the root to start R-Studio for Linux.

If there are problems in starting R-Studio for Linux and while working with it, you may use switches to avoid
them.

The following switches are available:
-all_drives Forces R-Studio for Linux to show all logical disks in the system. Normally

R-Studio for Linux shows only local disks in the system. Some storage devices may
pretend that they are not local disks.

https://www.r-studio.com/What-is-Logical-Disk.html
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-debug Includes additional debug information. When this switch is used, an additional
command Create FS Snapshot on the context menu appears for an object with a file
system. An FS Snapshot contains system data for the file system only (file
descriptions without file contents). If a problem appears, this snapshot can be sent to
R-Studio for Linux technical support to identify the problem. This switch greatly
slows R-Studio for Linux. You may also turn this mode on by selecting Debug Mode

on the Settings dialog box.
-flush Flushes the log file after each write to log operations. This switch is helpful when

R-Studio for Linux locks and its log file remains in memory cache unwritten to a
disk. This switch greatly slows R-Studio for Linux.

-log <filename> Started with this switch, R-Studio for Linux writes its log into the specified file. If
R-Studio for Linux locks and its log file remains in memory cache unwritten to a
disk, use the -flush switch.

-mem <size in MB> Sets memory usage limit in MB for R-Studio for Linux to reconstruct the file tree.
When it exceeds the limit, a Too many files... message appears. You may temporally
stop file listing and browse through found files. Then you can resume file listing. You
also may skip this file section and continue file listing. Example: -mem 400 - sets the
limit to 400 MB.

-no_ide_ext Turns off the inquiry about extended information on HDDs in Wind9x/ME. This
switch may be helpful if R-Studio for Linux returns information about HDDs
incorrectly (detects HDD geometry incorrectly).

-no_int13 Turns off the disc access through Int13 in Wind9x/ME. This switch may be helpful if
the system operates incorrectly (detects HDD geometry incorrectly or lock the
system).

-no_ios Turns off the Wind9x/ME protected-mode I/O system. This switch may be helpful if
this system operates incorrectly (detects HDD geometry incorrectly or lock the
system).

-reset R-Studio for Linux resets an HDD controller each time it reads a bad sector. This
switch may be helpful if the controller locks after it attempts to read a bad sector, or
returns incorrect data.

-safe Disables automatic partition search on a hard drive, file system recognition on
partitions, and other potentially problematic operations. In this mode, it is necessary
to use Find partition command from the hard drive context menu to manually find a
partition.

If an unrecognized problem appears, start R-Studio for Linux with the -debug and -log <filename>

switches, and send the log and screenshot of the R-Studio for Linux main panel to the R-Studio for Linux
technical support:

R-Studio for Linux Technical Support Team is available 24 hours a day, seven days a week, and has an
average response time less than 4 hours.

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Partition.html
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5.10 Properties Tab

Object size units

You may select the units in which the information on object sizes will be displayed. Some parameters can be
edited when the Debug mode is turned on on the Main dialog box of the R-Studio for Linux settings.

To select the units

1 Select Properties on the View menu

2 Select the units in which you want to see object sizes.

You may select
Show as Bytes
Show as Sectors
Show as Bytes and Sectors

1.Basic information

This section shows basic information for a disk object.

 More information...

Drive Type Device/disk type and subtype. Current R-Studio for Linux version supports the
following types:
Disk, WORM, CDROM, Optical, Changer, Floppy, RAM Disk, LDM Partition, LDM
Component, LDM Volume

and subtypes:
Device, OS File, Physical Drive, Mount Point, Partition, Volume Set, Mirror, Stripe Set,
RAID 4, RAID 5, RAID 6

Name Device/disk name

Size Device/disk size

Bus Type Device/disk bus type. Can be:
IDE/ATA, IDE/ATAPI, SCSI, Floppy, USB, 1394, SSA, FibreChannel, RAID, SMART, ABIOS

2.Information on hard drives and logical disks

This section shows available information on hard drives and logical disks. These properties depend on the
drive/disk type and appear only when applicable. Under Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10,
an IDE drive/disk may be represented as a SCSI device, that is why the SCSI Address section appears under
these OSes for those drives/disks.

 More information...

OS object Appears for image files under Windows 9x/ME and NT/2000/?XP/?2003/?Vista/?2008/?7/?
8/8.1/?10, for drives/disks under Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10
only. An object name used by OS to access the device/disk.

R-Studio for Linux
driver

Driver names (both internal and OS) used to access this drive/disk.

Sector Size Drive/disk sector size
Physical Drive
Geometry

This section shows physical geometry for a hard drive. For a logical disk it shows the
physical geometry for a hard drive where the logical disk resides

Cylinders

Tracks Per Cylinder

https://www.r-studio.com/What-is-Logical-Disk.html
https://www.r-studio.com/What-is-Disk-Image.html
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Sectors Per Track

Sector Size

Device
Identification

This section shows vendor information for the drive/disk

Vendor

Product

Firmware

Bus

SCSI Address This section shows SCSI information for the drive/disk
Port Number

Path ID

Target ID

Lun

Windows 9x/ME adds the following properties:
Int13 Drive Number 128 for the first hard drive accessible through Int13, 129 for the second one, etc.

0...128 for drives and other devices accessible through a Windows 9x/ME protected
mode driver, if their Int13 device option is disabled. R-Studio for Linux can use
Int13 disk access, and for some drive types, like SCSI devices, Int13 access is
preferable. You may consider enabling the Int13 device option in the Windows Device
Manager for such devices.

Int13 Extension
Version

Int13 Extension Version Support for hard drives. Extended Int13 support is necessary
for large drives. If this property is zero, Extended Int13 is not supported, otherwise, it
shows Extended Int13 standard version, the large, the better.

3.Properties controlling access to hard drives and logical disks

This section shows properties that control access (read and write) to hard drives and logical disks. They are set
to their optimal values and should be altered only if access problems appear.

 More information...

Drive Control

Maximum transfer Maximum data size that can be read or written during a single access to the drive. If
there are problems with drive access, decrease the value of this property

I/O Unit Data size read or written during a single access to the drive is a multiple value of this
property. If there are problems with drive access, decrease the value of this property

Buffer Alignment Drive data transfer buffer is positioned at an address multiple value of this property. If
there are problems with drive access, increase the value of this property.

These three properties are set by OS drivers. If the drivers set incorrect values, problems may appear during
data transfer operations. You can alter them until data transfer becomes stable.
I/O Tries Number of read/write tries during access to the drive. If there are bad sectors on the

drive, increase the value of this property. This may help to successfully read those
sectors. Sometimes, if the I/O Tries parameter is set too large and there are some
unreadable sectors on the hard drive, the hard drive-controller pair may refuse to

https://www.r-studio.com/What-are-Bad-Sectors.html
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perform any successive read/write operations with the entire hard drive when it fails to
read/write such sectors. In this case, set this parameter to zero.
The default value is specified on the Settings (Bad Sectors) panel.
R-Studio for Linux treats bad sectors in the following way:
It reads a certain part of disk (predefined by Windows) and
· If Default read attempts is set to 0, the entire part with bad sectors will be filled with

the specified pattern. 
· If Default read attempts is set to a non-zero value, R-Studio for Linux reads again

that part sector by sector, repeating the attempts the specified number of times. If
R-Studio for Linux still cannot read a bad sector, it fills the sectors with the
specified pattern. In this case only the bad sectors will be filled with the pattern, but
that extremely slows the disk read process.

For example, if you set Default read attempts to 1, a bad sector will be read 2 times.

4.Partition properties

A partition is a continuous area on a hard drive, characterized by its offset and size. There are partitions on
basic disks, dynamic disks, and recognized volumes and partitions. R-Studio for Linux treats regions like
partitions.

 More information...

Partition Offset Initial offset for the partition.
Partition Size Size of the partition.
Partition Type File system type for the partition. If the record in the drive partition table is incorrect,

this property may differ from the actual file system type for this partition. Still,
R-Studio for Linux will process this partition correctly, as it does not use this
property.

Partition number Appears under Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10 only. Shows the
number of the partition on the physical drive.

For regions and recognized partitions, Partition Offset and Partition Type properties can be manually
corrected.

5.Compound volume properties

A compound volume is a union of several partitions or other disk objects. Each union type has its own rules,
unique for each compound volume type. Among compound volumes are: Volume Sets (RAIDs Level 0),
Mirrors (RAIDs Level 1), RAIDs4/5/6 (RAIDs Level 4/5/6), both physical and created by the user (Virtual
Volume Sets, Virtual Stripe Sets, Virtual Mirrors, Virtual RAID5).

 More information...

Main properties of compound volumes are parents (disk objects from which a compound volume is
created) and their order. These properties may be viewed in the Parents tab.  For user-created compound
volumes these properties may be altered.
Raid Block Size Data block size for compound volumes of RAID (Level 0-5) types

6.LDM disks and volumes (Dynamic Disks)

LDM disks and volumes are volumes controlled by Logical Disk Manager (LDM). They are represented on a
hard drive as a LDM database rather than partition tables. Under Windows 2000/?XP/?2003/?Vista/?2008/?7/?
8/8.1/?10, LDM disks are also called Dynamic Disks.

https://www.r-studio.com/What-is-Disk-Partition.html
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 More information...

Offset of Logical
Disk

Initial offset of a logical disk on a hard drive. For disks, initially formatted by LDM, this
value is often 31.5KB, for converted disks, it may be larger.

Supposed Parents
Count

Supposed number of parent partitions for compound LDM volumes. If the LDM
database is not damaged, the value of this property must be equal to the number of
parent objects in the Parents tab for the disk object.

LDM Host GUID Global Unique Identifier of a computer system where this LDM disk group has been
created.

LDM DiskGroup GUID Global Unique Identifier of the LDM disk group.
LDM Disk GUID Global Unique Identifier of the hard drive.
LDM Volume GUID Global Unique Identifier of the volume.
LDM Disk ID Local hard drive Identifier, unique within this LDM disk group.
LDM Partition ID Local partition Identifier, unique within this LDM disk group.
LDM Component ID Local component Identifier, unique within this LDM disk group.
LDM Volume ID Local volume Identifier, unique within this LDM disk group.
LDM Disk AltName Additional Alternative Name given by LDM to the hard drive.
LDM Disk DriveHint Last name of the volume, under which is has been mounted in the system. May be

either a letter (C:, D:, etc.), or a mount point under Windows 2000/?XP/?2003/?Vista/?
2008/?7/?8/8.1/?10.

7.File System Volume properties

A File System (FS) volume is a disk object where a certain, supported by R-Studio for Linux, file system is
present. There are two FS volume types: FS volume on a regular disk object and a recognized volume, found
by a scan process. FS volume properties depend on volume's file system and type.

7.1.NTFS Volume properties

These properties are present for all NTFS volumes and represent their main properties. For recognized
volumes, these values can be altered.

 More information...

NTFS Information Regular volumes
Recognized NTFS Recognized volumes
Cluster Size Cluster size for the NTFS volume.
MFT record size Size of one MFT record describing one file on the NTFS volume. This is an important

property of any NTFS volume. Its common value is 1KB. If this property has incorrect
value, many files may be incorrectly recovered.

Sector Size Sector size for the physical drive. This property is read from the boot sector of the
NTFS volume and does not affect R-Studio for Linux operation.

Index Block Size Index block size for the NTFS volume. This property determines binary trees used to
store NTFS folder structure. It does not affect R-Studio for Linux operation.

MFT position MFT offset from the start of the NTFS volume.
MFT Mirror Position Second MFT copy offset from the start of the NTFS volume.

https://www.r-studio.com/What-is-disk-format.html
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Volume size Size of the NTFS volume. This property does not affect R-Studio for Linux
operation.

7.2.FAT Volume properties

These properties are present for all FAT volumes and represent their main properties. For recognized
volumes, these values can be altered.

 More information... 

FAT Information Regular volumes
Recognized FAT Recognized volumes
FAT Bits (12,16,32) FAT type. 12 for the FAT12, 16 for the FAT16, 32 for the FAT32.
Cluster Size Cluster size for the FAT volume.
First Cluster Offset Offset of the first cluster from the start of the FAT volume.
Boot Directory
Cluster

(For FAT32 only.) Cluster number where the root directory starts on the FAT volume
where the logical disk resides.

Root Directory
Offset

(For FAT12 and 16 only.) Root directory offset from the start of the FAT volume.

Root Directory
Length

(For FAT12 and 16 only.) Root directory length for the FAT volume.

First FAT Offset Offset for the first FAT table on the volume. Together with the Size of One Fat Table

property, is a most important property for a FAT volume. If this property is incorrect,
many files (especially fragmented ones) may be incorrectly recovered.

Size of One FAT
Table

Size of one FAT table on the volume.

Sector Size Sector size of the hard drive. This property is read from the boot sector of the FAT
volume and does not affect R-Studio for Linux operation.

Number of FAT
Copies

Number of FAT copies on the FAT volume.

Active FAT copy Active FAT table number for the FAT volume. Can be set to Disabled, Auto, 1, or 2. If
it is Disabled, R-Studio for Linux processes the volume as there is no FAT table
present. This may be useful if the volume has been reformatted and thus a new FAT
table is created and the old one is deleted. In this case, it is reasonable to recover files
from the previous volume without processing the new and irrelevant FAT table. All
files will be recovered as continuous byte chains beginning from their start cluster.
Unfragmented files will be recovered successfully. If it is 1 or 2, R-Studio for Linux
uses the first or second FAT table copy, respectively. If it is Auto, R-Studio for Linux
uses both FAT table copies and decides, which FAT table copy should be used for a
particular FAT table sector. This may be useful when both FAT tables are partially
damaged. 

Major version FAT version.
Minor version FAT minor version.
Volume size Size of the volume.

7.3.Ext2/3/4FS Volume properties

These properties are present for all Ext2/3/4FS volumes and represent their main properties. For recognized
volumes, these values can be altered.

https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-is-ExtFS.html
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 More information...

Ext2/3/4FS
Information

Regular volumes

Recognized Ext2FS Recognized volumes
Block Size Block size of Ext2FS file system. A block in the Ext2FS file system is similar to a

cluster in the FAT file system.
First SuperBlock
Offset

Offset of the first SuperBlock from the start of the Ext2FS volume.

Blocks Per Volume Number of blocks in the Ext2FS volume.
INodes Per Volume Number of inodes on the Ext2FS volume. An inode is a record describing file's size,

attributes, position on an Ext2FS volume - all information about a file, except its name,
which is stored separately. Therefore, the INodes Per Volume parameter is equal to
the maximum number of files on an Ext2FS volume.

Creator OS The OS that created this Ext2FS volume. May be Linux, Hurd, Masix, FreeBSD, Lites.
Major version Ext2FS version. Usually 1.
Minor version Ext2FS minor version. Usually 0.
Last Mount Time Last mount time for this Ext2FS volume.
Last Write Time Last write time for this Ext2FS volume.
Last Check Time Last check time for this Ext2FS volume.
Volume size Size of the volume.

7.4.Recognized Volume properties

These properties are present for all recognized volumes, regardless of their file system type. They estimate
how reliable those volumes are recognized. This is useful for fast search for, and selection of, optimally
recognized volume to recover.

 More information... 

Parsed File Entries Number of files proving that this recognized volume existed. May have any non-
negative values. The main property characterizing the reliability of volume recognition.
The larger it, the higher probability that this recognized volume has file system
properties that have been correctly found.

Parsed Boot
Records

Number of boot records proving that this recognized volume existed. May be 0 or 1.
This is the second important property characterizing the reliability of volume
recognition.

Estimated Size Estimated size of the recognized FS partition/volume. This property shows the most
probable size of the recognized FS partition/volume. Alternatively, Size and Partition

Size are set to the highest possible values in order to recover the maximum number of
files.
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VI R-Studio Emergency

Note: You cannot use this program to work with Mac computers based on Apple Silicon.

R-Studio Emergency is a tool that allows you to startup a computer with a damaged startup disk and recover
data stored on its hard drives. Then restored data can either be saved on its disk or transferred to a working
computer via a network.

The R-Studio Emergency version is a part of the R-Studio software package. 

You may run this R-Studio Emergency version on a computer for which you have bought an R-
Studio license, and you may not transfer the licensed software to another computer.

R-Studio Emergency
Contact Information and Technical Support
Installing R-Studio Emergency Startup Media Creator
Creating Startup Disks

R-Studio Emergency Operation
Starting a Computer with the R-Studio Emergency Startup Disks
File Recovery
Searching for a File
Disk Scan
Disk Images

Using R-Studio Emergency as Emergency Agent

Technical Information
Network Drives
Properties and Text/Hexadecimal Viewer
Log
Devices to Store Recovered Files

Hardware Compatibility List

6.1 Contact Informaiton and Technical Support

To obtain the latest version of R-Studio Emergency, go to:

Product Site: http://www.r-tt.com
Sales Department: sales@r-tt.com

R-StudioTechnical Support Team is available 24 hours a day, seven days a week, and has an average response
time less than 4 hours.

Tech. Support: support@r-tt.com
Send your support request to: http://www.r-tt.com/Support_request.html

http://www.r-tt.com
mailto:sales@r-tt.com
mailto:support@r-tt.com
http://www.r-tt.com/Support_request.html
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6.2 Creating Startup Disks

· Installing R-Studio Emergency Startup Media Creator
· Creating Startup Disks Using R-Studio Emergency Startup Media Creator
· Creating Startup Disks for Mac and Linux Computers

6.2.1 Installing R-Studio Emergency Startup Media Creator

You must have administrative privileges to install R-Studio Emergency Startup Media Creator. 

If you are not sure whether you have such privileges, you almost certainly do not have them. Contact your system
administrator for assistance.

1 Run the setup wizard

2 Read the License Agreement and accept its conditions.

3 Select the installation location

4 Select the Start Menu Folder
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5 Wait for the program to install

6 You may start creating  R-Studio Emergency immediately upon install completion.

6.2.2 Creating Startup Disks Using R-Studio Emergency Startup Media Creator

You need to create either 

· A startup FAT/FAT32 removable device recognized by your system as a bootable one. The total available size
of the device should be more than 50 MB. You may use this device to start both UEFI computers (modern
Windows/Mac/Linux systems) and old Windows/Mac/Linux machines.
or

· A startup CD/DVD disc. You may create an ISO image, or write the disc directly from R-Studio Emergency

Startup Media Creator, if there is a CD/DVD recorder in your system. You may use this disc to start both
UEFI computers (modern Windows/Mac/Linux systems) and old Windows/Mac/Linux machines.

· An ISO image to start up a virtual machine, to create a USB device using other software, or to burn it to a
CD/DVD disc using your favorite CD/DVD writing software.

You may create a Linux-based or WinPE based startup disk.

Note: R-Studio Emergency Startup Media Creator supports creating WindowsPE startup disks starting from
Windows 8.1. It's possible to create such disk from R-Studio Emergency Startup Media Creator on earlier
Windows versions if you yourself correctly install a workable copy of WindowsPE Assessment and Deployment
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Kit (Windows ADK). Microsoft recommends Windows ADK from Windows 10 version 2004 (20H1) for
versions prior to Windows 10.

You may create the R-Studio Emergency on a USB Activation Stick.

1 Run R-Studio Emergency

Welcome dialog box

click the Next button to select the base for the startup disk.

A Linux-based disk

Check the Hardware Compatibility List.

If you have problems with starting you computer up from the R-Studio Emergency startup disks, select
Configure startup media troubleshooting options on the Startup media type selection dialog box. Then the
Startup Media Troubleshooting Options dialog box will appear. You may configure these options to eliminate
those problems.

2 Select Linux based on the Startup OS selection and click the Next button.

Startup OS selection dialog box

3 Select the device on which you want to create the startup disk.

https://www.r-studio.com/universal-usb-stick-for-professional-data-recovery.html
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Startup media type selection dialog box

3 Enter your license key to register your copy of the R-Studio Emergency Startup Media Creator and

click the Next button.

Registration dialog box

3 Read and accept the License Agreement and click the Next button.

License Agreement dialog box

4 Specify the path and name for the ISO file or verify that you've select the correct USB device and click
the Next button.
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Insert media dialog box

> R-Studio Emergency Startup Media Creator will start creating the startup USB disk showing the

progress on the Creating startup media dialog box

Creating startup media dialog box

R-Studio Emergency Startup Media Creation is Finished message

Startup Media Troubleshooting Options

Those options will help you if you have problems with starting you computer up from the R-Studio startup disks.
Please, contact the R-Studio Technical Support Team for more information.
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R-Studio Startup Media Troubleshooting Options dialog box

A WindowsPE-based disk

2 Select Windows based on the Startup OS selection and click the Next button.

Startup OS selection dialog box

If you select this option for the first time, you'll need to download and install some extra Windows components.
Click the Download button and follow the on-screen instructions. When the process is finished, you'll be able to
continue creating the startup disk. You don't have to perform these steps next times.

You may also add hardware drivers at this stage.

3 Select the device on which you want to create the startup disk.

Startup media type selection dialog box
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3 Enter your license key to register your copy of the R-Studio Emergency Startup Media Creator and

click the Next button.

Registration dialog box

3 Read and accept the License Agreement and click the Next button.

License Agreement dialog box

4 Specify the path and name for the ISO file or verify that you've select the correct USB device and click
the Next button.

Insert media dialog box
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> R-Studio Emergency Startup Media Creator will start creating the startup USB disk showing the

progress on the Creating startup media dialog box

Creating startup media dialog box

R-Studio Emergency Startup Media Creation is Finished message

6.2.3 Creating Startup Disks on Mac and Linux Computers

To start a Mac or a Linux computer, you may use the following devices:

1. A USB device created using the R-Studio Emergency Startup Media Creator for Windows. See the Creating
Startup Disks Using R-Studio Emergency Startup Media Creator page for more details. 

2. A USB device created using a Mac or Linux computer. To create such device, download the ZIP archive of
R-Studio Emergency, unzip it, and write files to a FAT32-formatted USB device.

Please note that you cannot use this disk to start non-UEFI computers (old Macs, for example), nor can you just
copy those files to a CD/DVD disc to create an R-Studio Emergency startup disc. If you need a CD/DVD disk,
burn it using the ISO image.

3. A startup CD/DVD disc. Download the ISO image of that disk and burn it or use the R-Studio Emergency
Startup Media Creator for Windows to burn it on a Windows computer.

6.3 R-Studio Emergency Operation

Starting a Computer with the R-Studio Emergency Startup Disks
File Recovery
Searching for a File
Disk Scan
Disk Images

Using R-Studio Emergency as Emergency Agent
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Technical Information
Properties and Text/Hexadecimal Viewer
Network Drives
Log
Devices to Store Recovered Files

Hardware Compatibility List

R-Studio Emergency
Contact Information and Technical Support
Installing R-Studio Emergency Startup Media Creator
Creating Startup Disks

6.3.1 Starting a Computer with the R-Studio Emergency Startup Disks

We recommended that you print out this help page and have the hardcopy on hand while you are
performing this action.

If there is a non-IDE disk controller in your system, or you plan to use network disks or external hardware
devices, first check the Hardware Compatibility List.

If you plan to use any external device, turn it on before starting the system.

If the motherboard in your computer supports the Serial ATA (SATA) devices, but IDE disks are also present,
only the SATA devices should be set to the Enhanced Mode in BIOS.

To start the computer with the R-Studio Emergency startup CD/DVD disc or any removable
device,

1 Make sure that the first startup device in the system BIOS is the CD/DVD drive or the removable device

Disable "Secure boot" in the system BIOS if your computer is certified to run Windows 8. Refer to your
system documentation for details.

2 Insert the R-Studio Emergency startup CD/DVD disc and start your computer

If you have a Mac computer

To start a Mac computer with the R-Studio Emergency startup disk, 

1. Insert a CD/DVD disc or connect a USB disk

2. Switch the Mac on.

3. While loading, press the Option key on the Mac keyboard (the Alt key if you use a non-Apple keyboard).
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The Options key

4. Select the EFI boot disk and press Enter.

The R-Studio Emergency startup disk

R-Studio Emergency will start loading.

Then a startup screen will appear:

Select the R-Studio Emergency GUI (Graphic Mode) to run R-Studio Emergency in the graphic mode
in which its user interface is similar to the Windows version. If R-Studio Emergency cannot run in this
mode, restart the system in the Safe VGA mode (only VESA-compliant) which is compatible with most
video cards and monitors. If it fails too, select the Text mode in which the R-Studio Emergency user
interface is shown in the pseudo-graphic mode compatible with all video cards. The help describes this
pseudo-graphic mode.

> R-Studio Emergency will start and its Device/Disk panel will appear

To start the computer with the R-Studio Emergency startup floppy disks,
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1 Make sure that the first startup device in the system BIOS is A (Floppy)

Refer to your system documentation for details.

2 Insert the first startup floppy disk and start your computer

> The following text will appear on the screen:

Loading
Uncompressing ... OK, starting the kernel
VFS: Insert the second boot disk and press ENTER

3 Insert the second disk and press ENTER.

> R-Studio Emergency will start and its Device/Disk panel will appear

Secure boot:

It may be impossible to start a Windows 8 certified computer with the R-Studio Emergency startup disk without
some additional actions. This happens because any computer should use a so-called "Secure boot" procedure to
comply with Windows 8 hardware certification from Microsoft. In brief, this procedure prevents computer from
booting into any operating system that isn't digitally signed with an appropriate digital signature. "Secure boot" is
claimed to prevent unauthorized modification of the boot sector by bootkits, viruses, trojans, and other malicious
software. To the date, only Windows 8, Windows Server 2012, and selected Linux distributions support this
feature. As a side effect, it also prevents most LiveCDs, rescue disks (R-Studio and R-Drive Image included),
and other OS from running.

Likely enough, the other requirement of Windows 8 hardware certification is to make it possible for the user to
disable the Secure boot procedure. Those settings can be done through the system BIOS under the Boot
options. Generally, it's enough to enable Legacy support in those options, but sometimes it may require additional
actions. Please, refer to your system documentation to learn more about disabling/enabling Secure boot.

When Secure boot is disabled, it should be possible to start the computer with the R-Studio Emergency startup
disk.

Please note that you should enable this feature back after using the startup disks because Windows 8 or Server
2012 may not start properly without the Secure boot feature enabled.

6.3.2 File Recovery

To recover files,

1 Select a partition on the Device/Disk panel on which the files to recover reside and press the Enter key

> R-Studiowill change its panel showing the disk's folders/files structure

2 Select the file to recover on the Files View panel. Use the Tab key to switch between panes
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Files View panel

3 Press the F2 key and specify the output folder on the Recover dialog box

Recover dialog box

External USB drives with the NTFS file system: R-Studio Emergency can save recovered files on
such disks if they are properly disconnected in a Windows system using the Safely Remove Hardware icon
in the system tray or while shutting Windows down. 

Searching for a File
Mapping Network Drives
Viewing object properties

6.3.3 Searching for a File

To search for a file, 

1 Select Find on the Tools menu (or press the Alt+F key)

2 Specify a file name or mask

Find dialog box

Look at dialog box
Deleted files: If it is selected, R-Studio makes a search among deleted files/folders.
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Existing files: If it is selected, R-Studio makes a search among existing files/folders.
Files: If it is selected, R-Studio includes files into a search.
Folders: If it is selected, R-Studio includes folders into a search.

To find the next file corresponding to the specified file mask, 

* Press the Alt+N key

6.3.4 Disk Scan

To scan an object

1 Select an object on the Device/Disk panel and press the F6 key

2 Specify the required parameters on the Scan dialog box and press the Enter key

Scan dialog box

Scan dialog box
Start: Sets the start point of the area to be scanned.
Size: Sets the size of the area to be scanned.
Numbers in these fields can be in bytes or sectors.
If no letters are after the numbers, R-Studioassumes the numbers in bytes. 
The following case-ignoring notation is possible: 

b
kb
mb
gb
tb

Bytes
Kilobytes
Megabytes
Gigabytes
Terabytes
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> When an object is scanned, it may be searched for files, and found files may be recovered the same
way as for a regular object

Scan results

Found objects:
Extra Found Files Entries of known file types have been found
Recognized1 Records and file entries are found for this partition
Recognized2 Only file entries are found for this partition
Recognized3 Only boot records are found for this partition

To save scan information

1 Select an object with scan information

2 Press the Alt+D key and select Save Scan Information on the Drive menu

3 Specify the output folder and file name on the Save Scan Information dialog box

Mapping Network Drives

To open scan information

1 Select an object to which scan information is to be opened

2 Press the Alt+D key and select Open Scan Information on the Drive menu

3 Specify the folder and file name with the scan information on the Open Scan Information dialog box

Mapping Network Drives

To delete scan information

1 Select an object to which scan information is to be deleted

2 Press the Alt+D key and select Delete Scan Information on the Drive menu

6.3.5 Disk Images

To create an image file

1 Select an object on the Device/Disk panel
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2 Press the Alt+D key and select Create Plain Image File or Create Compressed Image File on the Drive
menu

Create Image dialog box

Plain Image If this option is selected, R-Studio will create a simple exact copy of the
object. This image format is compatible with the previous versions of R-

Studio.
Compressed Image If this option is selected, R-Studio will create an image file compatible with

the images created by R-Drive Image, but incompatible with the previous
versions of R-Studio.

3 Specify the output folder and file name on the Create Image File dialog box

Mapping Network Drives

To load an image file

1 Press the Alt+D key and select Open Image File on the Drive menu

2 Specify the folder and file name with the image on the Open Image File dialog box

Mapping Network Drives

6.4 Using R-Studio Emergency as an Emergency Agent

R-Studio Emergency Linux version can be used as an emergency agent for R-Studio. Moreover, if you have
a Mac computer, this is the only way to start it with R-Studio Agent Emergency.

To start the computer with the R-Studio Emergency/Agent startup CD/DVD disc or any removable
device ,

1 Make sure that the first startup device in the system BIOS is the CD/DVD drive or the removable device

Disable "Secure boot" in the system BIOS if your computer is certified to run Windows 8. Refer to your
system documentation for details.

2 Insert the R-Studio Emergency startup CD/DVD disc or the removable device and start your computer

If you have a Mac computer

To start a Mac computer with the R-Studio Emergency startup disk, 

1. Insert a CD/DVD disc or connect a USB disk

2. Switch the Mac on.

3. While loading, press the Option key on the Mac keyboard (the Alt key if you use a non-Apple keyboard).
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The Options key

4. Select the EFI boot disk and press Enter.

The R-Studio Emergency startup disk

R-Studio Emergency will start loading.

Then a startup screen will appear:

Startup Options 

2 Select the R-Studio Agent Emergency to run R-Studio Emergency as an emergency agent.

> R-Studio Agent Emergency will start and its prompt will appear
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R-Studio Emergency as an Emergency Agent

If your network has a DHCP server

The computer running R-Studio Agent Emergency will be assigned an IP address automatically

A prompt with a computer address will appear. You need to remember it to access the computer via
network.

If your network does not have a DHCP server

You need to configure the interfaces and IP addresses manually. 

1. Press Enter to start configuring the settings. A prompt to select an interface will appear. Enter the selected
interface name and press Enter.

2. A prompt to enter its IP address and optional subnet mask will appear. Enter the IP address and optional
subnet mask and press Enter.

 Network Setting Configuration

3. A prompt to configure another interface, gateway, or to finish configuring the interfaces will appear. Enter
gw, enter the IP address of the gateway, and press Enter.

 Network Setting Configuration

4. Press Enter to finish configuring the interfaces, or enter the name of the next interface to configure. 
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> R-Studio Agent Emergency will show a prompt that is ready to accept connections

R-Studio Emergency as an Emergency Agent

Now the computer may be accessed by R-Studio via network.

.

Secure boot:

It may be impossible to start a Windows 8 certified computer with the R-Studio Emergency startup disk without
some additional actions. This happens because any computer should use a so-called "Secure boot" procedure to
comply with Windows 8 hardware certification from Microsoft. In brief, this procedure prevents computer from
booting into any operating system that isn't digitally signed with an appropriate digital signature. "Secure boot" is
claimed to prevent unauthorized modification of the boot sector by bootkits, viruses, trojans, and other malicious
software. To the date, only Windows 8, Windows Server 2012, and selected Linux distributions support this
feature. As a side effect, it also prevents most LiveCDs, rescue disks (R-Studio and R-Drive Image included),
and other OS from running.

Likely enough, the other requirement of Windows 8 hardware certification is to make it possible for the user to
disable the Secure boot procedure. Those settings can be done through the system BIOS under the Boot
options. Generally, it's enough to enable Legacy support in those options, but sometimes it may require additional
actions. Please, refer to your system documentation to learn more about disabling/enabling Secure boot.

When Secure boot is disabled, it should be possible to start the computer with the R-Studio Emergency startup
disk.

Please note that you should enable this feature back after using the startup disks because Windows 8 or Server
2012 may not start properly without the Secure boot feature enabled.

To connect to R-Studio's computer,

1 Press the Enter key and enter the IP address of the computer where R-Studio is running as

IPaddress:port.

The default port is 8080, and you don't have to specify it.
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2 Enter the password if required, and press the Enter key.

> When the connection is established successfully, R-Studio Agent Emergency will notify you about

this.

R-Studio Emergency as an Emergency Agent

6.5 R-Studio Emergency Technical Information

Properties and Text/Hexadecimal Viewer
Network Drives
Log
Devices to Store Recovered Files
R-Studio Emergency

R-Studio Emergency
Contact Information and Technical Support
Installing R-Studio Emergency Startup Media Creator
Creating Startup Disks

R-Studio Emergency Operation
Starting a Computer with the R-Studio Emergency Startup Disks
File Recovery
Searching for a File
Disk Scan
Disk Images

Using R-Studio Emergency as Emergency Agent

Hardware Compatibility List

6.5.1 Properties and Text/Hexadecimal Viewer

To view object properties, 

1 Select an object

2 Press the F7 key
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To view an object

1 Select an object

2 Press the F3 key

3 Press the F6 key to view and select file attributes

Press the Esc key to close the viewer.

6.5.2 Network Drives

To map a network drive,

1 On a dialog box with Map Network Drive, press the Alt+M key

> The Querying DHCP message will appear 

If the network has a DHCP server, the computer will obtain an IP address automatically. A list of adapters
and their IP addresses will appear on the Network Adapters dialog box.

If the network does not have a DHCP server, select a network adapter on the Network Adapters dialog
box and press the F4 key. Enter the IP address and network mask and press the Enter button.

Network Addresses dialog box

2 Select a configured network adapter and press the Enter key

3 Enter the required information on the Map Network Drive message message

Map Network dialog box

Server IP Address: IP address of the computer where the network drive is to reside.
Server Share Name: Name of the shared folder where the network drive is to reside.
Login: Username of a user on the computer where the network drive is to reside.
Password: User's password on the computer where the network drive is to reside.

For the network drive's path //SERVER/Net_Drive, 
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Server IP address: The IP address of the SERVER computer (192.168.1.20)

Server share name: Net_Drive. 

> The mounted network disk will appear

To disconnect a mounted network drive

1 Select a mounted network drive

2 Switch to the Disconnect button and press the Enter key

6.5.3 Log

To clear log information

* Select Clear Log on the Tools menu

To save log information to a file

* Select Save Log To File on the Tools menu

6.5.4 Devices to Store Recovered Files

R-Studio Emergency can write recovered files to the following devices:

· FAT devices such as USB sticks, memory cards, and other similar devices. Such devices are inexpensive and
easily available, they can be fully accessed by all operating systems, but they have one important drawback:
they cannot store files larger that 2GB. So, if you plan to recover large video files, this is not your option.

· exFAT devices such as large USB sticks and memory cards, external hard disks, and other similar devices.
They are fully accessed by all operating systems. Unlike FAT devices, they don't have the 2GB file size limit.

· NTFS disks (primarily used in Windows computers).

 Access without any third-party software:

Windows computers: full.

Mac computers: read. 

Linux computers: full.

· HFS/HFS+ disks (used in Mac computers). 

Access without any third-party software:

Windows computers: no.

Mac computers: full. Some access problems may appear for files written by R-Studio Emergency.

Linux computers: full. Some access problems may appear for files written by R-Studio Emergency.

· Ext2/3/4 disks (used in Linux computers). 

Access without any third-party software:

Windows computers: no.

Mac computers: no

Linux computers: full.



R-Studio Manual320

© 2025 R-Tools Technology Inc.

· XFS disks (used in Linux computers). 

Access without any third-party software:

Windows computers: no.

Mac computers: no

Linux computers: full.

· Network disks. Such disks may be on other network computers or NAS devices. See the Network Drives

page for more details

How to solve file access problems on Macs

Finder in the OSX system shows such inaccessible folders and files in the following way:
Inaccessible folders in Finder

To get access to such data, do the following:

1. Under an administrator account, right-click the folder and select Get Info on the contextual menu.
Info of an inaccessible folder

Click the Lock icon in the Sharing & Permissions section to unlock the folder properties. The system will
ask you for the account password.
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2. Click the Privilege column and select Read & Write on the contextual menu.
Setting the access rights for the folder

3. If this is a folder with other folders and files, click the Properties icon and select Apply to enclosed

items.

Setting access rights for enclosed items in the folder

Then click the Lock icon to lock the properties back. 

6.6 R-Studio Emergency Hardware Compatibility List

R-Studio Emergency supports the following hardware devices:

Data Storage Devices Networking Devices

Serial ATA and Parallel ATA drivers

ACPI firmware driver for PATA

AHCI SATA

ALi PATA

AMD/NVidia PATA

ARTOP 6210/6260 PATA

ARTOP/Acard ATP867X PATA

ATI PATA

CMD / Silicon Image 680 PATA

CMD640 PCI PATA

CMD64x PATA

CS5510/5520 PATA

CS5530 PATA

CS5535 PATA

Ethernet (10 or 100Mbit)

3c501 `EtherLink`

3c503 `EtherLink II`

3c505 `EtherLink Plus`

3c507 `EtherLink 16`

3c509/3c529 (MCA)/3c579 `EtherLink III`

3c515 ISA `Fast EtherLink`

3c590/3c900 series (592/595/597)
`Vortex/Boomerang`

3cr990 series `Typhoon`

AMD 8111 (new PCI lance)

AMD LANCE and PCnet (AT1500 and NE2100)

AMD PCnet32 PCI

AT1700/1720
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CS5536 PATA

Compaq Triflex PATA

Cypress CY82C693 PATA

EFAR SLC90E66

Generic ATA

HPT 343/363 PATA

HPT 366/368 PATA

HPT 370/370A/371/372/374/302 PATA

HPT 372N/302N PATA

IT8211/2 PATA

IT8213 PATA

Initio 162x SATA

Intel ESB, ICH, PIIX3, PIIX4 PATA/SATA

Intel PATA MPIIX

Intel PATA old PIIX

Intel SCH PATA

JMicron PATA

Legacy ISA PATA

Marvell PATA support via legacy mode

Marvell SATA

NETCELL Revolution RAID

NVIDIA SATA

Nat Semi NS87410 PATA

Nat Semi NS87415 PATA

Ninja32/Delkin Cardbus ATA

OPTI FireStar PATA

OPTI621/6215 PATA

Older Promise PATA controller

PCMCIA PATA

Pacific Digital ADMA

Pacific Digital SATA QStor

Platform AHCI SATA

Promise PATA 2027x

Promise SATA SX4

Promise SATA TX2/TX4

QDI VLB PATA

RADISYS 82600 PATA

RDC PATA

SC1200 PATA

SERVERWORKS OSB4/CSB5/CSB6/HT1000
PATA

Adaptec Starfire/DuraLAN

Ansel Communications EISA 3200

Apricot Xen-II on board Ethernet

Atheros L2 Fast Ethernet

Broadcom 440x/47xx ethernet

CS89x0

Cabletron E21xx

DECchip Tulip (dc2114x) PCI

Dave ethernet support (DNET)

Davicom DM910x/DM980x

Early DECchip Tulip (dc2104x) PCI

EtherExpress 16

EtherExpressPro support/EtherExpress 10 (i82595)

Generic DECchip & DIGITAL EtherWORKS
PCI/EISA

HP 10/100VG PCLAN (ISA, EISA, PCI)

HP PCLAN (27245 and other 27xxx series)

HP PCLAN+ (27247B and 27252A)

ICL EtherTeam 16i/32

Intel(R) PRO/100+

LP486E on board Ethernet

Myson MTD-8xx PCI Ethernet

NE2000/NE1000

NI5010

NI5210

NI6510

National Semiconductor DP8381x series PCI
Ethernet

OpenCores 10/100 Mbps Ethernet MAC

PCI NE2000 and clones support (see help)

RDC R6040 Fast Ethernet Adapter

RealTek RTL-8129/8130/8139 PCI Fast Ethernet
Adapter

RealTek RTL-8139 C+ PCI Fast Ethernet Adapter

SEEQ8005

SMC 9194

SMC EtherPower II

SMC Ultra

SMSC LAN9420 PCI ethernet adapter

SiS 900/7016 PCI Fast Ethernet Adapter

Silan SC92031 PCI Fast Ethernet Adapter driver



R-Studio Emergency 323

© 2025 R-Tools Technology Inc.

ServerWorks Frodo / Apple K2 SATA

SiS 964/965/966/180 SATA

SiS PATA

Silicon Image 3124/3132 SATA

Silicon Image SATA

ULi Electronics SATA

VIA PATA

VIA SATA

VITESSE VSC-7174 / INTEL 31244 SATA

Winbond SL82C105 PATA

Winbond W83759A VLB PATA

SCSI low-level drivers

3ware 5/6/7/8xxx ATA-RAID

3ware 97xx SAS/SATA-RAID

3ware 9xxx SATA-RAID

7000FASST SCSI

ACARD SCSI

ARECA (ARC11xx/12xx/13xx/16xx)
SATA/SAS RAID Host Adapter

Adaptec AACRAID

Adaptec AHA152X/2825

Adaptec AHA1542

Adaptec AIC79xx U320

Adaptec AIC7xxx

Adaptec AIC7xxx Fast -> U160

Adaptec AIC94xx SAS/SATA

Adaptec I2O RAID

AdvanSys SCSI

Always IN2000 SCSI

BusLogic SCSI

DMX3191D SCSI

DTC3180/3280 SCSI

EATA ISA/EISA/PCI (DPT and generic
EATA/DMA-compliant boards)

Emulex LightPulse Fibre Channel Support

Future Domain 16xx SCSI/AHA-2920A

Generic NCR5380/53c400 SCSI MMIO

Generic NCR5380/53c400 SCSI PIO

HP Smart Array SCSI driver

HighPoint RocketRAID 3xxx/4xxx Controller

Sun Cassini

Sun GEM

Sun Happy Meal 10/100baseT

Sundance Alta

TI ThunderLAN

ULi M526x controller

VIA Rhine

WD80*3

Winbond W89c840 Ethernet

Zenith Z-Note

nForce Ethernet

Ethernet (1000 Mbit)

Alteon AceNIC/3Com 3C985/NetGear GA620
Gigabit

Atheros L1C Gigabit Ethernet

Atheros L1E Gigabit Ethernet

Atheros/Attansic L1 Gigabit Ethernet

Broadcom CNIC

Broadcom NetXtremeII

Broadcom Tigon3

DL2000/TC902x-based Gigabit Ethernet

IP1000 Gigabit Ethernet

Intel(R) 82575/82576 PCI-Express Gigabit Ethernet

Intel(R) 82576 Virtual Function Ethernet

Intel(R) PRO/1000 Gigabit Ethernet

Intel(R) PRO/1000 PCI-Express Gigabit Ethernet

JMicron(R) PCI-Express Gigabit Ethernet

National Semiconductor DP83820

New SysKonnect GigaEthernet

Packet Engines Hamachi GNIC-II

Packet Engines Yellowfin Gigabit-NIC

QLogic QLA3XXX Network Driver Support

Realtek 8169 gigabit ethernet

SiS190/SiS191 gigabit ethernet

SysKonnect Yukon2

VIA Velocity

Ethernet (10000 Mbit)

Broadcom NetXtremeII 10Gb

Chelsio 10Gb Ethernet

Chelsio Communications T3 10Gb Ethernet
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IBM Power Linux RAID adapter

IBM ServeRAID

Initio 9100U(W)

Initio INI-A100U2W

Intel/ICP (former GDT SCSI Disk Array) RAID
Controller

LSI Logic Legacy MegaRAID Driver

LSI Logic Management Module

LSI Logic MegaRAID Driver

LSI Logic MegaRAID SAS RAID Module

LSI MPT Fusion SAS 2.0 Device Driver

Marvell 88SE64XX/88SE94XX SAS/SATA

NCR53c406a SCSI

PAS16 SCSI

PMC SIERRA Linux MaxRAID adapter

PMC-Sierra SPC 8001 SAS/SATA Based Host
Adapter driver

Promise SuperTrak EX Series

QLogic ISP4XXX host adapter family

QLogic QLA2XXX Fibre Channel Support

Qlogic FAS SCSI

Qlogic QLA 1240/1x80/1x160 SCSI

SYM53C8XX Version 2 SCSI

Symbios 53c416 SCSI

Tekram DC390(T) and Am53/79C974 SCSI

Tekram DC395(U/UW/F) and DC315(U) SCSI

Trantor T128/T128F/T228 SCSI

UltraStor 14F/34F

UltraStor SCSI

VMware PVSCSI driver

Workbit NinjaSCSI-32Bi/UDE

USB support

Cypress C67x00 HCD

Datafab Compact Flash Reader

Freecom USB/ATAPI Bridge

ISD-200 USB/ATA Bridge

ISP 1760 HCD

ISP116X HCD

ISP1362 HCD

Lexar Jumpshot Compact Flash Reader

Chelsio Communications T4 Ethernet

Cisco VIC Ethernet NIC Support

Intel(R) 10GbE PCI Express adapters

Intel(R) PRO/10GbE

Mellanox Technologies 10Gbit Ethernet

Myricom Myri-10G Ethernet

NetXen Multi port (1/10) Gigabit Ethernet NIC

Neterion X3100 Series 10GbE PCIe Server Adapter

QLOGIC QLCNIC 1/10Gb Converged Ethernet
NIC Support

QLogic QLGE 10Gb Ethernet Driver Support

S2IO 10Gbe XFrame NIC

ServerEngines' 10Gbps NIC - BladeEngine

Solarflare Solarstorm SFC4000/SFC9000-family

Sun Neptune 10Gbit Ethernet

Tehuti Networks 10G Ethernet

Token Ring driver support

3Com 3C359 Token Link Velocity XL adapter

Generic TMS380 PCI

Generic TMS380 Token Ring ISA/PCI adapter

IBM Lanstreamer chipset PCI adapter

IBM Olympic chipset PCI adapter

IBM Tropic chipset based adapter

Madge Smart 16/4 PCI Mk2

Proteon ISA

SMC ISA/MCA adapter

SysKonnect TR4/16 ISA

USB Network Adapters

ASIX AX88xxx Based USB 2.0 Ethernet Adapters

CDC EEM

CDC Ethernet support (smart devices such as cable
modems)

Davicom DM9601 based USB 1.1 10/100 ethernet
devices

GeneSys GL620USB-A based cables

Host for RNDIS and ActiveSync devices

MosChip MCS7830 based Ethernet adapters

NetChip 1080 based cables (Laplink, ...)

Prolific PL-2301/2302 based cables
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OXU210HP HCD

Olympus MAUSB-10/Fuji DPC-R1

R8A66597 HCD

SL811HS HCD

SanDisk SDDR-09 (and other SmartMedia,
including DPCM)

SanDisk SDDR-55 SmartMedia

USB 2.0

USB Mass Storage

USB Monitor

USBAT/USBAT02-based storage

xHCI HCD (USB 3.0)

Block devices

Compaq SMART2

Compaq Smart Array 5xxx

Mylex DAC960/DAC1100 PCI RAID Controller

Normal floppy disk

Promise SATA SX8

IEEE 1394 (FireWire) support

Legacy alternative FireWire driver stack

Storage devices (SBP-2 protocol)

PCMCIA network device support

3Com 3c574 PCMCIA

3Com 3c589 PCMCIA

Asix AX88190 PCMCIA

COM20020 ARCnet PCMCIA

Fujitsu FMV-J18x PCMCIA

NE2000 compatible PCMCIA

New Media PCMCIA

SMC 91Cxx PCMCIA

Xircom 16-bit PCMCIA

Other devices

Microsoft Hyper-V Utilities driver

Microsoft Hyper-V client drivers

Microsoft Hyper-V virtual block driver

Microsoft Hyper-V virtual network driver

Microsoft Hyper-V virtual storage driver

SMSC LAN95XX based USB 2.0 10/100 ethernet
devices

Sharp Zaurus (stock ROMs) and compatible

Simple USB Network Links (CDC Ethernet subset)

USB CATC NetMate-based Ethernet device

USB KLSI KL5USB101-based ethernet device

USB Pegasus/Pegasus-II based ethernet device

USB RTL8150 based ethernet device
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VII R-Studio Agent Emergency

R-Studio Agent Emergency is a tool that allows you to start a network computer with a damaged startup disk
and recover data stored on its hard drives. Then restored data can be transferred to a working computer via the
network.

It works very simple: Just start the computer with the R-Studio Agent Emergency startup disk(s) and, if
necessary, manually configure a network interface for R-Studio Agent Emergency. When started, the
computer and its hard drives can be accessed by R-Studio installed on another computer on the network. 

Note: You cannot use this program to start Mac computers based on Apple Silicon.

Contact Information and Technical Support
Installing R-Studio Agent Emergency Startup Media Creator
Creating Startup Disks
Starting a Computer with the R-Studio Agent Emergency Startup Disk

Hardware Compatibility List
Disk Controllers
Network Cards

7.1 Contact Information and Technical Support

To obtain the latest version of R-Studio Agent Emergency, go to:

Product Site: http://www.r-tt.com
Sales Department: sales@r-tt.com

R-Studio Technical Support Team is available 24 hours a day, seven days a week, and has an average
response time less than 4 hours.

Tech. Support: support@r-tt.com
Send your support request to: http://www.r-tt.com/Support_request.html

7.2 Installing R-Studio Agent Emergency Startup Media Creator

You must have administrative privileges to install R-Studio Agent Emergency Startup Media
Creator. 

If you are not sure whether you have such privileges, you almost certainly do not have them. Contact your system
administrator for assistance.

1.Run the setup file. 
2.Follow the on-screen instructions. 

You may create startup disks even before the installation ends.

7.3 Creating Startup Disks

You need to create either 

· A startup CD/DVD disc. You may create an ISO image, or write the disc directly from R-Studio Emergency

Startup Media Creator, if there is a CD/DVD recorder in your system.

http://www.r-tt.com
mailto:sales@r-tt.com
mailto:support@r-tt.com
http://www.r-tt.com/Support_request.html
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or

· A startup FAT/FAT32 removable device recognized by your system as a bootable one. The total available size
of the device should be more than 10 MB.

or

· 4 formatted floppy disks

Check the Hardware Compatibility List.

When R-Studio Agent Emergency Startup Media Creator starts, its Welcome dialog box appears:

Welcome to R-Studio Agent Emergency Startup Media Creator dialog box

Welcome dialog box

click the Next button to see the list of all devices on which startup disks may be created.

Startup media type selection dialog box

To create a startup CD/DVD disc directly on your CD/DVD writer (if present):

1 Run R-Studio Agent Emergency

2 Select the CD/DVD writer on the Startup media type selection dialog box and click the Next button

3 Read and accept the License Agreement and enter the R-Studio Agent registration key on the R-
Studio Agent Emergency Activation dialog box and click the Next button

Note: You should enter the registration key of R-Studio Agent, not R-Studio itself.
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R-Studio Agent Emergency License Agreement dialog box

R-Studio Agent Emergency Activation dialog box

if you do not enter the registration key, R-Studio Agent Emergency will work in the Demo mode. You
may enter the key later when R-Studio Agent Emergency and R-Studio establish a connection

4 Insert a blank CD/DVD disk into the CD/DVD recorder and click the Next button

Insert media disc dialog box
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> R-Studio Agent Emergency Startup Media Creator will start creating the startup CD/DVD disc

showing the progress on the Creating startup media dialog box

Creating startup media dialog box

When R-Studio Agent Emergency Startup Media Creator finishes creating the startup CD/DVD disc,

the R-Studio Agent Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Emergency Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Back button.

R-Studio Agent Emergency Startup Media Creation is Finished message

To create an ISO image of a startup CD/DVD disc

1 Run R-Studio Agent Emergency

2 Select ISO Image for a startup CD/DVD on the R-Studio Agent Emergency Startup Media Creator

dialog box and click the Next button

3 Read and accept the License Agreement and enter the R-Studio Agent registration key on the R-
Studio Agent Emergency Activation dialog box and click the Next button

Note: You should enter the registration key of R-Studio Agent, not R-Studio itself.

if you do not enter the registration key, R-Studio Agent Emergency will work in the Demo mode. You
may enter the key later when R-Studio Agent Emergency and R-Studio establish a connection.

4 Select a place and file name for the ISO image of the startup CD/DVD and click the Save button

> When R-Studio Bootable Startup Media Creator finishes writing the file with the ISO image, the R-
Studio Agent Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Bootable Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Back button.
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R-Studio Agent Emergency Startup Media Creation is Finished dialog box

5 Create the startup CD/DVD using your favorite CD/DVD creation software

Load the created ISO image into the CD/DVD creation software. Consult documentation for the software
for details.

To create a startup FAT/FAT32 removable device

1 Run R-Studio Agent Emergency

2 Select the removable device on the Startup media type selection dialog box and click the Next button

3 Read and accept the License Agreement and enter the registration key on the R-Studio Agent
Emergency Activation dialog box and click the Next button

4 Check that the correct FAT/FAT32-formatted device is selected and click the Next button

Confirm device selection dialog box

> R-Studio Agent Emergency Startup Media Creator will start creating the startup USB disk showing

the progress on the Creating startup media dialog box

When R-Studio Agent Emergency Startup Media Creator finishes creating the startup device, the

R-Studio Agent Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Emergency Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Back button.
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R-Studio Agent Emergency Startup Media Creation is Finished dialog box

To create floppy disks:

You will need 4 formatted floppy disks.

1 Run R-Studio Agent Emergency

2 Select Floppy Disk for the startup floppy disk on the R-Studio Agent Emergency Startup Media

Creator dialog box and click the Next button

3 Enter the registration information and number on the Registration dialog box and click the Next button

If you leave all the field blank, R-Studio Agent Emergency will work with the Demo-version limitations

4 Insert the floppy disk and click the Next button on the Insert floppy dialog box

Insert floppy dialog box

> R-Studio Agent Emergency Startup Media Creator will start creating the startup floppy disk

showing the progress on the Creating startup media dialog box

Creating startup media dialog box



R-Studio Manual332

© 2025 R-Tools Technology Inc.

5 Insert the second floppy disk and click the OK button when the Please insert formatted diskette #2
into drive A: message will appear

Do it with the next 2 floppy disks.

> When R-Studio Startup Media Creator finishes creating the startup floppy disk, the R-Studio Agent

Emergency Startup Media Creation is Finished message will appear. You may either exit R-Studio

Startup Media Creator by clicking the Finish button or create another startup media by clicking the

Back button.

R-Studio Agent Emergency Startup Media Creation is Finished dialog box

7.4 Starting a Computer with the R-Studio Agent Emergency
Startup Disk

We recommended that you print out this help page and have the hardcopy on hand while you are
performing this action.

Before you start the computer you should be aware that your network has a DHCP server or you
know the computer's IP address and network mask.

If there is a non-IDE disk controller in your system, or you plan to use network disks or external hardware
devices, first check the Hardware Compatibility List.

If you plan to use any external device, turn it on before starting the system.

If the motherboard in your computer supports the Serial ATA (SATA) devices, but IDE disks are also present,
only the SATA devices should be set to the Enhanced Mode in BIOS.

To start the computer with the R-Studio Agent Emergency startup disks

1 Make sure that the first startup device in the system BIOS is the device from which you plan to start
your computer (a CD/DVD drive or A (Floppy)) 

Disable "Secure boot" in the system BIOS if your computer is certified to run Windows 8. Refer to your
system documentation for details. Refer to your system documentation for details.

2 Insert the R-Studio Agent Emergency startup CD/DVD disc, a removable device, or the first floppy disk

and start your computer

> R-Studio Agent Emergency will start and its prompt will appear

If you start your computer with floppy disks, you'll see prompts to insert a next floppy disk.
-----------------------------------------------------------------
Booting R-Studio Emergency. Please wait...
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Waiting 8 seconds for PCMCIA devices to settle
Booting R-Studio Agent Emergency. Now you may remove floppy.
-----------------------------------------------------------------
Querying DHCP to configure network interfaces...
Press ENTER within 10 seconds to configure them manually.

If your network has a DHCP server

The computer running R-Studio Agent Emergency will be assigned an IP address automatically

A prompt with a computer address will appear. You need to remember it to access the computer via
network.

If your network does not have a DHCP server

You need to configure the interfaces and IP addresses manually. 

1. A prompt to select an interface will appear. Enter the selected interface name and press Enter.
2. A prompt to enter its IP address and optional subnet mask will appear. Enter the IP address and optional

subnet mask and press Enter.
------------------------[ List of
Interfaces ]--------------------------------
Name           IP Address            NETMASK            Vendor
------------------------------------------------------------------
------------
re0            Unconfigured                             RealTek
8139C+
------------------------------------------------------------------
------------
# Enter interface name, 'gw' for default gateway or just press
ENTER to finish
#>re0
# Enter IP address and optional NETMASK delimited by space
#>192.168.0.10 255.255.255.0

3. A prompt to configure another interface, gateway, or to finish configuring the interfaces will appear. Enter
gw, enter the IP address of the gateway, and press Enter.
------------------------[ List of
Interfaces ]--------------------------------
Name           IP Address            NETMASK          Vendor
------------------------------------------------------------------
------------
re0            Unconfigured                           RealTek
8139C+
------------------------------------------------------------------
------------
# Enter interface name, 'gw' for default gateway or just press
ENTER to finish
#>re0
# Enter IP address and optional NETMASK delimited by space
#>192.168.0.10 255.255.255.0

------------------------[ List of
Interfaces ]--------------------------------
Name           IP Address            NETMASK            Vendor
------------------------------------------------------------------
------------
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re0            192.168.0.10          255.255.255.0      RealTek
8139C+
gw             Unconfigured                             Default
gateway
------------------------------------------------------------------
------------
# Enter interface name, 'gw' for default gateway or just press
ENTER to finish
#>gw
# Enter default gateway IP Address
#>192.168.0.1

------------------------[ List of
Interfaces ]--------------------------------
Name           IP Address            NETMASK            Vendor
------------------------------------------------------------------
------------
re0            192.168.0.10          255.255.255.0      RealTek
8139C+
gw             192.168.0.1                              Default
gateway
------------------------------------------------------------------
------------
# Enter interface name, 'gw' for default gateway or just press
ENTER to finish
#>

4. Press Enter to finish configuring the interfaces, or enter the name of the next interface to configure. 

> R-Studio Agent Emergency will show a prompt that is ready to accept connections

* R-Studio Agent started and ready to accept connections...
* You may press ENTER to start to remote R-Studio...

Now the computer may be accessed by R-Studio via network.

Secure boot:

It may be impossible to start a Windows 8 certified computer with the R-Studio Agent Emergency startup disk
without some additional actions. This happens because any computer should use a so-called "Secure boot"
procedure to comply with Windows 8 hardware certification from Microsoft. In brief, this procedure prevents
computer from booting into any operating system that isn't digitally signed with an appropriate digital signature.
"Secure boot" is claimed to prevent unauthorized modification of the boot sector by bootkits, viruses, trojans,
and other malicious software. To the date, only Windows 8, Windows Server 2012, and selected Linux
distributions support this feature. As a side effect, it also prevents most LiveCDs, rescue disks (R-Studio and R-
Drive Image included), and other OS from running.

Likely enough, the other requirement of Windows 8 hardware certification is to make it possible for the user to
disable the Secure boot procedure. Those settings can be done through the system BIOS under the Boot
options. Generally, it's enough to enable Legacy support in those options, but sometimes it may require additional
actions. Please, refer to your system documentation to learn more about disabling/enabling Secure boot.

When Secure boot is disabled, it should be possible to start the computer with the R-Studio Agent Emergency
startup disk.

Please note that you should enable this feature back after using the startup disks because Windows 8 or Server
2012 may not start properly without the Secure boot feature enabled.
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Starting a Connection from R-Studio Agent Emergency

When you need to connect R-Studio and R-Studio Agent Emergency over the Internet, it may be necessary
to start the connection from the computer where R-Studio Agent Emergency is running.

To connect to R-Studio's computer,

1 Press the Enter key and enter the IP address of the computer where R-Studio is running as

IPaddress:port.

* R-Studio Agent started and ready to accept connections...
* You may press ENTER to start connection to remote R-Studio...
# Enter R-Studio IP address or just press ENTER to cancel>
192.168.0.25:80

The default port is 8080, and you don't have to specify it.

2 Enter the password if required, and press the Enter key.

* R-Studio Agent started and ready to accept connections...
* You may press ENTER to start connection to remote R-Studio...
# Enter R-Studio IP address or just press ENTER to cancel>
192.168.0.25:80
# Enter password or just press ENTER to connect without
one>PaSsWoRd1234

> When the connection is established successfully, R-Studio Agent Emergency will notify you about

this.

* R-Studio Agent started and ready to accept connections...
* You may press ENTER to start connection to remote R-Studio...
# Enter R-Studio IP address or just press ENTER to cancel>
192.168.0.25:80
# Enter password or just press ENTER to connect without
one>PaSsWoRd1234
Connection with 192.168.0.25:80 is established successfully.

7.5 R-Studio Agent Emergency Hardware Compatibility List

Disk Controllers
Network Cards

R-Studio Agent Emergency
Contact Information and Technical Support
Installing R-Studio Agent Emergency Startup Media Creator
Creating Startup Disks
Starting a Computer with the R-Studio Agent Emergency Startup Disk

7.5.1 Disk Controllers

R-Studio Agent Emergency is based on the FreeBSD 5.3 kernel and supports devices from the list published
at http://www.freebsd.org/releases/5.3R/hardware-i386.html.

*: Supported in the floppy version

http://www.freebsd.org/releases/5.3R/hardware-i386.html
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Disk controllers

IDE/ATA controllers ( ata driver) *

The adapters supported by the aic driver include:

Adaptec AHA-1505 (ISA)
Adaptec AHA-1510A, AHA-1510B (ISA)
Adaptec AHA-1520A, AHA-1520B (ISA)
Adaptec AHA-1522A, AHA-1522B (ISA)
Adaptec AHA-1535 (ISA)
Creative Labs SoundBlaster SCSI host adapter (ISA)
Adaptec AHA-1460, AHA-1460B, AHA-1460C, AHA-1460D (PC Card)
Adaptec AHA-1030B, AHA-1030P (PC98)
NEC PC-9801-100 (PC98)

The aha driver supports the following SCSI host adapters:

Adaptec AHA-154xB
Adaptec AHA-154xC
Adaptec AHA-154xCF
Adaptec AHA-154xCP
Adaptec AHA-1640
Adaptec AHA-174x in 154x emulation mode
DTC 3290 SCSI controller in 1542 emulation mode
Tekram SCSI controllers in 154x emulation mode

The ahb driver supports the following SCSI host adapters:

Adaptec AHA-1740
Adaptec AHA-1742
Adaptec AHA-1740A
Adaptec AHA-1742A

The ahc driver supports the following SCSI host adapter chips and SCSI controller cards:

Adaptec AIC7770 host adapter chip
Adaptec AIC7850 host adapter chip
Adaptec AIC7860 host adapter chip
Adaptec AIC7870 host adapter chip
Adaptec AIC7880 host adapter chip
Adaptec AIC7890 host adapter chip
Adaptec AIC7891 host adapter chip
Adaptec AIC7892 host adapter chip
Adaptec AIC7895 host adapter chip
Adaptec AIC7896 host adapter chip
Adaptec AIC7897 host adapter chip
Adaptec AIC7899 host adapter chip
Adaptec 274X(W)
Adaptec 274X(T)
Adaptec 284X
Adaptec 2910
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Adaptec 2915
Adaptec 2920
Adaptec 2930C
Adaptec 2930U2
Adaptec 2940
Adaptec 2940J
Adaptec 2940N
Adaptec 2940U
Adaptec 2940AU
Adaptec 2940UW
Adaptec 2940UW Dual
Adaptec 2940UW Pro
Adaptec 2940U2W
Adaptec 2940U2B
Adaptec 2950U2W
Adaptec 2950U2B
Adaptec 19160B
Adaptec 29160B
Adaptec 29160N
Adaptec 3940
Adaptec 3940U
Adaptec 3940AU
Adaptec 3940UW
Adaptec 3940AUW
Adaptec 3940U2W
Adaptec 3950U2
Adaptec 3960
Adaptec 39160
Adaptec 3985
Adaptec 4944UW
NEC PC-9821Xt13 (PC-98)
NEC RvII26 (PC-98)
NEC PC-9821X-B02L/B09 (PC-98)
NEC SV-98/2-B03 (PC-98)
Many motherboards with on-board SCSI support

The ahd driver supports the following:

Adaptec AIC7901 host adapter chip
Adaptec AIC7901A host adapter chip
Adaptec AIC7902 host adapter chip
Adaptec 29320 host adapter
Adaptec 39320 host adapter
Many motherboards with on-board SCSI support

Controllers supported by the aac driver include:

Adaptec AAC-364
Adaptec SCSI RAID 2120S



R-Studio Manual338

© 2025 R-Tools Technology Inc.

Adaptec SCSI RAID 2130S
Adaptec SCSI RAID 2200S
Adaptec SCSI RAID 2410SA
Adaptec SCSI RAID 2810SA
Adaptec SCSI RAID 5400S
Dell CERC SATA RAID 2
Dell PERC 2/Si
Dell PERC 2/QC
Dell PERC 3/Si
Dell PERC 3/Di
Dell PERC 320/DC
HP NetRAID 4M

The adv driver supports the following SCSI controllers:

AdvanSys ABP510/5150
AdvanSys ABP5140
AdvanSys ABP5142
AdvanSys ABP902/3902
AdvanSys ABP3905
AdvanSys ABP915
AdvanSys ABP920
AdvanSys ABP3922
AdvanSys ABP3925
AdvanSys ABP930, ABP930U, ABP930UA
AdvanSys ABP960, ABP960U
AdvanSys ABP542
AdvanSys ABP742
AdvanSys ABP842
AdvanSys ABP940
AdvanSys ABP940UA/3940UA
AdvanSys ABP940U
AdvanSys ABP3960UA
AdvanSys ABP970, ABP970U
AdvanSys ABP752
AdvanSys ABP852
AdvanSys ABP950
AdvanSys ABP980, ABP980U
AdvanSys ABP980UA/3980UA
MELCO IFC-USP (PC-98)
RATOC REX-PCI30 (PC-98)
@Nifty FNECHARD IFC-USUP-TX (PC-98)

The adw driver supports SCSI controllers including:

AdvanSys ABP940UW/ABP3940UW
AdvanSys ABP950UW
AdvanSys ABP970UW
AdvanSys ABP3940U2W
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AdvanSys ABP3950U2W

The bt driver supports the following BusLogic MultiMaster ``W'', ``C'', ``S'', and ``A'' series and compatible
SCSI host adapters:

BusLogic BT-445C
BusLogic BT-445S
BusLogic BT-540CF
BusLogic BT-542B
BusLogic BT-542B
BusLogic BT-542D
BusLogic BT-545C
BusLogic BT-545S
BusLogic/BusTek BT-640
BusLogic BT-742A
BusLogic BT-742A
BusLogic BT-747C
BusLogic BT-747D
BusLogic BT-747S
BusLogic BT-757C
BusLogic BT-757CD
BusLogic BT-757D
BusLogic BT-757S
BusLogic BT-946C
BusLogic BT-948
BusLogic BT-956C
BusLogic BT-956CD
BusLogic BT-958
BusLogic BT-958D
Storage Dimensions SDC3211B / SDC3211F
AMI FastDisk Host Adapters that are true BusLogic MultiMaster clones are also supported by the bt driver.

The dpt driver provides support for the following RAID adapters:

DPT Smart Cache Plus
Smart Cache II (PM2?2?, PM2022 [EISA], PM2024/PM2124 [PCI]) (Gen2)
Smart RAID II (PM3?2?, PM3021, PM3222)
Smart Cache III (PM2?3?)
Smart RAID III (PM3?3?, PM3332 [EISA], PM3334UW [PCI]) (Gen3)
Smart Cache IV (PM2?4?, PM2042 [EISA], PM2044/PM2144 [PCI]) (Gen4)
Smart RAID IV

The adapters currently supported by the asr driver include the following:

Adaptec Zero-Channel SCSI RAID 2000S, 2005S, 2010S, 2015S
Adaptec SCSI RAID 2100S, 2110S
Adaptec ATA-100 RAID 2400A
Adaptec SCSI RAID 3200S, 3210S
Adaptec SCSI RAID 3400S, 3410S
Adaptec SmartRAID PM1554
Adaptec SmartRAID PM1564
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Adaptec SmartRAID PM2554
Adaptec SmartRAID PM2564
Adaptec SmartRAID PM2664
Adaptec SmartRAID PM2754
Adaptec SmartRAID PM2865
Adaptec SmartRAID PM3754
Adaptec SmartRAID PM3755U2B / SmartRAID V Millennium
Adaptec SmartRAID PM3757
DEC KZPCC-AC (LVD 1-ch, 4MB or 16MB cache), DEC KZPCC-CE (LVD 3-ch, 64MB cache), DEC
KZPCC-XC (LVD 1-ch, 16MB cache), DEC KZPCC-XE (LVD 3-ch, 64MB cache) -- rebadged
SmartRAID V Millennium

The amr driver supports the following:

AMI MegaRAID 320-1
AMI MegaRAID 320-2
AMI MegaRAID 320-4X
AMI MegaRAID Series 418
AMI MegaRAID Enterprise 1200 (Series 428)
AMI MegaRAID Enterprise 1300 (Series 434)
AMI MegaRAID Enterprise 1400 (Series 438)
AMI MegaRAID Enterprise 1500 (Series 467)
AMI MegaRAID Enterprise 1600 (Series 471)
AMI MegaRAID Elite 1500 (Series 467)
AMI MegaRAID Elite 1600 (Series 493)
AMI MegaRAID Elite 1650 (Series 4xx)
AMI MegaRAID Express 100 (Series 466WS)
AMI MegaRAID Express 200 (Series 466)
AMI MegaRAID Express 300 (Series 490)
AMI MegaRAID Express 500 (Series 475)
Dell PERC
Dell PERC 2/SC
Dell PERC 2/DC
Dell PERC 3/DCL
Dell PERC 3/QC
Dell PERC 4/Di
HP NetRAID-1/Si
HP NetRAID-3/Si (D4943A)
HP Embedded NetRAID
Note: Booting from these controllers is supported. EISA adapters are not supported.

Controllers supported by the mlx driver include:

Mylex DAC960P
Mylex DAC960PD / DEC KZPSC (Fast Wide)
Mylex DAC960PDU
Mylex DAC960PL
Mylex DAC960PJ
Mylex DAC960PG
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Mylex DAC960PU / DEC PZPAC (Ultra Wide)
Mylex AcceleRAID 150 (DAC960PRL)
Mylex AcceleRAID 250 (DAC960PTL1)
Mylex eXtremeRAID 1100 (DAC1164P)
RAIDarray 230 controllers, aka the Ultra-SCSI DEC KZPAC-AA (1-ch, 4MB cache), KZPAC-CA (3-ch,
4MB), KZPAC-CB (3-ch, 8MB cache)
All major firmware revisions (2.x, 3.x, 4.x and 5.x) are supported, however it is always advisable to upgrade to
the most recent firmware available for the controller. Compatible Mylex controllers not listed should work, but
have not been verified.
Note: Booting from these controllers is supported. EISA adapters are not supported.

Controllers supported by the mly driver include:

Mylex AcceleRAID 160
Mylex AcceleRAID 170
Mylex AcceleRAID 352
Mylex eXtremeRAID 2000
Mylex eXtremeRAID 3000
Compatible Mylex controllers not listed should work, but have not been verified.

The twe driver supports the following ATA RAID controllers:

AMCC's 3ware 5000 series
AMCC's 3ware 6000 series
AMCC's 3ware 7000-2
AMCC's 3ware 7006-2
AMCC's 3ware 7500-4LP
AMCC's 3ware 7500-8
AMCC's 3ware 7500-12
AMCC's 3ware 7506-4LP
AMCC's 3ware 7506-8
AMCC's 3ware 7506-12
AMCC's 3ware 8006-2LP
AMCC's 3ware 8500-4LP
AMCC's 3ware 8500-8
AMCC's 3ware 8500-12
AMCC's 3ware 8506-4LP
AMCC's 3ware 8506-8
AMCC's 3ware 8506-8MI
AMCC's 3ware 8506-12
AMCC's 3ware 8506-12MI

The twa driver supports the following PATA/SATA RAID controllers:

AMCC's 3ware 9500S-4LP
AMCC's 3ware 9500S-8
AMCC's 3ware 9500S-8MI
AMCC's 3ware 9500S-12
AMCC's 3ware 9500S-12MI



R-Studio Manual342

© 2025 R-Tools Technology Inc.

The ncr driver provides support for the following NCR/Symbios SCSI controller chips:

53C810
53C810A
53C815
53C820
53C825A
53C860
53C875
53C875J
53C885
53C895
53C895A
53C896
53C1510D

The following add-on boards are known to be supported:

I-O DATA SC-98/PCI (PC-98)
I-O DATA SC-PCI (PC-98)

The sym driver provides support for the following Symbios/LSI Logic PCI SCSI controllers:

53C810
53C810A
53C815
53C825
53C825A
53C860
53C875
53C876
53C895
53C895A
53C896
53C897
53C1000
53C1000R
53C1010-33
53C1010-66
53C1510D

The SCSI controllers supported by sym can be either embedded on a motherboard, or on one of the
following add-on boards:

ASUS SC-200, SC-896
Data Technology DTC3130 (all variants)
DawiControl DC2976UW
Diamond FirePort (all)
I-O DATA SC-UPCI (PC-98)
Logitec LHA-521UA (PC-98)
NCR cards (all)
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Symbios cards (all)
Tekram DC390W, 390U, 390F, 390U2B, 390U2W, 390U3D, and 390U3W
Tyan S1365

The following devices are currently supported by the ncv driver:

I-O DATA PCSC-DV
KME KXLC002 (TAXAN ICD-400PN, etc.), KXLC004, and UJDCD450
Macnica Miracle SCSI-II mPS110
Media Intelligent MSC-110, MSC-200
NEC PC-9801N-J03R
New Media Corporation BASICS SCSI
Qlogic Fast SCSI
RATOC REX-9530, REX-5572 (SCSI only)

Controllers supported by the stg driver include:

Adaptec 2920/A
Future Domain SCSI2GO
Future Domain TMC-18XX/3260
IBM SCSI PCMCIA Card
ICM PSC-2401 SCSI
MELCO IFC-SC
RATOC REX-5536, REX-5536AM, REX-5536M, REX-9836A
Note that the Adaptec 2920C is supported by the ahc driver.

Cards supported by the isp driver include:

ISP1000
PTI SBS440
ISP1020
ISP1040
PTI SBS450
Qlogic 1240
Qlogic 1020
Qlogic 1040
Qlogic 1080
Qlogic 1280
Qlogic 12160
Qlogic 2100
Qlogic 2102
Qlogic 2200
Qlogic 2202
Qlogic 2204
Qlogic 2300
Qlogic 2312
PTI SBS470
Antares P-0033

Controllers supported by the amd driver include:

MELCO IFC-DP (PC-98)
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Tekram DC390
Tekram DC390T

Controllers supported by the nsp driver include:

Alpha-Data AD-PCS201
I-O DATA CBSC16
Adaptec AIC-7110 Parallel to SCSI interfaces ( vpo driver)

The following controllers are supported by the ida driver:

Compaq SMART Array 221
Compaq Integrated SMART Array Controller
Compaq SMART Array 4200
Compaq SMART Array 4250ES
Compaq SMART 3200 Controller
Compaq SMART 3100ES Controller
Compaq SMART-2/DH Controller
Compaq SMART-2/SL Controller
Compaq SMART-2/P Controller
Compaq SMART-2/E Controller
Compaq SMART Controller

Controllers supported by the ciss driver include:

Compaq Smart Array 5300
Compaq Smart Array 532
Compaq Smart Array 5i
HP Smart Array 5312
HP Smart Array 6i
HP Smart Array 641
HP Smart Array 642
HP Smart Array 6400
HP Smart Array 6400 EM
HP Smart Array 6422
HP Smart Array V100
HP Modular Smart Array 20 (MSA20)
HP Modular Smart Array 500 (MSA500)

Controllers supported by the iir driver include:

Intel RAID Controller SRCMR
Intel Server RAID Controller U3-l (SRCU31a)
Intel Server RAID Controller U3-1L (SRCU31La)
Intel Server RAID Controller U3-2 (SRCU32)
All past and future releases of Intel and ICP RAID Controllers.
Intel RAID Controller SRCU21 (discontinued)
Intel RAID Controller SRCU31 (older revision, not compatible)
Intel RAID Controller SRCU31L (older revision, not compatible)
The SRCU31 and SRCU31L can be updated via a firmware update available from Intel.
Promise SuperTrak ATA RAID controllers (pst driver)
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The hptmv driver supports the HighPoint RocketRAID 182x SATA controllers.

Controllers supported by the ips driver include:

IBM ServeRAID 3H
ServeRAID 4L/4M/4H
ServeRAID Series 5
ServeRAID 6i/6M

The following controllers are supported by the mpt driver:

LSI Logic 53c1030 (Dual Ultra320 SCSI)
LSI Logic FC909 (1Gb/s Fibre Channel)
LSI Logic FC909A (Dual 1Gb/s Fibre Channel)
LSI Logic FC919 (2Gb/s Fibre Channel)
LSI Logic FC929 (Dual 2Gb/s Fibre Channel)
The SCSI controller chips supprted by the mpt driver can be found onboard on many systems including:
Dell PowerEdge 1750
IBM eServer xSeries 335

SCSI controllers supported by the trm driver include:

Tekram DC-315 PCI Ultra SCSI adapter without BIOS and internal SCSI connector
Tekram DC-315U PCI Ultra SCSI adapter without BIOS
Tekram DC-395F PCI Ultra-Wide SCSI adapter with flash BIOS and 68-pin external SCSI connector
Tekram DC-395U PCI Ultra SCSI adapter with flash BIOS
Tekram DC-395UW PCI Ultra-Wide SCSI adapter with flash BIOS
Tekram DC-395U2W PCI Ultra2-Wide SCSI adapter with flash BIOS
For the Tekram DC-310/U and DC-390F/U/UW/U2B/U2W/U3W PCI SCSI host adapters, use the sym
driver.

The wds driver supports the WD7000 SCSI controller.

7.5.2 Network Cards

R-Studio Agent Emergency is based on the FreeBSD 5.3 kernel and supports devices from the list published
at http://www.freebsd.org/releases/5.3R/hardware-i386.html.

*: Supported in the floppy version

Ethernet NICs

Adapters supported by the sf driver include:

ANA-62011 64-bit single port 10/100baseTX adapter
ANA-62022 64-bit dual port 10/100baseTX adapter
ANA-62044 64-bit quad port 10/100baseTX adapter
ANA-69011 32-bit single port 10/100baseTX adapter
ANA-62020 64-bit single port 100baseFX adapter

The ti driver supports Gigabit Ethernet adapters based on the Alteon Tigon I and II chips. The ti driver has
been tested with the following adapters:

3Com 3c985-SX Gigabit Ethernet adapter (Tigon 1)
3Com 3c985B-SX Gigabit Ethernet adapter (Tigon 2)
Alteon AceNIC V Gigabit Ethernet adapter (1000baseSX)
Alteon AceNIC V Gigabit Ethernet adapter (1000baseT)
Digital EtherWORKS 1000SX PCI Gigabit adapter

http://www.freebsd.org/releases/5.3R/hardware-i386.html
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Netgear GA620 Gigabit Ethernet adapter (1000baseSX)
Netgear GA620T Gigabit Ethernet adapter (1000baseT)

The following adapters should also be supported but have not yet been tested:

Asante GigaNIX1000T Gigabit Ethernet adapter
Asante PCI 1000BASE-SX Gigabit Ethernet adapter
Farallon PN9000SX Gigabit Ethernet adapter
NEC Gigabit Ethernet
Silicon Graphics PCI Gigabit Ethernet adapter

The pcn driver supports adapters and embedded controllers based on the AMD PCnet/FAST, PCnet/FAST+,
PCnet/FAST III, PCnet/PRO and PCnet/Home Fast Ethernet chips:

AMD Am53C974/Am79C970/Am79C974 PCnet-PCI *
AMD Am79C970A PCnet-PCI II *
AMD Am79C971 PCnet-FAST *
AMD Am79C972 PCnet-FAST+ *
AMD Am79C973/Am79C975 PCnet-FAST III *
AMD Am79C976 PCnet-PRO *
AMD PCnet/Home HomePNA
Allied-Telesis LA-PCI
Contec C-NET(98)S (PC-98)
NEC SV-98/2-B05, B06

The lnc driver supports the following adapters:

Novell NE2100 *
Novell NE32-VL *
Isolan AT 4141-0 (16 bit)
Isolan BICC
Isolink 4110 (8 bit)
Diamond HomeFree
Digital DEPCA
Hewlett Packard Vectra 486/66XM
Hewlett Packard Vectra XU
Also supported are adapters working with the pcn driver. The lnc driver runs these in compatibility mode, thus
the pcn driver should be preferred.
SMC 83c17x (EPIC)-based Ethernet NICs (tx driver)

The ed driver supports the following Ethernet NICs:

3Com 3c503 Etherlink II
AR-P500 Ethernet
Accton EN1644 (old model), EN1646 (old model), EN2203 (old model) (110pin) (flags 0xd00000)
Accton EN2212/EN2216/UE2216
Allied Telesis CentreCOM LA100-PCM_V2
Allied Telesis LA-98 (flags 0x000000) (PC-98)
Allied Telesis SIC-98, SIC-98NOTE (110pin), SIU-98 (flags 0x600000) (PC-98)
Allied Telesis SIU-98-D (flags 0x610000) (PC-98)
AmbiCom 10BaseT card
Bay Networks NETGEAR FA410TXC Fast Ethernet
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CNet BC40 adapter
Compex Net-A adapter
Contec C-NET(98), RT-1007(98), C-NET(9N) (110pin) (flags 0xa00000) (PC-98)
Contec C-NET(98)E-A, C-NET(98)L-A, C-NET(98)P (flags 0x300000) (PC-98)
Corega Ether98-T (flags 0x000000) (PC-98)
Corega Ether PCC-T/EtherII PCC-T/FEther PCC-TXF/PCC-TXD
CyQ've ELA-010
DEC EtherWorks DE305
Danpex EN-6200P2
D-Link DE-298, DE-298P (flags 0x500000) (PC-98)
D-Link DE-650/660
D-Link IC-CARD/IC-CARD+ Ethernet
ELECOM LD-98P (flags 0x500000) (PC-98)
ELECOM LD-BDN, LD-NW801G (flags 0x200000) (PC-98)
ELECOM Laneed LD-CDL/TX, LD-CDF, LD-CDS, LD-10/100CD, LD-CDWA (DP83902A)
HP PC Lan+ 27247B and 27252A
IBM Creditcard Ethernet I/II
ICM AD-ET2-T, DT-ET-25, DT-ET-T5, IF-2766ET, IF-2771ET, NB-ET-T (110pin) (flags 0x500000)
(PC-98)
I-O DATA LA/T-98, LA/T-98SB, LA2/T-98, ET/T-98 (flags 0x900000) (PC-98)
I-O DATA ET2/T-PCI
I-O DATA PCLATE
Kansai KLA-98C/T (flags 0x900000) (PC-98)
Kingston KNE-PC2, KNE-PCM/x Ethernet
Linksys EC2T/PCMPC100/PCM100, PCMLM56
Linksys EtherFast 10/100 PC Card, Combo PCMCIA Ethernet Card (PCMPC100 V2)
Logitec LAN-98T (flags 0xb00000) (PC-98)
MACNICA Ethernet ME1 for JEIDA
MACNICA ME98 (flags 0x900000) (PC-98)
MACNICA NE2098 (flags 0x400000) (PC-98)
MELCO EGY-98 (flags 0x300000) (PC-98)
MELCO LGH-98, LGY-98, LGY-98-N (110pin), IND-SP, IND-SS (flags 0x400000) (PC-98)
MELCO LGY-PCI-TR
MELCO LPC-T/LPC2-T/LPC2-CLT/LPC2-TX/LPC3-TX/LPC3-CLX
NDC Ethernet Instant-Link
NEC PC-9801-77, PC-9801-78 (flags 0x910000) (PC-98)
NEC PC-9801-107, PC-9801-108 (flags 0x800000) (PC-98)
National Semiconductor InfoMover NE4100
NetGear FA-410TX
NetVin 5000
Network Everywhere Ethernet 10BaseT PC Card
Networld 98X3 (flags 0xd00000) (PC-98)
Networld EC-98X, EP-98X (flags 0xd10000) (PC-98)
Novell NE1000/NE2000/NE2100
PLANEX ENW-8300-T
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PLANEX EN-2298-C (flags 0x200000) (PC-98)
PLANEX EN-2298P-T, EN-2298-T (flags 0x500000) (PC-98)
PLANEX FNW-3600-T
RealTek 8029
SMC Elite 16 WD8013
SMC Elite Ultra
SMC EtherEZ98 (flags 0x000000) (PC-98)
SMC WD8003E/WD8003EBT/WD8003S/WD8003SBT/WD8003W/WD8013EBT/WD8013W and
clones
Socket LP-E
Surecom EtherPerfect EP-427
Surecom NE-34
TDK LAK-CD031, Grey Cell GCS2000 Ethernet Card
Telecom Device SuperSocket RE450T
VIA VT86C926
Winbond W89C940
C-Bus, ISA, PCI and PC Card devices are supported.

Adapters supported by the rl driver include:

Accton ``Cheetah'' EN1207D (MPX 5030/5038; RealTek 8139 clone)
Allied Telesyn AT2550
Allied Telesyn AT2500TX
Belkin F5D5000
BUFFALO(Melco INC.) LPC-CB-CLX(CardBus)
Compaq HNE-300
CompUSA no-name 10/100 PCI Ethernet NIC
Corega FEther CB-TXD
Corega FEtherII CB-TXD
D-Link DFE-530TX+
D-Link DFE-538TX (same as 530+?)
D-Link DFE-690TXD
Edimax EP-4103DL CardBus
Encore ENL832-TX 10/100 M PCI
Farallon NetLINE 10/100 PCI
Genius GF100TXR,
GigaFast Ethernet EE100-AXP
KTX-9130TX 10/100 Fast Ethernet
LevelOne FPC-0106TX
Longshine LCS-8038TX-R
NDC Communications NE100TX-E
Netronix Inc. EA-1210 NetEther 10/100
Nortel Networks 10/100BaseTX
OvisLink LEF-8129TX
OvisLink LEF-8139TX
Peppercon AG ROL-F
Planex FNW-3800-TX
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SMC EZ Card 10/100 PCI 1211-TX
SOHO(PRAGMATIC) UE-1211C

The wb driver supports Winbond W89C840F based Fast Ethernet adapters and embedded controllers
including:

Trendware TE100-PCIE *

The vr driver supports VIA Technologies Rhine I, Rhine II, and Rhine III based Fast Ethernet adapters
including:

D-Link DFE530-TX
Hawking Technologies PN102TX
AOpen/Acer ALN-320

The sis driver supports Silicon Integrated Systems SiS 900 * and SiS 7016 * based Fast Ethernet adapters
and embedded controllers, as well as Fast Ethernet adapters based on the National Semiconductor
DP83815 (MacPhyter) chip. Supported adapters include:

@Nifty FNECHARD IFC USUP-TX
MELCO LGY-PCI-TXC
Netgear FA311-TX (DP83815)
Netgear FA312-TX (DP83815)
SiS 630, 635, and 735 motherboard chipsets

The nge driver supports National Semiconductor DP83820 * and DP83821 based Gigabit Ethernet adapters
including:

SMC EZ Card 1000 (SMC9462TX)
D-Link DGE-500T
Asante FriendlyNet GigaNIX 1000TA and 1000TPC
Addtron AEG320T
LinkSys EG1032 (32-bit PCI) and EG1064 (64-bit PCI)
Surecom Technology EP-320G-TX
Netgear GA622T
Netgear GA621
Ark PC SOHO-GA2500T (32-bit PCI) and SOHO-GA2000T (64-bit PCI)
Trendware TEG-PCITX (32-bit PCI) and TEG-PCITX2 (64-bit PCI)

The ste driver supports Sundance Technologies ST201 based Fast Ethernet adapters and embedded
controllers including:

D-Link DFE-530TXS
D-Link DFE-550TX

Adapters supported by the sk driver include:

3COM 3C940 single port, 1000baseT adapter
Belkin F5D5005 single port, 1000baseT adapter
Linksys EG1032 single port, 1000baseT adapter
SK-9521 SK-NET GE-T single port, 1000baseT adapter
SK-9821 SK-NET GE-T single port, 1000baseT adapter *
SK-9822 SK-NET GE-T dual port, 1000baseT adapter *
SK-9841 SK-NET GE-LX single port, single mode fiber adapter *
SK-9842 SK-NET GE-LX dual port, single mode fiber adapter *
SK-9843 SK-NET GE-SX single port, multimode fiber adapter *
SK-9844 SK-NET GE-SX dual port, multimode fiber adapter *
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SMC 9452TX single port, 1000baseT adapter

The tl driver supports Texas Instruments ThunderLAN based Ethernet and Fast Ethernet adapters including
a large number of Compaq PCI Ethernet adapters. Also supported are:

Olicom OC-2135/2138 10/100 TX UTP adapter
Olicom OC-2325/OC-2326 10/100 TX UTP adapter
Racore 8148 10baseT/100baseTX/100baseFX adapter
Racore 8165 10/100baseTX adapter

The tl driver also supports the built-in Ethernet adapters of various Compaq Prosignia servers and
Compaq Deskpro desktop machines including:

Compaq Netelligent 10
Compaq Netelligent 10 T PCI UTP/Coax
Compaq Netelligent 10/100
Compaq Netelligent 10/100 Dual-Port
Compaq Netelligent 10/100 Proliant
Compaq Netelligent 10/100 TX Embedded UTP
Compaq Netelligent 10/100 TX UTP
Compaq NetFlex 3P
Compaq NetFlex 3P Integrated
Compaq NetFlex 3P w/BNC

The dc driver provides support for the following chipsets: *

DEC/Intel 21143
ADMtek AL981 Comet, AN985 Centaur, ADM9511 Centaur II and ADM9513 Centaur II
ASIX Electronics AX88140A and AX88141
Conexant LANfinity RS7112 (miniPCI)
Davicom DM9009, DM9100, DM9102 and DM9102A
Lite-On 82c168 and 82c169 PNIC
Lite-On/Macronix 82c115 PNIC II
Macronix 98713, 98713A, 98715, 98715A, 98715AEC-C, 98725, 98727 and 98732
Xircom X3201 (cardbus only)

The following NICs are known to work with the dc driver at this time:

3Com OfficeConnect 10/100B (ADMtek AN985 Centaur-P)
Abocom FE2500
Accton EN1217 (98715A)
Accton EN2242 MiniPCI
Adico AE310TX (98715A)
Alfa Inc GFC2204 (ASIX AX88140A)
Built in 10Mbps only Ethernet on Compaq Presario 7900 series desktops (21143, non-MII)
Built in DE500-BA on DEC Alpha workstations (21143, non-MII)
Built in Sun DMFE 10/100 Mbps Ethernet on Sun Netra X1 and Sun Fire V100 (DM9102A, MII)
Built in Ethernet on LinkSys EtherFast 10/100 Instant GigaDrive (DM9102, MII)
CNet Pro110B (ASIX AX88140A)
CNet Pro120A (98715A or 98713A) and CNet Pro120B (98715)
Compex RL100-TX (98713 or 98713A)
D-Link DFE-570TX (21143, MII, quad port)
Digital DE500-BA 10/100 (21143, non-MII)
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ELECOM Laneed LD-CBL/TXA (ADMtek AN985)
Hawking CB102 CardBus
IBM EtherJet Cardbus Adapter
Intel PRO/100 Mobile Cardbus (versions that use the X3201 chipset)
Jaton XpressNet (Davicom DM9102)
Kingston KNE100TX (21143, MII)
Kingston KNE110TX (PNIC 82c169)
LinkSys LNE100TX (PNIC 82c168, 82c169)
LinkSys LNE100TX v2.0 (PNIC II 82c115)
LinkSys LNE100TX v4.0/4.1 (ADMtek AN985 Centaur-P)
Matrox FastNIC 10/100 (PNIC 82c168, 82c169)
Melco LGY-PCI-TXL
Microsoft MN-120 10/100 CardBus (ADMTek Centaur-C)
Microsoft MN-130 10/100 PCI (ADMTek Centaur-P)
NDC SOHOware SFA110A (98713A)
NDC SOHOware SFA110A Rev B4 (98715AEC-C)
NetGear FA310-TX Rev. D1, D2 or D3 (PNIC 82c169)
Netgear FA511
PlaneX FNW-3602-T (ADMtek AN985)
SMC EZ Card 10/100 1233A-TX (ADMtek AN985)
SVEC PN102-TX (98713)
Xircom Cardbus Realport
Xircom Cardbus Ethernet 10/100
Xircom Cardbus Ethernet II 10/100

Adapters supported by the aue driver include:

Abocom UFE1000, DSB650TX_NA
Accton USB320-EC, SpeedStream
ADMtek AN986, AN8511
Billionton USB100, USB100LP, USB100EL, USBE100
Corega Ether FEther USB-T, FEther USB-TX, FEther USB-TXS
D-Link DSB-650, DSB-650TX, DSB-650TX-PNA
Elecom LD-USBL/TX
Elsa Microlink USB2Ethernet
HP hn210e
I-O Data USB ETTX
Kingston KNU101TX
LinkSys USB10T adapters that contain the AN986 Pegasus chipset, USB10TA, USB10TX, USB100TX,
USB100H1
MELCO LUA-TX, LUA2-TX
Planex UE-200TX
Sandberg USB to Network Link (model number 133-06)
Siemens Speedstream
SmartBridges smartNIC
SMC 2202USB
SOHOware NUB100
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The cue driver supports CATC USB-EL1210A based USB Ethernet adapters including:

Belkin F5U011/F5U111
CATC Netmate
CATC Netmate II
SmartBridges SmartLink

The kue driver supports Kawasaki LSI KL5KLUSB101B based USB Ethernet adapters including:

3Com 3c19250
3Com 3c460 HomeConnect Ethernet USB Adapter
ADS Technologies USB-10BT
AOX USB101
ATen UC10T
Abocom URE 450
Corega USB-T
D-Link DSB-650C
Entrega NET-USB-E45, NET-HUB-3U1E
I/O Data USB ETT
Kawasaki DU-H3E
LinkSys USB10T
Netgear EA101
Peracom USB Ethernet Adapter
SMC 2102USB, 2104USB

The axe driver supports ASIX Electronics AX88172 based USB Ethernet adapters including:

Buffalo (Melco Inc.) LUA-U2-KTX
D-Link DUBE100
LinkSys USB200M
Netgear FA120
System TALKS Inc. SGC-X2UL

The rue driver supports RealTek RTL8150 based USB Ethernet adapters including:

Buffalo (Melco Inc.) LUA-KTX
Green House GH-USB100B
LinkSys USB100M
Billionton 10/100 FastEthernet USBKR2

The udav driver supports the following adapters:

Corega FEther USB-TXC

Adapters supported by the de driver include: 

Adaptec ANA-6944/TX
Cogent EM100FX and EM440TX
Corega FastEther PCI-TX
D-Link DFE-500TX
DEC DE435, DE425, DEC DE450, and DEC DE500
ELECOM LD-PCI2T, LD-PCITS
I-O DATA LA2/T-PCI
SMC Etherpower 8432, 9332 and 9334
ZNYX ZX3xx
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Controllers and cards supported by the fe driver include:

Allied Telesis RE1000, RE1000Plus, ME1500 (110-pin)
CONTEC C-NET(98)P2, C-NET (9N)E (110-pin), C-NET(9N)C (ExtCard)
CONTEC C-NET(PC)C PCMCIA Ethernet
Eiger Labs EPX-10BT
Fujitsu FMV-J182, FMV-J182A
Fujitsu MB86960A, MB86965A
Fujitsu MBH10303, MBH10302 Ethernet PCMCIA
Fujitsu Towa LA501 Ethernet
HITACHI HT-4840-11
NextCom J Link NC5310
RATOC REX-5588, REX-9822, REX-4886, and REX-R280
RATOC REX-9880/9881/9882/9883
TDK LAC-98012, LAC-98013, LAC-98025, LAC-9N011 (110-pin)
TDK LAK-CD021, LAK-CD021A, LAK-CD021BX
Ungermann-Bass Access/PC N98C+(PC85152, PC85142), Access/NOTE N98(PC86132) (110-pin)

Adapters supported by the fxp driver include:

Intel EtherExpress PRO/10
Intel InBusiness 10/100
Intel PRO/100B / EtherExpressPRO/100 B PCI Adapter *
Intel PRO/100+ Management Adapter
Intel PRO/100 VE Desktop Adapter
Intel PRO/100 M Desktop Adapter
Intel PRO/100 S Desktop, Server and Dual-Port Server Adapters
Contec C-NET(PI)-100TX (PC-98)
NEC PC-9821Ra20, Rv20, Xv13, Xv20 internal 100Base-TX (PC-98)
NEC PC-9821X-B06 (PC-98)
Many on-board network interfaces on Intel motherboards

The ex driver supports the following Ethernet adapters:

Intel EtherExpress Pro/10
Intel EtherExpress Pro/10+
The Olicom OC2220

The ie driver provides supports the following 8 and 16bit ISA Ethernet cards that are based on the Intel
i82586 chip:

3COM 3C507
AT&T EN100
AT&T Starlan 10
AT&T Starlan Fiber
Intel EtherExpress 16
RACAL Interlan NI5210

The ep driver supports Ethernet adapters based on the 3Com 3C5x9 Etherlink III Parallel Tasking chipset,
including:

3Com 3C1 CF
3Com 3C509-TP, 3C509-BNC, 3C509-Combo, 3C509-TPO, 3C509-TPC ISA
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3Com 3C509B-TP, 3C509B-BNC, 3C509B-Combo, 3C509B-TPO, 3C509B-TPC ISA
3Com 3C529, 3C529-TP MCA
3Com 3C562/3C563 PCMCIA
3Com 3C569B-J-TPO, 3C569B-J-COMBO CBUS
3Com 3C574-TX, 3CCFE574BT, 3CXFE574BT, 3C3FE574BT PCMCIA
3Com 3C579-TP, 3C579-BNC EISA
3Com 3C589, 3C589B, 3C589C, 3C589D, 3CXE589DT PCMCIA
3Com 3CCFEM556B, 3CCFEM556BI PCMCIA
3Com 3CXE589EC, 3CCE589EC, 3CXE589ET, 3CCE589ET PCMCIA
3Com Megahertz 3CCEM556, 3CXEM556, 3CCEM556B, 3CXEM556B PCMCIA
3Com OfficeConnect 3CXSH572BT, 3CCSH572BT PCMCIA
Farallon EtherMac PCMCIA

The el driver supports the 3Com 3c501 8bit ISA Ethernet card.

The xl driver supports the following hardware:

3Com 3c900-TPO *
3Com 3c900-COMBO *
3Com 3c905-TX *
3Com 3c905-T4 *
3Com 3c900B-TPO *
3Com 3c900B-TPC *
3Com 3c900B-FL *
3Com 3c900B-COMBO *
3Com 3c905B-T4 *
3Com 3c905B-TX *
3Com 3c905B-FX *
3Com 3c905B-COMBO *
3Com 3c905C-TX *
3Com 3c980, 3c980B, and 3c980C server adapters
3Com 3cSOHO100-TX OfficeConnect adapters
3Com 3c450 HomeConnect adapters
3Com 3c555, 3c556 and 3c556B mini-PCI adapters
3Com 3C3SH573BT, 3C575TX, 3CCFE575BT, 3CXFE575BT, 3CCFE575CT, 3CXFE575CT,
3CCFEM656, 3CCFEM656B, and 3CCFEM656C, 3CXFEM656, 3CXFEM656B, and 3CXFEM656C
CardBus adapters
3Com 3c905-TX, 3c905B-TX 3c905C-TX, and 3c920B-EMB embedded adapters
Both the 3C656 family of CardBus cards and the 3C556 family of MiniPCI cards have a built-in proprietary
modem. Neither the xl driver nor any other driver supports this modem.

The vx driver supports the following cards:

3Com 3c590 EtherLink III PCI *
3Com 3c592 EtherLink III EISA
3Com 3c595 Fast EtherLink III PCI in 10 Mbps mode *
3Com 3c597 Fast EtherLink III EISA in 10 Mbps mode
Crystal Semiconductor CS89x0-based NICs (cs driver)
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The sn driver supports SMC9xxx based ISA and PCMCIA cards including:

3Com Megahertz X-Jack Ethernet PC-Card CC-10BT

The xe driver supports the following cards:

Xircom CreditCard Ethernet (PS-CE2-10)
Xircom CreditCard Ethernet + Modem 28 (PS-CEM-28)
Xircom CreditCard Ethernet + Modem 33 (CEM33)
Xircom CreditCard 10/100 (CE3, CE3B)
Xircom CreditCard Ethernet 10/100 + Modem 56 (CEM56)
Xircom RealPort Ethernet 10 (RE10)
Xircom RealPort Ethernet 10/100 (RE100)
Xircom RealPort Ethernet 10/100 + Modem 56 (REM56, REM56G)
Accton Fast EtherCard-16 (EN2226)
Compaq Netelligent 10/100 PC Card (CPQ-10/100)
Intel EtherExpress Pro/100 PC Card Mobile Adapter 16 (Pro/100 M16A)
Other similar devices using the same hardware may also be supported.

Adapters supported by the lge driver include:

SMC TigerCard 1000 (SMC9462SX) *
D-Link DGE-500SX *

The txp driver supports the following cards:

3Com 3CR990-TX-95 *
3Com 3CR990-TX-97 *
3Com 3cR990B-TXM *
3Com 3CR990SVR95 *
3Com 3CR990SVR97 *
3Com 3cR990B-SRV *

The bge driver provides support for various NICs based on the Broadcom BCM570x family of Gigabit
Ethernet controller chips, including the following:

3Com 3c996-T (10/100/1000baseTX) *
Dell PowerEdge 1750 integrated BCM5704C NIC (10/100/1000baseTX) *
Dell PowerEdge 2550 integrated BCM5700 NIC (10/100/1000baseTX) *
Dell PowerEdge 2650 integrated BCM5703 NIC (10/100/1000baseTX) *
IBM x235 server integrated BCM5703x NIC (10/100/1000baseTX) *
HP ProLiant NC7760 embedded Gigabit NIC (10/100/1000baseTX) *
HP ProLiant NC7770 PCI-X Gigabit NIC (10/100/1000baseTX) *
HP ProLiant NC7781 embedded PCI-X Gigabit NIC (10/100/1000baseTX) *
Netgear GA302T (10/100/1000baseTX) *
SysKonnect SK-9D21 (10/100/1000baseTX) *
SysKonnect SK-9D41 (1000baseSX) *

The em driver supports Gigabit Ethernet adapters based on the Intel 82540, 82541PI, 82542, 82543, 82544,
82546, 82546EB and 82547 controller chips: 

Intel PRO/1000 CT Network Connection (82547)
Intel PRO/1000 F Server Adapter (82543)
Intel PRO/1000 Gigabit Server Adapter (82542)*
Intel PRO/1000 GT Desktop Adapter (82541PI)
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Intel PRO/1000 MF Dual Port Server Adapter (82546)
Intel PRO/1000 MF Server Adapter (82545)
Intel PRO/1000 MF Server Adapter (LX) (82545)
Intel PRO/1000 MT Desktop Adapter (82540)
Intel PRO/1000 MT Desktop Adapter (82541)
Intel PRO/1000 MT Dual Port Server Adapter (82546)
Intel PRO/1000 MT Quad Port Server Adapter (82546EB)
Intel PRO/1000 MT Server Adapter (82545)
Intel PRO/1000 T Desktop Adapter (82544)
Intel PRO/1000 T Server Adapter (82543)
Intel PRO/1000 XF Server Adapter (82544)
Intel PRO/1000 XT Server Adapter (82544)

The gx driver supports Gigabit Ethernet adapters based on the Intel 82542 and 82543 controller chips:

Intel PRO/1000 Gigabit Server Adapter (82542)
Intel PRO/1000 F Server Adapter (82543)
Intel PRO/1000 T Server Adapter (82543)

The hme driver supports the on-board Ethernet interfaces of many Sun UltraSPARC workstation and server
models. Cards supported by the hme driver include:

Sun PCI SunSwift Adapter
Sun SBus SunSwift Adapter ``( hme'' and ``SUNW,hme'')
Sun PCI Sun100BaseT Adapter 2.0
Sun SBus Sun100BaseT 2.0
Sun PCI Quad FastEthernet Controller
Sun SBus Quad FastEthernet Controller

The my driver provides support for various NICs based on the Myson chipset. Supported models include:

Myson MTD800 PCI Fast Ethernet chip
Myson MTD803 PCI Fast Ethernet chip
Myson MTD89X PCI Gigabit Ethernet chip

Broadcom BCM4401 based Fast Ethernet adapters (bfe driver) *

The re driver supports RealTek RTL8139C+, RTL8169, RTL8169S and RTL8110S based Fast Ethernet and
Gigabit Ethernet adapters including:

Alloy Computer Products EtherGOLD 1439E 10/100 (8139C+) *
Compaq Evo N1015v Integrated Ethernet (8139C+) *
Corega CG-LAPCIGT Gigabit Ethernet (8169S) *
Gigabyte 7N400 Pro2 Integrated Gigabit Ethernet (8110S) *
PLANEX COMMUNICATIONS Inc. GN-1200TC (8169S) *
Xterasys XN-152 10/100/1000 NIC (8169) *

The ixgb driver supports the following cards: 

Intel PRO/10GbE LR Server Adapter *
Intel PRO/10GbE SR Server Adapter *
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148
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- B -
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Basic File Recovery     19

Binary (byte to byte copy)    
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Offset     209

Size     209
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Recover     289

Save to File     289
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Auto Detect     123
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Code pages     260
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Create virtual volume sets or RAIDs     5, 95

Fast Partition Search     5

File Mask     40
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Find Previous     30

Find/Mark     30
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Known File Types     42
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OK     266

Open Drive Files     5, 19
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Open in Hex Editor     42
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Preview     33

Previous Pattern     260

Recover     19

Recover Marked     19

Refresh     5

Remove     5

Rename     19

Rename All     19

Reset     42

Save Changes     260

Scan     5, 42

Set Runtime Image     217
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Stop Runtime Imaging     217

Byte to byte image     72
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IP address     165
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Connect to R-Studio settings    

Password     165
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Server     165

Subnet Mask     165

Connecting over the Internet     165

Contact information and technical support     4

Context menu     30, 72

Add Custom offset     123
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Add Missing Disk     95
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Add missing parents     143
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Clear Log...     42

Close drive     29
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Copy as File Signature     269

Copy Editor Display     269
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Create Image File     72
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Create Virtual RAID5     95

Create Virtual Stripe Set     95

Create Virtual Volume Set     95
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Edit     71

File mask     40

Find Next     30

Find Previous     30

Find Previous Versions of the File     33
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Find Template Signature Previous     260

Find/Mark     30

Go Target     283
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Mark     19, 30

Mark All     19

Merge Down     42

Merge Down All     42

Merge Selected     42

Mount     72

No recalculate     287

Open Drive Files     19

Open Drive Files Sorted By     81

Open Scan Information     42

Preview     30, 33

Real File System Structure     81

Recover     19, 30

Recover All Files     81

Recover Marked     19

Remove All Scanned Information     42

Remove Region     69

Save Log to File...     42

Save Scan Information     42

Scan     42

Select From     260

Select To     260

Set As Default Target     283

Set Runtime Image     217

Show drive map...     232

Show Files In Tab     29

Show password     164

Stop Runtime Imaging     217

Toggle Bookmark     260
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Unlock encrypted drive     148

Unmark     19

Unmark All     19

Unmount     72

View/Edit     260

Contextt menu    
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Create menu    

Add Empty Space     95

Add Missing Disk     95

Copy object to...     209

Create Exclusive Region     71

Create Region     69

Create Virtual Block RAID     95

Create Virtual Mirror     95

Create Virtual Volume Set     95

Creating and saving your own RAID configuration     90

Creating Custom Patterns     270

Creating Startup Disks for Mac and Linux Computers  

 
 306

Cross-linked folders     283

Custom Recovery Lists     182

Customizing File Types     60, 62

Customizing File Types-II     64
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- D -
Data Copy in Text/hexadecimal editor     269

Data Formats and Multipliers     287

Data Recovery Issues     283

Data Recovery on HFS/HFS+ File System     287

Data recovery over network     159

Connect to Remote Computer     164

Data Recovery Using R-Studio     18

DeepSpar Disk Imager™ (DDI)     232

DeepSpar USB Stabilizer™     232

Description Files for Various RAID Configurations    
131

Devices to Store Recovered Files     319

Dialog box    

Forensic Log Settings     235

Dialog boxes    

Broken File Name     19

Connect to R-Studio     160, 163, 165

Copy Options     209

Create Exclusive Region     71

Create Image     72

Create Region     69

Edit Block RAID Layout Presets     90

Edit User's File Types     60

Export Recovery List     85

File mask     40

File Types     42

Files with bad sectors     289

Fill     260

Find/Mark     30

Go to     266

Go To Offset     266

Memory Usage     290

Please configure R-Studio Agent for Mac     163

Please configure R-Studio Agent for Windows    
161

Preset name     90

Raid Parameters Detection     123

Recover     19, 81, 164

Recover (Advanced)     83

R-Studio Agent for Linux Configuration     160

Scan     42

Scan Information     42

Search     266

Settings     10

There is not enough space on the disk     19

Direct     260

Disk Image Formats     288

Disk scan     5, 42

Drive Copy Wizard     209

Drive map     232

Drive menu    

Connect To Remote     164

Create Image     72

Open Drive Files     19

Open Drive Files Sorted By     81

Open Image File     72

Open Local Drives     164

Open Scan Informaiton     42

Real File System Structure     81

Recover All Files     81

Remove Scan Informaiton     42

Save Scan Informaiton     42
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Drives Copy Wizard     209
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Bookmarks     266
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Find Next     266

Find Previous     266

Find Template Signature Next     260

Find Template Signature Previous     260

Save Changes     260
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Direct     260

Std     260

Unlimited     260
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Exclusive Region     71
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Start     71

Exclusive Regions     71
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Extended Information Recovery     286
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File Already Exists    

Overwrite     83

Overwrite Bigger     83

Overwrite Older     83

Overwrite Smaller     83

Prompt     83

Rename     83

Skip     83
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File Maps     215
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Hide symbolic links     40
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Goto Target     283
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Preview     33
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Recover Marked     19
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Set As Default Target     283

Show Files in HexEditor     270

View/Edit     260

File search     5

File signature properties     60
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Select All     42

Set as Default     42
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Mass file recovery     81
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Process Memory     290
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Pattern Example I     274
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Properties tab    

Active FAT copy     292

Block Size     292

Blocks Per Volume     292

Boot Directory Cluster     292
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Partition Size     292
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RAID 5     95

RAID block size     95
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RAID for HP Servers     101

RAID Parameter Detection     123

RAID with Parity Delays     101

RAID10 (1+0)     113

RAID1E     115

RAID5E     117

RAID5EE     119

RAID6E     121

RapidSpar™     232

Recover options    
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Post Actions     19

Post Actions Options     176
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Recover metafiles     19
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Recover security:     19
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Remove hidden attributes     19

Restore folder structure:     19
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Installing R-Studio Agent Emergency Startup
Media Creator     326

Network Cards     345
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R-Studio Agent for Mac     163
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File mask     40

Find     30

Find All     30

Find Next     30

Find Previous     30
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Mark All     19
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Save to Hexadecimal File     260

Select All     260

Settings     10

Unmark All     19

TPM     137

- U -
Unlimited     260

USB Activation     171

- V -
Various Disk and Volume Managers     137

View menu    



Index 365

© 2025 R-Tools Technology Inc.

View menu    

ANSI     260

Arrange     19

Bookmarks View     260

Contents Columns     19

Data Interpreter View     260

Device View     5

Devices     5

Event Log     5, 19

Files panel     19

Folders panel     19

Log panel     19

OEM     260

Parents Tab     5
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